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CheckProcessingBrazil 1098
ProcessCheckBrazil 1098
CheckProcessingCanada 1099
ProcessCheckCanada 1100
CheckProcessingFrance 1100
ProcessCheckFrance 1101
CheckProcessingIndia 1102
ProcessCheckIndia 1102
CheckProcessingUK 1103
ProcessCheckUk 1104
CheckProcessingUs 1105
ProcessCheckUs 1105
CMISClient actions 1106
CMISCreateFolder 1107
CMISCreateFolderCustomType 1108
CMISDeleteFile 1109
CMISDeleteFolder 1110
CMISDoesFileExist 1111
CMISDoesFolderExist 1112
CMISDownloadFile 1113

CMISLogDocumentTypes

1114




CMISLogin 1114
CMISRefreshClientCache 1115
CMISSetDocUploadProperty 1116
CMISSetDocUploadType 1118
CMISSetVersion 1119
CMISUploadFile 1120
CMISUploadPage 1121
ColorToBW actions 1122
C2BW_Convert 1122
C2BW_SetAttributes 1123
Convert actions 1124
Common actions 1125
DeleteSourceImagePages 1126
ExceptionSetFileTypes 1126
ExceptionSetHandler 1127
ExceptionSetVariableName 1128
ExceptionSetTaskCondition 1129
SetNamePattern 1130
SetNamePatternFileCheck 1130
PDF compliance standards 1131
Excel actions 1131
ExcelAutoFitColumns 1132
ExcelAutoFitRows 1133
ExcelOrientationToLandscape 1134
ExcelOrientationToPortrait 1135
ExcelPrintBlankPage 1135
ExcelPrintGridlines 1136
ExcelPrintQuality 1137
ExcelScalingFactor 1138
ExcelShapeMinArea 1138
ExcelTiffCompression 1139
ExcelWorkbookToImage 1140
ExcelWorkbookToImageEx 1141
ExcelWorkbookToPdf 1142
Html actions 1143
HtmlLayout 1143
HtmlPrintQuality 1145
Html(TiffCompression 1145
HtmlToImage 1146
HtmlToPdf 1147
Images actions 1148
ImageDefaultDPI 1148
ImageFileTypesToConvert 1149
ImageMonoThreshold 1150
ImageMonoType 1151
ImageToTIFF 1152
Outlook actions 1153

OutlookAttachmentTypelndicator

1153




OutlookMessageToAttachmentOnly 1154

OutlookMessageToImageAndAttachment 1155
OutlookPrintQuality 1156
OutlookTiffCompression 1157
Pdf actions 1158
PDFBitDepth 1158
PDFCompression 1159
PDFConversionMethod 1160
PDFDocumentToImage 1161
PDFGrayscale 1162
PDFHorizontalResolution 1162
PDFQuality 1163
PDFVerticalResolution 1164
PdfFRE actions 1165
PDFFREDocumentToImage 1165
PDFFREReleaseEngine 1168
PDF image compression types 1169
Rtf actions 1170
RtfPrintQuality 1170
RtfTiffCompression 1171
RtfToImage 1172
RtfToPdf 1173
Tiff actions 1174
SplitMultipageTiff 1174
SplitTIFFCompression 1175
Txt actions 1176
TxtFontName 1176
TxtFontSize 1177
TxtPrintQuality 1178
TxtTiffCompression 1178
TxtToIlmage 1179
TxtToPdf 1180
Word actions 1181
WordDocumentToImage 1181
WordDocumentToPdf 1182
WordMonochromeQuality 1183
WordPrintQuality 1183
WordTiffCompression 1184
Zip actions 1185
ZipOverwrite 1185
ZipPassword 1186
ZipUnPack 1187
DatacapBOX actions 1188
Export object 1188
AddParentDataToPageMetadata 1190
CreateBatchSubfolder 1191
DCOVarsAreMetadata 1191

DocumentsToPDF 1192




FailIfFileExists 1193

FieldsAreMetadata 1194
OverwriteExistingFiles 1194
ProcessChildren 1195
ReplaceMetadata 1196
TargetFolder 1196
Upload 1197
Import object 1198
BackupFolder 1199
Download 1200
ImportAsDocumentType 1201
ImportLimit 1201
LookforExtensions 1202
SourceFolder 1203
Dcclip actions 1203
dci_clipfield 1204
DCImageFix actions 1205
ImageEnhance 1205
LoadSettings 1206
LoadSettings_FingerprintID 1207
DCO actions 1208
ChkConfidence 1209
ChkDCOStatus 1210
ChkDCOType 1211
ChkLastDCOTypeEx 1211
ChkIntegrity 1212
ChkLastDCOType 1213
ClearAltText 1214
ClearDCO 1215
CopyPD2DD 1215
CountPagesToDocumentVar 1216
CreateDocuments 1216
CreateFields 1217
DeleteFields 1218
IsDocumentCountMoreThan 1219
IsFirstDocumentInBatch 1219
JoinPreviousDocument 1220
PropagateToAltText 1221
RemoveDocumentStructure 1221
Savelmagelnformation 1222
SetDCOStatus 1224
SetDCOType 1225
SetDocStatus 1226
SetDocumentType 1226
SetFldConfidence 1227
SetPageFingerprintID 1228
SetPageStatus 1229

SetPageTemplatelD 1230




SetPageType 1230

dcpdf actions 1231
dcpdf_CreateTiffFromPDF 1232
dcpdf_CreateTiffFromPDF_CreateDocs 1233
dcpdf_MakePDFDoc 1235
dcpdf_MaxSizeToReconvert 1236
dcpdf_SetApplication 1237
dcpdf_SetAuthor 1238
dcpdf_SetImageBitcount 1239
dcpdf_SetImageCompression 1240
dcpdf_SetImageGrayscale 1240
dcpdf_SetImageQuality 1241
dcpdf_SetImageResolution 1242
dcpdf_SetKeywords 1243
dcpdf_SetProducer 1243
dcpdf_SetSubject 1244
dcpdf_SetTitle 1245
dcpdf_UseAltConversionMethod 1246

DocumentAnalytics actions 1246
FindLabelValuePairs 1248
FindLabelValuePair 1249
CopyLabelValuePairs 1249
CreateHTML 1250
CopyAllBlocks 1251
Analyzelayout 1252
FindPatterns 1253
ExtractText 1255
ExtractTextAlchemylLanguage (deprecated) 1257
ExtractTextLogEnable 1259
ExtractTextNLP 1259
FindExtractedText 1261

DocumentAnalytics.VisualRecognitionClassifier actions 1263
VisualRecogClassify 1263
VisualRecogSetCredentials 1264
VisualRecogSetMinConfidence 1265
VisualRecogSetURL 1266
VisualRecogTrain 1266

DocumentAnalytics.NaturalLanguageClassifier actions 1267
NLCClassify 1268
NLCClassifyText 1269
NLCSetCredentials 1269
NLCSetLanguage 1270
NLCSetMinConfidence 1271
NLCTrain 1272

Documentum actions 1273
DM_Logon 1273
DM_SetContentType 1275

DM_SetFolderName 1275




DM_SetObjectName 1276
DM_UploadDocument 1277
DM_UploadPage 1278
Email actions 1279
SendEMail 1279
SetAttachment 1280
SetBlindCarbonCopyRcpts 1281
SetCarbonCopyRcpts 1281
SetEmailBody 1282
SetMailServer 1283
SetRecipients 1284
SetSender 1284
SetSubject 1285
Equalize actions 1285
EqualizeUnbalancedImage 1286
Ewsmail actions 1287
ex_abort_time 1287
ex_done_folder 1288
ex_EMLOption 1289
ex_ews_version 1290
ex_HTTP_timeout 1291
ex_load_properties_option 1292
ex_login 1293
ex_logout 1294
ex_max_docs 1295
ex_problem_folder 1296
ex_scan 1297
ex_types 1298
ex_wait_time 1299
Export actions 1300
BatchVariable_ExportValue 1302
BlankFields 1303
BlankLines 1303
BPilot 1304
CloseExportFile 1305
DCOProperty 1306
DocumentVariable_ExportValue 1306
ExportAllFields 1307
ExportFieldValue 1308
ExportMYValue 1308
ExportSmartParameter 1309
ExportToBatchDir 1310
Filler 1310
FixedLenlLJ 1311
FixedLenRJ 1312
GetDATE 1312
GetProfileString 1313
GetTime

1314




Lineltem_AddElement

1315

Lineltem_BlankFields 1316
Lineltem_ClearElements 1317
LineItem_ExportElements 1317
LineItem_SmartParameter 1318
NewLine 1319
PageVariable_ExportValue 1320
ResetFieldVariables 1320
SaveFilePathAsVariable 1321
SetCSV 1321
SetElementSeparator 1322
SetExportFileEncodingAsASCII 1323
SetExportPath 1324
SetExtensionName 1325
SetFileName 1325
SetFill 1326
SetFixedLength 1327
SetlgnoreFieldStatus 1327
SetJustified 1328
SetOMR_Separator 1329
SetSpacefFill 1329
SetZeroFill 1330
Text 1331
Variable_ExportValue 1331
Variable_IsValue 1332
ExportDB actions 1333
AddRecord 1333
ExportBatchIDToColumn 1334
ExportCloseConnection 1335
ExportFieldToColumn 1336
ExportNodeXMLToColumn 1337
ExportOpenConnection 1338
ExportPropertyToColumn 1339
ExportSmartParamToColumn 1340
ExportToColumn 1341
SetTableName 1343
ExportXML actions 1344
xml_CommitNode 1344
xml_NewNode 1345
xml_SaveFile 1346
xml_SetAttributeValue 1346
xml_SetExportPath 1347
xml_SetFileEncodingAsASCII 1348
xml_SetFileName 1349
xml_SetNodeValue 1349
FileIO actions 1350
CheckFreeDiskSpace 1351

CopyDirectory

1352




CopyFile

1353

DeleteDirectory 1354
DeleteFile 1355
GetFileSize 1356
GetProfileString 1357
IsDirectoryPresent 1358
IsFilePresent 1359
IsFileReadOnly 1360
IsProfilePresent 1361
Readtextfile 1362
RenameFile 1363
SetFileReadOnly 1364
SetProfileString 1365
SplitFileName 1366
ZipOcrResults 1367
FileNetIDM actions 1368
AddAllImagesToDocument 1370
AddFileToDocument 1370
AddPDFImageToDocument 1371
AddTIFImageToDocument 1372
CreateFolder 1373
FileNetDB_ADOConnect 1373
FileNETDocID_SaveAsSmartParameter 1374
FileNETDocID_SetValue 1374
GetDocuments 1375
GetTopFolders 1376
IndexProperty_ID_Component 1376
IndexProperty_ID_DateComponent 1377
IndexProperty_ID_Value 1378
IndexProperty_LeftJUSTIFY 1379
IndexProperty_RightJUSTIFY 1380
IndexProperty_SmartParameter 1380
Library_DMA_Initialize 1381
Library_DS_Initialize 1382
Library_IS_Initialize 1382
Library_LogIn 1383
Library_LogOff 1384
NewDocument 1384
SaveDocToFolder 1385
Upload 1386
Upload_SetDelay 1387
Upload_SetNumAttempts 1387
UseIndexes_OFF 1388
Uselndexes_ON 1389
FileNet P8 actions 1389
FNP8_AddRedactionsToP8Document 1391
FNP8_CreateFolder 1392

FNP8_Login

1392




FNP8_MultiPageDocs

1393

FNP8_SearchAndDownload 1394
FNP8_SetSearchAndDownloadStatusProperty 1396
FNP8_SetSearchClass 1397
FNP8_SetSearchCurrentVersionOnly 1397
FNP8_SetSearchDownloadDir 1398
FNP8_SetSearchFolderRestriction 1399
FNP8_SetSearchIncludeDocsWithoutContent 1400
FNP8_SetSearchIncludeSubClasses 1401
FNP8_SetSearchMaxItems 1402
FNP8_SetSearchOrderBy 1402
FNP8_SetSearchWhereClause 1403
FNP8_SetDefineSecurityParentage 1404
FNP8_SetDestinationFolder 1405
FNP8_SetDocClassId 1406
FNP8_SetDocTitle 1406
FNP8_SetFileMimeType 1407
FNP8_SetFileType 1409
FNP8_SetKeyProperty 1410
FNP8_SetlLocale 1411
FNP8_SetMultiValueProperty 1411
FNP8_SetProperty 1412
FNP8_SetPropertyEx 1413
FNP8_SetRetry 1414
FNP8_SetTargetClassID 1414
FNP8_SetTargetObjectID 1415
FNP8_SetTimeout 1416
FNP8_SetUploadMode 1416
FNP8_SetURL 1417
FNP8_UpdateProperties 1418
FNP8_Upload 1418
FNP8_UploadDir 1419
FingerprintMaintenance actions 1420
CloseDatabase 1420
DeleteFingerprint 1421
DeleteFingerprints 1422
OpenDatabase 1423
SetFingerprintFolder 1424
FPXML actions 1424
ReadZonesFPX 1425
SetDetailsAndLineitemPairFPX 1426
SetDirectoryFPX 1427
WriteZoneFPX 1428
WriteZonesFPX 1429
Grayscale actions 1430
ConvertGraytoBW 1430
HandwritingRecognition actions 1431

Recognize

1432




SetAddressApartmentZone 1433

SetAddressCityStateZipZone 1434
SetAddressCityStateZone 1435
SetAddressCityZone 1435
SetAddressStateZone 1436
SetAddressZipZone 1437
SetAmountFormat 1438
SetBoxRemovalMode 1439
SetCreditCardFormat 1440
SetDateFormat 1441
SetDeskew 1442
SetFieldType 1443
SetFullNameFormat 1449
SetLanguage 1450
SetLineRemovalMode 1451
SetMultiLineMode 1452
SetNoiseRemoval 1453
SetPostalDatabase 1454
SetProcessingMode 1455
SetSpecialCharacterSet 1456
SetTemplate 1457
SetValidLength 1458
SetValidValues 1458
SetVocabulary 1459
SetWritingStyle 1460
IBMCM actions 1462
IBMCM_AddPages 1463
IBMCM_CreateFolder 1464
IBMCM_Createltem 1465
IBMCM_SetAttributeValue 1466
IBMCM_CreateChildItem 1468
IBMCM_SetChildAttributeValue 1468
IBMCM_DeletePages 1470
IBMCM_Logon 1471
IBMCM_ReplacePage 1472
IBMCM_SearchItem 1472
IBMCM_SetSearchOnlyFolderItems 1473
IBMCM_SetMimeType 1474
IBMCM_SetDestinationFolder 1476
IBMCM_SetDestinationFolderEx 1477
IBMCM_StoreltemIDinDCO 1478
IBMCM_UploadDCO_DOC 1479
IBMCM_UploadDCO_Page 1480
IBMCM_SearchAndDownload 1481
IBMCM_SetSearchAndDownloadCriteria 1482
IBMCM_SetSearchAndDownloadDirectory 1483
IBMCM_SetSearchAndDownloadMaximum 1485

IBMCM_SetSearchAndDownloadSort 1486




IBMCM_SetSearchAndDownloadStatusAttribute

1487
ICR_C actions 1488
EnableLoggingICR_C 1489
RecognizeFieldICR_C 1489
RecognizeFieldVoteICR_C 1490
RecognizePageFields2CCO_ICR_C 1491
RecognizePageFieldsICR_C 1492
RecognizePageFieldsICR_CEx 1493
RecognizePageICR_C 1493
RecognizePageToPDFICR_C 1494
ImageConvert actions 1495
AppendAllImages 1496
AppendAlllImages_ByType 1496
AppendImage 1497
AppendImage_StartAsNew 1498
ConvertToJPEG 1499
ConvertToTIFF 1500
RescaleImage 1500
SetChrominanceFactor 1501
SetDeleteOriginal 1502
SetGrayScale 1503
SetImageDPIByWidth 1503
SetLuminanceFactor 1504
SetTIFFCompression 1505
ImageFix actions 1506
Imail actions 1506
im_abort_time 1507
im_AcceptMixedAttachments 1508
im_AcceptNoAttachments 1509
im_done_folder 1510
im_login 1511
im_logout 1512
im_max_docs 1513
im_problem_folder 1513
im_reject_types 1514
im_scan 1515
im_SetProxy 1517
im_SortByDate 1518
im_StoreEML 1519
im_types 1520
im_UseSSL 1521
im_wait_time 1521
Imprint actions 1522
AnnotateImage 1523
RedactByRegEx 1524
RedactParameters 1525
SetAdjustedWidth 1526
SetFontName

1527




SetFontSize 1527

SetOpaque 1528
Intellocate actions 1529
iloc_AdjustZones 1529
iloc_AssignPageType 1530
iloc_SetDetailZones 1531
iloc_SetZones 1531
IsPageDataMissing 1532
Invoice actions 1533
AddToDetailErrorMsg 1535
AddToErrorMsg 1535
AllMixedCase 1536
AlterDatebyDay 1536
CalculateNotesZone 1537
CaptureOpInfo 1538
CheckAndFixDecimal 1538
CheckForSticky 1539
CheckFreeDiskSpace 1540
ClearErrorMsg 1541
CreateFingerprint 1541
DetailFix 1542
FindExportImage 1543
FPXMLUsed 1543
GenerateDetails 1544
iloc_SetDetailSimple 1544
IncrementBatchVar 1545
IsFingerPrintClass 1546
IsInINI 1546
IsInList 1547
IsMultipageDocument 1548
IsSinglePageDocument 1548
IsStationIDSuffix 1549
Is_JobNamePrefix 1549
LoadCCOFromField 1550
PopulateZNLineIltemFieldDynamic 1551
ReadFPXMLZones 1551
ScanLineltemDynamic 1552
SendOutlookNotification 1553
SetDynamicDetailZones 1553
SetStickyNo 1554
SwapImages 1555
SwitchMMDD 1555
UpdateFPStats 1556
ValidateVendor 1556
WriteErrorMessage 1557
IOverlay actions 1558
Overlay 1558

SetBackgroundImage 1559




SetDitheringBackground

1560

SetHaloBackground 1560
Locate actions 1561
AddKeyList 1565
AggregateKeyList 1566
CreateVirtualPage 1567
CreateVirtualZone 1568
DefaultValue 1570
FilterIt 1570
FindDBList 1571
FindDBList_InZone 1572
FindKeyList 1573
FindKeyList_InZone 1574
FindLastKeyList 1575
FindLastKeyList_InZone 1576
FindLastRegEx 1577
FindLastRegEx_InZone 1577
FindLastRegExList 1578
FindLastRegExList_InZone 1579
FindLastWord 1580
FindLastWord_InZone 1581
FindNextDBList 1582
FindNextDBList_InZone 1583
FindNextKeyList 1584
FindNextKeyList_InZone 1585
FindNextRegExList 1586
FindNextRegExList_InZone 1587
FindRegExList 1588
FindRegExList_InZone 1589
GetSelectedBlockType 1590
GoAboveWord 1591
GoBelowWord 1592
GoDownlLine 1593
GoFirstLine 1593
GoFirstWord 1594
GolastLine 1595
GolastWord 1596
GolLeftWord 1596
GoRightWord 1597
GoSiblingBlockNext 1598
GoSiblingBlockPrevious 1599
GoUpLine 1600
GroupWords 1601
GroupWordsLEFT 1602
GroupWordsRIGHT 1602
IsAlpha 1603
IsCurrency 1604

IsDateValue

1605




IsNumber

1606
IsSelectedBlockType 1607
IsValue 1608
IsValue_RegEx 1609
LocatePositionRestore 1609
LocatePositionSave 1610
MaxLength 1611
MergeWordLF 1612
MergeWordRT 1613
MinLength 1614
RegExFind 1614
RegExFind_InBlock 1615
RegExFind_InZone 1616
RegExFindNext 1617
RegExFindNext_InBlock 1618
RegExFindNext_InZone 1619
ScanRT 1620
SelectParentBlock 1620
SelectParentBlockOuterType 1622
SelectParentBlockType 1623
SelectSnippet 1624
SetKeyFileEncodingAsUnicode 1625
SetRect 1625
SetVirtualPageEndPosition 1626
SetVirtualPageStartPosition 1627
UpdateDCOField 1628
UpdateField 1628
UpdateFieldWithBlock 1629
ValuelnField 1630
ValuelnField_Fuzzy 1631
ValuelnField_RegEx 1631
WordFind 1632
WordFind_InZone 1633
WordFindNext 1634
WordFindNext_InZone 1635
WordFind_Offset 1636
Lookup actions 1637
ClearLookupResults 1637
CloseConnection 1638
ExecuteSQL 1638
ExecuteSQLEx 1639
OpenConnection 1640
PopulateWithResult 1641
SmartSQL 1642
SmartSQLEX 1643
MC_Identify 1644
AutoField 1644
FindFields

1645




ReadDCOSetup

1646

ReadPageSetup

1647

SetFormType

1648

SetMaxTolerantDistance

1648

MC_Validation

1649

AddCenturyTo2YearDigit
AddToDetailErrorMsg

1650

1651

AddToErrorMsg

1652

CalculateHCFALineCharges

CalculateUBLineCharges
CheckDocID

1652

1653

1654

ClearErrorMsg

1654

CommonParseAddress

1655

CommonValAddress

1656

ConvertHyphen

1657

FilterPID

1657

FormatFieldLengths

1658

InheritSnippets

1659

MC_ReadZones

1659

Parse3l1aPhSig

1660

Parse58ainsnm

1661

Parse58binsnm

1661

Parse58cinsnm

1662

ParseConditionCodes

1663

ParseEPSDT

1663

ParselLastFirstIniNames

1664

ParseNDC

1665

PopulateFromField

1666

SetConf

1666

SetOriginalTIF

1667

StripTrailingAlpha

1668

TransformLI

1668

UpdateCredentialList

1670

ValidateNPI

1671

ValProcedureCode

1671

ValRequiredGroup

1672

mvscan actions

1673

mv_retain_folder

1674

scan

1675

set_abort_time

1676

set_copy_folder

1677

set_delete_empty_folders

set_folder

1678

1679

set_image_validation

1680

set_max_docs

1681

set_metadata_types

1682

set_min_age

1683

set_move_wait_time

1684




set_multipage_burst

1685

set_problem_folder 1686
set_sort_method 1687
set_tree_mode 1688
set_types 1688
set_wait_time 1689
Maintenance Manager actions 1690
Application setup actions 1691
SetAdminDB 1691
SetApplication 1692
SetEngineDB 1693
SetPassword 1694
SetServer 1695
SetStation 1696
SetupDisconnectAll 1697
SetupOpenApplication 1697
SetupOpenApplicationEx 1698
SetUser 1700
Query setup actions 1701
QueryClear 1702
QuerySetAge 1702
QuerySetBatchRange 1704
QuerySetBranch 1704
QuerySetDateFormat 1705
QuerySetDateRange 1707
QuerySetDateTimeFormat 1708
QuerySetGeneric 1711
QuerySetJobID 1711
QuerySetOperator 1712
QuerySetPriority 1713
QuerySetSeparator 1714
QuerySetStation 1715
QuerySetStatus 1716
QuerySetTaskID 1717
Batch processing actions 1718
ProcessChangeBatchStatus 1719
ProcessChangeBatchStatusOrder 1720
ProcessChangeBatchStatusTaskOrder 1720
ProcessClearAuditTable 1721
ProcessClearDebugTable 1722
ProcessDeleteBatchesEx 1723
ProcesslInjectBatches 1724
ProcessMoveBatchesEx 1725
ProcessMoveDBRecords 1726
ProcessResetPendingOrNotify 1728
ProcessRunSqlQueryEx 1729
Logging actions 1730

LogClear

1731




LogConfigure

1731

LogSendEmail 1732
LogWriteEventLog 1734
LogWriteRecordSet 1735
LogWriteSQLQuery 1735
Reporting actions 1736
ReportQueryTMUsage 1737
ReportSetReportingTable 1737
ReportSetUsageDBTable 1738
OCR_J actions 1739
InitializeEngine 1740
Recognize 1740
ReleaseEngine 1742
OCR_A actions 1742
EnableEngineLogsOCR_A 1743
OCRA_ConvertImage2BW 1744
Recognize 1744
RecognizeBarcodeOCR_A 1751
RecognizeFieldOCR_A 1751
RecognizeFieldVoteOCR_A 1752
RecognizePageFieldsOCR_A 1753
RecognizePageOCR_A 1754
RecognizeTOALTOOCR_A 1754
RecognizeToPDFOCR_A 1756
ReleaseEngineOCR_A 1758
RotateImageOCR_A 1759
SetAutoRotationOCR_A 1760
SetConfCalculationParamsOCR_A 1760
SetFastModeOCR_A 1761
OCR_N actions 1762
RecognizePageFieldsOCR_N 1762
RecognizePageOCR_N 1763
OCR_SR actions 1764
Recognize 1765
RecognizeFieldOCR_S 1767
RecognizeFieldVoteOCR_S 1767
RecognizePageFieldsOCR_S 1768
RecognizePageOCR_S 1769
RecognizeToFileOCR_S 1771
RecognizeToPDFOCR_S 1773
RotateImageExXOCR_S 1775
RotateImageOCR_S 1776
SetContinueOnFailureOCR_S 1777
SetEngineTimeoutOCR_S 1778
SetOutOfProcessLoggingOCR_S 1779
SetOutOfProcessTimeoutOCR_S 1780
UseOutOfProcessRecogOCR_S 1781

OpenTextFaxServer actions

1781




Connect

1782

ContinueOnConnectionError 1783
ContinueOnFaxImportError 1784
Disconnect 1785
ImportFaxes 1786
SendAsFax 1787
SetAbortTimeout 1788
SetFaxRemovalAfterImport 1789
SetInputFolder 1790
SetMaxNumberOfFaxes 1790
SetNumberOfRetries 1791
SetPollingInterval 1792
SetProcessedFaxesFolder 1793
SetProtocol 1794
SetRetryTimeout 1795
SetServerName 1796
SetUserID 1797
SetUserPassword 1798
SetWindowsAuthentication 1799
PatternMatch actions 1799
MatchPattern 1800
pat_RecogMatch_Id 1801
pat_RegisterZones 1802
pat_ReleasePageAnchors 1803
PatternMatch_Fingerprint 1804
PatternMatch_Identify 1805
PatternMatch_PageType 1806
SetMatchConfidence 1807
Picture actions 1808
PIC_ApplyPictureString 1808
PIC_FilterFields 1809
PIC_FormatFields 1810
PIC_ReplaceBlankField 1812
PIC_SetPictureCharacter 1813
PIC_ValidateField 1814
POLR actions 1814
CallPOLR 1815
Recog_Shared actions 1816
AnalyzeImage 1817
CCONormalization_OFF 1818
CreateTextFile 1819
IsBlankPage 1820
RecogContinueOnFailure 1820
RecogOMRThreshold 1822
RegisterPageFields 1823
RotateTio 1824
SetAdjustFieldToChars 1825

SetFingerprintRecogPriority

1826




SetFullPageRecogArea 1826

SetOutOfProcessRecogTimeout 1827
SetRecogFailureRetryDelay 1828
SetupAutomaticRetry 1829
SnapCCOtoDCO 1831
SnapDCOtoCCO 1832
SnapFieldtoChars 1833
UseOutOfProcessRecog 1833
rrunner actions 1834
AbortOnError 1836
CheckAllIntegrity 1837
CheckDocCount 1837
CheckPageCount 1838
DebugMode_OFF 1839
DebugMode_ON 1839
GoToNextFunction 1840
MessagelD 1841
MessagelDParameter 1841
PilotMessage_Clear 1842
PilotMessage_Set 1843
ProcessChildren 1843
rr_AbortBatch 1844
rr_Get 1844
rr_WriteNode 1845
rrAppend 1846
rrCompare 1847
rrCompareCase 1848
rrCompareCaselLength 1849
rrCompareNot 1850
rrCompareNotCase 1851
rrCompareNotCaselLength 1852
rrCompareNumeric 1853
rrContains 1854
rrCopy 1855
rrPrepend 1856
rrSet 1857
SetBatchPriority 1858
SetOperatorID 1859
SetReturnValue 1859
SetStationID 1860
SetTaskStatus 1861
SkipChildren 1862
Status_Preserve_OFF 1862
Status_Preserve_ON 1863
Task_NumberOfSplits 1863
Task_RaiseCondition 1864
SharedRecognitionTools actions 1865

CreateCcoFromLayout 1865




SignatureValidation actions

1866

CreateNew 1866
SetMinimumConfidence 1867
SetSignatureReferenceFolderPath 1868
ValidateSignature 1869
SPExport actions 1870
SP_CreateFolder 1871
SP_Login 1872
SP_SetContentType 1872
SP_SetFileType 1873
SP_SetProperty 1874
SP_SetUploadMode 1875
SP_SetUrl 1875
SP_Upload 1876
SP_UploadDir 1877
Split actions 1877
SplitBatch 1878
Statistics actions 1879
AddToDBTotals 1880
CompareFieldsText 1880
IsBatchAborted 1881
SaveFieldsText 1881
TifMerge actions 1882
TifMerge_CheckStatus 1883
TifMerge_ExportToBatchDir 1884
TifMerge_MergeImages 1884
TifMerge_MyImage 1885
TifMerge_PreserveCompression 1886
TifMerge_SetFileName 1887
TifMerge_SetFilePath 1888
TM524 actions 1888
Validations actions 1888
AddLeadingZeros 1892
AddPaddingToEnd 1893
AddPaddingToStart 1893
AddTrailingZeros 1894
AllowOnlyChars 1895
AppendFromField 1895
AppendToField 1896
AssignFieldDefault 1896
CalculateDateDifference 1897
CalculateFields 1898
CheckSubFields 1900
CompareFields 1901
ConvertFieldToCurrency 1902
ConvertToLowerCase 1903
ConvertToUpperCase 1903
CopyField 1904




CopyFieldToField

1904

DateStampField

1905

DeleteAllAlpha

1906

DeleteAllMiscChars

1906

DeleteAlINumeric

1907

DeleteAllPunct

1908

DeleteAllSysChars

1908

DeleteChildType

1909

DeleteLCSpaces

1909

DeleteParentObj

1910

DeleteSelectedChars

1911

EmptyFieldValue

1912

FieldContainsValue

1912

FilterFieldSelectedChars

1913

FormatNumberTolLocale

1913

GetJobID

1915

HasChildOfType

1915

InsertChars

1916

InsertDecimalPoint

1917

IsFieldCurrency

1917

IsFieldDate

1918

IsFieldDateEqualOrAfter

1919

IsFieldDateEqualOrBefore

1919

IsFieldDateUpToToday

1920

IsFieldDateWithinRange

1920

IsFieldDateWithinXDays

1921

IsFieldDateWithReformat

1922

IsFieldEmpty

1922

IsFieldFilled

1923

IsFieldGreaterOrEqual

1924

IsFieldHidden

1925

IsFieldLengthMax

1925

IsFieldLengthMin

1926

IsFieldLessOrEqual

1926

IsFieldMatching

1927

IsFieldPercentAlpha

1928

IsFieldPercentNonNumeric
IsFieldPercentNumeric

1928

1929

IsMatchingJobID

1930

IsMaxOMRChecked

1930

IsMinOMRChecked

1931

IsPatternInField

1932

IsSupportedImageFile

1932

IsThisFieldEmpty

1933

IsThisFieldFilled

1934

IsVariableEmpty

1934

IsVariableFilled

1935

ParseMultilineAddress

1936




ParseName

1936

ReplaceChars 1937
ReplaceValueAtPosition 1938
ResetField 1938
SetIsOverrideable 1939
SplitFieldValuePreserveEnd 1940
SplitFieldValuePreserveStart 1940
SumFields 1941
TimeStampField 1942
TrimSpaces 1943
TruncateFromEnd 1943
TruncateFromStart 1944
Vote actions 1944
VoteFld 1945
Vscan actions 1945
AddDocument 1946
CopyFile 1947
DeleteImageFile 1948
MovelImageFileToDirectory 1949
Scan 1950
SearchInSubdirectory 1951
SetAlternateImageNames 1951
SetFastMode 1952
SetImageType 1953
SetMaxImageFiles 1954
SetMultiPageTiff 1954
SetSortOrder 1955
SetSourceDirectory 1956
Web Services actions 1957
WsClearHeaders 1958
WsClearParameters 1958
WsClearResultItems 1959
WsEncodeParameter 1960
WsGetFile 1961
WsGetValues 1961
WsSetCredentials 1962
WsSetHeader 1963
WsSetNamespace 1964
WsSetParameter 1964
WsSetResultItem 1965
WsSetTimeout 1966
WsUploadData 1966
WsUploadFile 1967
Zones actions 1968
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Dokumentacja programu IBM Datacap 9.1.3

Witamy w dokumentacji programu IBM® Datacap w wersji 9.1.3, w ktérej znajdziesz informacje dotyczace
instalacji, obstugi i uzywania programu IBM Datacap.
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Co nowego w wersji 9.1.3 programu IBM Datacap

Sekcja ,,Co nowego” zawiera informacje o nowych funkcjach i zmianach wprowadzonych w najnowszej wersji
IBM® Datacap 9.1.3 wzgledem poprzedniej wersji IBM Datacap 9.1.2.

e Conowego w wersji 9.1.3 programu IBM Datacap
Wersja 9.1.3 programu IBM Datacap oferuje nowe funkcje i udoskonalenia.
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Co nowego w wersiji 9.1.3 programu IBM Datacap

Wersja 9.1.3 programu IBM® Datacap oferuje nowe funkcje i udoskonalenia.

Udoskonalenia w programie Datacap Navigator

e Monitor zadan programu Datacap Navigator — wyszukiwanie wg daty

W Monitorze zadan programu Datacap Navigator mozna wyszukiwaé partie wedtug daty. Wyszukiwanie
nie ogranicza sie do istniejgcych zatadowanych stron. W zapytaniach o daty obstugiwane sg operatory
réwnosci, poprzedzania, nastepstwa i przedziatu. Wiecej informacji...

e Przy skanowaniu transakcyjnym z programu Navigator lub IBM Case Manager obstugiwana jest
przegladarka wirtualna Daeja.

e W programie Datacap Navigator wprowadzono nastepujace nowe funkcje i udoskonalenia:

Speed Scan Client: klient szybkiego skanowania

Batch Prep Client: klient przygotowania partii

Speed Index Client: klient indeksowania szybkiego

Rownolegte przesytanie stron, ktore zwieksza wydajnos$¢ przesytania

Obstuga przesytania asynchronicznego

o

O O O O

Wiecej informacji...

Utatwienia w uzywaniu
Datacap Navigator oferuje nastepujace udoskonalenia, dzieki ktorym mozliwe jest:

(o]
o
o

o O O O o

O O O O ©O

zaktualizowanie filtru;

skonfigurowanie przyciskow w panelu pola klienta Verify;

usuniecie jednym kliknieciem wszystkich stron w widoku miniatur. Ta funkcja jest dostepna
tylko w kliencie Speed Scan;

wyswietlenie listy zapisanych filtrow;

zmiana statusu partii z powrotem na Oczekujaca;

usuniecie wszystkich obrazéw w partii jednym kliknieciem w panelu skanowania;
wyswietlanie zrozumiatych etykiet w drzewie partii klientéw Scan, Fix-up i Verify, po
zeskanowaniu dokumentéw ze skanera lub folderu lokalnego badz po skopiowaniu stron
lub podzieleniu dokumentéw;

zmiana statusu partii z powrotem na Oczekujace w klientach, takich jak klient Speed Scan i
Speed Index;

wys$wietlanie paska przewijania w przegladarce wirtualnej, w widoku miniatur;

sortowanie odfiltrowanej listy partii w Monitorze zadan;

tworzenie predefiniowanych filtréw (z wieloma kryteriami) i zapisywanie filtréw;
stosowanie zapisanych filtrow bez koniecznosci tworzenia ich za kazdym razem od nowa;
usuwanie filtrow.

e Mozliwe jest uzywanie adnotatorow ExtractText w przypadku korzystania z tekstu zajmujacego wiecej niz
jeden blok na poziomie dokumentu.

Nowe dziatania w bibliotece dziatan programu Datacap

e Dziatanie rrCompareNumeric

Dziatanie rrCompareNumeric umozliwia poréwnywanie wartosci liczbowych za pomocg operatorow
mniejszosci i wiekszosci. Wiecej informacji...

2 Datacap 9.1.3



Dziatanie SaveImageInformation

Dziatanie SaveImagelnformation uzyskuje informacje o obrazie i zapisuje je w obiekcie DCO. Wiecej
informaciji...

Dziatanie Visual Recognition Classifier

Dodano nowe dziatanie stuzace do szkolenia klasyfikatora Visual Recognition Classifier. Dziatanie to jest
podobne do dziatania stuzacego do uczenia klasyfikatora Natural Language Classifier. Ponadto zmienito
sie dziatanie classify zaréwno dla klasyfikatora IBM Watson Natural Language Classifier, jak i VisualAge
— obecnie jego parametrem jest nazwa klasyfikatora. Dzieki temu autor aplikacji nie musi uzywac

identyfikatora klasyfikatora, ktory mozna traktowac jako wewnetrzng wartos$c¢ +F28. Wiecej informaciji...

Dziatanie Natural Language Classifier

Dodano nowe dziatania stuzace do klasyfikacji tekstu przy uzyciu klasyfikatora IBM Watson Natural
Language Classifier. Wiecej informacji...

Nowe dziatania IBM Content Manager

Te dziatania sg przydatne do wyszukiwania i pobierania dokumentéw programu IBM Content Manager.
Zobacz inne dziatania

Nowe dziatania FileNet P8
Te dziatania sg przydatne do wyszukiwania i pobierania dokumentéw. Zobacz inne dziatania
Dziatanie rrContains

Dziatanie rrContains umozliwia manipulowanie czescig tancucha w zmiennej lub w polu. Na podstawie
wprowadzonych parametrow inteligentnych wyszukuje i poréwnuje wartosci zmiennych dwéch
obiektow. Wiecej informacii...

Dziatanie CreateVirtualZone

To dziatanie tworzy strefe pola w czasie wykonywania na podstawie zidentyfikowanych potozen tekstu.
Wiecej informaciji...

Nowe dziatanie stuzace do ustawienia klucza grupy filtrow zestawu partii

Dodano nowe dziatanie umozliwiajace twoércom aplikacji ustawienie nowego klucza grupy filtrow partii w
tabeli tmbatch. Dziatanie akceptuje jedng lub wiecej nazw grup i zapisuje tancuch lub (co jest
preferowane) odwzorowang warto$¢ catkowitg (obliczang na podstawie trybu). Po zwolnieniu partii
klient (Rulerunner, FastDoc, DcDesktop lub Navigator) przekazuje te informacje do aTM.

Dziatanie RefreshFields

Dziatanie RefreshFields tworzy pola, ale zachowuje istniejgce dane. Jest podobne do dziatania
CreateFields, z tym ze jesli istnieje plik danych dla strony, to poprzednio utworzone pola nie sg usuwane,
a do strony dodawane sg nowe pola.

Dziatania AddDcoNode

Dziatanie AddDcoNode tworzy wezet DCO typu wskazanego przez pole, strone lub dokument. Nowe
wezty mozna dodawaé na wszystkich poziomach (tj. dokumentu, strony i pola). Jesli istnieje wezet tego
samego typu o tym samym identyfikatorze, to nowy wezet nie jest tworzony, a dziatanie zwraca wartos$¢
True.
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Dziatanie rrSet_IDzmienia nazwe docelowego wezta DCO tak, by byta réwna wartosci ze zrédta.
Przypisuje docelowemu identyfikatorowi (dco.id) wartos¢ ze zrédta. Dziatanie zwraca False tylko wtedy,
gdy nie moze odszukac¢ obiektu docelowego. W przeciwnym razie zwraca True.

Udoskonalenia ogdlne

e Wytaczanie ikony zamknigcia na karcie

W ustawieniach gtownych funkcji programu Datacap na pulpicie dodano ustawienie umozliwiajace
wtaczenie lub wytaczenie ikony zamkniecia karty (Monitor zadan, Szybkie skanowanie). Domyslnie ikona
zamkniecia jest wtgczona.

¢ Utajnianie wielostronicowych plikow i PDF
Mozliwe jest utajnianie wielostronicowych plikow TIFF i PDF.
¢ Filtrowanie partii na podstawie rol i grup w srodowiskach DcDesktop i FastDoc
Mozliwe jest filtrowanie partii na podstawie roli grup w srodowiskach DcDesktop i FastDoc.
¢ Masowe pobieranie tresci FileNet P8 przy uzyciu zadania przegladania w systemie FileNet.

Mozna wykorzystaé srodowisko przegladania FileNet do masowego pobierania tresci systemu FileNet
P8. Wiecej informaciji...

e Optymalizacja wydajnosci

Odswiezanie stron interfejsu uzytkownika stuzacych do weryfikacji i klasyfikowania trwa teraz krécej,
gdy uzywane jest uwierzytelnianie LLLDAP.

o Ustawienie tabel OCR/A nakazujace rozpoznawanie kazdej linijki jako wiersza tabeli

Udostepniono ustawienie mechanizmu ABBYY zwigzane z rozpoznawaniem tabel. Nakazuje ono
rozpoznawanie kazdej linijki w tabeli jako osobnego wiersza tej tabeli. Jesli kazda linijka jest osobnym
wierszem tabeli, a mimo to mechanizm rozpoznaje komorki wielowierszowe, mozna uzy¢ tego
ustawienia, aby wymusic¢ traktowanie kazdej linijki jako osobnego wiersza.

¢ Udoskonalenie programu Datacap Application Manager

Udoskonalony program Datacap Application Manager umozliwia wybranie wartosci "{domyslne}" dla
niektorych ustawien aplikacji, tak aby obowigzywaty ustawienia ze strony serwera. Do listy
mechanizmow uwierzytelniania dodano ADLDS.

o Wieksza skutecznosé identyfikacji dzieki mozliwosci zdefiniowania strefy w lokalizacji

Dodano mechanizm udostepniajagcy OCRA wspotrzedne tabeli dla wybranego zestawy regut. Stuzy to
usprawnieniu identyfikacji tabel, gdy mozliwe jest wyznaczenie strefy w lokalizacji.

¢ Wyswietlanie dostepnych szablondw partii dla wybranego zestawu regut

Dodano okno dialogowe wys$wietlajgce dostepne szablony partii dla wybranego zestawu regut. Dodano
takze przycisk "URUCHOM" inicjujacy dziatanie wybranego zestawu regut.

e W programie Datacap Studio dodano kreator parametrow inteligentnych

W programie Datacap Datacap Studio podczas ustawienia parametrow dziatan dostepny jest nowy
kreator parametréw inteligentnych. Wiecej informacji...
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Inne nowe mozliwosci

Mozliwosé skanowania na komputerach Apple Macintosh
Mozliwe jest skanowanie przy uzyciu komputera Apple Macintosh.
Mozliwosé zaktualizowania liczb stron i dokumentéw po zakoiiczeniu skanowania

Mozliwe jest zaktualizowanie liczb stron i dokumentéw wyswietlanych w Monitorze zadan bezposrednio
po zakonczeniu czynnos$ci skanowania.

Mozliwo$é wyswietlania list wynikéw wyszukiwania ustug Web Services

Listy wynikow wyszukiwania ustug Web Services mozna wyswietla¢ w interfejsie uzytkownika stuzacym
do weryfikacji.

OCR/A moze rozpoznawac tabele wytacznie na podstawie linii siatki

OCR/A moze rozpoznawac tabele wytacznie na podstawie linii siatki. Obstugiwane jest ustawienie
konfiguracyjne y_SplitOnlyBySeparators w bibliotece Abbyy OCR/A, ktore nakazuje mechanizmowi
rozpoznawanie tabel wytacznie na podstawie linii siatki na stronie.

Zmiana mechanizmu rozpoznawania OCR/SR
Modut OCR/SR wyposazono w nowy mechanizm rozpoznawania w wersji 20

Mozliwe jest okreslanie konfigurowalnych kryteriéw ustalania priorytetow dla kolejkowania w
programie Datacap

W programie Datacap obstugiwane jest kolejkowanie na podstawie bliskosci "wymaganego terminu".
Mozliwe jest dodatkowo kolejkowanie wedtug godziny rozpoczecia zadania i kolejkowanie wedtug
godziny rozpoczecia czynnosci. Gdy dla partii niestandardowej zostanie okreslony termin (data/godzina),
serwer moze prowadzi¢ sortowanie wedtug tej kolumny.

Funkcje klasyfikacji obrazéw

Mozliwa jest klasyfikacja obrazéw przy uzyciu ustugi Watson Image Recognition.

Komponenty i funkcje nieaktualne

Z produktu Datacap usunieto biblioteke dziatan OCR/S.
Usunieto opcje dotyczace kodow kreskowych i pisma odrecznego z karty OCR/S w programie Datacap
Studio.

Temat nadrzedny: Co nowego w wersji 9.1.3 programu IBM Datacap

Utatwienia dostepu w programie Datacap Navigator

Program Datacap Navigator oferuje funkcje utatwiajgce korzystanie z niego osobom niepetnosprawnym.

Wazne: Utatwienia dostepu sg obstugiwane tylko w przegladarkach WWW dla systemow operacyjnych z rodziny
Microsoft Windows.

Sterowanie i nawigacja za pomoca klawiatury

Dostepne sg nastepujgce funkcje umozliwiajgce wprowadzanie danych i nawigacje za pomoca klawiatury:
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Sterowanie programem z klawiatury
Do obstugi programu Datacap Navigator mozna zamiast myszy uzywac klawiatury. Aby skorzystac z
wybranego przycisku w interfejsie uzytkownika, nalezy przej$¢ do tego przycisku i nacisnag¢ klawisz
Enter. Aby wprowadzi¢ dane, nalezy przejs¢ do pola wprowadzania danych, wpisa¢ dane i nacisna¢
klawisz Enter lub klawisz Tab, ktory spowoduje wyjscie z pola.

Miejsce aktywne dla klawiatury
Miejsce aktywne dla klawiatury jest wyrdznione lub podswietlone. Jest to aktywny obszar okna, do
ktorego kierowane sg informacje o naci$nietych klawiszach.

Nawigacja za pomoca klawiatury
Klawisze Tab, Shift+Tab i strzatek umozliwiajg przechodzenie miedzy gtownymi elementami strony,
widoku lub sekcji specjalnej. W przypadku niektérych elementow, takich jak widoki drzewa lub selektory
dat, mozna tez uzywac klawiszy Home, End, Page Up i Page Down. Naci$niecie klawiszy
Ctrl+Shift+strzatka w dét na stronie przegladania umozliwi nawigacje za pomoca banera, paska narzedzi,
widoku drzewa i widoku listy.

Mozesz uzy¢ narzedzia JAWS w celu pominiecia sekcji tresci przez przejécie do obszardw punktéw
orientacyjnych na stronie. W programie JAWS nacisnij klawisze Insert+Ctrl+;, aby otworzy¢ okno
dialogowe zawierajace liste punktow orientacyjnych. Wybierz punkt orientacyjny, aby poming¢ bloki
sekcji i przej$¢ do tego obszaru. Na przyktad mozna wybrac opcje gtéwny z listy punktow orientacyjnych
w celu przejscia do gtéwnej tresci strony. Alternatywnie mozna przej$¢ do gtéwnej tresci strony,
naciskajac klawisze Insert+F7 w programie JAWS w celu otwarcia okna dialogowego zawierajacego liste
ukrytych odsytaczy na stronie. Mozna wybrac opcje Przejdz do gtéwnej tresci w celu przejscia do gtownej
tresci, lub wybrac¢ opcje Przejdz do przyciskéw nawigacji w celu przejscia do przyciskow nawigacji po
lewej stronie. Uzyj klawisza Tab, aby przej$¢ do odsytaczy, nacisnij klawisz Enter, aby wybrac odsytacz, a
nastepnie nacisnij klawisz Tab, aby uaktywnic¢ obszar docelowy powigzany z wybranym odsytaczem.

Klikniecie i przesuniecie obszaru aktywnego za pomoca klawisza Tab
W celu efektywnego postugiwania sie klawiaturg nalezy zrozumiec réznice miedzy kliknieciem a
przesunieciem obszaru aktywnego za pomoca klawisza Tab. Jesli uzytkownik korzysta tylko z myszy,
wowczas klawisz Tab jest nieistotny; jednak korzystanie z niego ma znaczenie w przypadku korzystania
ze skrotéw klawiszowych.

e Obszar aktywny ustawiony za pomocag klawisza Tab jest oznaczony kropkowanym kwadratem
wokot elementu. Ustawienie obszaru aktywnego mozna zmienic¢ za pomoca klawisza Tab i
klawiszy strzatek, albo poprzez klikniecie elementu przyciskiem myszy.

o Podczas nawigowania za pomoca klawisza Tab obszar aktywny jest przesuwany kolejno od
jednego elementu do nastepnego, a obszar aktywny wybrany poprzez klikniecie nie ulega
zmianie. Po osiggnieciu ostatniej sekcji strony obszar aktywny przesuwany za pomoca
klawisza Tab przenosi sie do pierwszego elementu w nastepnej sekcji.

o W przypadku korzystania z klawiszy strzatek obszar aktywny przesuwany klawiszami oraz
obszar aktywny wybierany kliknieciem przesuwajg sie kolejno, w tej samej sekcji ekranu.

e Obszar aktywny ustawiony przez klikniecie jest wyrdzniony kolorowym podswietleniem wokot
elementu. Aby zmieni¢ obszar aktywny ustawiony za pomoca myszy, nalezy klikna¢ element
mysza, uzyc¢ klawiszy strzatek albo uzy¢ klawisza Tab, a nastepnie nacisna¢ Enter.

Gdy aplikacja Datacap Navigator otworzy nowe okno, np. przeznaczone do konkretnego dziatania, albo
wyswietli okno dialogowe zawierajgce np. ostrzezenia i btedy, obszar aktywny jest ustawiany u gory
strony (po zamknieciu okna albo okna dialogowego). Aby wréci¢ do pierwotnego potozenia obszaru
aktywnego, uzyj kombinacji klawiszy Ctrl+Shift+Strzatka w dot i Strzatka w gore lub Tab.

Instalacja cicha
Aby skorzystac z instalacji z utatwieniami dostepu, nalezy wybrac¢ instalacje cicha.

Skroty klawiszowe
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Dostep do wszystkich funkcji programu Datacap Navigator jest mozliwy za posrednictwem klawiatury.

Dostep z wykorzystaniem klawiatury spetnia standardowe wytyczne systemu Microsoft Windows.

Dostep z klawiatury rézni sie od standardowych wytycznych obowigzujgcych w systemie Microsoft Windows w
nastepujacych aspektach:

Klawisze dostepu, przechodzenie klawiszem Tab i tabele

Klawisze dostepu sa przypisane tylko do przyciskéw i elementéw menu. Do dowolnego pola mozna
natomiast przej$c, naciskajac klawisz Tab.

Naciénij klawisz Tab, aby przenies¢ kursor do tabeli. Ponownie nacisnij klawisz Tab, aby przenies$¢ kursor
do nastepnej komdrki w tabeli. Aby wyj$¢ z tabeli do nastepnego pola, nacisnij i przytrzymaj klawisz Ctrl,
a nastepnie nacisénij klawisz Tab. Gdy kursor znajduje sie w tabeli, naciéniecie klawisza Enter nie jest
rownowazne kliknieciu przycisku OK w celu zamkniecia okna; najpierw nalezy wyjs$c z tabeli.

Aby edytowac¢ komorke tabeli zawierajgca pole ztozone, nacisnij klawisz F2, za pomocg klawiszy ze
strzatkami w gore i w dot przejdz do zadanej pozycji, a nastepnie nacisnij klawisz Enter, aby jg wybrac.

Karty i stronicowanie

Miedzy kartami mozna przechodzi¢ za pomoca klawiszy ze strzatkg w lewo i w prawo.

W celu przejscia na pierwsza karte nalezy nacisna¢ klawisz Home. W celu przejscia do ostatniej karty
nalezy nacisna¢ klawisz End.

W celu przejscia do nastepnej strony nalezy nacisna¢ klawisz Ctrl z klawiszem Page Down, lub nacisna¢
jednoczesnie Ctrl+Tab.

W celu przejscia do poprzedniej strony nalezy nacisna¢ klawisz Ctrl z klawiszem Page Up, lub nacisngé
jednoczesnie Ctrl+Shift+Tab.

Pola ztozone

Aby przej$¢ do elementu, nalezy uzy¢ klawiszy strzatek w gore i w dot. Nastepnie nacisna¢ klawisz Enter,
aby dokonac¢ wyboru.

Menu
W systemie operacyjnym Windows otworz menu dla aktywnej pozycji, naciskajagc kombinacje klawiszy
Shift+F10.
W celu nawigowania w pozycjach menu mozna korzystac z klawiszy strzatek w gore i w dot. Nastepnie
nalezy nacisng¢ klawisz Enter lub klawisz spacji, aby aktywowac pozycje menu lub aby otworzy¢
podmenu.
W celu zamkniecia menu lub podmenu nalezy nacisna¢ klawisz Esc lub klawisz strzatki w lewo.
Widoki drzew

Whpisywanie znakdw lub naciskanie klawisza Backspace, gdy aktywny jest element drzewa, nie powoduje
wybrania elementu.

Jesli w systemie jest zainstalowany pakiet Java™ 2 Software Development Kit 1.4, to po nacisnieciu
klawisza z literg wybrany zostanie nastepny element w drzewie rozpoczynajacy sie od tej litery.

W celu nawigowania w widokach drzew mozna korzystac z nastepujgcych klawiszy:
Tabela 1. Nawigacja w widoku drzewa

Dziatanie Klawisz

Nawigacja do drzewa Tab
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Dziatanie Klawisz
Nawigacja do nastepnego wezta rownorzednego Strzatka w gore
Otwarcie poddrzewa Strzatka w prawo
Zamkniecie poddrzewa Strzatka w lewo
Nawigacja do otwartego poddrzewa Strzatka w prawo
Nawigacja do wezta nadrzednego Strzatka w lewo
Aktywacja elementu drzewa Enter

Nawigacja do pierwszego wezta drzewa Home

Nawigacja do ostatniego widocznego wezta drzewa | End

Pola listy, pola wyboru i przyciski opcji
W polu listy przejdz do zadanej pozycji elementu za pomocg klawiszy ze strzatkg w gore i w dot, a
nastepnie nacisnij klawisz Enter, aby dokona¢ wyboru. Aby wybrac kilka pozycji nastepujacych
bezposrednio po sobie, naciskaj klawisz ze strzatkg w gore lub w dot, jednoczesnie trzymajac nacisniety
klawisz Shift.

Jesli w systemie jest zainstalowany pakiet Java 2 Software Development Kit 1.4, to mozna wybrac
pozycje w polu listy, polu ztozonym lub tabeli, naciskajac klawisz z odpowiednig litera.

W polach listy mozna wybiera¢ pojedyncze przetgczniki, naciskajac klawisz Tab, a nastepnie klawisz
spacji, lub korzystajac z klawiszy dostepu. Klawisze ze strzatkami nie wybierajg przyciskow opcji
wewnatrz grupy.

Probnik dat kalendarzowych

W celu nawigowania wéréd komérek dat nalezy korzystaé z klawiszy strzatek w lewo, w prawo, w gére i w
dot.

W celu przetaczenia na ten sam dzien nastepnego miesigca nalezy nacisngé¢ klawisz Page Down.
W celu przetaczenia na ten sam dzien poprzedniego miesigca nalezy nacisna¢ klawisz Page Up.
W celu przetaczenia na ten sam dzien nastepnego roku nalezy nacisna¢ klawisze Ctrl+Page Down.
W celu przetaczenia na ten sam dzien poprzedniego roku nalezy nacisna¢ klawisze Ctrl+Page Up.
W celu przejscia do pierwszego dnia miesigca nalezy uzy¢ klawisza Home.

W celu przejscia do ostatniego dnia miesigca nalezy uzy¢ klawisza End.

Naciéniecie klawisza Enter powoduje wybor daty.

Pomoc w dymkach
Za pomoca klawisza Tab przejdz do pola lub elementu z pomoca w dymku. Nastepnie nacisnij klawisze
Ctrl+F1, aby wywota¢ pomoc w dymku.

Nawigacja w oknach wywotywanych

W roznych sytuacjach program Datacap Navigator wyswietla informacje lub komunikaty o btedach w oknach
wyskakujacych. W tej sekcji zostat wyjasniony sposob nawigowania za pomocg klawiatury i innych utatwien
dostepu w kazdym typie okna.

Tabela 2. Klawisze potrzebne do nawigacji w oknach wyskakujgcych bez uzycia myszy
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Typ okna | Opcje klawiatury
wyskakuja
cego

Informacja | Aby zamknaé, nacisnij klawisz Esc.

Alert Aby zamknaé, przejdz klawiszem Tab do przyciskow dostepnych w oknie.

Btad Aby wyswietli¢ petny komunikat o btedzie, przejdz klawiszem Tab do Wyjscia bteddw i nacisnij
klawisz Enter. Nastepnie przejdz klawiszem Tab do komunikatu o btedzie. Aby zamkna¢, nacisnij
klawisz Esc.

Wskazdéwka: W trybie wirtualnego kursora PC obszar aktywny jest ponownie ustawiany u gory
biezacej strony po zamknieciu okna wywotywanego.

Dane Wpisz zadane informacje. Aby zamkna¢, przejdz klawiszem Tab do przycisku OK lub Anuluj i
wejsciowe | nacisnij klawisz Enter.

Zgodnosc z rozwigzaniami technicznymi dla niepetnosprawnych

Program Datacap Navigator jest zgodny z lektorem ekranowym JAWS. Datacap Navigator ma wtasciwosci, ktore
sg wymagane przez aplikacje JAWS do udostepnienia wys$wietlanych na ekranie informacji uzytkownikom z
wadami wzroku.

Wymaganie: Lektor ekranowy JAWS musi by¢ uruchomiony za pomoca komendy java, a nie komendy javaw;
lektor ekranowy nie bedzie dziatat prawidtowo, jesli zostanie uruchomiony za pomocg komendy javaw.

Dokumentacja produktu

Dokumentacja tego produktu dostepna jest w formatach uwzgledniajacych utatwienia dostepu.

Dokumentacja jest dostepna w formacie HTML z utatwieniami dostepu. Zastosowanie formatu HTML umozliwia
wyswietlenie dokumentacji zgodnie z preferencjami wyswietlania okreslonymi w uzywanej przegladarce.
Mozliwe jest rowniez uzywanie lektorow ekranowych i innych rozwigzan technicznych dla uzytkownikow
niepetnosprawnych.

Dokumentacja jest takze dostepna w formacie PDF.

e Skroty klawiszowe w programie Datacap Navigator
W programie Datacap Navigator mozna uzywac skrétow klawiszowych do nawigaciji i wybierania
elementow interfejsu uzytkownika stuzacych do skanowania, przekazywania, klasyfikacji i weryfikacji.

Temat nadrzedny: Dokumentacja programu IBM Datacap 9.1.3

Skroty klawiszowe w programie Datacap Navigator

W programie Datacap Navigator mozna uzywac skrotow klawiszowych do nawigacji i wybierania elementow
interfejsu uzytkownika stuzacych do skanowania, przekazywania, klasyfikacji i weryfikacji.

Tabela 1. Skréty klawiszowe dotyczace czynnosci skanowania w
programie Datacap Navigator

Skrot klawiszowy Funkcja
Ctrl+1 Wyslij
Ctrl+ 2 Wstrzymaj
Ctrl+4 Anuluj
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Skrot klawiszowy Funkcja

Ctrl+ U Przejdz o jedng strone w gore w strukturze
partii

Ctrl+D Przejdz o jedng strone w dét w strukturze partii

Ctrl + F10 Usun strone w strukturze partii

Ctrl+ F11 Usun wszystkie strony w strukturze partii

Tabela 2. Skréty klawiszowe dotyczace
czynnosci przekazywania w programie

Datacap Navigator

Skrot klawiszowy | Funkcja

Ctrl+1 Wyslij

Ctrl+2 Wstrzymaj

Ctrl+ 3 Przerwij

Tabela 3. Skréty klawiszowe dotyczace czynnosci klasyfikacji w programie Datacap
Navigator

Skrot klawiszowy Funkcja

Ctrl +, Przejdz o jedng strone w gore w strukturze partii

Ctrl +. Przejdz o jedng strone w dot w strukturze partii

Ctrl+1 Wyslij

Ctrl+ 2 Wstrzymaj

Ctrl+5 Przejdz do poprzedniej strony w strukturze partii

Ctrl+ 6 Przejdz do nastepnej strony w strukturze partii

Ctrl+ 7 Przejdz do poprzedniej strony z btedem w strukturze partii

Ctrl+8 Przejdz do nastepnej strony z btedem w strukturze partii

Ctrl+9 Wyswietl i przetacz superzmiennag w tytule przegladarki
obrazéw

Ctrl + F1 Rozwin lub zwin wezet, aby uwidoczni¢ lub ukry¢ wezet
podrzedny w strukturze partii

Ctrl + F2 Skopiuj strone do biezgcego dokumentu

Ctrl+ F3 Podziel dokument w strukturze partii

Ctrl + F8 Potgcz wszystkie dokumenty z pierwszym dokumentem

Ctrl + F9 Sprawdz integralnosc¢ struktury partii

Ctrl+1 Oznacz strone do ponownego skanowania

Ctrl+Q Oznacz strone lub status dokumentu jako Usunieto lub
Problem

Ctrl+V Oznacz strone lub dokument do recenzji

Ctrl+Y Dotacz biezacy dokument do poprzedniego

Tabela 4. Skréty klawiszowe dotyczace czynnosci weryfikacji w programie Datacap
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Navigator

Skrot klawiszowy Funkcja

Ctrl+1 Wyslij

Ctrl+ 2 Wstrzymaj

Ctrl+5 Przejdz do poprzedniej strony w strukturze partii

Ctrl+ 6 Przejdz do nastepnej strony w strukturze partii

Ctrl+7 Przejdz do poprzedniej strony z btedem w strukturze partii

Ctrl+ 8 Przejdz do nastepnej strony z btedem w strukturze partii

Ctrl+9 Uruchom regute sprawdzania poprawnosci biezacej
strony

Alt +L Przejdz do nastepnego pola o niskiej pewnosci

Tabela 5. Skréty klawiszowe do funkcji

drukowania

Skrot klawiszowy | Funkcja

P Drukuj strone

Shift+P Drukuj dokument

Ctrl+P Drukuj przedziat stron

Temat nadrzedny: Utatwienia dostepu w programie Datacap Navigator

Datacap

Datacap is a complete solution for document and data capture. Datacap scans, classifies, recognizes, validates,
verifies, and exports data and document images quickly, accurately and cost effectively.

By combining the common recognition engines for OCR, ICR, OMR and barcodes with libraries of hundreds of
script-based and code-based (.NET) actions, Datacap accurately captures data from any type of structured,
highly variable, or unstructured documents.

Datacap can capture machine print, hand print, bar codes, and check box data. By using the Datacap rules
engine, data capture can be tailored to fit the most demanding business requirements and can be changed
quickly when business needs change.

For indexing applications, Datacap streamlines the manual data entry of index entries by using recognition to
automatically identify the index values on each document and to automate the document identification
process.

Datacap software components

Datacap contains various software components. Each component performs or supports a defined set of
functions. When you run the installation program to install Datacap, you can select individual installation
features. These features might contain one or more subfeatures.

List of Datacap software components — Custom installation

For custom installation, you can select following Datacap software components:
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e Datacap Server
e Datacap Clients
o Applications
= IBM Datacap Accounts Payable
m IBM Datacap Medical Claims
o Datacap FastDoc
o Datacap Studio
o Datacap Maintenance Manager
e Datacap Rulerunner Server
e Datacap Web Server
e Datacap Web Service
e Datacap Windows Service
e Datacap Report Viewer
e Connectors
o IBM Datacap Connector for eMail and Electronic Documents
o IBM Datacap Connector for Fax
o IBM Datacap Connector for EMC Documentum
o IBM Datacap Connector for Microsoft SharePoint
IBM Datacap Insight Edition (Document Analytics)

Note: The components with a prefix "IBM Datacap" are chargeable components, and you must buy them
separately. In the installer, they appear with a red "X". You must select them and install, only if you are a valid
user.

Datacap Server

The server component provides the following core functions of the Datacap system:

e Managing and serving batches to workstations and users

e Managing the tasks according to the workflow of the Datacap application

e Providing user authentication and access control, assigning batch IDs, controlling batch queues, and
controlling access to the Datacap databases

All communication between the Datacap Server and its clients, or the other core server components, use the
Datacap socket protocol. For communicating with the databases, Datacap Server uses Microsoft Object Linking
and Embedding for Database (OLE DB). Datacap Server also uses the Common Internet File System (CIFS)
interface to mount the file share that is required to access batches.

The Datacap Server supports various authentication systems. The main application settings file datacap.xml is
on the file share where the application files are stored. In smaller systems, the file is on a Datacap Server. In
medium or large systems, the file is on a dedicated file server or a NAS or SAN device.

Datacap Clients

The Datacap client component is a set of programs that you can use to access Datacap applications.
Applications

An application unites a set of Datacap capabilities with the aim of solving a specific business need. In Datacap
custom installation setup, you can select following applications:

IBM Datacap Accounts Payable

The Datacap Accounts Payable solution is used for automating the process of capturing invoices. The APT uses
optical character recognition and highly configurable location rules to accurately capture invoice data. The
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invoice data comprises invoice number, invoice date, purchase order number, invoice total, and the data from
each line item in the invoice. The invoice images and data are then delivered to your accounts payable, ERP,
document management, and other systems. For more information, see Datacap Accounts Payable.

IBM Datacap Medical Claims

Medical Claims is a software solution that automates data entry from professional claim forms (CMS 1500) that
are used by individual medical providers or suppliers. The software also automates data from institutional
claim forms (UB04) that are used by institutional providers such as hospitals. Medical Claims application is
used to manage the entire capture process, including scanning of claims forms, enhancement of the images,
recognition of data fields, and the validation and verification of data. The application exports images and index
data to content management systems through integration interfaces. For more information, see Medical
Claims.

Datacap FastDoc

FastDoc is a client that you can use to scan, index, monitor jobs, and manually run background tasks on
documents and image files. You can also use FastDoc as a rapid application development tool. You can run
FastDoc in a stand-alone environment where FastDoc manages its own batches or as a client to the Datacap
Server. For more information, see FastDoc

Datacap Studio

Datacap Studio is the application development environment for Datacap. When you install Datacap Studio, it
includes an unrestricted version of the Application Manager, for managing multi-machine distributed
environments through a centralized set of key Datacap configuration settings. These settings are stored in
shared files. For more information, see Datacap Studio.

Datacap Maintenance Manager

Datacap Maintenance Manager provides application monitoring and notification capabilities that can automate
administrative functions such as resetting batches or archiving old batches. For more information, see
Installing and configuring Datacap Maintenance Manager.

Datacap Rulerunner Server

Datacap Rulerunner Service runs as a Windows service and runs batch processing tasks that do not require
operator interaction, such as recognition and export. In a typical production environment, Rulerunner is
configured to run the page identification and recognition tasks automatically. After verification and submission,
Rulerunner detects that the batch is ready for export and runs the export task automatically. For more
information, see Installing Rulerunner on the Rulerunner server.

Datacap Web Server

Datacap Web Server hosts Datacap web applications with Microsoft IIS server. The IIS server communicates
with the backend services through the Datacap Web Server. For more information, see Configuring Datacap
Web Server on a supported version of Windows Server.

Datacap Web Services

Datacap Web Services are also called wTM. It could be a windows-based service or Microsoft IIS-based web
service. Datacap web service supports HTTP and HTTPS protocols. For more information, see Installing
Datacap Web Services.

Datacap Report Viewer
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Datacap Report Viewer is a reporting tool for real-time reports of Datacap activity. Report Viewer retrieves
usage statistics and other data from the Engine database. The Datacap Report Viewer web application displays
real-time reports of activity that is related to your Datacap applications. For more information, see Installing
and configuring Datacap Report Viewer.

Connectors

Connectors are chargeable software components that you must buy separately. You must have a valid license
to use the connectors.

IBM Datacap Connector for eMail and Electronic Documents

It imports email attachments from Exchange and Internet Message Access Protocol (IMAP) mail servers and
converts electronic documents. For more information, see Email Connector actions.

IBM Datacap Connector for Fax

It imports fax images from a Fax server. Fax Connector actions are used to create Datacap document batches
from incoming faxes. You can also send the contents of a document to a specified fax number. For more
information, see Fax Connector actions.

IBM Datacap Connector for EMC Documentum

The Documentum Connector actions integrate Datacap applications with the Documentum Docbase content
repository. You can then use the Documentum Connector actions to upload documents and index fields into a
Documentum repository. For more information, see Documentum Connector actions.

IBM Datacap Connector for Microsoft SharePoint

The Datacap Connector for Microsoft SharePoint actions integrates Datacap applications with Microsoft Office
SharePoint Services for Microsoft SharePoint. You can use SharePoint Connector actions to upload documents
and set index fields in a SharePoint library. For more information, see SharePoint Connector actions

IBM Datacap Insight Edition (Document Analytics)

Datacap Insight Edition is an intelligent capture solution that combines advanced imaging, natural language
processing, and machine-learning technologies. It automates the processing of unstructured documents by
performing multi-level analysis. Datacap Insight Edition can distinguish between different types of documents
based on their structure. The solution is also capable of applying reasoning, logic, and context-sensitive
analysis to identify and classify information.

Datacap Navigator and Datacap Web Client

Datacap Navigator and Datacap Web Client provide functions that are similar to the Datacap client but do not
require more software to be installed on the computer.

When you verify a batch by using the web client, verification rules are run on the web server. You can also
configure an application workflow and run administrative tasks such as setting up Datacap groups and users.
Authentication for Datacap Navigator is done through calls to Datacap Web Services.

Datacap Navigator is based on IBM® Content Navigator technology and is installed, configured, and
administered with IBM Content Navigator tools. Datacap Navigator communicates with the Datacap Server by
using the Datacap Web Services APIs. For lookup and verification, Datacap Navigator uses the IBM Content
Navigator External Data Services infrastructure.
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Datacap databases

Datacap applications use relational databases. In the Datacap sample and add-on applications, Microsoft
Access databases are used for portability reasons but must not be used in production. In a production system,
Datacap databases are hosted in DB2®, Microsoft SQL Server, or Oracle. Datacap uses the following databases:

Administration

The Administration database stores information about users, groups, workstation, auditing, functional security,
and application configuration. The administration database also stores workflow configurations.

Engine
The Engine database stores information about batches, statistics, and queue states.
Fingerprints

The Fingerprints database manages the pointers to the fingerprints that are used in an application. Each
application has its own set of self-contained databases.

External

External database is a database that is accessed by Datacap applications during processing. Datacap
applications can perform lookups to validate data such as vendor IDs, purchase order numbers, postal codes,
customer IDs, on this database.

e FastDoc
FastDoc is a client that you can use to scan, index, monitor jobs, and manually run background tasks on
documents and image files. You can also use FastDoc as a rapid application development tool. You can
run FastDoc in a stand-alone environment where FastDoc manages its own batches or as a client to the
Datacap Server.

FastDoc

FastDoc is a client that you can use to scan, index, monitor jobs, and manually run background tasks on
documents and image files. You can also use FastDoc as a rapid application development tool. You can run
FastDoc in a stand-alone environment where FastDoc manages its own batches or as a client to the Datacap
Server.

By using FastDoc, you can do the following tasks:

e Automate the capture of index data from machine or manually printed documents and eliminate tedious
and error-prone manual data entry.

e Capture index data from text and bar codes, retain document types and the variations in each document
type and data field locations after it processes one time.

e Monitor batches in the Job Monitor where you can view batch details, change their status, and optionally
delete batches.

e Separate pages into documents, automatically capture index entries for those documents, and export
the index data and document content.

e Develop Datacap applications quickly by using your application as a starting point without using Datacap
Studio or extend the application by using Datacap Studio if the FastDoc application does not support all
your requirements.

You can create applications on FastDoc as a stand-alone client on your local computer, an integrated Datacap
client, or both. At the Login screen, you can select Local to process a local workflow without connecting to
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Datacap server. Or you can select Datacap to connect FastDoc to Datacap server and log into a Datacap
application.

Local mode
In Local mode, FastDoc operates as an easy to use, stand-alone client that scans, manually indexes, and
uploads batches of documents to repositories and file systems without connecting to Datacap server or
other Datacap components. In Local mode, you can run smaller, less complicated jobs locally without
setting up templates, programing rule sets, or configuring applications by using Datacap Studio and
Application Manager on Datacap server.

Datacap mode
In Datacap mode, FastDoc scans, auto indexes, and uploads batches of documents to Datacap server.
For example, you can use FastDoc to process invoice image files for the Datacap Accounts Payable
application. In this mode, FastDoc can take advantage of Datacap server capabilities to further develop
the application by using Datacap Studio and Application Manager. Click the user name at the top of the
screen to logoff from Datacap and display the Log On screen. You can continue to work in Local mode or
exit FastDoc.

Local and Datacap mode
You can run your batches locally and upload them to Datacap Server in the background later by using the
Datacap Web Client Upload service.

FastDoc easily integrates with IBM® FileNet® Content Manager and Microsoft SharePoint.

In Local mode and Datacap mode, you can also export FastDoc documents to any of the repositories that are
configured for Datacap in Datacap Studio. If you do not want to use these supported repositories, you can
export documents as sets of images and index files in CSV or XML format to a file system in your network.

FastDoc works with document scanners and multifunction peripheral devices that use TWAIN and ISIS drivers.
It can also process previously scanned and faxed images and multi-page files in TIFF, JPEG, BMP, PNG, and
PDF formats.

You can run FastDoc Administrator mode and Operator mode. In Administrator mode, you can configure
document and processing settings and use the batch profile for RAD. Operator mode is used for scanning and
processing documents in production.

Parent topic: Datacap software components
Related tasks:
Installing and configuring the Datacap Web Client upload service

Datacap capture solutions

Datacap provides several industry-specific capture applications that are available out of the box.

e Medical Claims
Medical Claims is a software solution that automates data entry from professional claim forms (CMS
1500) used by individual medical providers or suppliers, and from institutional claim forms (UB04) used
by institutional providers such as hospitals.

e Datacap Accounts Payable
The Datacap APT foundation application is the Datacap Accounts Payable solution for automating the
process of capturing invoices.

Medical Claims

Medical Claims is a software solution that automates data entry from professional claim forms (CMS 1500)
used by individual medical providers or suppliers, and from institutional claim forms (UB04) used by

16 Datacap 9.1.3



institutional providers such as hospitals.

Medical Claims manages the entire capture process, from scanning of claims forms, enhancement of the
images to increase recognition accuracy, recognition of data fields, and the validation and verification of data.
Medical Claims then coordinates the upload of HIPAA-compliant claim data to adjudication systems for
payment, and exports images and index data to content management systems through integration interfaces.
It eliminates costly, error-prone manual data entry and accelerates claim processing.

Datacap Studio provides an enhanced environment for creating and maintaining rules. Claim forms can be
captured by using a scanner or other capture device, or can be previously scanned for the digital images to be
saved to a folder. Professional (CMS 1500) forms and institutional (UB04) forms are now processed in separate
workflows, and in these workflows, red dropout (data alone) claims and black (with lines and boxes) claims
must be batched and scanned separately.

Medical Claims recognizes machine print data (OCR), handprint data (ICR), and bar codes on the forms.
Extensive validations are then applied to the claim data to ensure that accuracy. Validations include lookups for
fields such as state codes, member IDs, diagnostic codes, and place of service. Other validations check for
required fields and appropriate data formats. The form data and snippets of the claim image are then
presented in a verification panel for an operator to review and, if necessary, make corrections. Fields that need
attention are automatically highlighted for the operator. Verification panels can be in Windows based or
browser-based. After the operator reviews the form, the data verification is again applied to ensure that
accuracy. Medical Claims then creates EDI 837 formatted data files from the claims data. The formats of these
files are typically customized for the target business and adjudication systems.

Parent topic: Datacap capture solutions

Datacap Accounts Payable

The Datacap APT foundation application is the Datacap Accounts Payable solution for automating the process
of capturing invoices.

APT uses optical character recognition and highly configurable location rules to accurately capture invoice data
such as invoice number, invoice date, purchase order number, invoice total, and the data from each line item in
the invoice. The invoice images and data are then delivered to your accounts payable, ERP, document
management, and other systems.

Datacap Accounts Payable (Datacap APT) is delivered with sample images and a multi-page invoice separator
page for different preconfigured jobs. You can run the tasks in these jobs to use APT without having to
configure additional steps.

Datacap APT includes the APT Add Demo Vendor utility program for you to add vendors to a vendor list, which
acts as a sample Accounts Payable Vendor database. The vendor list is used to perform vendor lookups and
validations on your Accounts Payable Vendor database because APT cannot initially access the database.

Parent topic: Datacap capture solutions

Locating applications on a network

The Datacap datacap.xml file, which is typically in the shared Datacap folder on the Datacap server, contains
information about the locations of the available Datacap applications.

About this task
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Each Datacap application has its own application configuration file that identifies the locations of the
components that are used by that application. This application configuration file (.app) includes details about
the locations of its components, such as batches folder, input image folder, and databases.

The Datacap Application Manager is used to identify the location of the datacap.xml file and to manage the
contents of the application configuration files.

In the diagram, the configuration file for App2 defines the location of the Datacap server that hosts the
application and the locations of the application’s databases, batches folder, and other components of the

application.
Mmln wDrHStatin_n et bt e et e et ....E
Use the Datacap Application
Datacap Manager to configure .app files
Client
Datacap Server
Datacap H
Application Datacap Server
Manager —
—»  Appl.app
Database Server
(DB2, SAL or Oracle)
[
Datacap.xml » AppZ2.app N
Client Workstation — <—— )
File Server
Datacap A~
Client .| App3.app Applications
Datacap 1
Application Batches
Manager
lise the Datacap
Application Manager <Datacap ver="8.0">

[0 locate datacap.xml <app name="App1" ref="\\svr\datacap\app1"/>

<app name="App2" ref="\\svr\datacap\app2"/=
<app name="App3" ref="\\svr\datacap\app3"/=
</datacap=

Scenario: An imaging solution to streamline document storage

Datacap integrates with IBM® FileNet® Content Manager and IBM Case Foundation to provide a comprehensive
imaging solution.

Problem

Efficiently managing the documents that they need to conduct their businesses is a challenge that many
organizations face today. Storing and archiving paper and electronic documents is a problem of immense
proportions. The challenge is not only to control all types of media, but also to ensure that you can retrieve and
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manage the data throughout the lifecycle of business processes. A production imaging solution provides an
optimal way of addressing these challenges.

Solution

Finding a way to overcome the problems that are inherent in paper and electronic storage aligns with
organizational efforts to use enterprise content management systems. Those systems that can include
production imaging features are compelling.

For a complete discussion of imaging solution scenarios, see Implementing Imaging Solutions with IBM
Production Imaging Edition and IBM Datacap at http://www.redbooks.ibm.com/abstracts/sg247969.html?
Open.

Parent topic: Planning your Datacap system

Scenario: Order processing automation for a mail-order
pharmacy

Datacap can integrate with IBM® FileNet® Content Manager to provide comprehensive pharmacy order
processing by mail.

Problem

Many mail-order businesses, such as pharmacies, require improved image quality on incoming forms, more
automated processes, increased performance and throughput, and an overall reduction of manual labor.

Solution

In the initial steps of a solution, Datacap provides an excellent way to scan, recognize, and verify incoming
documentation related to new and existing orders. Various connectors can be licensed with the product to
enable storage integration with document and image storage products, such as IBM FileNet Content Manager.

Specifically, an organization can deploy Datacap software to capture information from mail-order forms by
using optical character recognition (OCR), intelligent character recognition (ICR), optical mark recognition
(OMR), and barcode recognition. The captured information is used to automate the indexing of document
images for storage to a Content Manager system. The data is also used to populate an additional database for
creating prescription fulfillment at the production center. There, workers fill and package the captured
prescription orders which are then mailed to customers around the nation.

For more details on an actual customer success story related to automating mail-order pharmacy order
processing with an IBM based solution, see http://www.ibm.com/software/success/cssdb.nsf/CS/IHAL-
8BPQQP?0OpenDocument&Site=cmportfolio&cty=en_us. For details on how IBM Case Manager might be used
to extend such a solution to provide a full-scale healthcare-related case management system, see
https://www.ibm.com/developerworks/mydeveloperworks/blogs/iic-san-mateo/entry/test_entry?lang=en.

Parent topic: Planning your Datacap system

Uwagi

Niniejsza publikacja zostata opracowana z myslg o produktach i ustugach oferowanych w Stanach
Zjednoczonych.
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IBM moze nie oferowac w innych krajach produktéw, ustug lub opcji omawianych w tej publikacji. Informacije o
produktach i ustugach dostepnych w danym kraju mozna uzyskac¢ od lokalnego przedstawiciela IBM.
Odwotanie do produktu, programu lub ustugi IBM nie oznacza, ze mozna uzy¢ wytacznie tego produktu,
programu lub ustugi. Zamiast nich mozna zastosowac ich odpowiednik funkcjonalny pod warunkiem, ze nie
narusza to praw wtasnosci intelektualnej IBM. Jednakze cata odpowiedzialnos¢ za ocene przydatnosci i
sprawdzenie dziatania produktu, programu lub ustugi pochodzacych od producenta innego niz IBM spoczywa
na uzytkowniku.

IBM moze posiadaé patenty lub ztozone wnioski patentowe na towary i ustugi, o ktérych mowa w niniejszej
publikacji. Przedstawienie niniejszej publikacji nie daje zadnych uprawnien licencyjnych do tychze patentow.
Pisemne zapytania w sprawie licencji mozna przesyta¢ na adres:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
USA

Zapytania w sprawie licencji na informacje dotyczace zestawow znakéw dwubajtowych (DBCS) nalezy kierowac
do lokalnych dziatow wtasnosci intelektualnej IBM (IBM Intellectual Property Department) lub zgtaszaé na
pi$mie pod adresem:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japonia

Ponizszy akapit nie obowiazuje w Wielkiej Brytanii, a takze w innych krajach, w ktérych jego tresé
pozostaje w sprzecznosci z przepisami prawa miejscowego: INTERNATIONAL BUSINESS MACHINES
CORPORATION DOSTARCZA TE PUBLIKACJE W TAKIM STANIE, W JAKIM SIE ZNAJDUJE ("AS IS"), BEZ
JAKICHKOLWIEK GWARANCII (W TYM TAKZE REKOJIMI), WYRAZNYCH LUB DOMNIEMANYCH, A W
SZCZEGOLNOSCI DOMNIEMANYCH GWARANCJI PRZYDATNOSCI HANDLOWEJ, PRZYDATNOSCI DO
OKRESLONEGO CELU ORAZ GWARANCJI, ZE PUBLIKACJA TA NIE NARUSZA PRAW STRON TRZECICH.
Ustawodawstwa niektoérych krajéw nie dopuszczajg zastrzezen dotyczacych gwarancji wyraznych lub
domniemanych w odniesieniu do pewnych transakcji; w takiej sytuacji powyzsze zdanie nie ma zastosowania.

Informacje zawarte w niniejszej publikacji mogg zawieraé niescistosci techniczne lub btedy typograficzne.
Informacje te sg okresowo aktualizowane, a zmiany te zostang uwzglednione w kolejnych wydaniach tej
publikacji. IBM zastrzega sobie prawo do wprowadzania ulepszen i/lub zmian w produktach i/lub programach
opisanych w tej publikacji w dowolnym czasie, bez wczeséniejszego powiadomienia.

Wszelkie wzmianki w tej publikacji na temat stron internetowych innych podmiotéw zostaty wprowadzone
wytacznie dla wygody uzytkownika i w zadnym wypadku nie stanowig zachety do ich odwiedzania. Materiaty
dostepne na tych stronach nie sg czescig materiatdw opracowanych dla tego produktu IBM, a uzytkownik
korzysta z nich na wtasng odpowiedzialnosc.

IBM ma prawo do uzywania i rozpowszechniania informacji przystanych przez uzytkownika w dowolny sposob,
jaki uzna za wtasciwy, bez zadnych zobowigzan wobec ich autora.

Licencjobiorcy tego programu, ktdrzy chcieliby uzyskac informacje na temat programu w celu: (i) wdrozenia
wymiany informacji miedzy niezaleznie utworzonymi programami i innymi programami (tagcznie z tym
opisywanym) oraz (ii) wspélnego wykorzystywania wymienianych informacji, powinni skontaktowac sie z:

IBM Corporation
JA46A/GA
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555 Bailey Avenue
San Jose, CA 95141-1003
USA

Informacje takie mogg by¢ udostepnione, o ile spetnione zostang odpowiednie warunki, w tym, w niektorych
przypadkach, zostanie uiszczona stosowna optata.

Licencjonowany program opisany w niniejszej publikacji oraz wszystkie inne licencjonowane materiaty
dostepne dla tego programu sa dostarczane przez IBM na warunkach okreslonych w Umowie IBM z Klientem,
Miedzynarodowej Umowie Licencyjnej IBM na Program lub w innych podobnych umowach zawartych miedzy
IBM a uzytkownikami.

Wszelkie dane dotyczace wydajnosci zostaty zebrane w kontrolowanym $rodowisku. W zwigzku z tym rezultaty
uzyskane w innych srodowiskach operacyjnych moga sie znaczgco réznic¢. Niektdre pomiary mogty byc
dokonywane na systemach bedacych w fazie rozwoju i nie ma gwarancji, ze pomiary wykonane na ogélnie
dostepnych systemach dadza takie same wyniki. Niektdre z pomiarow mogty by¢ estymowane przez
ekstrapolacje. Rzeczywiste wyniki mogg byc¢ inne. Uzytkownicy powinni we wtasnym zakresie sprawdzic¢
odpowiednie dane dla ich $rodowiska.

Informacje dotyczace produktdw innych niz produkty IBM pochodzg od dostawcéw tych produktéw, z
opublikowanych przez nich zapowiedzi lub innych powszechnie dostepnych zrodet. IBM nie testowat tych
produktow i nie moze potwierdzi¢ doktadnosci pomiarow wydajnosci, kompatybilnosci ani zadnych innych
danych zwiazanych z tymi produktami. Pytania dotyczace mozliwosci produktéw innych podmiotéw nalezy
kierowac¢ do dostawcéw tych produktow.

Wszelkie stwierdzenia dotyczace przysztych kierunkéw rozwoju i zamierzen IBM mogg zostaé¢ zmienione lub
wycofane bez powiadomienia.

Publikacja ta zawiera przyktadowe dane i raporty uzywane w codziennej pracy. W celu kompleksowego ich
zilustrowania podane przyktady zawierajg nazwiska osob prywatnych, nazwy przedsiebiorstw oraz nazwy
produktow. Wszystkie te nazwy/nazwiska sa fikcyjne i jakiekolwiek podobienstwo do istniejgcych
nazw/nazwisk i adresow jest catkowicie przypadkowe.

LICENCJA W ZAKRESIE PRAW AUTORSKICH:

Niniejsza publikacja zawiera przyktadowe aplikacje w kodzie zrodtowym, ilustrujgce techniki programowania w
roznych systemach operacyjnych. Uzytkownik moze kopiowac, modyfikowac i dystrybuowac te programy
przyktadowe w dowolnej formie bez uiszczania optat na rzecz IBM, w celu projektowania, uzywania, sprzedazy
lub dystrybucji aplikacji zgodnych z aplikacyjnym interfejsem programowym dla tego systemu operacyjnego,
dla ktorego napisane zostaty programy przyktadowe. Programy przyktadowe nie zostaty gruntownie
przetestowane. IBM nie moze zatem gwarantowac ani sugerowac niezawodnosci, uzytecznosci i
funkcjonalnosci tych programéw. Programy przyktadowe sg dostarczane w stanie, w jakim sie znajdujg ("AS
IS"), bez udzielania jakichkolwiek gwarancji (rekojmie rowniez wytacza sie). IBM nie ponosi odpowiedzialnosci
za jakiekolwiek szkody wynikajace z uzywania programow przyktadowych.

Kazda kopia programu przyktadowego lub jakikolwiek jego fragment, jak tez jakiekolwiek prace pochodne
muszg zawiera¢ nastepujace uwagi dotyczace praw autorskich: © (nazwa przedsiebiorstwa uzytkownika, rok).
Fragmenty niniejszego kodu pochodza z programéw przyktadowych IBM Corp. © Copyright IBM Corp. 2004,
2010. Wszelkie prawa zastrzezone.

W przypadku przegladania niniejszych informacji w formie elektronicznej zdjecia i kolorowe ilustracje mogg nie
by¢ wyswietlane.

e Postanowienia dotyczace ochrony prywatnosci
e Znaki towarowe
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Temat nadrzedny: Przeglad

Postanowienia dotyczace ochrony prywatnosci

Oprogramowanie IBM, w tym rozwigzanie SaaS (Software as a Service), zwane dalej "Oferowanym
Oprogramowaniem" moze korzystac z informacji cookie lub z innych technologii do gromadzenia danych o
uzywaniu produktow, do poprawienia jakosci ustug dla uzytkownikow koncowych, do dopasowania interakcji do
ich oczekiwan oraz do innych celéw. W wielu przypadkach Oferowane Oprogramowanie nie gromadzi informacji
pozwalajacych na identyfikacje osoby. Cze$¢ Oferowanego Oprogramowania moze jednak umozliwiac¢
gromadzenie informacji pozwalajacych na identyfikacje osoby. Jesli Oferowane Oprogramowanie korzysta z
informacji cookie do gromadzenia informacji pozwalajacych na identyfikacje osoby, ponizej znajduja sie
szczego6towe informacje na temat takiego korzystania.

Oferowane Oprogramowanie nie korzysta z informacji cookie ani innych technologii do gromadzenia informacji
pozwalajgcych na identyfikacje osoby.

Jesli konfiguracje Oferowanego Oprogramowania umozliwiajg gromadzenie informacji pozwalajacych na
identyfikacje uzytkownikow koncowych za posrednictwem informacji cookie lub innych technologii, nalezy
wystapic¢ o porade prawng w zakresie prawa obowigzujgcego przy takim gromadzeniu danych, w tym wymagan
dotyczacych powiadomienia i zgody.

Wiecej informacji na temat korzystania z roznych technologii, w tym z informacji cookie, do opisanych wyzej
celéw znajduje sie w sekcji Ochrona prywatnosci w IBM, po adresem http://www.ibm.com/privacy oraz
Oswiadczenie IBM o Ochronie Prywatnosci w Internecie, pod adresem http://www.ibm.com/privacy/details, a
takze w sekcji zatytutowanej "Cookies, Web Beacons and Other Technologies" oraz "IBM Software Products
and Software-as-a-Service Privacy Statement", pod adresem http://www.ibm.com/software/info/product-
privacy.

Temat nadrzedny: Uwagi

Znaki towarowe

Nastepujace nazwy sg znakami towarowymi International Business Machines Corporation w Stanach
Zjednoczonych i/lub innych krajach: http://www.ibm.com/legal/copytrade.shtml

Adobe, logo Adobe, PostScript i logo PostScript sg zastrzezonymi znakami towarowymi lub znakami
towarowymi Adobe Systems Incorporated w Stanach Zjednoczonych i/lub w innych krajach.

Intel, logo Intel, Intel Inside, logo Intel Inside, Intel Centrino, logo Intel Centrino, Celeron, Intel Xeon, Intel
SpeedStep, Itanium i Pentium sg znakami towarowymi lub zastrzezonymi znakami towarowymi Intel
Corporation lub przedsiebiorstw podporzagdkowanych w Stanach Zjednoczonych i innych krajach.

Linux jest zastrzezonym znakiem towarowym Linusa Torvaldsa w Stanach Zjednoczonych i w innych krajach.

Microsoft, Windows i Windows NT sg znakami towarowymi Microsoft Corporation w Stanach Zjednoczonych
i/lub w innych krajach.

UNIX jest zastrzezonym znakiem towarowym The Open Group w Stanach Zjednoczonych i innych krajach.

Java™ oraz wszystkie znaki towarowe i logo dotyczace jezyka Java sg znakami towarowymi lub zastrzezonymi
znakami towarowymi Oracle i/lub przedsiebiorstw afiliowanych.

i0S jest zastrzezonym znakiem towarowym Cisco w Stanach Zjednoczonych uzywanym przez Apple Computer
Corp w ramach licencji.
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Android jest znakiem towarowym Google Inc.

Prawa autorskie do ikon z rodziny Material nalezg do Google Inc. Ikony pochodza ze strony
https://www.google.com/design/icons/

Nazwy innych firm, produktow i ustug moga by¢ znakami towarowymi lub znakami ustug innych podmiotéw.

Temat nadrzedny: Uwagi

Installing

Before you install or migrate your system, install the necessary prerequisites and plan a system that meets
your needs.

Planning your Datacap system

Planning your Datacap system includes activities that are related to domains, Windows accounts,
authentication systems, and Datacap users, groups, stations, and databases.

Prerequisites for installing Datacap

Before you begin any installation of Datacap, ensure that your system is configured with the required
prerequisite software.

Installing and configuring Datacap on one machine

You can install, configure, and operate Datacap on a single machine for demonstration or testing
purposes only.

Installing and configuring in a client/server environment

The typical installation configuration for Datacap is one where the various Datacap software components
are installed on dedicated machines. These software components include application servers, web
servers, database servers, scan workstations, verify workstations, etc.

Configuring databases

The Datacap applications can use DB2®, Microsoft SQL Server, or Oracle databases to store workflow
definitions, security parameters, processing information, and fingerprints.

Upgrading

Migrating a Datacap environment to a new release requires that you upgrade the component software
and migrate your deployed applications. Depending on the currently installed version of Datacap,
upgrading the software may first require removing the previous version before installing the new release.
The migration steps can include revising existing functionality, adding new features, or changing
baseline user interfaces.

Migrating from previous releases

Migrating a Datacap environment to a new release requires that you upgrade the component software
and migrate your deployed applications. The migration steps can include revising existing functionality,
adding new features, or changing baseline user interfaces.

Uninstalling Datacap

The Datacap installation removal process removes only those files that the previous Datacap installation
process created.

Planning your Datacap system

Planning your Datacap system includes activities that are related to domains, Windows accounts,
authentication systems, and Datacap users, groups, stations, and databases.

About this task

Review these topics so that you understand the following concepts before you install and configure IBM®
Datacap:
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Datacap domain and Windows accounts

In a client/server environment, Datacap users, background services, and processes require read, write,
create, delete, and change files on various computers. To grant the appropriate permissions to the
appropriate users, you must create Windows accounts for the Datacap users, application pools,
background services, and background processes.

In addition, the computers on which Datacap is installed and to which the Windows accounts are
granted access rights must be part of a single domain or a set of trusted domains.

A number of the Windows accounts used by Datacap background services must also be granted the
Logon as a service on the domain controller. For more information, see Domains and Windows accounts.

Authentication systems
You also need to determine how you want Datacap users to be authenticated. Datacap supports the use
of the following internal and external authentication systems:

e Datacap authentication (TMA)

e Active Directory Service Interfaces (ADSI)

e Lightweight Directory Access Protocol (LDAP)

e Active Directory Lightweight Directory Services (ADLDS)

e Low-Level Lightweight Directory Access Protocol (LLLDAP)

While Datacap can access servers that host ADLDS or LLLDAP authentication systems that are outside
the Datacap domain, ADSI and LDAP authentication servers must be in the Datacap domain. For more
information, see Authentication.

Datacap users, groups, and stations

For Datacap to use its authentication system, you must set up users and stations in your Datacap
application. If you choose to manage permissions at the group level, you can also set up groups. For
Datacap to use an external ADSI, LDAP, ADLDS, or LLLDAP authentication system, you must set up users
or groups in your Datacap application that correspond to the Datacap accounts or groups that are set up
in the external authentication system. For more information, see Users and groups.

Stations in a Datacap application can be set up as you choose. You can set up a station for each physical
computer, or a single station name can be used for multiple computers. You can set up stations to limit
the types of tasks that can be run by a user and provide routing of batches. You can also monitor
individual or aggregated activity. For more information, see Stations.

Datacap databases
Because Datacap applications include the use of databases, the Windows accounts of some Datacap
components must be set up as database users and assigned the appropriate database permissions. For
more information, see Database users.

e System requirements
Use the Software Product Compatibility Reports page to generate a report for supported operating
systems, related software, hypervisors, hardware requirements, and detailed system requirements,
including component-level details. You can also get support information related to product translations
and product end of service.

e Planning your system architecture
Datacap provides a flexible and scalable architecture for distributing tasks across machines according to
the anticipated processing load.

e Domains and Windows accounts
In a client/server environment, regardless of the authentication system in use, all of the computers that
are hosting the Datacap software components must be part of a single domain or part of multiple
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domains that trust each other. You need to know the name of your domain or domains during some
steps of theDatacap installation process.

e Stations
Station names in a Datacap application can be set up for each physical computer, for each type of
workstation (such as Scan or Verify), or, for a group of computers in a department or a physical location.

e Databases
Datacap is installed with a Microsoft Access database, however, Microsoft Access is not supported in a
Datacap production environment. You can configure your Datacap production environment to use a
DB2%, Microsoft SQL Server, or Oracle database.

e Installation methods
The installation plan for Datacap depends on whether you are upgrading from an earlier version, and
whether you are installing to the default location on the machine, C:\Datacap.

e High availability (load balancing)
You can use network load balancers to manage client requests across servers in a Datacap system.

e Scenario: An imaging solution to streamline document storage
Datacap integrates with IBM FileNet® Content Manager and IBM Case Foundation to provide a
comprehensive imaging solution.

e Scenario: Order processing automation for a mail-order pharmacy
Datacap can integrate with IBM FileNet Content Manager to provide comprehensive pharmacy order
processing by mail.

Parent topic: Installing

System requirements

Use the Software Product Compatibility Reports page to generate a report for supported operating systems,
related software, hypervisors, hardware requirements, and detailed system requirements, including
component-level details. You can also get support information related to product translations and product end
of service.

Go to the page at Software Product Compatibility Reports to create a high-level report for operating systems,
related software, hypervisors, and supported translations for Datacap. You can also create an in-depth report
to get detailed Datacap system requirements, hardware requirements, and end of service information. You can
search for Datacap in all of the report types and reports are generated based on your query values.

The following report types are the most commonly generated reports from software product compatibility
reports:

Detailed system requirements
When you select your product version for the detailed system requirements report, you can set a report
filter for Operating system platforms, Product components, and Capabilities, including prerequisites and
support software. After you view the report, you can save it as a URL to generate anytime or download it
as a PDF.

Hardware requirements
When you select your product version for the hardware requirements report, you can set a report filter
by the Operating system families option. Set the operating system filter by selecting some or all of the
operating systems that are supported by your product. After you view the report, you can save it as a
URL to generate anytime or download it as a PDF.

Translations
You can search for the list of available translations by a specific product or for a list of products that are
translated into a specific language. For example, when you select Translations available for a specific
product and enter the product and version, you can see a list of the available translations for that
product version. After you view the report, you can save it as a URL to generate anytime or download it
as a PDF.
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End of service
The end of service report shows the service window of the products that you specify over an eight-year
span. For example, you can find out when your product is scheduled to go out of service.

Parent topic: Planning your Datacap system

Planning your system architecture

Datacap provides a flexible and scalable architecture for distributing tasks across machines according to the
anticipated processing load.

About this task

At one end of the spectrum is the single machine configuration, where all Datacap software components are
installed on the same machine. This configuration is typically used for providing product demonstrations, in a
proof of concept environment, or during initial product evaluation.

At the other end of the spectrum is the client/server configuration, where the various Datacap software
components are installed on dedicated machines, such as web servers and database servers. This
configuration can support hundreds of simultaneous users, and uses centralized application management and
shared databases.
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Spanning the center of the spectrum are various hybrid configurations in which two or more Datacap software
components are installed on the same machine. For example, you might install and run Datacap Web Client and
Report Viewer on the same web server. You might also install and run the Rulerunner Service and the
Fingerprint Service on another server.

Restriction: Datacap applications can be configured for use with Datacap Web Client or Datacap Navigator, but
not both.

e Application Manager

When you create a new application by using the application wizard, the application is added to the list of
applications in the Application Manager. The Application Manager is used to identify the location of the
datacap.xml file and to manage the contents of the application configuration file. The application
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configuration file includes details about the locations of its components, such as the batches folder, the
input image folder, and databases.

e Rulerunner Manager
On the Rulerunner Manager, you can configure settings for how the Rulerunner Service processes tasks.
You can decide which applications, workflows, and tasks are processed by the Rulerunner Service, how
a batch is selected for processing, and configure Rulerunner logging.

e Datacap Server Manager
In the Datacap Server Manager, you can start, pause, and stop the Datacap Server service, set the
System event log and the Datacap log, and determine whether to set the queue by job or task.

Parent topic: Planning your Datacap system

Application Manager

When you create a new application by using the application wizard, the application is added to the list of
applications in the Application Manager. The Application Manager is used to identify the location of the
datacap.xml file and to manage the contents of the application configuration file. The application configuration
file includes details about the locations of its components, such as the batches folder, the input image folder,
and databases.

You can use the Application Manager to store passwords, connection strings, paths, and other settings in the
.app application configuration file. Each Datacap application has its own application configuration file that
identifies the locations of the components that are used by that application. You must use the Application
Manager to modify the application configuration file. Do not modify the .app file directly. For example, you can
copy an application from a test environment to a production environment, except for the .app file that is unique
for each environment.

The Application Manager works well with separate test and production environments because it stores
information that is specific to the application environment, such as database locations and physical paths. You
must use the Application Manager to configure the export database.

Application settings

On the Main tab, you must enter the application paths for the batch, export, and Fingerprint folders. You must
also enter the workflow paths, such as the Setup DCO, Locale, Rules, and various database paths.

On the Datacap tab, you must enter the paths for the Administration and Engine databases and the server
name and location.

On the Rulerunner tab, you can enter tasks and task profiles to be run by Rulerunner. Rulerunner runs the task
profiles that are listed in the Application Manager.

On the Custom values tab, developers can set up custom values to create application-specific settings and your
application can access those settings by using smart parameters. You can also store passwords in the .app
application file. To pass passwords as action parameters, you can use smart parameters that retrieve
credentials from the .app file where the passwords are stored as encoded strings. Passwords must be entered
into the Advanced Values section to be encrypted.

On the Service tab, you must enter the path to the datacap.xml application management file.

Parent topic: Planning your system architecture

Related information:

Storing passwords, connection strings, and other parameters in the .app file
Configuring the export database

Smart parameters
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Storing passwords in the .app file
Creating the application framework

Rulerunner Manager

On the Rulerunner Manager, you can configure settings for how the Rulerunner Service processes tasks. You
can decide which applications, workflows, and tasks are processed by the Rulerunner Service, how a batch is
selected for processing, and configure Rulerunner logging.

Rulerunner Manager settings

On the Rulerunner tab, you can start and stop the Rulerunner Service. When you click Stop, the Rulerunner
Service stops after the current processing is complete.

On the Rulerunner Login tab, you must select the authentication method when you want to change the
Rulerunner Service settings and when the Rulerunner Service runs tasks.

On the Workflow:Job:Task tab, you can configure the applications and tasks that the Rulerunner Service
processes. In the workflow pane, you can see the list of applications that are stored in the datacap.xml file on
the Datacap server and information about the application workflows, jobs, and tasks. In the thread pane, you
can create threads and configure the tasks that each Rulerunner thread is to process. You can create one or
more threads and copy application tasks to the threads. The details pane displays the settings that are related
to the node that is selected in the first two panes. You can specify the priority of the task and set a value to
delay a task that is not available for processing.

On the Settings tab, you can set the Thread Timeout with the maximum time the Rulerunner Service waits until
stopping all Rulerunner threads. You can also set the time interval for restarting the Rulerunner service. The
Mixed Queuing option determines how a batch is selected to run for an application. If you clear the Mixed
Queuing option, the queuing is sequential.

e Mixed queuing - The Rulerunner service sends the list of tasks to run within the application to the
Datacap server. The Datacap server selects the oldest, highest priority batch that is pending for the
selected tasks and notifies Rulerunner to run that batch.

e Sequential queuing - The Rulerunner service selects the oldest pending batch from each of the selected
tasks, one after the other. The first batch is selected from the first task. The second batch is selected
from the second task. Sequential queuing is typically required when the Rulerunner service runs batch
creation tasks, such as Vscan.

On the Logging tab, there are four options to set up Rulerunner logging. You can select the Quick Log, ATM Log,
Rulerunner Log, or RRS Log option to set the level and detail that you want in the log.

e Select the Quick Log when you want to adjust the level of detail that is written to all of the logs: the ATM
log, the Rulerunner log, and the RRS log. When you change the logging level on the Quick Log, the
logging level is adjusted for all three logs.

e Select the ATM Log when you want to adjust the type and amount of detail that is written only to the ATM
log, including the time difference between the current and the last message.

e Select the Rulerunner Log when you want to adjust the type and amount of detail that is written to the
Rulerunner and thread-specific log files and to the System Event log.

e Select the RRS Log when you want to adjust the type and amount of detail that is written to the RRS log,
including the message severity level, date and time stamp, and the application ID.

If the Rulerunner Service loses its connection to the Datacap server, the service logs exception messages that
indicate the lost connection. The frequency of these logged messages depends on the interval between
reconnection attempts. The default interval is 300 seconds. You can change this interval by setting the value of
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the Windows registry key Sleep reconnect timeout. The registry location for the key is
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Datacap\Rulerunner\Misc\.

Parent topic: Planning your system architecture
Related tasks:
Configuring Rulerunner to run tasks

Datacap Server Manager

In the Datacap Server Manager, you can start, pause, and stop the Datacap Server service, set the System
event log and the Datacap log, and determine whether to set the queue by job or task.

In the Advanced settings pane of the Datacap Server Manager, you can configure the Datacap Server service
connections port and set the database command timeout. You can also select your authentication method and
configure the Batch naming template. For more information, see Advanced settings for the Datacap Server
service.

Parent topic: Planning your system architecture
Related reference:

Datacap Server service settings

Advanced settings for the Datacap Server service

Domains and Windows accounts

In a client/server environment, regardless of the authentication system in use, all of the computers that are
hosting the Datacap software components must be part of a single domain or part of multiple domains that
trust each other. You need to know the name of your domain or domains during some steps of theDatacap
installation process.

Additionally, you must create Windows accounts for the Datacap users, application pools, and background
services and processes that read, write, create, delete, and change files and folders on various computers.

Datacap does not require you to create individual Windows accounts for every user and background service or
process that you identify. You can choose to use a single Windows account for a group of users who all need
the same sharing and security permissions. For example, all instances of the Rulerunner Service can use the
same Windows account.

The permissions that you grant to each type of Windows account varies. Specific instructions for granting
permissions to each Windows account for each type of user, background service, or background process are
provided in the detailed installation and configuration instructions for that user, background service, or
background process.

In general, the following Datacap software components are associated with types of users, background
services and processes, and application pools.

Users that use interactive Datacap software components
Datacap Desktop, FastDoc, Datacap Studio, Application Manager, Datacap Web Client, and others.
Background services and processes
Rulerunner Service, Datacap Web Client Upload Service, Datacap Web Services, Maintenance Manager,
Datacap Server Service.
Application pools
Datacap Web Client, Report Viewer, Fingerprint Service.
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e Users and groups
You can define the tasks that can be run by specific users or groups of users. You can also define user
names to control the flow of batches to specific users.

e Database users
The Datacap applications access the Administration and Engine databases and can optionally include
Fingerprint databases. You must grant access rights to the Datacap components for the databases that
they use.

e Authentication
You must determine which authentication system you are using and configure Datacap for user
authentication or group authentication.

Parent topic: Planning your Datacap system

Users and groups

You can define the tasks that can be run by specific users or groups of users. You can also define user names to
control the flow of batches to specific users.

For each of your Datacap applications, identify the Datacap software components that you are using and the
associated users. Be sure to include both human users and automatic processes.

Include human users that use interactive Datacap software components, such as Datacap Desktop, FastDoc,
Datacap Web Client, Datacap Server Manager, Application Manager, and Rulerunner Manager. These users are
typically system administrators, developers, supervisors, and other types of users.

Include all background services and processes that run Datacap tasks automatically, such as Rulerunner,
Datacap Web Client Upload Service, Datacap Web Services, and Datacap Maintenance Manager.

Parent topic: Domains and Windows accounts

Database users

The Datacap applications access the Administration and Engine databases and can optionally include
Fingerprint databases. You must grant access rights to the Datacap components for the databases that they
use.

Datacap applications can also include access to external databases that are used for lookups (Lookup) and to
which data is exported (Export).

When all of these databases (Administration, Engine, Fingerprint, Lookup, Export) are used by a Datacap
application, each Datacap component must be granted specific access rights to the appropriate databases.

Table 1. List of Datacap components and the databases they access

Datacap component Access these databases

Datacap Server Administration, Engine, Fingerprint, Lookup

Rulerunner Fingerprint, Lookup, Export

Datacap Web Client, Fingerprint and Lookup - when you run actions, such as validation task profiles,

Datacap Desktop that use these databases

FastDoc Lookup - when you run actions, such as validation task profiles, that use this
database
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When Microsoft SQL Server, Oracle, or DB2® authentication is used for the database connection strings, then a
single database account can be used for connections to each database. Create these credentials for this
account (user ID and password) in the Datacap Application Manager.

When Windows authentication is used with SQL Server, then there must be one SQL Server account for each
Windows account that is used by a Datacap component. Alternatively, Windows groups can be used to
authenticate the Datacap component Windows account to SQL Server.

When you are using an authentication system that does not require users to be set up in your Datacap
application, you must set up Datacap users for Datacap components for database authentication purposes.

For more information about database rights that need to be granted, see Database security permissions.

Parent topic: Domains and Windows accounts

Authentication

You must determine which authentication system you are using and configure Datacap for user authentication
or group authentication.

You must configure the Datacap accounts and groups that are based on your authentication system. For more
information, see Configuring the Datacap Server service to use an external authentication system.

Parent topic: Domains and Windows accounts

Stations

Station names in a Datacap application can be set up for each physical computer, for each type of workstation
(such as Scan or Verify), or, for a group of computers in a department or a physical location.

You can limit the tasks that can be run by users that log in to a Datacap application with a specific station
name. You can also route batches that are based on station name.

Depending on whether each station represents a single computer or a group of computers, you can monitor the
activity on an individual computer or in aggregate.

Users that use interactive Datacap software components enter station names manually, and the station names
they use do not need to match the name of the computer they are using. The background services or processes
in each Datacap application provide the computer name automatically as the station name or must be
configured to provide the station name.

For more information about using stations, see Understanding virtual stations and Understanding queuing of
batches to specific users and stations.

Parent topic: Planning your Datacap system

Databases

Datacap is installed with a Microsoft Access database, however, Microsoft Access is not supported in a Datacap
production environment. You can configure your Datacap production environment to use a DB2®, Microsoft SQL
Server, or Oracle database.

Review this planning information before you define and configure a DB2, Microsoft SQL Server, or Oracle
database for your Datacap application databases.
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You must be a Database Administrator with a working knowledge of the database management system to
create a DB2, Microsoft SQL Server, or Oracle database. And to define the structure of the Datacap application
databases for it.

The DB2, SQL Server, or Oracle database Server and Client software is not installed as part of the Datacap
product installation. This software is available on the vendor media or by download from the vendor website.

Install the database server software on the computer where you want to run the database. You must have
access to this computer.

Evaluate your needs and resources to decide the type of environment on which you want to install your
database:

e Insmaller environments, you can install the database server and some or all of the Datacap software
components on the same computer

e In larger, distributed systems, you might want to install one database server for all of the clients that use
the database. Or you can one database server for each environment, such as Test and Production.

You must run the database client software on every Datacap computer that accesses the database server.

Any computer that does lookups on the database must have access to the computer where the database server
is installed.

Using the DB2, SQL Server, or Oracle Administration Tools, you create an initial, empty or database for the
Administration, Engine, and Fingerprint databases. You must specify the elements of the database, for example
the name of the database, user permissions.

Verify that the Datacap applications that you want to copy to the DB2, SQL Server, or Oracle were created.

e Microsoft SQL Server prerequisites
Before you can define and configure Datacap application databases for Microsoft SQL Server, ensure
that the required software is installed on your system.

e Oracle database prerequisites
Before you can define and configure Datacap application databases for Oracle, ensure that the required
software is installed on your system.

e DB2 prerequisites
Before you can define and configure Datacap application databases for DB2, ensure that the required
software is installed on your system.

e Connecting to databases
You can use different authentication methods to provide access from Datacap to DB2, Microsoft SQL
Server, or Oracle databases.

Parent topic: Planning your Datacap system
Related information:
Datacap database configuration

Microsoft SQL Server prerequisites

Before you can define and configure Datacap application databases for Microsoft SQL Server, ensure that the
required software is installed on your system.

The following prerequisites must be installed and running on the appropriate computers in your Datacap
system:

e Datacap 8.0 or later:
o Set up Datacap Server Service
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o Set up at least one Datacap Client station
e Microsoft SQL Server version 2005 or later on the database server computer
e Microsoft SQL Server 2008 Native Client on every Datacap computer that accesses the database server.
The Native Client contains the SQL OLE DB provider driver that Datacap uses to connect to SQL Server.
No further configuration is required.

Parent topic: Databases

Oracle database prerequisites

Before you can define and configure Datacap application databases for Oracle, ensure that the required
software is installed on your system.

The following prerequisites must be installed and running on the appropriate computers in your Datacap
system:

e Datacap 8.0 or later:

o Set up Datacap Server Service

o Set up at least one Datacap Client station

e Oracle Data Access Components (ODAC) on the database server computer. Create the Oracle database
with UTF8 encoding to support Unicode.

e Oracle Data Access Components (ODAC) as the Oracle Client. The version of the client software be must
be 32-bit and match the version of your Oracle server.

o Install Oracle Data Access Products software on the Datacap Server, any stations that run
Maintenance Manager, and any Datacap Client station that requires a connection to the
Fingerprint database of the application.

o For Datacap applications that use fingerprints, install Oracle Data Access Products software on
Rulerunner Service server stations, and development and management workstations that manage
Fingerprints.

o An Administration database installation of the Oracle Client includes all of the required
components.

e Set up a Net Service Name for your Administration and Engine databases by using the Oracle Net
Configuration Assistant. Set up the Net Service Name on the computer that hosts the Datacap Server.
For a Fingerprint database, set up a Net Service Name on any Datacap Client station that requires a
connection to the Fingerprint database of the application.

Parent topic: Databases

DB2 prerequisites

Before you can define and configure Datacap application databases for DB2®, ensure that the required
software is installed on your system.

IBM® Datacap, release 9.0.1 is certified for IBM DB2 Workgroup Server Edition - Restricted Use V10.5 for
Windows on AMD64 and Intel EM64T systems (x64) Multilingual (CTWNO9ML )

The following prerequisites must be installed and running on the appropriate computers in your Datacap
system:

e IBM Datacap Version 9.0.1:
o Set up Datacap Server Service
o Set up at least one Datacap Client station
e DB2 Server version 10.5 on the database server computer
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e DB2 Client version 10.5 on the computers where the Application Copy Tool and the Datacap Server are
running

The DB2 client libraries that you use for Datacap Version 9.0.1 can be found on the following page,
under IBM Data Server Client: http://www.ibm.com/support/docview.wss?uid=swg24038262.

Select the version of Windows that matches your system.

Parent topic: Databases

Connecting to databases

You can use different authentication methods to provide access from Datacap to DB2®, Microsoft SQL Server,
or Oracle databases.

About this task

You can connect to databases by using one of the following authentication methods:

e Windows Authentication: Uses Microsoft Active Directory Domain service account credentials for
Datacap Server Service, Datacap Web, and Rulerunner Service. Create one or more local SQL Server user
accounts, and grant them read/write access to the Datacap databases. When you create connection
strings for your application to access the databases, include the appropriate local SQL Server user name
and password in each connection string.

e SOQL Authentication: Requires a SQL Server Login ID and password in connection strings that are
provided by Datacap Application Manager.

For Oracle databases, you must use Oracle Authentication. This requires that each client or server provides an

Oracle Login ID and password which must match the credentials of a user who is defined in the Oracle
database.

Procedure

To connect to the database:

1. Configure Windows authentication for SQL Server:
a. Open the SQL Server Configuration Manager or SQL Server Management Studio and log in to
Administrator or to an account with rights to create users.
b. Set up user credentials and permissions for the SQL Server. These user credentials and
permissions must exist in the Datacap databases.
c. Grant Read/Write access to the Datacap databases to the Microsoft Active Directory Domain
service account.
d. See the documentation that was provided with your SQL Server database for instructions on
setting user credentials and permissions.
2. Configure SQL Server authentication:
a. Open the SQL Server Configuration Manager or SQL Server Management Studio and log in to
Administrator or to an account with rights to create users.
b. Set up user credentials and permissions for the SQL Server. These user credentials and
permissions must exist in the Datacap databases.
c. See the documentation that was provided with your SQL Server database for instructions on
setting user credentials and permissions.
3. Configure Oracle authentication:
a. Open the Net Configuration Assistant and log in to Administrator or to an account with rights to
create users.
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b. Create a single Oracle Net Service Name. A Net Service Name is required for every Datacap Server
that accesses the Administration and Engine databases and every Datacap Client that accesses
the Fingerprint database.

c. See the documentation that was provided with your Oracle database for instructions on creating a
Net Service Name. When you create connection strings for Datacap to access the database,
include the Oracle user name and password for the Datacap database in each connection string.

4. Configure DB2 authentication:

For DB2 databases, you must use DB2 Authentication. This requires that each client or server provides a
DB2 login ID and password, which must match the credentials of a user who is defined in the DB2
database.

a. Open the IBM® Data Studio Database Administration tool for DB2 10.5.

b. Using the Administration Explorer, connect to the target DB2 database.

c. See the documentation that was provided with your DB2 database for instructions on creating a
user ID and password to use when logging into the database from a Datacap application..

When you create connection strings for Datacap to access the database, include the Datacap user
name and password for the Datacap database in each connection string. If the user that created
the database tables is different from the user ID that is connecting to the database, then you
must also use the CurrentSchema setting in the connection string and specify the user ID that
created the tables.

Parent topic: Databases

Installation methods

The installation plan for Datacap depends on whether you are upgrading from an earlier version, and whether
you are installing to the default location on the machine, C:\Datacap.

You cannot install Datacap 9.0.1 on a machine on which any earlier versions of Datacap are installed. You can
upgrade from an earlier version of Datacap, which involves installing Datacap 9.0.1 on machines that have no
Datacap components, folders, registry keys, or websites already installed. Then, convert and migrate your
applications from the earlier version to Datacap 9.0.1. For more information, see Migrating from previous
releases .

Although the installation package can be located anywhere (for example, on an accessible network drive orin a
CD/DVD drive), the destination of the installed software must be on a physical hard disk drive of the machine
from which you run Setup.exe.

Important:

You must install Datacap with all the required features. If you have a Datacap system with a limited set of
features, then the installation of one or more new Datacap features on the same system might result in an
installation error (error code 1334).

For example, if a system has only Taskmaster Client installed, then trying to install RuleRunner on the same
system later might result in installation failure with error 1334.

The only characters that can be used in the Datacap 9.0.1 installation path are the alphanumeric (a-z, A-Z, 0-
9), underscore (_), backslash (\), and colon (:) characters from the US ASCII character set. Other characters
cause the installation process to fail.

You install Datacap to C:\Datacap by using the installation wizard.
Note: Applications are typically run from the directory where you installed the software, but it is not a
requirement. For example, you might run your programs for testing from a C:\Test\ directory. However, if you try
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to change the setup program for an application that is in a directory other than where you installed the Datacap
software, the *.set files are not found when you change the setup program. An error occurs in the Datacap Web
Client, such as Unable to locate ProgramSet file 'rulerunner.exe.set.xml' at
'C:\Test\ProgramSet\Rulerunner.exe.set.xml. You can avoid this problem by copying the ProgramSet
directory from the installation location to the directory that contains the application.

When you configure Datacap on a single workstation or in a client/server environment, your Windows user
account must have administrator rights on the workstation.

Installing and configuring on a single workstation
You can install, configure, and run Datacap components on a single Microsoft Windows workstation. This
configuration uses the Datacap TravelDocs sample application as the example so you can see it process
batches of sample documents. Your Windows user account must have administrator rights on the
workstation.

Installing and configuring in a client/server environment
You can install, configure, and run Datacap server and client components in a client/server environment.
You can use the sample TravelDocs application to see how Datacap processes batches of sample
documents. Your Windows user account must have administrator rights on every machine on which you
install Datacap. For a checklist of the account and configuration settings, see Client/server installation
checklist.

For information on how to obtain detailed hardware and operating system requirement reports for Datacap
software, see: System requirements.

Deploying Datacap servers and clients over WAN

Remote users that access Datacap over a wide area network (WAN) can use any of the following options:

e Thin clients based on Taskmaster Web
e Thin clients based on Datacap Navigator
e FastDoc Capture operating in offline mode

The Datacap thick clients (such as DotScan, DotEdit, or DcDesktop) and utilities (NENU, Fingerprint
Maintenance Tool) require LAN communication speeds and low latency for responsive performance.

Connect all the Datacap Taskmaster Servers, Datacap Navigator servers, Rulerunner Servers, Web Servers, file
servers, and databases to a single high performance LAN for best results. Network delays between Taskmaster
Server, shared files and databases cause degraded performance of Job Monitor and data intensive operations.

Some customers successfully operate Datacap thick clients in remote sites using Citrix or other remote access
technology.

Important:

IBM has not tested or sought certification with Citrix, and does not provide support for Citrix. If you deploy
Datacap clients on Citrix and encounter issues, IBM might require you to reproduce the issues outside of Citrix
as part of the investigation.

For more information about deployment recommendations and diagrams, see the IBM Redbook Implementing
Imaging Solutions with IBM Production Imaging Edition and IBM Datacap Capture, section 2.5.

Parent topic: Planning your Datacap system

High availability (load balancing)

You can use network load balancers to manage client requests across servers in a Datacap system.
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Load balancing is a method for scaling a system horizontally by distributing the work across many computer
nodes in a "farm." It also provides high availability by redirecting clients to a working node in case of failure. A
load balancer or content switch presents a single address for communication with multiple servers for one or
more Datacap applications. You configure the load balancer to send requests that are directed to each pooled /
balanced address to one of the servers in the farm. You can select round-robin scheduling or another method.
Configure the Datacap Server connection timeout to be longer than the processing time for the longest batch.
Typically, 1 hour is sufficient.

If possible, you can grant network access to the back-end server addresses for easier initial setup and
subsequent problem solving. Test your system without any load balancing at first. Add load balancing to one
component at a time, and reconfigure as needed. Test each balanced address, including failover to each back-
end server, before you test the next component. If policy requires that you disable connections to the back-end
servers, be prepared to re-enable for troubleshooting, if required.

Datacap Server

Clients access the Datacap Server by using a TCP/IP socket-based protocol. You configure the Datacap Server
name or IP address and port in Datacap Application Manager. The Datacap Server normally listens on port
2402, but you can change the port number in Datacap Server Manager. If you change the port number in
Datacap Server Manager, you must also configure the port number in Datacap Application Manager. If a load
balanced server fails, all new client requests are directed to a different server, the old session becomes invalid,
and the user or client must log in again. Any outstanding server requests are terminated and batches that are in
process via that server remain in a running status. Users who logged in to this server receive an error message
and must log in again. TCP/IP sessions are inherently persistent and there is no need for the load balancer to
persist Datacap Server sessions. However, you might want to configure the load balancer to persist sessions
based on the client IP address to force all threads from any Rulerunner server to use the same Datacap Server.
For high availability, the best practice is to configure multiple Datacap Server instances in a farm by using a
network load balancer or content switch. Enter the single virtual (balanced) address for Datacap Server in
Datacap Application Manager. Configure the load balancer with persistent, sticky sessions based on the source
IP.

Datacap Web Client

The servers where the Datacap Web Client is located can be farmed. Designate one or more IP addresses or
port on your network for your Datacap Web Client site home page. Client browsers connect to this load
balancer port by using an HTTP or HTTPS protocol. Configure your load balancer to redirect those requests to
individual web servers by using round-robin scheduling, or another method. Ports 80 and 443 are standard but
you can configure an alternate port in the Microsoft IIS Manager. The Datacap Web Client uses session cookies,
so you must configure the load balancer to persist sessions based on the client's IP address. Set the load
balancer session timeout to match the IIS session timeout. If a server fails, users who connected to the failed
server receive an error message and must log in again.

Datacap Web Services

Datacap Web Services servers can be farmed. Clients connect to an address and port for the load balancer and
are directed to a specific server. Sessions must be persisted by the load balancer and the session timeout must
match the web service session timeout. There are different methods to achieve session persistence, refer to
your specific load balancer manual for complete details. Failure of a Datacap Web Services server generates an
error for requests that are in progress and the requested operations might not be completed.

Datacap Report Viewer
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The Datacap Report Viewer IIS servers can be farmed. Clients connect to an address and port for the load
balancer and are directed to a specific server. Sessions must be persisted based on IP address, and the session
timeout must match the IIS server session timeout. If a Datacap Report Viewer server fails, all existing
sessions end.

Fingerprint Service

The Fingerprint Service servers can be farmed, if the fingerprints are static during normal system operation.
Updates and deletions of fingerprints are not synchronized automatically between servers. Fingerprint servers
must be restarted, or their contents programmatically reset to keep them synchronized, if changes are made to
the set of fingerprints. You must configure the load balancer to persist sessions based on the client's IP
address.

Rulerunner

The Rulerunner servers independently poll Datacap servers for pending work. These servers do not require or
benefit from load balancing.

Datacap Navigator

Datacap Navigator is a plug-in for IBM® Content Navigator. For information about configuring a load-balanced
environment, see Getting IBM Content Navigator up and running. Refer to the steps that are marked High
Availability Clusters.

Table 1. Load balancing options for Datacap servers

Datacap Server Load Balanced Protocol

Datacap Server (application server) | Yes, persistent sessions by client TCP/IP socket
IP

Datacap Web Client server Yes, persistent sessions by client HTTP, HTTPS
IP

Datacap Web Services server Yes, persistent sessions by client HTTP, HTTPS
1P

Datacap Report Viewer server Yes, persistent sessions by client HTTP, HTTPS
IP

Fingerprint Service server Yes, persistent sessions by client HTTP, HTTPS
IP

Rulerunner server No

Parent topic: Planning your Datacap system

Prerequisites for installing Datacap

Before you begin any installation of Datacap, ensure that your system is configured with the required
prerequisite software.

For more information, see System requirements.

Attention: Datacap Insight Edition requires a 32-bit Java runtime environment (JRE). The default location for
the JRE is Datacap_Installation\dcshared\jre. If you install the JRE in another location, you must specify the
installation path in the JAVA HOME system environment variable.
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e Backing up and removing Datacap version 8.0.1 or earlier
You cannot install Datacap 9.0.1 on a machine on which any earlier versions of Datacap are installed.

e Installation and configuration prerequisites
Before you begin installing Datacap software, ensure that you meet these prerequisites. These
prerequisites ensure that you can install, configure, and run the Datacap components of an application
either on a single machine, or on multiple machines in a client/server distributed network configuration.

e FastDoc prerequisites
Before you install FastDoc on a stand-alone workstation, ensure the required software is installed on
your system.

e Microsoft Internet Information Services and Microsoft .NET Framework
If you are going to install one or more of the Datacap Web Client server components, Report Viewer,
Fingerprint Service, or Datacap Web Services, Microsoft IIS must be installed before Microsoft .NET
Framework 3.5.1. If IIS is installed after .NET,, you must run the Microsoft ASP.NET IIS Registration Tool
(aspnet_regiis.exe) with the installation parameter -i to update the ASP.NET application script maps to
point to the appropriate ASP.NET ISAPI version.

e Turning on Microsoft .NET Framework 3.5.1
Before you install Datacap on your Windows workstations or servers, ensure that the Microsoft .NET
Framework 3.5.1 operating system feature is turned on or added on every workstation and server.

e Updating ASP.NET
Follow these instructions when you know that Microsoft .NET was installed before Microsoft Internet
Information Services (IIS) on the web server, or if you are not sure that Microsoft Internet Information
Services was installed first.

e Verifying that IIS components are installed
Ensure that the IIS Web Server Role Services are installed for the Datacap Web Client server
components, such as Datacap Web Client, Report Viewer, Fingerprint Service, and Datacap Web
Services.

e Setting up the scanner
When a computer is to be used as a scan station, follow the manufacturer’s instructions to attach the
scanner to the computer. Install and configure the required scanner drivers and software. Be sure you
can scan successfully with an image capture software product other tha Datacap. If you are unable to
scan documents with software that is not Datacap, you cannot scan documents with Datacap.

e Ensuring the correct Windows language is selected
When you process images with data in a language other than English on an English language version of
Windows, ensure that the Windows Language for non-Unicode programs setting matches the language
that you want to recognize.

e Installing Microsoft .NET Framework 4.0
Computers running Datacap software components require Microsoft .NET Framework 4.0. If Microsoft
.NET Framework 4.0 is not already installed, it is installed automatically during the Datacap software
installation process.

Parent topic: Installing

Backing up and removing Datacap version 8.0.1 or earlier

You cannot install Datacap 9.0.1 on a machine on which any earlier versions of Datacap are installed.

About this task

To upgrade from an earlier version of Datacap, install Datacap 9.0.1 on machines on which no Datacap
components, folders, registry keys, or websites exist. You must convert and migrate your applications from the
earlier version to Datacap 9.0.1. For more information, see Migrating from previous releases .
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If you are going to install Datacap 9.0.1 on a machine that was part of an earlier Datacap system, you must
remove all traces of Datacap before you begin.

Parent topic: Prerequisites for installing Datacap

Installation and configuration prerequisites

Before you begin installing Datacap software, ensure that you meet these prerequisites. These prerequisites
ensure that you can install, configure, and run the Datacap components of an application either on a single
machine, or on multiple machines in a client/server distributed network configuration.

Datacap Web Client server prerequisites

Before you install the Datacap Web Client server components on a Windows server, add the Microsoft IIS Web
Server Role using the Add role wizard.

After you add the IIS Web Server Role, add the .NET 3.5.1 Feature.

If you are not sure whether these components are installed on your web servers, or if you are not sure that they
were installed in the correct sequence, see the following.

e Microsoft Internet Information Services and Microsoft .NET Framework
e Updating ASP.NET.

Datacap server and workstation prerequisites

Before you install any Datacap components, ensure that Microsoft .NET 3.5.1 is installed on all servers and
workstations on which Datacap is to be installed. For instructions, see Turning on Microsoft .NET Framework
3.5.1.

Datacap components that are installed in a multi-machine environment use TCP port 2402 to access the
Datacap Server. If there is a firewall on the Datacap Server, you must open this port.

Datacap software component dependencies

Some Datacap software components depend on the presence of other Datacap software components to run.

e To export to Microsoft SharePoint using FastDoc, the Datacap for Microsoft SharePoint connector is
required.

e To process Adobe PDF documents using Flex, the Datacap for email and Electronic Documents
connector is required.

Parent topic: Prerequisites for installing Datacap

FastDoc prerequisites

Before you install FastDoc on a stand-alone workstation, ensure the required software is installed on your
system.

The following prerequisites must be met before you can install FastDoc:

e If you are processing images and capturing data in a non-English language, make sure the correct
Windows language is selected.
e For Windows 7 machines, ensure that Microsoft .NET Framework 4.5.1 is installed.
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e FastDoc requires additional Microsoft software that, if it is not already installed, is installed
automatically during the installation process.

e Ensure that your scanner is set up and works outside of FastDoc.

e If you are processing pre-scanned images from other scanners, ensure all images are scanned at the
resolution that you are using in FastDoc and ensure that the resolution is not changed over time.
Resolutions 300 DPI or 78 DPCM are recommended.

Parent topic: Prerequisites for installing Datacap
Related tasks:
Installing FastDoc on one machine

Microsoft Internet Information Services and Microsoft .NET
Framework

If you are going to install one or more of the Datacap Web Client server components, Report Viewer, Fingerprint
Service, or Datacap Web Services, Microsoft IIS must be installed before Microsoft .NET Framework 3.5.1. If
IIS is installed after .NET,, you must run the Microsoft ASP.NET IIS Registration Tool (aspnet_regiis.exe) with
the installation parameter -i to update the ASP.NET application script maps to point to the appropriate ASP.NET
ISAPI version.

About this task

For instructions on running the tool, see Updating ASP.NET. For more information about the tool, search for
aspnet_regiis.exe on the Microsoft website.

Procedure

To determine whether IIS and .NET are already installed.

1. From Start, select Administrative Tools > Server Manager.
2. In the Server Manager hierarchy pane, expand Roles. The Web Server (IIS) role is visible.
3. To determine whether the Microsoft .NET Framework 3.5.1 is installed, expand the Features Summary.
An entry for the Microsoft .NET Framework 3.5.1 feature is displayed.
4. Depending on whether either or both are installed, do one of the following.
a. If NET and IIS are not displayed, install IIS, then install Microsoft .NET Framework 3.5.1. Then,
continue with the Datacap installation process.
b. If both .NET and IIS are displayed, run aspnet_regiis.exe, continue with the Datacap installation
process.
c. If only IIS is displayed, install Microsoft .NET Framework 3.5.1. Then, continue with the Datacap
installation process.
d. If only .NET is displayed, install IIS, then run aspnet_regiis.exe. Then, continue with the Datacap
installation process.

Parent topic: Prerequisites for installing Datacap

Turning on Microsoft .NET Framework 3.5.1

Before you install Datacap on your Windows workstations or servers, ensure that the Microsoft .NET
Framework 3.5.1 operating system feature is turned on or added on every workstation and server.

Procedure
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1. To turn on Microsoft .NET Framework 3.5.1 on Windows 7:
a. Select Start > Control Panel > Programs > Programs and Features.
b. Select Turn Windows features on or off.
c. If not already installed, select Microsoft .NET Framework 3.5.1 and click OK.
d. Restart the machine when prompted.
2. To turn on Microsoft .NET Framework 3.5.1 on Windows 2008:
a. Select Start > Administrative Tools > Server Manager.
b. In the Server Manager hierarchy pane, select Features.
c. If not already installed, click Add Features.
d. Select .NET Framework 3.5.1 Feature and click Next.
e. Click Install.
f. Ensure that the installation was successful, then click Close.

Parent topic: Prerequisites for installing Datacap

Updating ASP.NET

Follow these instructions when you know that Microsoft .NET was installed before Microsoft Internet
Information Services (IIS) on the web server, or if you are not sure that Microsoft Internet Information Services
was installed first.

Before you begin

In Windows 2008, Microsoft aspnet_regiis.exe must be run in Administrator mode, and can be runin a
command prompt window. Before you begin, ensure that a shortcut exists, or add a shortcut to
%windir%\system32\cmd.exe to your Start menu.

About this task

This procedure provides instructions on how to run Microsoft aspnet_regiis.exe to update the ASP.NET
application script maps to point to the appropriate version of ASP.NET.

e When the server hosts Datacap Web Client, Report Viewer, or Datacap web services (WTM), run the
aspnet regiis.exe found in the C:\Windows\Microsoft.NET\Framework\v4.0.30319\ folder.

e When the server hosts the Fingerprint Service, run the aspnet regiis.exe program file that is found
in the C:\Windows\Microsoft.NET\Framework\v2.0.50727\ folder.

e If the server hosts Datacap Web Client, Report Viewer, or Datacap web services (WTM), and the
Fingerprint Service, run both versions of aspnet regiis.exe.

Procedure

1. On the Start menu, right-click the shortcut for the command prompt window and select Run as
administrator.

2. Runthe aspnet regiis.exe with the -i parameter, using the entire path, such as in the following
examples: C:\>C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319\aspnet regiis.exe -i
And C:\>C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\aspnet regiis.exe -i.
Progress messages are displayed indicating the start and completion of the installation.

3. When the installation is finished, close the command prompt window.

Parent topic: Prerequisites for installing Datacap

Verifying that IIS components are installed
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Ensure that the IIS Web Server Role Services are installed for the Datacap Web Client server components, such
as Datacap Web Client, Report Viewer, Fingerprint Service, and Datacap Web Services.

About this task

The Datacap Web Client server components must have specific IIS Web Server Role Services installed.

Procedure

Ensure that the IIS components are installed.

1. From the Start menu on the web server, select Administrative Tools > Server Manager.

2. In the Server Manager hierarchy pane, expand Roles and select Web Server (I1S).

3. In the Web Server (IIS) pane, expand Role Services. Under Common HTTP Features ensure that Static
Content, Default Document, Directory Browsing, and HTTP Errors are installed. If you are installing wTM,
do not install the WebDAV Publishing role service because it prevents the Datacap web services PUT
method from functioning.

4, In the Role Services pane under Application Development, ensure that the ASP.NET, .NET Extensibility,
ASP, ISAPI Extensions, and ISAPI Filters are installed.

5. In the Role Services pane, under Health and Diagnostics ensure that HTTP Logging and Request Monitor

are installed.

. In the Role Services pane, under Security ensure that Request Filtering is installed.

. In the Role Services pane, under Performance ensure that Static Content Compression is installed.

. In the Role Services pane, under Management Tools ensure that IIS Management Console is installed.

. (Windows Server 2012 R2) In Server Manager, click Dashboard, and click Add roles and features.

a. In the Add Roles and Features Wizard, go to the Features section.
b. In .NET Framework 4.5 Features > WCF Services, select the HTTP Activation check box.

10. Close the Server Manager window.
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Parent topic: Prerequisites for installing Datacap

Setting up the scanner

When a computer is to be used as a scan station, follow the manufacturer’s instructions to attach the scanner
to the computer. Install and configure the required scanner drivers and software. Be sure you can scan
successfully with an image capture software product other tha Datacap. If you are unable to scan documents
with software that is not Datacap, you cannot scan documents with Datacap.

About this task

Tip: A physical scanner is not required for running the Datacap that is separately licensed or sample
applications because those applications can process the prescanned, sample images that are included during
installation.

Parent topic: Prerequisites for installing Datacap

Ensuring the correct Windows language is selected

When you process images with data in a language other than English on an English language version of
Windows, ensure that the Windows Language for non-Unicode programs setting matches the language that you
want to recognize.

Procedure
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To ensure that the correct language has been selected in Windows.

. From the Windows Start menu, select Control Panel. The Control Panel window opens.

. Double-click Regional and Language. The Regional and Language window opens.

. Click the Administrative tab.

. Click Change system locale. The Regional and Language Settings window opens with the Current®
language for non-Unicode programs displayed.

. If the correct language is displayed, click Cancel to close the window.

6. If the language displayed does not match the language that is to be recognized, select the correct locale,

click OK and follow the prompts to restart the workstation.
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Parent topic: Prerequisites for installing Datacap
Related tasks:
Installing FastDoc on one machine

Installing Microsoft .NET Framework 4.0

Computers running Datacap software components require Microsoft .NET Framework 4.0. If Microsoft .NET
Framework 4.0 is not already installed, it is installed automatically during the Datacap software installation
process.

About this task

You can install Microsoft .NET Framework 4.0 on your servers and workstations before you install Datacap to
shorten the time that is required for the Datacap installation.

Parent topic: Prerequisites for installing Datacap

Ensuring that the Datacap Server Service is started

The Datacap Server Service must be running before you start an application or a Datacap component. You can
check the status of the service and start the service in the Datacap Server Manager.

About this task

All configurations of Datacap require that the Datacap Server Service must be running before you can
successfully start an application or Datacap component. This requirement applies whether the Datacap Server
Service is started on the Workstation in a single computer configuration or on the Datacap Server for
client/server configurations.

In a single computer configuration, the Datacap Server Service runs by using the LocalSystem account.
In a client/server configuration, the Datacap Server Service runs by using the account that you set up for it.

You start the Datacap Server Service by using the Datacap Server Manager. You can also ensure that the
Datacap Server Service is started by checking the status message that is displayed by the Datacap Server
Manager.

Procedure

To start the Datacap Server Service:
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1. From Start, select IBM Datacap Services > Datacap Server Manager. If the User Account Control window
opens, click Yes.

2. Check the Status message and start the service if it is stopped.
Tip: If a Datacap Service error displays when you start the service in a client/server environment, the
Service does not have adequate rights to log on to the server. For more information, see Granting
Datacap Server Service the Log On as a Service Privilege.

3. Close the Datacap Server Manager window.

Related tasks:
Granting Datacap server service the Log On as a Service privilege

Ensuring that the Datacap Server Service is stopped

You can stop the Datacap Server Service in the Datacap Server Manager to do maintenance tasks and other
activities. You can also ensure that the Datacap Server Service is stopped by checking the status message that
is displayed by the Datacap Server Manager.

About this task

If you are stopping the Datacap Server Service in a client/service environment, run these steps on the server
where the Datacap Server is installed.

Procedure

To stop the Datacap Server Service:

1. From the Windows Start menu, select IBM Datacap Services > Datacap Server Manager. When User
Access Control (UAC) is enabled, the User Account Control window is displayed. Click Yes.

2. Check the Status message and stop the service if it is started.

3. Close the Datacap Server Manager window.

Installing and configuring Datacap on one machine

You can install, configure, and operate Datacap on a single machine for demonstration or testing purposes only.

Datacap is designed to be installed, configured, and operated in a client/server environment. The following
components can be installed, configured, and run on the single Windows machine for demonstration or testing
purposes.

e Datacap Server service

e Datacap Web Client

e Report Viewer

e Rulerunner Service (single thread)

You must configure the single machine for Datacap authentication. The Datacap Server service, Datacap Web
Client application pool, Report Viewer application pool, and Rulerunner Service use the default LocalSystem
account on the single machine.

The Windows account that you use when you log in to the single machine must have administrator rights.

After you install the Datacap software from the installation wizard, you must apply the software license by
going to the IBM Datacap Services folder, opening the Datacap License Manager, and selecting your license
options. The IBM® Datacap *.swidtag license files are in the C:\Datacap\iso-swid folder.
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Installing FastDoc on one machine

You run the installation program wizard to install the FastDoc components on a single workstation where
the Datacap software is not installed.

Single machine installation and configuration

You can install, configure, and operate Datacap on a single machine for demonstration or testing
purposes only.

Parent topic: Installing

Installing FastDoc on one machine

You run the installation program wizard to install the FastDoc components on a single workstation where the
Datacap software is not installed.

About this task

You can get the installation package, Setup.exe, from a network drive, local drive, or a CD/DVD drive. You must
install FastDoc on the physical hard disk of the computer from which you run Setup.exe.

For security purposes, the Key Management tool (dcskey.exe) is installed on the Datacap Server. You can use
dcskey.exe to generate the security encryption key on FastDoc based on the following installation use cases.
Tip: In the use cases where FastDoc does not use Datacap Server, the server still must be installed for FastDoc
to be able to obtain dcskey.exe.

Table 1. Installation use cases

Use case Action required
FastDoc runs as a client to Datacap Server Import dcskey.exe from the
server

FastDoc is not a Datacap client, shares Datacap Application Manager files | Generate the key on one of the
with other FastDoc clients clients and import it to the other

clients

FastDoc is not a Datacap client, which is used by one user on a stand-alone | None
workstation and does not share Datacap Application Manager files with
other clients

After you generate the key on the FastDoc client, delete dcskey.exe and the key file from the client computer.

Procedure

To install FastDoc on a stand-alone workstation:

1.
2.

Place the installation package on your network.
Open Windows Explorer, go to and double-click the Setup.exe file. If the User Account Control window
displays, click Yes.

. At the Select the language dialog, select the appropriate language and click OK. The language that you

select determines the language that is displayed by the installation program wizard during the
installation process.

. At the Welcome window, click Next.
. At the Software License Agreement window, select I accept the terms in the license agreement and click

Next.

. At the Setup Type window, select Custom and click Next.
. At the Custom Setup window, expand the Datacap client component and select FastDoc if it is not

already selected.
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8. Click all of the other components and select X This feature will not be available and click Next. A red X is
displayed next to these components.
9. At the Ready to install the Program window, click Install. FastDoc and the other standard components
are installed.
10. Click Finish to close the installation program wizard.

Parent topic: Installing and configuring Datacap on one machine
Related concepts:

FastDoc prerequisites

Related tasks:

Ensuring the correct Windows language is selected

Installing Datacap on one machine

You must follow a specific procedure to install the Datacap components on a Windows single machine. The
configuration of Datacap on a single machine is for demonstration or test purposes only. You can install the
TravelDocs application to confirm that the software is installed and configured correctly.

About this task

The Datacap installation and configuration steps are performed in the following sequence.

Procedure

1. Ensure that you complete the prerequisites that are detailed in Installation and Configuration
Prerequisites.

. Add the local system account to the single machine's Administrators group.

. Run the Datacap installation program, install the Datacap software components and any additional
components for which you have a license on the single machine.

. Export the encryption keys.

. Start the Datacap server service.

. Run the Datacap TravelDocs application.

. Stop the Datacap server service.

. Configure Datacap Web Client.

. Configure Internet Explorer.

10. Start the Datacap server service.

11. Run the Datacap TravelDocs application.

12. Configure Report Viewer and view reports.

13. Configure the Rulerunner Service to run tasks on a single thread.

14. Run TravelDocs tasks.
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e Adding the local system account to Administrators group
Add the local system account of the workstation to the Administrators group of the workstation. The
account now has local administrator rights on the computer.

e Installing Datacap components on one machine
The procedure to install Datacap components on a single machine includes installing the required
components and any separately licensed applications and connectors.

e Exporting encryption keys
You must generate security keys that allow Datacap to encrypt and decrypt passwords. To replace
existing keys with new keys, you can specify a parameter to generate encryption keys to a local store.
You can specify a different parameter to export the encryption keys from the local keystore to a file that
can be imported to other computers.
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e Datacap Web Client installation and configuration
You can run tasks from a computer on which the Internet Explorer browser is installed when you set up
the Datacap Web Client. In a single machine configuration that is used for testing and demonstration
purposes, Datacap Web Client runs using the LocalSystem account.

e Datacap Report Viewer
The Datacap Report Viewer web application displays real-time reports of activity that is related to your
Datacap applications.

e Rulerunner Service (single thread)
The Rulerunner Service is a Datacap component that runs Datacap Studio application background tasks
that require no human interaction. Examples of background tasks are VScan, recognition, image pre-
processing, validation, and export tasks.

Related concepts:
Installation and configuration prerequisites

Adding the local system account to Administrators group

Add the local system account of the workstation to the Administrators group of the workstation. The account
now has local administrator rights on the computer.

Parent topic: Installing Datacap on one machine

Installing Datacap components on one machine

The procedure to install Datacap components on a single machine includes installing the required components
and any separately licensed applications and connectors.

About this task

Run the Datacap installation program wizard to install Datacap on a single machine. The components that you
install include the main Datacap components and any separately licensed applications and connectors.

These instructions apply to single machines with a Windows operating system.

Procedure

To install Datacap on a single machine:

1. Make the installation package available on your network or insert the Datacap CD in the Workstation’s
CD/DVD drive. If the installation process does not start automatically or if the package is on the network,
open Windows Explorer, navigate to and double-click the Setup.exe. When User Account Control (UAC) is
on, the User Account Control window opens. Click Yes.

2. Select the appropriate language, then click OK. The language that you select determines the language
that is displayed by the installation program wizard during the installation process.

3. When more software is needed, the installation program wizard displays a list of the items to be

installed. Click Install.

. Click Next.

. Accept the license agreement and click Next.

. Select the Custom option. Click Next.

. Include all of the Datacap software components.

. Expand the Datacap client software component and include only the separately licensed applications.

. Expand the Connectors software component and include only the connectors for which you have a

license.
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10. Click Next.
11. Click Install.
12. Click Finish.

Parent topic: Installing Datacap on one machine

Exporting encryption keys

You must generate security keys that allow Datacap to encrypt and decrypt passwords. To replace existing keys
with new keys, you can specify a parameter to generate encryption keys to a local store. You can specify a
different parameter to export the encryption keys from the local keystore to a file that can be imported to other
computers.

About this task

You must generate and use the security encryption keys that allow Datacap to encrypt and decrypt the
passwords that are used by users, services, and processes to access the Datacap server service and to log in to
databases.

In a single machine configuration, you must generate and export the encryption keys that all of the Datacap
components on the single machine use.

In a client/server configuration, you must generate and export matching security encryption keys from the
server on which the Datacap server software component is installed to all of the computers on which any
Datacap component is installed. This requirement secures any passwords that are passed over or received
from the network by the Datacap component.

Procedure

To generate encryption keys and export them:

1. Open a command prompt and navigate to the C:\Datacap\Taskmaster folder. In a client/server
configuration, perform this step on the computer on which the Datacap server software component is
installed.

2. Run the key management program, dcskey.exe, inserting one or more of the following parameters in the
command. For example, to export keys during a new Datacap installation, you would enter dcskey.exe

e.

e
Exports the encryption keys from the local keystore to a dc_KTF.xml key transport file. You can
use this file to import the keys to other computers. If no keys exist in the keystore, the e
parameter generates new ones before the export. If keys exist in the keystore, the e parameter
exports those keys.

gnk

Generates, but does not export, encryption keys in the local keystore. Use this parameter any
time you must replace existing keys with new keys. For example, you would run the command
dcskey.exe gnk e toreplace existing keys and export them. The newly exported keys would
then must be imported onto all other Datacap computers in your configuration.

Parent topic: Installing Datacap on one machine

Datacap Web Client installation and configuration
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You can run tasks from a computer on which the Internet Explorer browser is installed when you set up the
Datacap Web Client. In a single machine configuration that is used for testing and demonstration purposes,
Datacap Web Client runs using the LocalSystem account.

The steps that you must follow to install and configure Datacap Web Client include ensuring that the required
IIS components are installed and creating the Datacap Web Client site. You use the Datacap Web Client Server
Configuration tool to set up the Datacap Web Client site for a single machine configuration. A single machine
configuration requires the tmweb.net application pool to be set for the LocalSystem account.

e Creating the Datacap Web Client site
You can create the Datacap Web Client site to run tasks from a computer on which the Internet Explorer
browser is installed. The steps that you follow to install and configure the Datacap Web Client site
include ensuring that the required IIS components are installed and configuring the tmweb.net
application pool.

e Internet Explorer configuration for Datacap Web Client
You must configure Internet Explorer to run Datacap Web Client in a single machine installation.

Parent topic: Installing Datacap on one machine

Creating the Datacap Web Client site

You can create the Datacap Web Client site to run tasks from a computer on which the Internet Explorer
browser is installed. The steps that you follow to install and configure the Datacap Web Client site include
ensuring that the required IIS components are installed and configuring the tmweb.net application pool.

Before you begin

Before creating the Datacap Web Client site, stop or ensure the Datacap Server Service is stopped.

About this task

You must create the Datacap Web Client site by using the Datacap Web Client Server Configuration tool.

Procedure

1. From the Windows Start menu, select IBM Datacap Web > Datacap Web > Server Configuration Tools.
When User Account Control (UAC) is on, the User Account Control window opens. Click Yes.
2. Determine whether the contents of the information box indicate one of the following conditions:

o If one or more of the items that are listed in the information box are Not Found, click OK, then
follow the instructions in Microsoft Internet Information Services and Microsoft .NET Framework
to determine whether IIS and .NET were installed in the correct sequence and that all of the IIS
components are installed.

o If all of the items that are listed in the information box are Found, click OK and continue with
these instructions.

3. Ensure that the default value for each of the settings is appropriate for your web site, processing needs,
and corporate requirements.

o When yourDatacap Web Client site is not nested under the Default Web Site, select the
appropriate Site and change the Site Settings.

o Depending on the usual size of the images or groups of images that are uploaded from the
Datacap Web Client, you must adjust the value of the ASP.NET Maximum File Upload Size and ASP
Maximum Requesting Entity Body Limit fields.

o Depending on your typical processing loads and schedules, change the default value of the App
Pool Recycling Schedule to a time during which there are few or no batches in process Datacap
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16.

17.

Web Client. For more information on recycling and Datacap Web Client, see Effects of IIS
application pool recycling onDatacap Web Client batches.

o Depending on your company's security policies, change the value of the Connection time-out
field.

. Click Configure.
. Click OK, then click Exit. The Datacap Web Client site is created.
. From the Windows Start menu, select Control Panel > Administrative Tools, then double-click Internet

Information Services (IIS) Manager.

. In the Connections pane, expand the computer node, expand the Sites node, and expand the Default

Web Site or your web site. The tmweb.net site is displayed. If it is not displayed, right-click the site and
select Refresh.

. In the Application Pools pane, select the tmweb.net application pool, then in the Actions pane, in the

Edit Application Pool section, click Advanced Settings.

. In the Process Model section, click the browse button to the right of Identity.
10.
11.
12.
13.
14.
15.

In the Application Pool Identity window, change the Built-in account to LocalSystem, then click OK.

In the Process Model section, set Load User Profile to True.

Click OK.

In the Connections pane, expand the Sites node, and expand the Default Web Site or your web site.
Select the tmweb.net site, and in the middle pane, double-click Session State.

Under Cookie Settings, change the Name to tmweb or another unique name, then, in the Actions pane,
click Apply.

In the Connections pane, select the Default Web Site, then, in the Actions pane, under Manage Web Site,
click Restart.

In the Connections pane, select the Default Web Site or your web site, then, in the Actions pane, under
Manage Web Site, click Restart.

Parent topic: Datacap Web Client installation and configuration
Related information:
Effects of application pool recycling on Datacap Web Client batches

Internet Explorer configuration for Datacap Web Client

You must configure Internet Explorer to run Datacap Web Client in a single machine installation.

You can configure Internet Explorer to run locally on the same computer asDatacap Web Client in a single
machine installation for demonstration and testing purposes. The procedure for configuring Internet Explorer
includes adding the TMWeb.net address as a trusted site and testing Internet Explorer using the Datacap Web
Client Configuration tool.

Adding the tmweb.net address as a trusted site

You must add the tmweb.net address as a trusted site in a single machine installation to prevent
Internet Explorer from blocking access to theDatacap Web Client site.

Configuring Internet Explorer on a single machine

You can configure Internet Explorer to run on a single machine with the Datacap Web Client for
demonstration and test purposes.

Parent topic: Datacap Web Client installation and configuration

Adding the tmweb.net address as a trusted site

You must add the tmweb.net address as a trusted site in a single machine installation to prevent Internet
Explorer from blocking access to theDatacap Web Client site.
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About this task

In a single machine installation, you can enter the default server address as a trusted site for Internet Explorer
access to the Datacap Web Client site.

Procedure

1.
2.
3.
4.
5.
6.

Open Internet Explorer.

On the Tools menu, select Internet Options to open the Internet Options dialog.

Click the Security tab to display the options.

Select the Trusted sites option and press Sites to open the Trusted Sites dialog.

Enter the default server address http://localhost in the Add this website to the zone field, then click Add.
Close the Trusted Sites dialog and select OK to close the Internet Options dialog.

Parent topic: Internet Explorer configuration for Datacap Web Client

Configuring Internet Explorer on a single machine

You can configure Internet Explorer to run on a single machine with the Datacap Web Client for demonstration
and test purposes.

About this task

This procedure provides instructions on how to set up Internet Explorer using the Datacap Web Client
Configuration tool in a single machine configuration. When you configure Internet Explorer, you can use the
Datacap Web Client for processing tasks. This procedure also provides instructions on how to test your
configuration of Internet Explorer.

Important: When the operating system of the machine on which you want to run Internet Explorer to
accessDatacap Web Client is a 64-bit operating system, you must use the 32-bit version of Internet Explorer to
access Datacap Web Client

Procedure

1.

w

From the Windows Start menu, select IBM Datacap Web > Datacap Web Client Configuration Tools.
When User Access Control is on, the User Account Control window opens. Click Yes.

. Ensure that http://localhost is the default URL that is displayed.
. Click Configure, OK, and Exit.
. Start Internet Explorer and enter the URL forDatacap Web Client, followed by the tmweb.net virtual

directory and the test page, http://localhost/tmweb.net/ietest.aspx.

. When User Access Control is on, the first time you access the test page the User Access Control window

opens. Click Yes to download the Datacap TIFF Viewer, Thumbnails, and DataEdit Controls.

. Click Test. The green check marks are displayed when the test completes successfully. If the Datacap

TIFF Viewer does not download, switch to the 32-bit version of Internet Explorer and repeat this
procedure from step 1.

Parent topic: Internet Explorer configuration for Datacap Web Client

Datacap Report Viewer

The Datacap Report Viewer web application displays real-time reports of activity that is related to your Datacap
applications.
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For a list of the standard reports, see Standard reports.

e Overview of Datacap Report Viewer installation and configuration
You must complete the required tasks to install and configure the Datacap Report Viewer reporting
component.

e Adding an application pool for Report Viewer
When you are running on Windows 7 or Windows 2008, you must add a Microsoft Internet Information
Services (IIS) Application Pool for use by Report Viewer.

e Single machine installation: Setting up the Datacap Report Viewer website
You must set up the Report Viewer website on Microsoft Internet Information Services (IIS) 7.5.

e Adding the Datacap Report Viewer address as a trusted site
You add the Report Viewer address as a trusted site in a single computer installation of Datacap to
prevent Internet Explorer from blocking access to the Datacap website.

Parent topic: Installing Datacap on one machine
Related information:
Custom Datacap Report Viewer reports

Overview of Datacap Report Viewer installation and
configuration

You must complete the required tasks to install and configure the Datacap Report Viewer reporting component.
Before you start, ensure that you met the installation and configuration prerequisites.

In a single computer configuration, Report Viewer runs by using the LocalSystem account. To set up a single
computer configuration:

1. Ensure that you have the required Microsoft Internet Information Services components installed.
2. Add an Application Pool for Report Viewer.
3. Set up the Report Viewer website.

In a client/server environment:

. Create or ensure that an account exists for Report Viewer.

. Ensure that you have the required Microsoft Internet Information Services (IIS) components installed.
. Set up various Report Viewer permissions.

. Install Report Viewer on the web server.

. Import encryption keys on the web server.

. Add an Application Pool for Report Viewer.

. Set up the Report Viewer website and Application Pool advanced settings.
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Parent topic: Datacap Report Viewer
Related concepts:
Installation and configuration prerequisites

Adding an application pool for Report Viewer

When you are running on Windows 7 or Windows 2008, you must add a Microsoft Internet Information
Services (IIS) Application Pool for use by Report Viewer.

Procedure
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To add an Application Pool for Report Viewer:

1.

o0 AW

From the Windows Start menu, select Administrative Tools > Internet Information Services (IIS)
Manager.

. In the Connections pane, expand the computer, right-click Application Pools and select Add Application

Pool.

. Set the Name to Report Viewer.

. Set the .NET Framework version to .NET Framework v4.0.30319.
. Set the Managed pipeline mode to Integrated.

. Select the Start application pool immediately option and click OK.

Parent topic: Datacap Report Viewer

Single machine installation: Setting up the Datacap Report
Viewer website

You must set up the Report Viewer website on Microsoft Internet Information Services (IIS) 7.5.

Procedure

To set up the Report Viewer website:

1.
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17.

18.

19.

From the Windows Start menu on the Workstation, select Administrative Tools > Internet Information
Services (IIS) Manager.

. In the Connections pane, expand the computer and expand Sites. Then, right-click the Default Web Site

and select Add Application.

. Set the Alias to Report Viewer.
. Click Select and select the Report Viewer Application Pool that you added, then click OK.
. Set the Physical path by entering or browsing to the Report Viewer installation folder. The default

location is C:\Datacap\RV2.

. Click OK to close the Add Application dialog.

. In the Connections pane, select Application Pools.

. In the Application Pools pane, select the Report Viewer application pool.

. In the Actions pane, in the Edit Application Pool section, click Advanced Settings.
10.
11.
12.
13.
14.
15.
16.

Ensure that the Microsoft .NET version is set to v4.0.

Ensure that Enable 32-Bit Applications is set to True.

In the Process Model section, click Browse next to Identity.

In the Application Pool Identity window, change the Built-in account to LocalSystem, then click OK.
In the Process Model section, set Load User Profile to True.

Click OK.

In the Connections pane, expand the computer and expand Sites. Then, expand the Default Web Site
and select the Report Viewer site, and in the middle pane, double-click Session State.

Under Cookie Settings, change the Name to Report Viewer or another unique name, then, in the
Actions pane, click Apply.

In the Connections pane, select the Default Web Site, then, in the Actions pane, under Manage Web Site,
click Restart.

Confirm that the Web Server, Application Pool, and Default website are started.

Parent topic: Datacap Report Viewer

Adding the Datacap Report Viewer address as a trusted site
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You add the Report Viewer address as a trusted site in a single computer installation of Datacap to prevent
Internet Explorer from blocking access to the Datacap website.

Procedure

To add the Report Viewer address as a trusted site:

. Open Internet Explorer and select Tools > Internet Options.

. In the Internet Options window, click the Security tab.

. Select Trusted sites and click Sites.

. In the Trusted Sites window, enter the default server address (http://localhost) in the Add this website to
the zone field, then click Add

. Click Close.

6. Click OK in the Internet Options dialog.
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Parent topic: Datacap Report Viewer

Rulerunner Service (single thread)

The Rulerunner Service is a Datacap component that runs Datacap Studio application background tasks that
require no human interaction. Examples of background tasks are VScan, recognition, image pre-processing,
validation, and export tasks.

Rulerunner can be configured to run on a single thread with standard Datacap licensing. Configuring
Rulerunner to run on multiple threads requires additional licensing.

For demonstration and testing purposes, you can configure Rulerunner on a single machine where all of the
Datacap components are installed. The single machine configuration does not allow Rulerunner to take full
advantage of the machine's multiple processors. Do not use this configuration as your production configuration.

e Configure Rulerunner on a single machine
You can configure Rulerunner on a single machine to run Datacap TravelDocs tasks for demonstration
and testing purposes.

e Granting the Rulerunner account the Log On as Service privilege
You must configure the Rulerunner Service properties with the privilege to log on as a local system
account. This privilege allows the Rulerunner Service to run as a Windows service.

e Configuring Rulerunner to run TravelDocs tasks
You can configure Rulerunner to run the TravelDocs PagelID task, Profiler task, and Export task.

e Configuring TravelDocs task profiles
You can ensure that the Datacap Application Manager displays only those task profiles that you want
Rulerunner to run.

e Starting the Rulerunner Service
After you set up or change the Rulerunner Service, go to the Rulerunner Manager and start the
Rulerunner service.

e Monitoring batches during Rulerunner processing
Monitor your batches using the Datacap Web Job Monitor to watch batches change status as they are
processed by Rulerunner.

Parent topic: Installing Datacap on one machine

Configure Rulerunner on a single machine
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You can configure Rulerunner on a single machine to run Datacap TravelDocs tasks for demonstration and
testing purposes.

You can set up a single Rulerunner thread to run Datacap TravelDocs tasks and to monitor Rulerunner
processing when all Datacap components are installed on a single machine. In this configuration, the
Rulerunner Service runs using the LocalSystem account.

The process is made up of the following steps:

1. Configure the Rulerunner account.

2. Configure Rulerunner to run Datacap TravelDocs tasks.
3. Create Datacap TravelDocs batches.

4. Start Rulerunner.

5. Monitor Rulerunner processing.

Parent topic: Rulerunner Service (single thread)

Granting the Rulerunner account the Log On as Service
privilege

You must configure the Rulerunner Service properties with the privilege to log on as a local system account.
This privilege allows the Rulerunner Service to run as a Windows service.

About this task

This procedure provides instructions on how to ensure the Local System account that is used by the Rulerunner
Service is granted the Log On as a Service privilege.

Procedure

1. From the Start menu, select Control Panel > Administrative Tools > Services. When User Account Control
(UAC) is on, the User Account Control window opens. Click Yes.

2. Right-click the Rulerunner Service and select Properties.

3. Click the Log On tab.

4. Select or ensure that the Local System account is selected and click Apply.

5. Click OK to close the Properties dialog.

6. Close the Services window.

Parent topic: Rulerunner Service (single thread)

Configuring Rulerunner to run TravelDocs tasks

You can configure Rulerunner to run the TravelDocs PagelD task, Profiler task, and Export task.

Before you begin

Before configuring Rulerunner, start or ensure the Datacap Server Service is started.

About this task

This procedure provides instructions on how to configure Rulerunner to run the TravelDocs PagelD, Profiler,
and Export tasks on a single thread.
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Your license determines the number of threads that you can configure in Rulerunner Manager set up.

Procedure

To configure Rulerunner to run TravelDocs tasks:

1. From the Start menu, select IBM Datacap Services > Datacap Rulerunner Manager.
a. If User Account Control (UAC) is enabled, click Yes to close the User Account Control window.
b. If the Status is Running, click Stop.
c. If the Status is Stopped, continue with the next step.
. Click the Rulerunner Login tab.
. Select the Datacap Authentication option to enable the login credential fields.
. For the Datacap, User ID, Password, and Station ID, enter admin, admin, and 1, and click Connect.
. Click the Workflow:Job:Task tab. The names of the applications from the datacap.xml file are displayed
in one pane. The other pane does not contain threads the first time that you use Rulerunner Manager.
. Click the check box next to the TravelDocs application. The application tree expands with the Server,
Administrator database, and Engine database selected.
7. Right-click in the pane and select Thread, then select Add Thread.
8. In the other pane, expand the TravelDocs application, click the check box next to the PagelD task,
Profiler task, and Export task in both the Main Job and the Web Job.
9. Click and drag the Main Job onto the thread.
10. Click Save to save your changes, and then click Yes to save the configuration file.
11. Click the Rulerunner Login tab and click Disconnect.
12. Close the Rulerunner Manager window.
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What to do next

From a workstation, start your Datacap client application using your admin user ID, password and station ID.
Run your application or applications so that there are batches pending for the tasks that Rulerunner is
configured to process.

Parent topic: Rulerunner Service (single thread)

Configuring TravelDocs task profiles

You can ensure that the Datacap Application Manager displays only those task profiles that you want
Rulerunner to run.

Procedure

To configure TravelDocs task profiles:

1. From the Start menu, select IBM Datacap Services > Datacap > Datacap Application Manager.

a. If User Account Control (UAC) is enabled, click Yes to close the User Account Control window.
2. Select the TravelDocs application. The Main tab displays the paths.
3. Click the Rulerunner tab. This tab displays the task profiles that are processed by Rulerunner.
4, Click the red X next to the VScan profile name, and click Yes to confirm you want to remove the task.
5. Confirm that the PagelD task, Profiler task, and Export task are displayed.
6. Close the Datacap Application Manager.

What to do next

Stop and restart the Datacap Server Service before starting the Datacap application.
Parent topic: Rulerunner Service (single thread)
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Starting the Rulerunner Service

After you set up or change the Rulerunner Service, go to the Rulerunner Manager and start the Rulerunner
service.

Procedure

Follow this procedure to start the Rulerunner Service.

1. Go to Start > IBM Datacap Services > Datacap Rulerunner Manager. If the User Account Control window
opens, click Yes.

2. If the Status is Stopped, click Start. The Status changes to Running.

3. Close the Rulerunner Manager window.

Parent topic: Rulerunner Service (single thread)

Monitoring batches during Rulerunner processing

Monitor your batches using the Datacap Web Job Monitor to watch batches change status as they are
processed by Rulerunner.

Parent topic: Rulerunner Service (single thread)

Installing and configuring in a client/server environment

The typical installation configuration for Datacap is one where the various Datacap software components are
installed on dedicated machines. These software components include application servers, web servers,
database servers, scan workstations, verify workstations, etc.

The following installation sections provide information on installing Datacap on multiple machines in a
distributed environment.

After you install the Datacap software from the installation wizard, you must apply the software license by
going to the IBM Datacap Services folder, opening the Datacap License Manager, and selecting your license
options. The IBM® Datacap *.swidtag license files are in the C:\Datacap\iso-swid folder.

e Datacap installation and configuration in a client/server environment
The list of Datacap components you can install in a client/server environment includes the Datacap Web
Client, Datacap Application Manager, andRulerunner. You can also install Maintenance Manager, Report
Viewer, and Datacap Web Services.

e Datacap Web Services installation steps
The Datacap Web Services installation in a client/server environment requires you to follow several
steps, including preparation, installation, configuration, and verification steps.

e Client/server installation checklist
This checklist provides a summary of the account and configuration settings that are required to run
Datacap software components in a client/server environment for demonstration, proof of concept,
development and test purposes.

e Datacap installation command-line parameters
You can run the Datacap installation program Setup.exe file by using command-line parameters from the
command line.

Parent topic: Installing
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Datacap installation and configuration in a client/server
environment

The list of Datacap components you can install in a client/server environment includes the Datacap Web Client,
Datacap Application Manager, andRulerunner. You can also install Maintenance Manager, Report Viewer, and
Datacap Web Services.

Datacap can be installed, configured, and run in a client/server environment. Datacap includes many
components, some of which are required for Datacap to function. Some components are not required for
Datacap to function but can be installed to meet your processing requirements. You can install and configure
some or all of these components for demonstration, proof of concept, development, and test purposes.

e Datacap Server

e Datacap Clients, including Datacap FastDoc, Datacap Studio, and Datacap Maintenance Manager.
e Datacap Rulerunner Server

e Datacap Web Server

e Datacap Web Service

e Datacap Windows Service

e Report Viewer

e Connectors

You can set up and run the separately licensed Datacap applications, including theDatacap Accounts Payable
application.

For a checklist of the account and configuration settings, see the Client/server installation checklist.

After you install the Datacap software from the installation wizard, you must apply the software license by
going to the IBM Datacap Services folder, opening the Datacap License Manager, and selecting your license
options. The IBM® Datacap *.swidtag license files are in the C:\Datacap\iso-swid folder.

e Datacap client/server configuration
Datacap can be configured in many ways, such as installing components on separate machines,
installing multiple components on a single machine, or installing a single component on multiple
machines.

e Installing and configuring Datacap on a client and server
The steps to install and configure Datacap include installing components such as the Datacap Web
Client, Report Viewer, Maintenance Manager, and Rulerunner. The sample TravelDocs application that is
delivered with Datacap provides you with an easy way to confirm that you set up Datacap correctly.

e Installation instructions for Datacap server
Installation instructions for the Datacap server include ensuring that an account with administrator
privileges is granted Full Control access to all of the machines on which the Datacap components are
being installed.

e Client/server environment: Datacap Web Client installation and configuration
You can run tasks from a computer on which the Internet Explorer browser is installed when you set up
the Datacap Web Client. In a single machine configuration that is used for testing and demonstration
purposes, Datacap Web Client runs using the LocalSystem account.

e Installing and configuring Datacap Navigator
Datacap Navigator is a web client for Datacap based on IBM Content Navigator. You set up the Datacap
Navigator client by loading a plug-in and configuring repositories and desktops in IBM Content
Navigator.

e Installing the developer workstation software components
Run the Datacap installation program wizard on the workstation of a developer to install the Datacap
software components.
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e Copying the application to the Datacap Server
The following information provides instructions for copying specific applications. However, the
instructions are equally applicable to a customized application, and you can refer to any one of the
topics for copying your custom application. You need to start Datacap Studio, start the Datacap Studio
Application Copy wizard, and copy the application from the developer workstation to the server. The
application can then be accessed by other workstations that are running the Datacap Client or Datacap
Web Client, and by other services and processes.

e Complete the Datacap server configuration
You must update the datacap.xml file on the Datacap server to add references to applications. You must
also set up security on the folder that contains the applications.

e Complete the Datacap Web Client server configuration
To complete the Datacap Web Client server configuration, you must set the location of the Datacap.xml
file. Then, you must restart Internet Information Services.

e Configuring and testing the remote workstation
You can configure and test a remote workstation that uses Internet Explorer to access Datacap Web
Client.

e Installing the Datacap client on the user workstation
You can run the Datacap installation program wizard on a user workstation to install the necessary
Datacap client software.

e Installing and configuring Datacap Report Viewer
You can install and configure Report Viewer to run locally or in a Datacap client/server environment so
you can use the browser-based Datacap Web Client for processing.

e Installing and configuring the Rulerunner Service
The Rulerunner Service is a Datacap component that runs Datacap Studio application tasks in the
background.

e Installing and configuring the Datacap Fingerprint Service
The Datacap Fingerprint Service, with actions in the Autodoc actions library, supports the ability to
cache and use the fingerprints from one or multiple Datacap applications simultaneously. The
Fingerprint Service eliminates the fingerprint load time for all but the first batch that is processed by an
application.

e Installing and configuring the Datacap Web Client upload service
After you scan files and create batches with Datacap, you can upload the files by using the Datacap Web
Client upload service.

e Starting Datacap Studio
This procedure provides instructions on how to start the Datacap Studio software component.

e Installing and configuring Datacap Maintenance Manager
Datacap Maintenance Manager is a Datacap software component that sets up batch monitoring, status
notification, and automatic deletion of completed batches.

e Configuring authentication for Datacap
You can configure Datacap to use Datacap authentication or to use one of the external authentication
methods.

e Installing and configuring IBM Datacap Advanced Handwriting Recognition 9.0.1
The IBM Datacap Advanced Handwriting Recognition 9.0.1 is an add-on for handwriting recognition for
checks.

Parent topic: Installing and configuring in a client/server environment
Related concepts:
Client/server installation checklist

Datacap client/server configuration

Datacap can be configured in many ways, such as installing components on separate machines, installing
multiple components on a single machine, or installing a single component on multiple machines.
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The multiple machine configuration that is used throughout the client/server examples that are provided in
these tasks includes the following machines:

The Datacap Server that hosts the main application settings file (datacap.xml), the applications, batch
files, and databases.

The Datacap Web Server and the Report Viewer.

The developer workstation that hosts the Datacap clients, including Datacap Studio, Datacap Desktop,
FastDoc, and Maintenance Manager.

Workstations that host Datacap clients, such as Datacap Desktop, your browser, and the Datacap Web
Client Upload Service.

The Rulerunner server hosts the Rulerunner Service, which runs tasks that do not require human
interaction.

The Fingerprint Service server that hosts the Fingerprint Service.

You must also create accounts and permissions that are needed for the following types of users, processes,
and services.

Implementation and development personnel with administrative rights on all machines
Users

Datacap Server service

Datacap Web Client

Rulerunner Service

Maintenance Manager

Report Viewer

Fingerprint Service

Datacap Web Services

Parent topic: Datacap installation and configuration in a client/server environment

Installing and configuring Datacap on a client and server

The steps to install and configure Datacap include installing components such as the Datacap Web Client,
Report Viewer, Maintenance Manager, and Rulerunner. The sample TravelDocs application that is delivered
with Datacap provides you with an easy way to confirm that you set up Datacap correctly.

Procedure

To install and configure Datacap on a client and server:
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. Ensure that you meet the prerequisites that are detailed in Installation and Configuration Prerequisites.

. Install the Datacap Server software component on the server.

. Configure Datacap on the server.

. Install Datacap Web Client on the web server.

. Configure Datacap Web Client on the web server.

. Install the Datacap client software component, the separately licensed applications, and the connectors

for which you have licenses on the developer workstation.
Important: Include the Datacap Connector for eMail and Electronic Documents connector, which is
required for Datacap Studio.

. Copy the TravelDocs application from the developer workstation to the server.
. Complete the Datacap Web Client server configuration.

. Complete the configuration.

10.
11.
12.

Run the TravelDocs application to validate the server installation.
Configure Internet Explorer on the developer workstation.
Run Datacap Web Client TravelDocs to validate the web server installation.
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13. Install and configure the Datacap client software component on a user's workstation.
14. Install Report Viewer on the web server.

15. Configure Report Viewer on the web server.

16. View Report Viewer reports to validate the Report Viewer installation.

17. Install Rulerunner on the Rulerunner server.

18. Configure Rulerunner to run TravelDocs both single thread and multi-thread tasks.
19. Run TravelDocs tasks to validate the Rulerunner installation.

20. Configure Rulerunner to run your application tasks.

21. Install Maintenance Manager on the developer workstation.

22. Set upMaintenance Manager application or actions on the developer workstation.
23. Run Maintenance Manager actions to validate the installation.

24, Configure Datacap to use Windows Authentication.

25. Use Fingerprint Maintenance Tool.

26. Install, configure, and test the Fingerprint Service on the Fingerprint Service server.
27. Update an application to use the Fingerprint Service.

28. Configure and distribute the Datacap Web Client Upload Service.

29. Install, configure, and test Datacap Web Services.

30. Install, configure, and test FastDoc.

31. Install, configure, and run theDatacap Accounts Payable application.

Parent topic: Datacap installation and configuration in a client/server environment
Related concepts:
Installation and configuration prerequisites

Installation instructions for Datacap server

Installation instructions for the Datacap server include ensuring that an account with administrator privileges is
granted Full Control access to all of the machines on which the Datacap components are being installed.

Before you install Datacap server, ensure that you meet the prerequisites that are detailed in Installation and
Configuration Prerequisites.

e Ensure an account exists for the Datacap server service
When you perform the default Datacap installation and configuration, the Datacap server service uses
the Local System account to log onto the server.

e Installing Datacap server
Run the Datacap installation program wizard on a server to install the necessary Datacap software
components.

e Configuring Datacap on the server
To configure Datacap on the server, you must grant the appropriate permissions to the Datacap server
service and grant the appropriate permissions to folders and users.

e Configuring a Datacap application for Datacap Mobile
This topic provides information specific to configuring the parts of your Datacap application to work with
Datacap Mobile. Good knowledge of Datacap application configuration tasks and Datacap Studio or
FastDoc are expected. Also, Datacap Mobile SDK documentation is included in both the iOS and Android
SDK archive files that can be found in the Datacap installation tree under the \Datacap\MobileSDK}\
folder, and for the latest release, on IBM Fix Central.

e Exporting encryption keys
You must generate security keys that allow Datacap to encrypt and decrypt passwords. To replace
existing keys with new keys, you can specify a parameter to generate encryption keys to a local store.
You can specify a different parameter to export the encryption keys from the local keystore to a file that
can be imported to other computers.

Parent topic: Datacap installation and configuration in a client/server environment
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Related concepts:
Installation and configuration prerequisites

Ensure an account exists for the Datacap server service

When you perform the default Datacap installation and configuration, the Datacap server service uses the Local
System account to log onto the server.

In a client/server environment, create or ensure that a domain/Windows account exists for the Datacap server
service. Datacap does not require that a unique Windows account be set up for the Datacap server service. The
Datacap server service can use any Windows account provided that account can be set up with the appropriate
sharing and security permissions. If you have multiple Datacap servers, you can set up individual Windows
accounts or you can set up a single Windows account that is shared.

Parent topic: Installation instructions for Datacap server

Installing Datacap server

Run the Datacap installation program wizard on a server to install the necessary Datacap software
components.

About this task

The components that you install are the Datacap server component and the separately licensed connectors for
which you have a license. If you have multiple Datacap servers, repeat these instructions on each server.

Procedure

No oA~

[ee]

. Make the installation package available on your network, or insert the Datacap CD in the server’s

CD/DVD drive. If the installation process does not start automatically, or if the package is on the
network, open Windows Explorer, navigate to and double-click the Setup.exe. When User Account
Control (UAC) is on, the User Account Control window opens. Click Yes.

. Select the appropriate language. Then, click OK. The language that you select determines the language

that is displayed by the installation program wizard during the installation process.

. When additional, redistributable software is required, the installation program wizard displays a list of

the items to be installed. Click Install.

. Click Next.

. Accept the license agreement and click Next.

. Select the Custom option. Then, click Next.

. Exclude all components from the installation process except Datacap Server and the separately licensed

connectors for which you have a license.

. Click Next.
9.
10.

Click Install.
Click Finish.

Parent topic: Installation instructions for Datacap server

Configuring Datacap on the server

To configure Datacap on the server, you must grant the appropriate permissions to the Datacap server service
and grant the appropriate permissions to folders and users.
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Granting Datacap server service the Log On as a Service privilege

You must configure the Datacap Server properties to ensure the domain account that is used by the
Datacap server service is granted the Log On as a Service privilege.

Setting up sharing permissions on the Datacap folder

You must set up sharing permissions for the C:\Datacap folder by setting sharing permissions Datacap
Properties Sharing window

Setting up security on the Datacap folder

You must set up security for the shared C:\Datacap folder by setting security permissions in the Datacap
Properties Securities window.

Setting up security on the Datacap\RRS folder

You must set up the appropriate security permissions for the C:\Datacap\RRS folder on the server when
the operating system is Windows 2008.

Parent topic: Installation instructions for Datacap server

Granting Datacap server service the Log On as a Service
privilege

You must configure the Datacap Server properties to ensure the domain account that is used by the Datacap
server service is granted the Log On as a Service privilege.

About this task

If you have multiple Datacap servers, repeat this process for each server.

Procedure

To grant Datacap server service the Log On as a Service privilege:

1.

B~ W

From the Start menu on the server, click Control Panel > Administrative Tools > and double-click
Services.

. If you want the Datacap server to start automatically when the server is restarted, select Datacap Server

and change the Startup Type to Automatic and save your change.

. Right-click Datacap Server and select Properties.
. Click the Log On tab, then select This account.
. Locate or enter the domain name, user name, and password of the Windows account to be used by the

Datacap server service, and click Apply.

Parent topic: Configuring Datacap on the server

Setting up sharing permissions on the Datacap folder

You must set up sharing permissions for the C:\Datacap folder by setting sharing permissions Datacap
Properties Sharing window

Procedure

1.

2.

3.

On the server, start Windows Explorer, navigate to, and right-click the C:\Datacap folder and select
Properties.

Click the Sharing tab. Then, click Advanced Sharing. When User Account Control (UAC) is on, the User
Account Control window is displayed. Click Yes.

Click Share this Folder and keep Datacap as the Share name.
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4. Click Permissions. Ensure that the NETWORK SERVICE and local IUSR accounts are set to allow Full
Control.

. Ensure that the domain/Windows user IDs of developers are set to allow Full Control.

. Ensure that the domain/Windows user ID of Datacap server service is set to allow Full Control.

. Ensure that the domain/Windows user ID of Datacap Web Client is set to allow Read.

. When the batches folders for the application are staying on server in C:\Datacap\Application path,
ensure that the domain/Windows user IDs of Datacap users are set to allow Full Control.

00 N o ol

Parent topic: Configuring Datacap on the server

Setting up security on the Datacap folder

You must set up security for the shared C:\Datacap folder by setting security permissions in the Datacap
Properties Securities window.

Procedure

1. On the server, start Windows Explorer, navigate to, and right-click the C:\Datacap folder and select
Properties.

2. Click the Security tab. Then, click Edit. When User Account Control (UAC) is on, the User Account Control
window is displayed. Click Yes.

3. Ensure that the domain/Windows user IDs of developers who can change existing Datacap applications
are set to allow Read & Execute. This developer cannot create new applications.

4. Ensure that the domain/Windows user IDs of developers who can create new Datacap applications in
the C:\Datacap folder are set to allow Full Control.

5. Ensure that the domain/Windows user ID of Datacap server service is set to allow Read & Execute.

. Ensure that the domain/Windows user ID of Datacap Web Client is set to allow Read & Execute.

7. If the batches folders stay on the server in the C:\Datacap\Application path, ensure that the
domain/Windows user IDs of Datacap users are set to allow Read & Execute.

o

Parent topic: Configuring Datacap on the server

Setting up security on the Datacap\RRS folder

You must set up the appropriate security permissions for the C:\Datacap\RRS folder on the server when the
operating system is Windows 2008.

Procedure

1. On the server, start Windows Explorer, navigate to and right-click the C:\Datacap\RRS folder and select
Properties.

2. Click the Security tab to display it. Then, click Edit. When User Account Control (UAC) is on, the User
Account Control window is displayed. Click Yes.

3. Add or ensure that the NETWORK SERVICE and local IUSR accounts are set to allow Read & Execute.

Parent topic: Configuring Datacap on the server

Configuring a Datacap application for Datacap Mobile

This topic provides information specific to configuring the parts of your Datacap application to work with
Datacap Mobile. Good knowledge of Datacap application configuration tasks and Datacap Studio or FastDoc are
expected. Also, Datacap Mobile SDK documentation is included in both the iOS and Android SDK archive files
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that can be found in the Datacap installation tree under the \Datacap\MobileSDK\ folder, and for the latest
release, on IBM Fix Central.

e Configuring property display for mobile
This section provides information about how to configure property display for mobile.

e Configuring bar code based classification
Using Datacap Studio or FastDoc, you can associate a specific bar code type and value to a page type for
Datacap Mobile to automatically read the bar code and assign the matching page type at snap or import
time. When you open a claim with your auto-insurance company, they assign a unique claim number to
your claim and reference it in a bar code on their claim form every time they exchange correspondence
with you, such as when requesting additional supporting documents from you. This is to help them sort
out the returning mail and automatically route it to your claim agent. To support that case in your
Datacap application, you need to associate a regular expression matching the numbering pattern of the
claim to the claim form page type (for instance). Datacap Mobile then reads the barcode value, executes
the regular expression against it, and if it finds a match automatically assigns the claim form page type
to the image at snap time.

e Configuring template based zonal recognition
Template based zonal recognition is used to automate the extraction of machine-printed characters
from fixed forms. Using Datacap Studio or FastDoc you import an image of the type of form you want,
captured on your mobile device. Then you need to create zones and associate them to the data fields of
the page type associated to the image. This constitutes a "zonal template". For example, you can define
a zonal template for a "Claim form" page type to capture the claimant's first and last names, policy
number, claim number from a bar code, car model, make, and license plate number appearing on the
claim form. Datacap Mobile reads the zone definitions associated with the page type, at snap or import
time, or every time a new page type is selected in the Folder screen (Document Assembly screen), and
automatically performs character recognition associated to each zone.

e Configuring recognition of identification documents
Datacap Mobile can automatically read the information encoded in identification documents and extract
data.

e Configuring check recognition
Datacap Mobile extracts key data from checks, such as the date, courtesy and legal amounts, payee
name and the routing, account, and check numbers which are components of the Magnetic Ink
Character Recognition (MICR) line at the bottom of checks.

e Configuring the geolocation
Datacap Mobile transfers the current location of the device to the Datacap application and images.

Parent topic: Installation instructions for Datacap server

Basic principles

Datacap Mobile works off the Setup DCO

Datacap Mobile offers a lot of flexibility and configures itself as per the document model defined in the Datacap
(server) application that it connects to. Using Datacap Studio or FastDoc you can, as an administrator, configure
Datacap to address the specific use case and nature of the business documents to be processed.

For example, for an account opening application, you can define the document types and data that need to be
captured from the account application form, an identification card, a pay stubs, etc. required to open the
account.

This document and data model is called the application "Document Hierarchy" or "Setup DCQ", in Datacap.
When connecting the Datacap Mobile app to the Datacap application on the Datacap Server, you are now able
to use the document, page, and field types that have been defined in the app's pick lists.
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In addition to the Document Hierarchy, you can configure processing capabilities unique to your application.
For example, and more specifically for mobile, you can configure a bar code to automatically identify your
account application form and associate to the form a zonal recognition template to automatically capture all
the data you need from the form. You can do the same to automate the recognition of a US Driver License, for
example.

Auto-classification in Datacap Mobile

Datacap Mobile automatically assigns a type to a document based on recognizing a bar code value or on the
defaults defined on the Datacap Document Hierarchy.

e If barcode-based classification is not set up in the Datacap application, then Datacap Mobile by default
assigns the first document type and page type it finds in the Document Hierarchy sequence. If the user
manually specifies a document type in the Camera screen, then Datacap Mobile by default assigns the
first page type within that document type.

e If bar code based classification is set up, Datacap Mobile determines the page type first based on the
detected bar code value which, in turn, causes the parent document type to be assigned. For example, in
an account opening application, the critical pages for classification are the application form and the back
side of the driver license, because they each have a uniquely identifiable bar code. When capturing the
driver license's back side first, Datacap Mobile assigns the "DL Back" page type and automatically
switches the document type to "Driver License" in the Camera screen. It remains the default setting until
another type of page is detected and, possibly, the document is switched. The driver license’s front side
is not critical for classification; it will be assigned the current default page type, and hence, document

type.

Character recognition and working with mobile images

To configure the mobile input channel of your Datacap application, and work with image fingerprints in Datacap
Studio or FastDoc, you need to get images that originate from a mobile device, especially when configuring
zonal OCR. Using image fingerprints scanned from a scanner might work, but mostly won't.

This is because OCR engines operate best on images with a resolution in the 200-300 DPI range. They have
been designed so that within this range they can fairly accurately segment the images to determine lines of
text, character attributes, such as font types and sizes, or to discriminate between small size text and noise,
specks, etc. mostly based on measuring the size of what they are looking at. So, it is essential to be able to
relate these attributes to the physical dimensions of the documents, to normalize them to a fixed DPI value,
typically 300.

Unfortunately, contrary to a scanner that can precisely detect the physical dimensions of the document placed
on its platen and acquire an image at a specific DPI value, a mobile device’s camera can snap a document from
any distance and therefore is not able to assign an accurate resolution to the images it produces. For a given
camera pixel width and height, the farther and smaller the document appears in the camera screen, the lower
the resolution gets after deskewing and cropping.

To deal with this problem, Datacap Mobile, in automatic mode, only snaps images that occupy about 70% of
the screen surface area, ensuring that “enough pixels” of the document are acquired to match an assumed
resolution of 200-300 DPI, and the skewing of the document remains within acceptable limits. This ensures
that a perfect quadrangle can be reconstructed and well-proportioned against the original image.

Also, for some use cases it makes sense to complement recognition on the mobile side, say, extraction of a few
fields to present for repair to the user, with recognition of additional fields and validation/verification on the
server side. In this situation, it is important to normalize the images to 300 DPI to get to a common reference
for accurately positioning the zones on the server side and in the other Datacap clients that will be used for
verification, such as Datacap Desktop or Navigator. This is especially important for small-size documents, such
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as driver licenses, that can be shot in landscape mode to occupy the whole camera display. In this case the
apparent DPI is much higher than normal and confuses the OCR engines used in Datacap server.

For this purpose, it is advisable to insert the SetImageDPIByWidth action from the ImageConvert library to
resize proportionally the incoming images to 300 DPI based on the known physical dimensions of the
document. Assigning fixed physical dimensions is not an issue when dealing with forms as they typically have a
fixed and predictable layout.

Getting started quickly with the mobile template

The Mobile Template is a very simple Datacap application that allows you to get started with configuring a
Datacap application for Datacap mobile very quickly. It includes a basic one-document/one-page document
hierarchy that you can expand from, as well as jobs, task profiles, and rulesets that have been preset for that
purpose.

Jobs are the entry points in a Datacap application, and there can only be one specified per Application you
define in Datacap Mobile. These are the jobs defined in the Mobile Template:

e Mobile only is what you want to use when you do all the processing, that is, snap, deskew, classify, OCR,
assemble, repair, and upload, on the mobile side, and only need to verify and export to a repository on
the server side. Once the images are uploaded, together with extracted field/property data on the
Datacap server, it essentially rescales them with the SetImageDPIByWidth action and sends them to
Verify without any other processing. This is very fast. You can even remove the Verify task to have a
direct process to the repository.

Note: Even though the Identify Page compiled ruleset does not run on the server side (that is, not
included in this job), you still use it to set up automatic bar code recognition on the mobile side. Datacap
Mobile only needs to read from the Setup DCO the bar code processing variables written by the Identify
Pages to the batch level (selected bar code types) and to each mapped page type (the regular
expression to extract the bar code value)

e Mobile and server Color is what you would want to use for a combination of mobile and server-side
processing. For example, if you want to process content-intensive document, with no predictable layout,
you would likely need to recognize the full-page content of mobile images and process it server-side. In
addition to the processing described above, this job allows to run the full power of the Identify Pages
ruleset (blank page, fingerprints, keywords, content classification, etc.), server-side full-page OCR with
structural analysis, extraction of content by location, document assembly, and merging of server-side
and mobile-side extracted fields, and validation rules.

¢ Mobile and server Bitonal is similar to the above, but adds image enhancement and conversion to black
and white images, required in certain cases

e Import Color is used for testing, to import preexisting, deskewed color mobile images from your local
file system in Datacap. This is useful for testing server-side processing without having to recapture
images all the way from mobile every time. You just need a good set and re-import it to test as you refine
the server-side processing.

e Import Bitonal- same as above but for black and white images

You can download the Mobile Template from developerWorks and drop it in the [...]Datacap/Templates folder
of theDatacap folder structure. After adding a reference to it in the datacap.xml file, it automatically displays in
the list of templates that you can choose from when you use the Datacap Application Wizard to create your
application.

Configuring property display for mobile

This section provides information about how to configure property display for mobile.
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Hiding fields on mobile only

In your Datacap application, you can set the STATUS variable of any object of the document hierarchy to "-2" to
hide it from mobile users only. This can be useful when you build applications with recognition and indexing on
both the mobile and server sides and you do not want server-side fields that are used by internal users to be
displayed to mobile users.

Underscore character "_" converted to blank space

If you want to enhance the document, page, and field symbolic names of the Setup DCO without going to the
extent of using labels, Datacap converts underscores to blank spaces for you.

Assigning friendly names to fields/properties

Datacap Mobile supports displaying friendly names by using the label variable that is used in Datacap
applications. For example, in Check Processing, to grab the check account number from the "MICRDatal"
component of the MICR line, add a variable named label, using Datacap Studio, and assign the value of
"Account Number" for it to be displayed in Datacap Mobile.

Parent topic: Configuring a Datacap application for Datacap Mobile

Configuring bar code based classification

Using Datacap Studio or FastDoc, you can associate a specific bar code type and value to a page type for
Datacap Mobile to automatically read the bar code and assign the matching page type at snap or import time.
When you open a claim with your auto-insurance company, they assign a unique claim number to your claim
and reference it in a bar code on their claim form every time they exchange correspondence with you, such as
when requesting additional supporting documents from you. This is to help them sort out the returning mail
and automatically route it to your claim agent. To support that case in your Datacap application, you need to
associate a regular expression matching the numbering pattern of the claim to the claim form page type (for
instance). Datacap Mobile then reads the barcode value, executes the regular expression against it, and if it
finds a match automatically assigns the claim form page type to the image at snap time.

Procedure

To configure bar code classification, complete the following steps:

. Open Datacap Studio and then log in to your application.

. Allow Global Rules to load.

. Right-click Identify Pages and choose Install in application.

. Scroll down to Identify Pages. Right-click Identify Pages and choose Settings. The bar code
configuration displays.

. Expand Barcode Recogpnition.

. Select Types and the bar code type.

. Select Orientation and the type of orientation.

. Check the Regular Expressions check box.

. In Mappings, enter a regular expression in the Barcode Value field. For example, to identify all claims
with a number looking like "CL-4326543", with "CL-" always fixed, followed by a number, enter a pattern
of the form "CL-|d*", which matches a case sensitive string starting with "CL-" followed by any number of
digits. If you want to match a pattern of exactly 7 digits after "CL-", you can use "CL-\d{7}".

10. Select Page Type.

11. Click Save.
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Bar codes supported in Datacap Mobile
The following bar codes are supported in Datacap Mobile:

AZTEC, CODABAR, CODE128, CODE39, CODE93, DATAMATRIX, EAN-8 EAN-13, INTERLEAVED 2 OF 5
(ITF), PDF417, QR CODE, UPC-A, and UPC-E.

Parent topic: Configuring a Datacap application for Datacap Mobile

Configuring template based zonal recognition

Template based zonal recognition is used to automate the extraction of machine-printed characters from fixed
forms. Using Datacap Studio or FastDoc you import an image of the type of form you want, captured on your
mobile device. Then you need to create zones and associate them to the data fields of the page type associated
to the image. This constitutes a "zonal template". For example, you can define a zonal template for a "Claim

form"
carm
defini

page type to capture the claimant's first and last names, policy number, claim number from a bar code,
odel, make, and license plate number appearing on the claim form. Datacap Mobile reads the zone
tions associated with the page type, at snap or import time, or every time a new page type is selected in

the Folder screen (Document Assembly screen), and automatically performs character recognition associated
to each zone.

Procedur

e

Youn

eed an image sample captured and deskewed on your phone for each page type on which you want to

associate an OCR zonal template.

To configure predefined field templates, complete the following steps :
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. Open Datacap Studio and then log in to your application.

. Click the Zones tab to open the Fingerprints view.

. Add a mobile fingerprint (or select an existing one).

. Right-click a top level fingerprint class and choose Add fingerprint.

. Browse to your sample image and open it.

. Click the padlock icon to lock the document hierarchy.

. Expand the hierarchy to display fields.

. Select a field and draw a rectangular zone inside the Image View tab.

. Repeat the step above for each field on which you want to perform OCR.

. Save the document hierarchy.

. Click the padlock icon to unlock the document hierarchy.
Important: For a zonal template to function properly, it is essential to position the extraction zones on
the fingerprint accurately. Ensure that the incoming images are proportioned same as the fingerprint, so
that Datacap Mobile can grab the image snippets for OCR in the proper locations after deskewing. Note
that Datacap Mobile gets positional information from the Default_Position variable for each field in the
Setup DCO. This variable gets automatically updated with new position information by Datacap Studio or
FastDoc each time the zone position is adjusted in the fingerprint. Be aware that if you use a single
fingerprint (zonal template) for both mobile and standard scanning, changes applied last get written to
the Default_Position variable and might not be appropriate for mobile and vice-a-verse.

Helping the OCR engine recognize an arbitrary character sequence

In cases when the content of a field can be a random sequence of characters, it can be difficult for the
Datacap Mobile OCR engine to correctly recognize certain characters, such as "1" vs. "I" or "l", "0"
(alpha) vs. "0" (numeric), etc., which are not supposed to occur in the dictionaries that have been used
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to train the engine. To help the engine handle exceptions and correctly recognize arbitrary sequences of
characters, a regular expression that defines the expected pattern can be associated to a Datacap field.

To do so in Datacap Studio, simply add a variable named hr_Regex to the field and assign a regular
expression as a value. For example for a field that contains a Vehicle Identification Number or VIN,
enter:

/™ (?<wmi>[A-HJ-NPR-Z\d] {3}) (?<vds>[A-HJ-NPR-7\d] {5}) (?<check>[\dX]) (?<vis>(?
<year>[A-HJ-NPR-z\d]) (?<plant>[A-HJ-NPR-Z\d]) (?<seg>[A-HJ-NPR-z\d] {6}))S$/

For example, this regular expression will match VINs of the form:

o 3FADP4AJ3CM159727 (specific to Ford)
o JHMGE8H39CC039314 (specific to Honda)

Parent topic: Configuring a Datacap application for Datacap Mobile

Configuring recognition of identification documents

Datacap Mobile can automatically read the information encoded in identification documents and extract data.

Parent topic: Configuring a Datacap application for Datacap Mobile

Passports

Datacap Mobile can automatically recognize biometric passports by reading the information encoded in the
lines of the Machine Readable Zone (MRZ) at the bottom of the photo page of passports. It can extract key
data, such as names, passport number, nationality, and expiration date directly from the MRZ. Using Datacap
Studio, you just need to define document, page and fields with predefined variables, and when the page type is
selected by the user or assigned by default, the recognition engine reads the MRZ lines, populates the fields
and checks confidence.

Procedure

To configure passport recognition in Datacap Studio, follow these steps:

1. Add a document type with any symbolic and display names.
2. Add a page type with any symbolic and display names for the ID.
3. Define the following variables for the page above:
o id_type=MRZ2
o o id_subtype = passport
o o id_nation = USA
o oid_page_type = code_page
4. Add the field types of interest with any symbolic and display names for the ID.
5. For each field type of interest, define the following variable (plus optionally a label, as needed): ID_Key =
<DL_field>; Where <DL_field> equals any of the following:
ID Number
ID First_ Name
ID Surname
ID Birthdate
ID Expiration
ID Sex
ID_Expedition_Country Code

O 0O 0O 0O o 0O ©°

US Driver Licenses
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Datacap Mobile can automatically recognize AAMVA-compliant US Driver Licenses by reading the information
encoded in the PDF417 bar code printed in the back of the license. It can extract data such as the driver's first
name, last name, license number, date of birth, and address, etc. A number of US States still do not comply, or
do not fully comply, with the AAMVA standard. Similarly older valid driver licenses compliant with an earlier
version of the standard (prior to the 2013 revision), can't be recognized. However, newly issued driver licenses
are more and more compliant with the standard or to an extent that is required by Datacap Mobile. The
Territories and States that do not comply at all with the standard are: American Samoa, Minnesota, Missouri,
and Washington.

Procedure

Using Datacap Studio, you just need to define document, page and fields with predefined variables, and when
the page type is selected by the user or assigned by default or through bar code based classification, the
recognition engine reads the 2D bar code (of type PDF417), populate the fields, and checks confidence. Follow
these steps to configure passport recognition in Datacap Studio:

1. Add a document type with any symbolic or display name.
2. Add a page type with any symbolic name (ex: Driver_License_Back) or display name (ex: Back) for the
back (bar code) side of the US Driver License.
3. Define the following variables for the page above:
o (d_type = Drivinglicense
o id_nation = USA
o id_page_type = code_page
4. Add the field types of interest with any symbolic and display names for the ID. For each field type of
interest, define the following variable (plus optionally a label, as needed): ID_Key = <DL_field>; Where
<DL_field> equals any of the following;:
ID Number
ID First_Name
ID Surname
ID Birthdate
ID_Expiration
ID Sex
aamva_field_<data_element>

O O 0O O 0 O o

Where <data_element> can be any additional mandatory or optional data elements that are specified in
the AAMVA DL/ID Card Design Standard. Mandatory data elements are:

Data element Description

DCA Jurisdiction-specific vehicle class
DCB Jurisdiction-specific restriction codes
DCD Jurisdiction-specific endorsement codes
DBA Document Expiration Date

DCS Customer Family Name

DAC Customer First Name

DAD Customer Middle Name(s)

DBD Document Issue Date

DBB Date of Birth

DBC Physical Description — Sex
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DAY Physical Description — Eye Color
DAU Physical Description — Height
DAG Address — Street 1

DAI Address — City

DAJ Address — Jurisdiction Code (Sate)
DAK Address — Postal Code

DAQ Customer ID Number

DCF Document Discriminator

DCG Country Identification

DDE Family name truncation

DDF First name truncation

DDG Middle name truncation

Here is an example:

Field symbolic name

ID key variable

ID_Number

ID_Key=ID_Number

ID_First_Name

ID_Key=ID_First_Name

ID_Surname

ID_Key=ID_Surname

ID_Birthdate

ID_Key=ID_Birthdate

ID_Expiration

ID_Key=ID_Expiration

ID_Sex

ID_Key=ID_Sex

ID_Eye

ID_Key= aamva_field_DAY

ID_Street_Address

ID_Key= aamva_field_DAG

ID_City_Address

ID_Key= aamva_field_DAI

ID_State_Address

ID_Key=aamva_field_DAJ

ID_Zip_Address

ID_Key=aamva_field_DAK

French National ID Card recognition (iOS only)

Datacap Mobile can automatically recognize French National ID Cards (Carte Nationale d’identité), by reading
the MRZ lines at the bottom of the photo side. It can extract key data, such as first name, last name, ID card
number, and birth date, directly from the MRZ. Using Datacap Studio, you need to define document, page and
fields with predefined variables. When the page type is selected by the user or assigned by default, the
recognition engine reads the MRZ lines, populates the fields and checks confidence.

Procedure

Follow these steps to configure passport recognition in Datacap Studio:

1. Add a document type with any symbolic and display names.
2. Add a page type with any symbolic and display names for the ID.
3. Define the following variables for the page above:

o id_type = Personalld
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o id_subtype =id_card
o id_nation = FRA
o (d_page_type = code_page
4. Add the field types of interest with any symbolic and display names for the ID.
5. For each field type of interest, define the following variable (plus optionally a label, as needed): ID_Key =
<DL_field>; Where <DL_field> equals any of the following:
ID Number
ID First_Name
ID Surname
ID Birthdate
ID Expiration

O O O O ©O

Configuring check recognition

Datacap Mobile extracts key data from checks, such as the date, courtesy and legal amounts, payee name and
the routing, account, and check numbers which are components of the Magnetic Ink Character Recognition
(MICR) line at the bottom of checks.

Parent topic: Configuring a Datacap application for Datacap Mobile

Understanding the check processing

The capability to process checks on Datacap Mobile requires a connection to the Datacap server because the
recognition process is executed on the server side, via an optional, add-on component called IBM Datacap
Advanced Handwriting Recognition. Hence, make sure that it is installed on the Datacap server.

After Datacap Mobile has captured the image of a check, it makes a "transactional" call to the Datacap server
to pass the image and receive the extracted data back for validation by the user. Checks are typically small in
size and this round trip only takes a few seconds. To make the interface between DatacapMobile and any type
of server-side processing easy and flexible, Datacap has a special helper application named 'Transaction’,
which installs directly on the Datacap server and acts as a front end to the Check Processing functions.

Transaction application

Its role is to:

1. receive the check image and some check-specific variables, such as the width and DPI and check
country, passed on untouched by Datacap Mobile from the Datacap application it is connected to
(remember, the one you log on to in Applications)

2. perform some check-specific image pre-processing functions, such as resizing and setting a DPI value

. invoke the check recognition action and get the results

4. send back the extracted data (only; the image is discarded) once the check has been recognized to
Datacap Mobile.

5. This application does not require any special configuration.

w

Configuring your application

Follow these steps in Datacap Studio for configuring the Datacap application for check processing.:

1. Add a page type with any symbolic name, for example, Check

2. Add a variable to that page type named ProcessChecks with value set to True. This instructs Datacap
Mobile to process the document as a check, that is, to send the image to the Datacap server for
processing and get the results back for display and repair.
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3. Add a variable to that page type named hr_CheckCountry with value set to the country's 3-letter ISO
code (ex: USA).

4. Add a variable to that page type named hr_CheckWidth with value set to the size in inches of the check
(default is 8.5).

5. Add a variable to that page type named hr_CheckDPI with value set to the resolution expected for the
check processing engine (default is 300); typical is 200 to 300. You might need to adjust this value to get
the best results, especially to recognize the MICR line.

6. Add field types with the symbolic names that are supported for the selected country. For example, for

US checks:
o CheckNumber. Add a friendly name Check number
o Date
o Amount
o Payeeline. Add a friendly name Payee
o MICRRoutineNumber. Add a friendly name Routine number
o MICRAccountNumber. Add a friendly name Account number

Adding the ProcessCheck variable also tells Datacap Mobile to expose the Check processing icon in the
Properties screen so that the user can rerun recognition of the check, if needed. Check processing is
invoked automatically at snap time if it is set as default.

Note that similar to ID recognition, there is no need to define zones for the server to grab the data.
Analysis of the check image and extraction of the data are based on country-specific templates that are
built in the Check Processing engine. This is why we need to pass the check country, size and DPI, so
that the engine can select the template appropriate for the country and find the zones in the expected
locations.

However you do need to assign the symbolic field names as specified by the engine. Datacap Mobile only
displays the fields that are set up in the Document Hierarchy. For a US check, available fields are:
CheckDate, CheckNumber, CheckSignature, Amount, Date, CAR, LAR, PayeelLine, MICR, PayorBlock, and
PayorLine. Also, you can access the breakdown of the check Date into Month, Date, and Year, and the
breakdown of the MICR line into its components MICRRoutineNumber, MICRAccountNumber,
MICRCheckNumber, or MICRData0, MICRDatal, and MICRData2, typically for getting at the routing,
account, and check numbers.

Configuring the Payee Line field

Cursive and hand-print writing can be recognized in the Payee Line. However, you need to supply a dictionary of
possible combinations of predefined vocabulary and aliases, each assigned a parameter that reflects the
probability of occurrence in the image snippet of the Payee line. For example, you can define a list of the
possible combinations around your company name (the name of the company the checks should be made
payable to). Other payees are unlikely if you are not processing checks for the benefit of others. The recognition
engine selects the vocabulary entries that are most probable. The path to the dictionary needs to be defined.
By Default, in the Transaction application, which is the one invoking check recognition for Datacap Mobile, it is
located under:\Datacap\Transaction\dco_Transaction\Vocabularies\payee.txt.

Here is an example:

”THE PAYMENT CENTER", 5
"PETER SMITH", 5

"HARBOR STREET FINANCIAL", 5
"HARBORSTREET FINANCIAL", 5

Where the number represents the probability weight from 1 to 10.

Configuring the geolocation
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Datacap Mobile transfers the current location of the device to the Datacap application and images.

Procedure

To configure the geolocation, complete the following steps.

1. Make sure Location Services are turned on and authorized for the app on the device.

2. Use Datacap Studio or FastDoc to add a field with the symbolic name Location to any document or page
that you want Datacap Mobile to store geolocation information to. It also stores the GPS latitude and
longitude coordinates at the page level in Latitude and Longitude variables respectively, and in the JPEG
image as EXIF geolocation tags to be used outside of the ECM repository.

Parent topic: Configuring a Datacap application for Datacap Mobile

Exporting encryption keys

You must generate security keys that allow Datacap to encrypt and decrypt passwords. To replace existing keys
with new keys, you can specify a parameter to generate encryption keys to a local store. You can specify a
different parameter to export the encryption keys from the local keystore to a file that can be imported to other
computers.

About this task

You must generate and use the security encryption keys that allow Datacap to encrypt and decrypt the
passwords that are used by users, services, and processes to access the Datacap server service and to log in to
databases.

In a single machine configuration, you must generate and export the encryption keys that all of the Datacap
components on the single machine use.

In a client/server configuration, you must generate and export matching security encryption keys from the
server on which the Datacap server software component is installed to all of the computers on which any
Datacap component is installed. This requirement secures any passwords that are passed over or received
from the network by the Datacap component.

Procedure

To generate encryption keys and export them:

1. Open a command prompt and navigate to the C:\Datacap\Taskmaster folder. In a client/server
configuration, perform this step on the computer on which the Datacap server software component is
installed.

2. Run the key management program, dcskey.exe, inserting one or more of the following parameters in the
command. For example, to export keys during a new Datacap installation, you would enter dcskey.exe

e.

e
Exports the encryption keys from the local keystore to a dc_KTF.xml key transport file. You can
use this file to import the keys to other computers. If no keys exist in the keystore, the e
parameter generates new ones before the export. If keys exist in the keystore, the e parameter
exports those keys.

gnk

Generates, but does not export, encryption keys in the local keystore. Use this parameter any
time you must replace existing keys with new keys. For example, you would run the command
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dcskey.exe gnk e toreplace existing keys and export them. The newly exported keys would
then must be imported onto all other Datacap computers in your configuration.

Parent topic: Installation instructions for Datacap server

Client/server environment: Datacap Web Client installation
and configuration

You can run tasks from a computer on which the Internet Explorer browser is installed when you set up the
Datacap Web Client. In a single machine configuration that is used for testing and demonstration purposes,
Datacap Web Client runs using the LocalSystem account.

The steps that you must follow to install and configure Datacap Web Client include ensuring that the required
IIS components are installed and creating the Datacap Web Client site. You use the Datacap Web Client Server
Configuration tool to set up the Datacap Web Client site for a single machine configuration. A single machine
configuration requires the tmweb.net application pool to be set for the LocalSystem account.

e Client/server environment: Installing and configuring Datacap Web Client on an IIS server
You can install and configure Datacap Web Client on a Windows I1S server to use the browser-based
Datacap Web Client for processing.

Parent topic: Datacap installation and configuration in a client/server environment

Client/server environment: Installing and configuring Datacap
Web Client on an IIS server

You can install and configure Datacap Web Client on a Windows IIS server to use the browser-based Datacap
Web Client for processing.

e Client/server environment: Verifying that IIS components are installed
Ensure that the IIS Web Server Role Services are installed for the Datacap Web Client server
components, such as Datacap Web Client, Report Viewer, Fingerprint Service, and Datacap Web
Services.

e Client/server environment: Ensuring an account exists for Datacap Web Client
Ensure that a domain/Windows account exists for Datacap Web Client. Datacap does not require a
unique Windows account to be set up for Datacap Web Client.

e Client/server environment: Installing Datacap Web Client
You can install Datacap Web Client on the server using the Datacap installation program wizard.

e Client/server environment: Importing encryption keys to Datacap computers
In a client/server configuration, you must import security encryption keys to the computer where you
are installing and configuring each Datacap component. This requirement secures passwords that are
sent across the network between Datacap servers and clients.

e Client/server environment: Creating the Datacap Web Client site
You can create the Datacap Web Client site to run tasks from a computer on which the Internet Explorer
browser is installed. The steps that you follow to install and configure the Datacap Web Client site
include ensuring that the required IIS components are installed and configuring the tmweb.net
application pool.

e Client/server environment: Setting the Datacap Web Client Application Pool Identity
You must set the Datacap Web Client Application Pool Identity in the Internet Information Services (IIS)
Manager window.

e Client/server environment: Changing the SSL setting in the server.ini file (optional)
When you use Secure Socket Layer to encrypt communications between Datacap Web Client and its
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clients, you can change the value of the SSL setting in the server.ini file.

Parent topic: Client/server environment: Datacap Web Client installation and configuration

Client/server environment: Verifying that IIS components are
installed

Ensure that the IIS Web Server Role Services are installed for the Datacap Web Client server components, such
as Datacap Web Client, Report Viewer, Fingerprint Service, and Datacap Web Services.

About this task

The Datacap Web Client server components must have specific IIS Web Server Role Services installed.

Procedure

Ensure that the IIS components are installed.

1.
2.
3.

O 00 N O

10.

From the Start menu on the web server, select Administrative Tools > Server Manager.

In the Server Manager hierarchy pane, expand Roles and select Web Server (IIS).

In the Web Server (IIS) pane, expand Role Services. Under Common HTTP Features ensure that Static
Content, Default Document, Directory Browsing, and HTTP Errors are installed. If you are installing wTM,
do not install the WebDAV Publishing role service because it prevents the Datacap web services PUT
method from functioning.

. In the Role Services pane under Application Development, ensure that the ASP.NET, .NET Extensibility,

ASP, ISAPI Extensions, and ISAPI Filters are installed.

. In the Role Services pane, under Health and Diagnostics ensure that HTTP Logging and Request Monitor

are installed.

. In the Role Services pane, under Security ensure that Request Filtering is installed.

. In the Role Services pane, under Performance ensure that Static Content Compression is installed.

. In the Role Services pane, under Management Tools ensure that IIS Management Console is installed.
. (Windows Server 2012 R2) In Server Manager, click Dashboard, and click Add roles and features.

a. In the Add Roles and Features Wizard, go to the Features section.
b. In .NET Framework 4.5 Features > WCF Services, select the HTTP Activation check box.
Close the Server Manager window.

Parent topic: Client/server environment: Installing and configuring Datacap Web Client on an IIS server

Client/server environment: Ensuring an account exists for
Datacap Web Client

Ensure that a domain/Windows account exists for Datacap Web Client. Datacap does not require a unique
Windows account to be set up for Datacap Web Client.

About this task

Datacap Web Client can use any Windows account that is set up with the appropriate sharing and security
permissions. When Datacap Web Client and Report Viewer are installed on the same web server, they must use
the same domain/Windows account. Be sure that you set up the appropriate sharing and security permissions
for the domain/Windows account used by Datacap Web Client. These permissions were included as part of the
installation instructions for the Datacap server.
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Parent topic: Client/server environment: Installing and configuring Datacap Web Client on an IIS server

Client/server environment: Installing Datacap Web Client

You can install Datacap Web Client on the server using the Datacap installation program wizard.

Before you begin

Before installing Datacap Web Client, stop or ensure the Datacap Server Service is stopped.

About this task

This procedure provides instructions on how to run the Datacap installation program wizard on a server to
install the Datacap software components. The components that you install are the Datacap Web Server
component and the separately licensed Datacap connectors for which you have a license.

Procedure

1. Make the installation package available on your network or insert the Datacap CD in the Server’s CD/DVD
drive. If the installation process does not start automatically, or if the package is on the network, open
Windows Explorer, navigate to and double-click the Setup.exe. When User Account Control (UAC) is on,
the User Account Control window opens. Click Yes.

2. Select the appropriate language and click OK. The language that you select determines the language
that is displayed by the installation program wizard during the installation process.

3. When additional, redistributable software is required, the installation program wizard displays a list of
the items to be installed. Click Install.

4. Click Next.
5. Accept the license agreement and click Next.
6. Select the Custom option and click Next.
7. Exclude all components from the installation process except Datacap Web Server and the separately
licensed connectors for which you have a license.
8. Click Next.
9. Click Install.
10. Click Finish.

Parent topic: Client/server environment: Installing and configuring Datacap Web Client on an IIS server

Client/server environment: Importing encryption keys to
Datacap computers

In a client/server configuration, you must import security encryption keys to the computer where you are
installing and configuring each Datacap component. This requirement secures passwords that are sent across
the network between Datacap servers and clients.

Before you begin

You must generate the encryption keys in the keystore on a server on which the Datacap server software
component is installed. You export the new keys to a key transport file.

Procedure
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To import encryption keys to Datacap computers:

1. Find the dc_KTF.xml key transport file in the c:\Datacap\Taskmaster folder on the Datacap server where
you generated and exported the encryption keys.

2. Copy the dc_KTF.xml key transport file to the appropriate folder on the computer where you installed
the new component. The encryption keys are automatically applied to the keystore the next time you
start the Datacap component.

Table 1. Encryption key folder locations by

component
Component Folder
Datacap Server C:\Datacap\Taskmaster

Datacap applications | C:\Datacap\Taskmaster

Datacap Desktop C:\Datacap\DcDesktop
Datacap Studio C:\Datacap\DStudio
Datacap FastDoc C:\Datacap\FastDoc

Datacap Report Viewer | C:\Datacap\RV2\bin

Datacap Web Client C:\Datacap\tmweb.net\bin

Datacap Web Services | C:\Datacap\wTM\bin

Parent topic: Client/server environment: Installing and configuring Datacap Web Client on an IIS server

Client/server environment: Creating the Datacap Web Client
site

You can create the Datacap Web Client site to run tasks from a computer on which the Internet Explorer
browser is installed. The steps that you follow to install and configure the Datacap Web Client site include
ensuring that the required IIS components are installed and configuring the tmweb.net application pool.

Before you begin

Before creating the Datacap Web Client site, stop or ensure the Datacap Server Service is stopped.

About this task

You must create the Datacap Web Client site by using the Datacap Web Client Server Configuration tool.

Procedure

1. From the Windows Start menu, select IBM Datacap Web > Datacap Web > Server Configuration Tools.
When User Account Control (UAC) is on, the User Account Control window opens. Click Yes.
2. Determine whether the contents of the information box indicate one of the following conditions:

o If one or more of the items that are listed in the information box are Not Found, click OK, then
follow the instructions in Microsoft Internet Information Services and Microsoft .NET Framework
to determine whether IIS and .NET were installed in the correct sequence and that all of the IIS
components are installed.

o If all of the items that are listed in the information box are Found, click OK and continue with
these instructions.
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3. Ensure that the default value for each of the settings is appropriate for your web site, processing needs,
and corporate requirements.

o When yourDatacap Web Client site is not nested under the Default Web Site, select the
appropriate Site and change the Site Settings.

o Depending on the usual size of the images or groups of images that are uploaded from the
Datacap Web Client, you must adjust the value of the ASP.NET Maximum File Upload Size and ASP
Maximum Requesting Entity Body Limit fields.

o Depending on your typical processing loads and schedules, change the default value of the App
Pool Recycling Schedule to a time during which there are few or no batches in process Datacap
Web Client. For more information on recycling and Datacap Web Client, see Effects of IIS
application pool recycling onDatacap Web Client batches.

o Depending on your company's security policies, change the value of the Connection time-out
field.

. Click Configure.

. Click OK, then click Exit. The Datacap Web Client site is created.

. From the Windows Start menu, select Control Panel > Administrative Tools, then double-click Internet
Information Services (IIS) Manager.

7. In the Connections pane, expand the computer node, expand the Sites node, and expand the Default
Web Site or your web site. The tmweb.net site is displayed. If it is not displayed, right-click the site and
select Refresh.

. In the Application Pools pane, select the tmweb.net application pool, then in the Actions pane, in the
Edit Application Pool section, click Advanced Settings.

9. In the Process Model section, set Load User Profile to True.

10. Click OK.

11. In the Connections pane, expand the Sites node, and expand the Default Web Site or your web site.

12. Select the tmweb.net site, and in the middle pane, double-click Session State.

13. Under Cookie Settings, change the Name to tmweb or another unique name, then, in the Actions pane,

click Apply.

14. In the Connections pane, select the Default Web Site or your web site, then, in the Actions pane, under

Manage Web Site, click Restart.

o o1 b~
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Parent topic: Client/server environment: Installing and configuring Datacap Web Client on an IIS server

Client/server environment: Setting the Datacap Web Client
Application Pool Identity

You must set the Datacap Web Client Application Pool Identity in the Internet Information Services (IIS)
Manager window.

About this task

This procedure provides instructions on how to set the Application Pool Identity in IIS that Datacap Web Client
uses to access Datacap.

Procedure

To set the Datacap Web Client Application Pool Identity:

1. From the Windows Start menu, select Control Panel > Administrative Tools > Internet Information
Services Manager.
2. In the Connections pane, expand the server node and select Application Pools.
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7.
8.
9.

. In the Application Pools pane, select tmweb.net AppPool, then in the Actions pane, in the Edit

Application Pool section, click Advanced Settings.

. In the Process Model section, click the Browse button next to the Identity field.
. In the Application Pool Identity window, select Custom account and click Set.
. In the Set Credentials window, enter the Datacap Web Client domain/Windows account information in

the format, accountname@domainname. Enter the password twice, then click OK.
In the Process Model section, set Load User Profile field to True.

Click OK.

Confirm that WebServer, Application Pool, and Default Web Site are started.

Parent topic: Client/server environment: Installing and configuring Datacap Web Client on an IIS server

Client/server environment: Changing the SSL setting in the
server.ini file (optional)

When you use Secure Socket Layer to encrypt communications between Datacap Web Client and its clients,
you can change the value of the SSL setting in the server.ini file.

Procedure

1.

2.

On the Datacap Web Client server, start Windows Explorer, navigate to, and use a text editor, such as
Notepad, to open the C:\Datacap\tmweb.net\server.ini file.
Change the UseSS1=0 setting to UsesSsS1=1, save the change, and close the server.ini file.

Parent topic: Client/server environment: Installing and configuring Datacap Web Client on an IIS server

Installing and configuring Datacap Navigator

Datacap Navigator is a web client for Datacap based on IBM® Content Navigator. You set up the Datacap
Navigator client by loading a plug-in and configuring repositories and desktops in IBM Content Navigator.

To set up Datacap Navigator, you first install the client as a plug-in to IBM Content Navigator. Then, you
configure repositories that correspond to Datacap applications. Finally, you can customize the default desktops
that are generated for Datacap Navigator.

Datacap Navigator installation steps

Datacap Navigator is installed as a plug-in to IBM Content Navigator.

Upgrading IBM Daeja ViewONE Virtual

IBM Daeja® ViewONE Virtual is included with IBM Content Navigator. If you plan to use IBM Daegja
ViewONE Virtual to view documents in Datacap Navigator, you must use IBM Daeja ViewONE Virtual
Version 4.1.5 with iFix001 or later.

Adding applications to Datacap Navigator

Configure repositories to specify additional Datacap applications that will be available to users in the
Datacap Navigator client.

Configuring variables in the batch structure

By default, Datacap Navigator displays read-only TYPE and STATUS variables for batches in the batch
structure (also known as the DCO Tree View). You can configure Datacap Navigator to display variables
as drop-down lists that allow users to select values. Alternatively, you can display variables as text
boxes that allow users to input values for each variable. You can also add and remove variables from the
batch structure.

Creating a choice list for a field in the field detail panel

In Datacap Navigator, you can add a page field in the field detail panel as a select box or a choice list.
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e Adding Datacap Navigator tasks to your application
To work with an application in Datacap Navigator, the application must include Datacap Navigator tasks.

e Customizing Datacap Navigator desktops
You can customize Datacap desktops by modifying the default desktop settings.

e Configuring Internet Explorer for TWAIN scanning in Datacap Navigator
You can enable Web TWAIN scanning and document import in Google Chrome and Mozilla Firefox
browsers by installing Web TWAIN. Datacap Navigator users are prompted to download and install a
service component the first time they attempt to scan. By default, Microsoft Internet Explorer uses
ActiveX for TWAIN scanning and document import. ActiveX is configured manually or by running the
Web Client Configuration Tool. Web TWAIN scanning is more secure than using ActiveX.

e Running validation rules
You can run validation rules on Start Batch Panel fields.

e Extracting data to drop-down list
You can verify panes that can populate drop-down lists from line item details and in table cells.

e Role-based redaction
You can use the role-based redaction feature to hide specific sensitive information in a document or
image.

e Role-based batch filtering
The Role-based batch filtering feature provides a security mechanism by restricting the access to the
batches that depend on the authorization level of the user for a particular application, for example,
TravelDocs. In Datacap Navigator, the users can only view and work on the batches based on the user’s
groups. This feature also enables Datacap Navigator users to assign group access control to batches by
using standard actions. Role-based filtering is designed to work with any authentication method.

e Creating custom panels in Datacap Navigator
A panel is a data entry screen. Panels are dynamically generated by the system and require no additional
setup. You can create your own layouts by creating custom panels for verify tasks, start batch panels,
and batch editor panels. You can arrange the fields and change the appearance and behavior of the
panels as required.

e Adding a Start Panel widget on a Classify task page by using the Classify.js program
You can use the Datacap administration settings to add the Start Panel widget on a Classify task page by
using the Classify.js program. By default, the Classify task page displays the Start Panel widget between
the Image Viewer and Batch Structure widgets. You can change the location of the widgets on the page.

e Adding a Start Panel widget on a Multiple task page by using the Multiple program
You can use the Datacap administration settings to add the Start Panel widget on a Multiple task page by
using the Multiple program. By default, the Multiple task page displays the Start Panel widget between
the Image Viewer and Batch Structure widgets. You can change the location of the widgets on the page.

e Changing the layout of the widgets by changing your user settings
You can change the location of the widgets to be displayed on the Classify or Multiple task page.

Parent topic: Datacap installation and configuration in a client/server environment

Datacap Navigator installation steps

Datacap Navigator is installed as a plug-in to IBM® Content Navigator.

Before you begin

Ensure that the following prerequisites for using Datacap Navigator are met:

e Datacap Web Services (WTM) are installed and configured. For instructions, see Datacap Web Services
installation steps.
e IBM Content Navigator Version 2.0.3 or later is installed and running.
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If you plan to use IBM Daeja® ViewONE Virtual to view documents in Datacap Navigator, ensure that IBM
Daeja ViewONE Virtual version 4.1.5 with iFix001 is installed. For more information, see Upgrading IBM
Daeja ViewONE Virtual.

Datacap applications are configured.

You have administrator privileges on your scan workstation. The first time that you scan, you are
prompted to download and run an installation program for Web TWAIN Scan. Workstation Administrator
privileges are required to run the installation program. Alternatively, you can install Web TWAIN
manually by using an MSI file: Datacap_installation\tmweb.java\DynamicWebTWAINHTML5Edition.msi.
You can also deploy Web TWAIN to client computers by using a Windows Group Policy; for instructions,
see https://support.microsoft.com/en-us/kb/816102.

Procedure

To install Datacap Navigator:

1.

10.

Access the IBM Content Navigator administration tool. In a browser, enter a URL with the following
format:

http://host _name:port number/context root/?desktop=admin

By default, the context root is navigator.

. Select Plug-ins and click the New Plug-in button.
. In the JAR file path field, enter the location of the Datacap Navigator plug-in file: DatacapWebPlugin.jar.

You can enter the URL or the fully qualified path of the plug-in file. By default, the plug-in file is installed
in the Datacap_install/tmweb.java/ directory. If the plug-in file can be accessed directly, enter the fully
qualified path of the plug-in file. For example:

On Windows: C:\datacap\tmweb.java\DatacapWebPlugin.jar

On AIX: opt/DatacapWebPlugin.jar

If the plug-in file is published on a web server, you can enter the URL of the plug-in file.

Attention: Ensure that the plug-in file is not in your JDBC directory or in a directory that is included in the
class path of your web application server. Otherwise, the plug-in will fail to load and the following error

will be generated:
java.lang.NoClassDefFoundError: com.ibm.ecm.extension.Plugin

. Click Load. The Datacap Client plug-in configuration page loads.
. Optional: In the Application field, enter the name of the application to use with default Datacap

desktops. Later, you can add more applications. For instructions, see Adding applications to Datacap
Navigator.

. Optional: In the Datacap wTM URI field, enter the Datacap Web Services URI that will be used to

connect to your Datacap server. For example: http://9.126.73.125:808/ServicewTM.svc.

. Optional: Click Generate Default Desktop to create default Datacap desktops. To modify the default

desktops or create more desktops, see Customizing Datacap Navigator desktops.

. Click Save and Close.
. If Datacap Web Services are installed on IBM WebSphere® Application Server, restart WebSphere

Application Server.
Validate that you can access Datacap Navigator. For more information, see Datacap Navigator access.

Parent topic: Installing and configuring Datacap Navigator
Related information:

[*BM Content Navigator documentation

Upgrading IBM Daeja ViewONE Virtual

IBM® Daeja® ViewONE Virtual is included with IBM Content Navigator. If you plan to use IBM Daeja ViewONE
Virtual to view documents in Datacap Navigator, you must use IBM Daeja ViewONE Virtual Version 4.1.5 with
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iFix001 or later.

About this task

If you are using IBM Content Navigator Version 2.0.3 with Fix Pack 6, install iFix001 or later for IBM Daeja
ViewONE Virtual Version 4.1.5. To acquire a Daeja iFix:

e Download the Daeja Viewer iFix from Fix Central if you have the Daeja stand-alone license.
e Contact IBM Support to request the Daeja Viewer iFix if you have the Daeja embedded license.

For more information about Daeja licenses, see Daeja fix integration with ECM client products.

If you are using IBM Content Navigator Version 2.0.3 with Fix Pack 4 or Fix Pack 5, you must first manually
upgrade IBM Daeja ViewONE Virtual to Version 4.1.5 and then install iFix002 or later. To manually upgrade IBM
Daeja ViewONE Virtual, see Upgrading the Daeja ViewONE version on IBM Content Navigator V2.0.3. If you do
not have a standalone license to IBM Daeja ViewONE Virtual, you must upgrade IBM Content Navigator to Fix
Pack 6, and then contact IBM Support.

Procedure

To download and install iFix001:

1. Log in to Fix Central.

2. In the Product Selector list, enter Enterprise Content Management.

3. In the Product list, select Daeja ViewONE Virtual.

4, In the Installed Version list, select 4.1.5.

5. Select your platform and click Continue.

6. Browse to iFix001, download, and install. See the iFix001 Readme for installation instructions.

Parent topic: Installing and configuring Datacap Navigator

Adding applications to Datacap Navigator

Configure repositories to specify additional Datacap applications that will be available to users in the Datacap
Navigator client.

Procedure

To configure repositories for Datacap Navigator:

1. Access the IBM® Content Navigator administration tool. In a browser, enter a URL with the following
format:

http://host _name:port number/context root/?desktop=admin

By default, the context root is navigator.

2. Click Repositories in the left pane.

3. On the Repositories page, click New Repository and select Datacap Application. You might need to
refresh your browser to view the Datacap Application option.

4. Specify the following fields:

Field name Instructions
Display name Enter the name of the Datacap application that will be displayed in Datacap
Navigator.
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Field name Instructions

ID The ID is generated automatically when you enter the display name.
Datacap wTM URI Enter the web service entry point to the Datacap Web Services API.
Application Select a Datacap application. It might take a few seconds for the list to be

populated with application names. If the list is not populated, verify that
the URI is correct and Datacap Web Services (WTM) are configured
correctly. Then try again.

Use ActiveX in IE Click Yes to use ActiveX for TWAIN scanning and document import in
Internet Explorer. ActiveX is configured manually or by running the Web
Client Configuration Tool.

Click No to use Web TWAIN scanning in Internet Explorer. Web TWAIN
scanning is more secure than ActiveX. Internet Explorer version 9 supports
ActiveX only.

Use Virtual Viewer Click Yes to use Daeja ViewONE Virtual to view documents in the
repository. Daeja ViewONE Virtual is a server-based viewer that does not
require Java on the client.

Click No to use Daeja ViewONE Professional to view documents in the
repository. Java must be installed on the client to use Daeja ViewONE
Professional.

5. Click Connect and log in to the application.
. Click the Configuration Parameters tab.

7. Specify whether to enable single sign-on. When you enable this option, you must specify LLLDAP
authentication in Datacap Server Manager. For more information, see Configuring single sign-on (SSO)
for Datacap Navigator and LLLDAP group authentication.

8. Select the columns that you want to display by default in Datacap Navigator on the Job Monitor and Task
List pages.

9. Click Save and Close.

10. Optional: Repeat this procedure to make additional applications available in Datacap Navigator.

o

Parent topic: Installing and configuring Datacap Navigator

Configuring variables in the batch structure

By default, Datacap Navigator displays read-only TYPE and STATUS variables for batches in the batch structure
(also known as the DCO Tree View). You can configure Datacap Navigator to display variables as drop-down
lists that allow users to select values. Alternatively, you can display variables as text boxes that allow users to
input values for each variable. You can also add and remove variables from the batch structure.

Procedure

To configure the display of variables in the batch structure:

1. Open the Datacap Navigator Administration View. In a browser, enter a URL with the following format:
http://host _name:port number/context root/?desktop=dcadmin

By default, the context root is navigator.
2. Navigate to the Display variables area of the advanced task settings.
a. In the left pane, click Workflows.
b. In the right pane, select a workflow and click Edit.
c. Select a job and click Edit.
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d. Select a task and click Edit.
e. On the Task > Advanced tab, scroll down to the Display variables area.
3. Enter key-value pairs in the Props for var fields to configure how variables are displayed in the batch
structure. The first field contains the variable name (such as TYPE). Enter values in the second field as
follows:

Value in Props for Var

field (second box) Description
0 Displays read-only variable values.
1 Displays editable variable values. A drop-down list is displayed for the

TYPE and STATUS columns in the batch structure. When you enter 1 for
other variables, a text box editor is displayed in the batch structure column
for the variable.

1, setup Displays a drop-down list of values that are configured in the Setup DCO
dictionary. Use Datacap Studio to define the dictionary. The name of the
dictionary is based on the level:

Batch level

The dictionary name is B:colname
Document level

The dictionary name is D:colname
Page level

The dictionary name is P:colname

1 s comma-separa ted Specify values to display in the drop-down list. For example, enter
list of values 1,a,b,ctodisplay a drop-down list that contains the values a, b, and c.

Tip: To add a variable, click the plus sign (+). To remove a variable, click the minus sign (-).

Parent topic: Installing and configuring Datacap Navigator

Creating a choice list for a field in the field detail panel

In Datacap Navigator, you can add a page field in the field detail panel as a select box or a choice list.

Procedure

To add the page field in the field detail panel as a choice list, complete the following steps:

1. Open the application in Datacap Studio

2. Select a page field and add DICT or SELECT variable in this field.

3. Login to Datacap Navigator again.
Note: Do not add "Text" or "Sticky" variable to this field. If this field has the variable "RecogType" with a
value "4", then the field is displayed as a radio button or check box.

Parent topic: Installing and configuring Datacap Navigator

Adding Datacap Navigator tasks to your application

To work with an application in Datacap Navigator, the application must include Datacap Navigator tasks.

Before you begin
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Ensure that the Datacap Navigator plug-in is deployed and a repository is created for the application.

About this task

When you create an application by using the Application wizard in Datacap Version 9.0 Feature Pack 2 or later,
the application has Datacap Navigator tasks by default. If you want to work with an existing Datacap Version
9.0 application which does not have Datacap Navigator tasks, you must manually add these tasks. If you want
to work with an application from a previous version, you must migrate the applications first; see the following
topics for instructions:

e Migrating Datacap applications from 8.0.1 t0 9.0
e Migrating Datacap applications from 8.1 to 9.0

Procedure

To manually add Datacap Navigator tasks to your application:

1. Open the Datacap Navigator Administration View. In a browser, enter a URL with the following format:

http://host _name:port number/context root/?desktop=dcadmin

By default, the context root is navigator.
2. In the left pane, click Workflows.
3. In the right pane, select a workflow and click Edit. Then, create a job and tasks for Datacap Navigator.
a. On the Task > General tab, specify Program options for Datacap Navigator tasks as follows:

Datacap Navigator task | Program option on the General tab
Scan Scan.js

Upload Upload.js

Verify Multiple

Fixup Multiple

b. On the Task > Advanced tab, scroll down to the Datacap Navigator area and specify Web Program
options for Verify and Fixup tasks as follows:

Web Program option on the Advanced
Datacap Navigator task |tab

Verify Verify.js

Fixup Classify.js

Tip: You can configure Datacap Navigator tasks based on the task settings in the Datacap

Accounts Payable (APT) sample application that is included with Version 9.0 Feature Pack 1 and

later. View the task settings that are defined for the default Web Demo job in the APT workflow.
4. In the left pane, click Shortcuts. Create shortcuts for Datacap Navigator tasks.

Parent topic: Installing and configuring Datacap Navigator

Customizing Datacap Navigator desktops

You can customize Datacap desktops by modifying the default desktop settings.

Procedure

To customize Datacap Navigator desktops:
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1. Access the IBM® Content Navigator administration tool. In a browser, enter a URL with the following
format:

http://host _name:port number/context root/?desktop=admin

By default, the context root is navigator.

2. Click Desktops in the left pane.

. Select a Datacap desktop to customize and click Edit.

4. On the General page in the Authentication area you can specify the repository (Datacap application) that
is opened by default when you start Datacap Navigator. You can also limit access to specific users or
groups.

5. Click the Repositories tab. You can specify the Datacap applications to expose in the desktop.

6. Click the Layout tab.

o Inthe Desktop Features area, you can add or remove access to IBM Content Navigator features.
For example, select Browse to enable browsing in the repository from the Datacap Navigator
interface. When you select the Browse feature, a Browse icon is added to the Datacap Navigator
window in the left pane.

o Inthe Additional Desktop Components area, you can choose whether to show or hide document
thumbnails, the global toolbar, and the status bar.

7. Click the Menus tab. In the Context Menus > Feature Context Menus area, ensure that Datacap User
Session Context Menu is specified for the Banner user session context menu option. Specifying this
option displays the Change User Settings option on the user ID drop-down menu in the Datacap
Navigator banner.

w

Parent topic: Installing and configuring Datacap Navigator

Configuring Internet Explorer for TWAIN scanning in Datacap
Navigator

You can enable Web TWAIN scanning and document import in Google Chrome and Mozilla Firefox browsers by
installing Web TWAIN. Datacap Navigator users are prompted to download and install a service component the
first time they attempt to scan. By default, Microsoft Internet Explorer uses ActiveX for TWAIN scanning and
document import. ActiveX is configured manually or by running the Web Client Configuration Tool. Web TWAIN
scanning is more secure than using ActiveX.

About this task

Internet Explorer version 9 supports ActiveX only. You can configure Internet Explorer versions 10 and 11 to
use Web TWAIN scanning instead of ActiveX as follows:

Procedure

1. Access the IBM® Content Navigator administration tool. In a browser, enter a URL with the following
format:

http://host _name:port number/context root/?desktop=admin

By default, the context root is navigator.
2. Click Repositories in the left pane.
3. On the Repositories page, select a Datacap application and click Edit.
4. On the General tab, select No for the Use ActiveX in IE setting.

Parent topic: Installing and configuring Datacap Navigator
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Related information:
[* IBM Content Navigator configuration database

Running validation rules

You can run validation rules on Start Batch Panel fields.

Parent topic: Installing and configuring Datacap Navigator

Datacap Navigator Application configuration

Configure Datacap Navigator to run validation rules.

Procedure

To run validation rules on Start Batch Panel, the name of the validation task profile must be entered in the
Datacap Navigator Application task settings:

1.

w

Start Datacap Navigator, select the Administrator view, click Workflow, and select the Remote Scan Task
for which you want to specify the task profile.

. In the Selected task details pane, click the Advanced tab.
. Scroll to the Rulerunner settings section.
. In the Main task profile field, enter a name for the validation task profile, such as validateStartPanel

as it was defined in Datacap Studio Application Task Profile.

. Click Save.

Important: When you scan an image, if the "required" field in the Start Batch Panel is blank or empty,
and the batch is submitted, a window opens that prompts the user to enter a value into the "required"
field.

Datacap Studio configuration

Configure Datacap Studio to run validation rules.

Procedure

A WODN P

. Start Datacap Studio.

. Create a task profile. For example, "ValidateStartPanel" that is associated to ruleset.

. Create a validation rule for each Start Batch Panel field that you want to validate.

. Bind each rule to the associated field in the DCO. For example, the following rule validates if the field is a

"required field": Validate Start Batch Panel ruleset:
O Status Preserve OFF ()
O SetIsOverrideable("false")
O IsFieldFilled("FieldName")

Batch-level metadata can be entered from a Start Batch panel and the display is based on the specific
task settings. The Start Batch panel is dynamically created with data entry fields automatically displayed
for all fields that are defined at the batch level within the application setup DCO.

Extracting data to drop-down list

You can verify panes that can populate drop-down lists from line item details and in table cells.
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Support populating a drop-down list with a list of extracted values

If you run rule set and generate the extracted data in page data file, for example, tm000001.xml, you can add a
variable "CHOICELIST" to define extracted values on a field.

The following three ways are supported to associate a field with the data in another field (consider this field as
the field saving extracted data):

The extracted data should be in JISON format:

1. <V n="CHOICELIST">{"mode": "r", "choices": [{"displayName": "International Business Machines
Corporation", "value": "IBM"}, {"displayName": "Microsoft Corporation", "value": "MS"}]}</V>

2. <V n="CHOICELIST">{"mode": "r", "choices": ["IBM", "MS"]}</V>

3. <V n="CHOICELIST">{"mode": "a", "choices": "EntityList, Entity"}</V>

mode: "r" -> replace the original choice list with the extracted data.
mode: "a" -> append the extracted data to the original choice list.
if no "mode", default is "a"

If "choices" is a string, the string format should be: "<field name>, <column name>" that means the string is
the field to extract data, the field should be a table.

For example:

<F
id=" dcs_markdown workspace Transform htmlout 0 com.ibm.dc.install.doc dcnviO1l3 Text
_Field">

<V n="TYPE">Text_Field</V>

<V n="Position">582,101,926,176</V>

<V n="CHOICELIST">{"mode": "r",6 "choices": ["IBM 1", "Microsoft 2", "Oracle 3",
"EMC_4"]}</V>

<V n="STATUS">0</V>

Support drop-down list box within a Datacap Navigator table cell

This supports the following JSON format:

1. <V n="<TYPE of column>_CHOICELIST"V n="CHOICELIST">{"mode": "r", "choices": [{"displayName":
"International Business Machines Corporation", "value": "IBM"}, {"displayName": "Microsoft Corporation",
"value": "MS"}}</V>

2. <V n="<TYPE of column>_CHOICELIST"V n="CHOICELIST">{"mode": "r", "choices": ["IBM", "MS"]}</V>

3. <V n="<TYPE of column>_CHOICELIST">{"mode": "r","choices": "Details,Price"}</V><V n="CHOICELIST">
{"mode": "a", "choices": "EntityList,Entity"}</V>

For example:

<F

id="_ dcs markdown workspace Transform htmlout 0 com.ibm.dc.install.doc dcnvi01l3 Taxe
s">

<V n="TYPE">Taxes</V>

<V n="Position">0,0,0,0</V>

<V n="STATUS">0</V>

<V n="PreVerify Vval"/>

<V n="PreVerify Pos">0,0,0,0</V>

<V n="label">Taxes</V>

<V n="Tax Value CHOICELIST">{"mode": "r","choices": "Details,Price"}</V>
<F
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id=" dcs_markdown workspace Transform htmlout 0 com.ibm.dc.install.doc dcnviO1l3 TaxL
ineiteml">

<V n="TYPE">TaxLineitem</V>

<V n="STATUS">0</V>

<V n="Position">0,0,0,0</V>

<V n="PreVerify val"/>

<V n="PreVerify Pos">0,0,0,0</V>

<V n="label">Tax Lineitem</V>

<F
id=" dcs_markdown workspace Transform htmlout 0 com.ibm.dc.install.doc dcnvi0l3 Tax
Type">

<V n="TYPE">Tax Type</V>

<V n="STATUS">0</V>

<V n="Position">0,0,0,0</V>

<V n="PreVerify Val">Sales</V>
<V n="PreVerify Pos">0,0,0,0</V>
<V n="label">Tax Type</V>

<C ¢cn="10" cr="0,0,0,0">51</C>

</F>

<F

id=" dcs_markdown workspace Transform htmlout 0 com.ibm.dc.install.doc dcnvi0Ol3 Tax
Value">

<V n="TYPE">Tax Value</V>

<V n="STATUS">0</V>

<V n="Position">2249,2126,2379,2164</V>

<V n="Locale Checked">Yes</V>

<V n="PreVerify Val">107.63</V>

<V n="PreVerify Pos">2249,2126,2379,2164</V>
<V n="label">Tax Value</V>

<C ¢cn="10" cr="2253,2130,2265,2160">53</C>
<C ¢cn="10" cr="2274,2130,2293,2160">48</C>
<C ¢cn="10" cr="2297,2130,2317,2160">48</C>
<C ¢cn="10" cr="2322,2156,2326,2160">46</C>
<C ¢cn="10" cr="2331,2130,2351,2160">48</C>
<C ¢cn="10" cr="2355,2130,2375,2160">48</C>
</F>

</F>

<F

id="_dcs_markdown workspace Transform htmlout 0 com.ibm.dc.install.doc _dcnviO1l3 TaxL
ineitem2">

Parent topic: Installing and configuring Datacap Navigator

Role-based redaction

You can use the role-based redaction feature to hide specific sensitive information in a document or image.

The redaction feature finds sensitive information in a document or image, and creates rectangular redaction
annotations to cover the sensitive information. When the documents are subsequently viewed, the sensitive
information is hidden from unauthorized users. You can edit the redactions in Datacap Navigator, and can
export them to FileNet P8. The redactions are displayed as rectangles, which can be opaque or semi-
transparent, and visible and editable in the Datacap Navigator client, but not in Desktop, FastDoc, or TMWeb.
Redactions can be exported to FileNet P8, and subsequently viewed in IBM® Content Navigator.

e Enabling Role-based redaction
Role-based redaction feature introduces a rectangular annotation that hides sensitive information on a
document image. When a user views a document image, the redacted information is either hidden, or
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made visible, depending on the permission granted to the user. To use the Role-based redaction feature,
you must configure and enable the feature.

e Role-based redaction settings
You can use the Role-based redaction settings, where you can assign policy editors, redaction editors,
specify redaction reasons, and so on. Redaction Reasons and Policies must be pre-defined in IBM
Content Navigator, and imported into the Datacap application by using the Datacap Navigator
administrator feature.

e (Creating and editing role-based redaction
You can create and edit role-based redactions in Datacap Navigator, and export the redactions to
FileNet P8 Any user in Datacap Navigator has permission to create and edit redactions that are imported
or defined for that Datacap application.

Parent topic: Installing and configuring Datacap Navigator

Enabling Role-based redaction

Role-based redaction feature introduces a rectangular annotation that hides sensitive information on a
document image. When a user views a document image, the redacted information is either hidden, or made
visible, depending on the permission granted to the user. To use the Role-based redaction feature, you must
configure and enable the feature.

Before you begin

Ensure that the following prerequisites are installed to configure and use the Role-based redaction feature:

e IBM® Daeja® ViewONE Virtual 5.0, or later
For more information about configuring IBM Daeja ViewONE Virtual, see Configuring the IBM Daeja
ViewONE Virtual viewer.
Note: You must acquire a separate license for IBM Daeja ViewONE viewer redaction services. For more
information, see Adding entitlements to an integrated version of IBM Daeja ViewONE, V4.1 or later.

You can verify that whether virtual viewer li cense file is applied or not at this location: ...
\ECMClient\configure\explodedformat\navigator\WEB-INF\lic-server-virtual.vl

e IBM Content Navigator version 3.0, or later

Configure the IBM Content Navigator desktop to use a viewer mapping that assigns the IBM Daeja
ViewONE Virtual viewer as the viewer for PDF and TIFF files for IBM FileNet P8 repositories.

e AFileNet P8 repository with Role-based redaction reasons and policies defined using IBM Content
Navigator
e Datacap Navigator

Datacap Navigator is the only Datacap UI capable of displaying Role-based redactions, and creating or
editing them.

Procedure

To enable and use role-based redaction, complete the following steps:

1. Log in to IBM Content Navigator.
2. In the navigation tree, click Viewer Map, and then click New Viewer Map to create a new viewer map
with the name of your choice. For example, Virtual Viewer.
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3. After adding the required details, click New Mapping, and specify the Repository type as "FileNet
Content Manager" and Viewer as "Daeja ViewONE Virtual".

4., Specify the file type as "application/pdf", "image/tiff", and "image/x-tiff", and click OK.
Important: Single-page TIFF or JPG images can be exported with redactions. Exporting multi-page TIFF
or PDF is not supported for redactions.You must split multi-page image files after ingestion. You might
re-merge the files before exporting. When the FNP8 Upload action is used, redactions are saved in a
FileNet P8 repository. Redactions are not currently preserved by the FNP8 UploadDir action.

5. Go to IBM Content Navigator repository configuration, and click Configuration parameter.

6. Click Enable for Role-based redaction.
Note: The supporting P8 add-on (IBM Content Navigator 3.0.0 Redaction Extensions) is installed when
Role-based redactions option is enabled. The add-on cannot be removed after it is installed; however,
you can disable the role-based redaction feature.

For more information about Role-based redaction settings, see Role-based redaction settings

Parent topic: Role-based redaction

Role-based redaction settings

You can use the Role-based redaction settings, where you can assign policy editors, redaction editors, specify
redaction reasons, and so on. Redaction Reasons and Policies must be pre-defined in IBM® Content Navigator,
and imported into the Datacap application by using the Datacap Navigator administrator feature.

Role-based redaction repository settings

Assign policy editors

e A policy editor is allowed to create, edit, and delete policies and roles.

e The creator of a policy or role is not granted any direct permissions to the policy or role. The
creator has edit access only if they are a policy editor.

e Policies and roles are edited in the IBM Content Navigator administration interface so policy
editors must also be IBM Content Navigator administrators.

Assign redaction editors

e Aredaction editor is granted permission in the repository to create instances of the Role-based
redaction annotation class.

e When the redaction editor user has permission to create annotations for the document, the final
permission to create a Role-based redaction for a particular reason is controlled by redaction
policies.

e The creator of a Role-based redaction is not granted any direct permissions to the redaction. Edit
access is granted only by redaction policies.

Note: Redacted PDF files are delivered as PDF (default) or TIFF files.

Role-based Redaction Settings

Reasons

Redaction reason identifies the type of sensitive data that is redacted, and manages redaction reason
definitions. A redaction reason:

e Has a Name, Description, and unique ID (GUID).
e Isassigned to each role-based redaction annotation.
e Is connected to role permissions by a policy.
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e Redaction reason definitions are stored in the IBM Content Navigator configuration database and
might be used in any FileNet P8 repository that is enabled for Role-based redaction.

e Datacap imports the redaction reason definitions from IBM Content Navigator.

e IBM Content Navigator maintains a record of whether a reason is used in Datacap orin a FileNet
P8 repository. A reason that is in use cannot be deleted.

¢ Redaction reason definitions can be exported and imported by IBM Content Navigator.

Policies and Roles

e The Policies and Roles define user and group access for role-based redaction reasons, and are
saved in the FileNet P8 repository.

e The Policies and Roles are managed by the Policy editors who are selected in the repository
configuration.

Parent topic: Role-based redaction

Creating and editing role-based redaction

You can create and edit role-based redactions in Datacap Navigator, and export the redactions to FileNet P8
Any user in Datacap Navigator has permission to create and edit redactions that are imported or defined for
that Datacap application.

Procedure

1. Log in to Datacap Navigator desktop of a Datacap application that implements role-based redactions.

2. Scan or import a pre-scanned image from a directory, and then click Submit.
The batch might be uploaded to the server automatically; otherwise, you can use the Upload shortcut to
upload. The Job Monitor shows a table that contains the batch that you created.
Note: The Task column in the table shows the value as "Batch Profiler", and the Status column shows
the value as "pending".

3. To refresh the status, click the Refresh icon. If Rulerunner Server is configured and active, the status
changes to "running".

If Rulerunner is not running, you can run the Profiler task using Datacap Desktop thick client. The
Profiler rules typically locate the sensitive information by using the DocumentAnalytics actions, and
redact the information using the RedactFields action.

4. Click the Refresh icon. The Task column in the table shows the value as "Verify".

5. Ensure that the desired batch is selected, and then click Start.
The image is displayed overlayed with redactions over the sensitive data that are created by the
automated process. The DocumentAnalytics actions detect the sensitive information in the image, and
redact the information with rectangles. The rectangles represent redaction annotations.
Note: You can edit the redactions in Datacap Navigator, and select the information that you want to
redact in the image.

6. Go to one of the redactions, right-click the redaction annotation, select the redaction reason, and the
click Apply.

You can change the size or position of a redaction. You can also delete or create a new redaction by
selecting the rectangle annotation tool in the left toolbar and dragging the mouse on the image.

7. When you are satisfied with the redaction positions and reasons, click Submit to submit the document to
the next stage of the process, which is to export the document with redactions to FileNet P8.
8. Open the document in the IBM® Content Navigator viewer.
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If you have permissions according to the role-based redaction policies in FileNet P8, then you can create
privileged users to see the sensitive information and you can also make modifications, such as changing
the size of the redaction. If you have no permissions, then the redacted information is always covered.
Note: If a redaction is used in Datacap batches, the redaction persists after you export the redactions to
FileNet P8.
If any redactions are created in a Datacap document (manually in verify, or automatically using
RedactFields), and the doc is exported as one or more single-page TIF or JPG files, the redactions are
uploaded too. In FileNet P8, redactions are considered a type of "annotation". In addition, if any pages in
the document were processed (meaning, the OCR results were searched for sensitive content) using the
RedactFields action, an audit record is created in FileNet P8, which is also considered a type of
annotation. In addition, in FileNet P8 the document's Sensitive Content property is set to "1" if any
redactions were created, and "0" if RedactFields was run but no sensitive data was found to redact. The
P8 export / upload will fail if any of the following is true:
o the export repository does not have role based redactions enabled
o any of the redaction reasons (that were imported originally into the Datacap application from IBM
Content Navigator) don't exist in the export FileNet P8 repository
o any of the redaction reasons don't have an associated redaction policy in the export FileNet P8
repository

Parent topic: Role-based redaction

Role-based batch filtering

The Role-based batch filtering feature provides a security mechanism by restricting the access to the batches
that depend on the authorization level of the user for a particular application, for example, TravelDocs. In
Datacap Navigator, the users can only view and work on the batches based on the user’s groups. This feature
also enables Datacap Navigator users to assign group access control to batches by using standard actions.
Role-based filtering is designed to work with any authentication method.

There are the following modes that belong to the role based batch filtering feature:

Exclusive - The batch must belong to one of the user’s groups.

Additive - The batch can belong to multiple groups but must belong to at least one of the user’s groups.
Inclusive - The batch can belong to multiple groups and user must belong to all those groups. User
might belong to more groups.

none - You can use this mode to disable the role based batch filtering feature.

Here are a few examples:

A user can only view and work on the documents that are created on the user’s current workstation. This
is accomplished by assigning the station IDs when the user logs in to Datacap Navigator.

When a user logs in, the user’s access is limited to the batches that are currently owned by the LDAP
group of that location.

Users at Location A can scan a batch and make it quickly available for the first-pass verification at the
same location.

Users at Location A can see a list of batches in the Job Monitor that are tagged with the LDAP group for
that Location A.

Users at a particular location are authorized to view the batches that originate from that location. In
addition, they can only run the tasks that are available in the Shortcut pane.

Weight for the groups
You can assign weight to a particular group when you use the role-based batch filtering feature. A group
with the highest weight, which is represented by 0 to 10, has priority over the other groups.
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e Assigning weight to the groups
You can assign weight to a particular group when you use the role-based batch filtering feature.

Parent topic: Installing and configuring Datacap Navigator

Weight for the groups

You can assign weight to a particular group when you use the role-based batch filtering feature. A group with
the highest weight, which is represented by 0 to 10, has priority over the other groups.

The following scenario explains the feature:

e There are the following two groups:

o Group A: Weight assigned is 1

o Group B: Weight assigned is 6
Group A has the following two users:

o Userl

o User2
Group B has the following users:

o User?2

o User3
User 2 (Belongs to Group A) logs in to Datacap Navigator, and creates a batch.
The batch that User 2 created belongs to the Group B as the Group B has higher weight than the Group
A.

For more information about assigning weight to the groups, see Assigning weight to the groups.
Parent topic: Role-based batch filtering

Assigning weight to the groups

You can assign weight to a particular group when you use the role-based batch filtering feature.

Procedure

To assign weight to a group, complete the following steps:

1. Log in to Datacap Navigator.

2. In the left pane, click Groups.

3. On the Groups page, select a group, and the click the Edit tab.
4. In the Weight list, select a number.

5. Click Save and Close.

Parent topic: Role-based batch filtering

Creating custom panels in Datacap Navigator

A panel is a data entry screen. Panels are dynamically generated by the system and require no additional setup.
You can create your own layouts by creating custom panels for verify tasks, start batch panels, and batch editor
panels. You can arrange the fields and change the appearance and behavior of the panels as required.

About this task
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The following procedure describes how to create a custom panel for the verify task. The procedure for creating
custom start batch and batch editor panel is similar.

Procedure

To create a custom verify panel:

1. Open the Datacap Navigator Administration View. In a browser, enter a URL with the following format:

http://host _name:port number/context root/?desktop=dcadmin

By default, the context root is navigator.

2. Click Panels in the left pane.

. Click New Panel and select Verification Panel.

4. Specify the associated workflow, page type, and a name for the panel. A default panel layout is
generated and displayed in the center pane. The default panel layout contains all fields that are defined
for the selected page type.

5. Arrange fields in the panel. You can change the order by dragging fields in the center pane, remove any
unwanted fields, and drag removed fields back into the center pane.

6. Click Save and Close.

7. Enable the new verify panel in the workflow.

Tip: For start batch panels, set the DCO Type in the Scan task advanced properties to TravelDocs. For
batch editor panels, there is no need to configure task settings; the system fetches the last batch editor
panel that was created for the application.

a. Click Workflows in the left pane.

b. Select your workflow and click Edit.

c. Select Navigator Job and click Edit.

d. Click Tasks.

e. Select Verify and click Edit.

f. Click Advanced.

g. In the Custom web panels area, select Use custom web panels.

h. Enter the page type and panel name that you specified when you created the panel.

i. Click Save and Close to save your changes to the verify task.

8. Log out and close your browser. Your new panel is displayed the next time that you run the verify task.

w

e Adding custom code to Datacap Navigator panels
You can add functionality or UI elements to Datacap Navigator panels. For example, you can add a logo
image to a specific panel by modifying the HTML code in the panel data file.

Parent topic: Installing and configuring Datacap Navigator

Adding custom code to Datacap Navigator panels

You can add functionality or UI elements to Datacap Navigator panels. For example, you can add a logo image
to a specific panel by modifying the HTML code in the panel data file.

Procedure

To add custom code to a panel:

1. On the computer where Datacap is installed, use Windows Explorer to navigate to the panels folder. The
panels folder is in the Datacap applications installation folder, for example:
C:\Datacap\APT\navigatorpanel\panels.

2. Open the panel (JSON file) that you want to modify in a text editor.
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3. Modify the panel code. The JSON file is a standard Dojo widget template. For example, to add an
element to the panel such as a logo image, add the URL of the logo image to the panel code: <img
src=\"http:\/\/images\/logo.png\" />

4. Save and close the JSON file.

Parent topic: Creating custom panels in Datacap Navigator

Adding a Start Panel widget on a Classify task page by using
the Classify.js program

You can use the Datacap administration settings to add the Start Panel widget on a Classify task page by using
the Classify.js program. By default, the Classify task page displays the Start Panel widget between the Image
Viewer and Batch Structure widgets. You can change the location of the widgets on the page.

Procedure
1. Log in to Datacap Navigator, and select an application. For example, TravelDocs.
2. Open the Datacap administration view.
3. Click the Workflows tab, and select a workflow.
4. On the Workflow page, click the Jobs tab, and select a Fixup job.
5. On the Job page, click the Tasks tab, and select a task. For example, FixUp.
6. On the Task page, under the General tab, the Program list displays a new value as Classify.js, select

Classify.js.

. Click the Advanced tab.

8. Select the Show the Start Batch Panel check box. When you select this check box, then after opening
any Classify task, the task page shows the Start Panel.

9. In the Custom web panels area, select Use custom web panels check box, and enter the page type and
panel name that you specified when you created the panel. For more information about creating custom
panels, see Creating custom panels in Datacap Navigator.

10. Click Save and Close.

11. Click the Layout tab. In the layout, by default, you can see the Start Panel widget between Image Viewer
and Batch Structure widgets for the classify.js program. You can change the location by dragging and
dropping the widget.

12. Open a Classify task, the Classify task page shows the Start Panel. For more information about changing
the layout of the widgets by changing your user settings, see Changing the layout of the widgets by
changing your user settings

~

Parent topic: Installing and configuring Datacap Navigator

Adding a Start Panel widget on a Multiple task page by using
the Multiple program

You can use the Datacap administration settings to add the Start Panel widget on a Multiple task page by using
the Multiple program. By default, the Multiple task page displays the Start Panel widget between the Image
Viewer and Batch Structure widgets. You can change the location of the widgets on the page.

Procedure

1. Log in to Datacap Navigator, and select an application. For example, TravelDocs.
2. Open the Datacap administration view.
3. Click the Workflows tab, and select a workflow.
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4, On the Workflow page, click the Jobs tab, and select a Fixup job.

5. On the Job page, click the Tasks tab, and select a task. For example, FixUp.

6. On the Task page, under the General tab, the Program list displays a new value as Multiple, select
Multiple.

7. Click the Advanced tab.

8. Select the Show the Start Batch Panel check box. When you select this check box, then after opening
any Multiple task, the task page shows the Start Panel.

9. In the Custom web panels area, select Use custom web panels check box, and enter the page type and
panel name that you specified when you created the panel. For more information about creating custom
panels, see Creating custom panels in Datacap Navigator.

10. Click Save and Close.

11. Click the Layout tab. In the layout, by default, you can see the Start Panel widget between Image Viewer
and Batch Structure widgets for the Multiple program. You can change the location by dragging and
dropping the widget.

12. Open a Multiple task, the Multiple task page shows the Start Panel. For more information about changing
the layout of the widgets by changing your user settings, see Changing the layout of the widgets by
changing your user settings

Parent topic: Installing and configuring Datacap Navigator

Changing the layout of the widgets by changing your user
settings

You can change the location of the widgets to be displayed on the Classify or Multiple task page.

Procedure

1. To change the user settings from any Datacap Navigator view, click the user ID menu, and then click
Change User Settings.

2. On the Settings page, click the Classify tab, and then click the Layout tab.

3. Select the Customize the layout check box.

4. Change the layout by dragging and dropping the widget. The Classify page shows the widget location per
your settings on the Layout page.

Parent topic: Installing and configuring Datacap Navigator

Installing the developer workstation software components

Run the Datacap installation program wizard on the workstation of a developer to install the Datacap software
components.

About this task

The software components that you install include the Datacap client and sample applications. Also, the
separately licensed applications, and connectors for which you have a license, the Datacap Studio, FastDoc,
and Maintenance Manager software components.

These instructions apply to workstations that run on Windows 7.

Procedure

To install the developer workstation components:
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1. Put the installation package on your network, or insert the Datacap CD in the developer workstation
CD/DVD drive. If the installation process does not start automatically, or if the package is on the
network, open Windows Explorer, go to and double-click the Setup.exe. Click Yes at the User Account
Control window.

2. Select the appropriate language and click OK. The language that you select is displayed on the
installation program screens during the installation.

3. When more, redistributive software is required, the installation program wizard displays a list of the
items that must be installed, click Install.

4, Click Next.

5. Click to accept the license agreement and click Next.

6. Select the Custom option and click Next.

7. Exclude all of the components except the Datacap Client and the separately licensed applications and
connectors for which you have a license. Be sure the FastDoc, Datacap Studio, and Maintenance
Manager components are included.

8. Click Next.

9. Click Install.

10. Click Finish.

e (Creating or ensuring accounts exist for developers
Datacap does not require that a unique Windows account is set up for each developer. A developer can
use any Windows account that is configured with the appropriate sharing and security permissions.

e Importing encryption keys to Datacap computers
In a client/server configuration, you must import security encryption keys to the computer where you
are installing and configuring each Datacap component. This requirement secures passwords that are
sent across the network between Datacap servers and clients.

e Setting up the scanner
When a computer is to be used as a scan station, follow the manufacturer’s instructions to attach the
scanner to the computer. Install and configure the required scanner drivers and software. Be sure you
can scan successfully with an image capture software product other tha Datacap. If you are unable to
scan documents with software that is not Datacap, you cannot scan documents with Datacap.

e Configure Internet Explorer on the developer workstation
You must configure Internet Explorer on the developer workstation to enable access to Datacap Web
Client, the system administration panel, and the user panel.

Parent topic: Datacap installation and configuration in a client/server environment

Creating or ensuring accounts exist for developers

Datacap does not require that a unique Windows account is set up for each developer. A developer can use any
Windows account that is configured with the appropriate sharing and security permissions.

About this task

Create or ensure that a domain or Windows account exists that all developers can use.

Parent topic: Installing the developer workstation software components

Importing encryption keys to Datacap computers

In a client/server configuration, you must import security encryption keys to the computer where you are
installing and configuring each Datacap component. This requirement secures passwords that are sent across
the network between Datacap servers and clients.

102 Datacap 9.1.3



Before you begin

You must generate the encryption keys in the keystore on a server on which the Datacap server software
component is installed. You export the new keys to a key transport file.

Procedure

To import encryption keys to Datacap computers:

1. Find the dc_KTF.xml key transport file in the c:\Datacap\Taskmaster folder on the Datacap server where
you generated and exported the encryption keys.

2. Copy the dc_KTF.xml key transport file to the appropriate folder on the computer where you installed
the new component. The encryption keys are automatically applied to the keystore the next time you
start the Datacap component.

Table 1. Encryption key folder locations by

compone nt
Component Folder
Datacap Server C:\Datacap\Taskmaster

Datacap applications | C:\Datacap\Taskmaster

Datacap Desktop C:\Datacap\DcDesktop
Datacap Studio C:\Datacap\DStudio
Datacap FastDoc C:\Datacap\FastDoc

Datacap Report Viewer | C:\Datacap\RV2\bin

Datacap Web Client C:\Datacap\tmweb.net\bin

Datacap Web Services | C:\Datacap\wTM\bin

Parent topic: Installing the developer workstation software components

Setting up the scanner

When a computer is to be used as a scan station, follow the manufacturer’s instructions to attach the scanner
to the computer. Install and configure the required scanner drivers and software. Be sure you can scan
successfully with an image capture software product other tha Datacap. If you are unable to scan documents
with software that is not Datacap, you cannot scan documents with Datacap.

About this task

Tip: A physical scanner is not required for running the Datacap that is separately licensed or sample
applications because those applications can process the prescanned, sample images that are included during
installation.

Parent topic: Installing the developer workstation software components

Configure Internet Explorer on the developer workstation

You must configure Internet Explorer on the developer workstation to enable access to Datacap Web Client,
the system administration panel, and the user panel.
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About this task

To set up the developer workstation, follow the steps in Configuring and testing the remote workstation.
Parent topic: Installing the developer workstation software components

Copying the application to the Datacap Server

The following information provides instructions for copying specific applications. However, the instructions are
equally applicable to a customized application, and you can refer to any one of the topics for copying your
custom application. You need to start Datacap Studio, start the Datacap Studio Application Copy wizard, and
copy the application from the developer workstation to the server. The application can then be accessed by
other workstations that are running the Datacap Client or Datacap Web Client, and by other services and
processes.

About this task

The Windows account that you use to log on must have full control for both sharing and security permissions on
the Datacap folder on the Datacap Server. If the application includes custom Datacap web pages, your
Windows account must have sharing permissions on the Datacap web server and for the Datacap folder. Your
Windows account must also have full control for security permissions on the tmweb.net folder.

Important:

When you are copying a foundation or sample application to change it or customize it to your business needs,
rename it. Instructions for renaming are included in Copying the application to Datacap Server. Renaming the
application achieves the following benefits:

e Avoid losing your customization when you are upgrading to later versions of Datacap. Application folders
with the names of Datacap applications can be overwritten.

e Better identify the business function the application provides for your users

e Leave the foundation and sample applications intact in case you encounter issues with your customized
version. You can use the original application for troubleshooting to determine whether or how the
feature works in the original application as compared to your customized version

e Leave the foundation and sample applications intact so you can use them as models when you are
building your own rulesets and tasks

e Sharing the Datacap and tmweb.net folders on the Datacap web server
When you want to copy a Datacap application that includes customized Datacap web pages, the
Application wizard copies the pages to the Datacap web server. Before copying, you must share and set
up the appropriate permissions for the C:\Datacap and C:\Datacap\tmweb.net folders on the web server.

e Starting Datacap Studio to use the Application wizard
To use the Application wizard to copy an application, start Datacap Studio without opening an
application.

e Setting or ensuring the correct Datacap.xml file is in use
Ensure that Datacap Studio is using the correct version of the datacap.xml file. The correct version is the
local file that contains an entry for the application that you want to copy from the developer workstation
to the Datacap Server.

e Copying the application to Datacap Server
You can copy the application from the developer workstation to the Datacap Server by using the Datacap
Studio Application Copy wizard.

e Copying the Datacap.xml file from the developer workstation to the Datacap Server
The datacap.xml file on the developer workstation contains information about the application that you
copied and the location of the application's files on the Datacap Server.

104 Datacap 9.1.3



Setting the location of the Datacap Server and the Datacap.xml file
You must define the location of the datacap.xml and the location of the Datacap Server for the
application that you want to run.

Parent topic: Datacap installation and configuration in a client/server environment

Sharing the Datacap and tmweb.net folders on the Datacap
web server

When you want to copy a Datacap application that includes customized Datacap web pages, the Application
wizard copies the pages to the Datacap web server. Before copying, you must share and set up the appropriate
permissions for the C:\Datacap and C:\Datacap\tmweb.net folders on the web server.

About this task

After you finish copying the application, you can remove the permissions from the folders and stop sharing.

Procedure

1.

[S2IF SOV}
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12.
13.

On the web server, start Windows Explorer, browse to and right-click the C:\Datacap folder and select
Properties.

. Click the Sharing tab, then click Advanced Sharing. When User Account Control (UAC) is on, the User

Account Control window is displayed. Click Yes.

. Click Share this Folder and keep Datacap as the Share name.
. Click Permissions.
. Add or ensure that the domain/Windows user ID of the developer who is copying the application is set to

allow Full Control.

. Click OK to close the Permissions dialog.

. Click OK to close the Advanced Sharing dialog.

. Click Close to close the Properties dialog.

. In Windows Explorer, browse to and right-click the C:\Datacap\tmweb.net folder and select Properties.
10.
11.

Click the Security tab, then click Edit.

Add or ensure that the domain/Windows user ID of the developer who is copying the application is set to
allow Full Control.

Click OK to close the Permissions dialog.

Click Close to close the Properties dialog.

Parent topic: Copying the application to the Datacap Server

Starting Datacap Studio to use the Application wizard

To use the Application wizard to copy an application, start Datacap Studio without opening an application.

Procedure

To start Datacap Studio without opening an application:

1.

2.

On the developer workstation, in the Start menu, click IBM Datacap Developer Tools>Datacap Studio.
When User Account Control (UAC) is on, the User Account Control window opens. Click Yes.

On the Applications window, click Close. An empty Datacap Studio main window opens on the
Rulemanager tab.
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Parent topic: Copying the application to the Datacap Server

Setting or ensuring the correct Datacap.xml file is in use

Ensure that Datacap Studio is using the correct version of the datacap.xml file. The correct version is the local
file that contains an entry for the application that you want to copy from the developer workstation to the
Datacap Server.

About this task

When you install the Datacap Client software on the developer workstation, the sampleDatacap applications
are installed. A default version of the datacap.xml file is placed in the C:\Datacap folder. This datacap.xml file
contains entries for the Datacap applications and allows Datacap Studio to locate the applications.

Procedure

To set the Datacap.xml file:

1. On the developer workstation, with an empty Datacap Studio main window open, click Settings.

2. Click the DCapp tab.

3. Set or ensure that the path in the Main application management file field is set to the local copy of the
datacap.xml file. Then, click OK.

4, Close and restart Datacap Studio after you change the path to the datacap.xml file so you can use the
new file.

Parent topic: Copying the application to the Datacap Server

Copying the application to Datacap Server

You can copy the application from the developer workstation to the Datacap Server by using the Datacap
Studio Application Copy wizard.

About this task

Important: By its design, the Application Copy wizard does not copy batches or their associated records in the
engine database to the server.

Procedure

1. On the developer workstation, with an empty Datacap Studio main window open, click Datacap
application wizard. The Application Wizard Overview window opens.

2. Click Next. The Application Wizard Mode window opens.

3. Select the Copy an existing RRS application option, then click Next. The Application Wizard Copy an
existing application window opens.

4. Enter or select information for the following fields:

Table 1. Entering information in the Application Wizard Copy an existing application
window

Exampl
Field Description e

106 Datacap 9.1.3



Exampl

Field Description e
Select The items in this list are the applications that are listed in the datacap.xml file that | APT,
an is in use. If the application you are copying does not display, follow the MClaim
applicati |instructions in Setting the Datacap.xml file to point to the correct datacap.xml file. |s, or
onto TravelD
copy ocs
from the
list
Root Target folder on the Server under which the new application folder is created. \\Serve
folder on r\Datac
target ap
system
Datacap |Location of the tmweb.net folder on the Datacap Web Client server. Leave blank if |\\WebS
Web Datacap Web Client is not set up yet or if there are no custom web pages in the erver\D
folder source application. If Datacap Web Client is set up and there are custom web atacap\
pages in the source application, use the correct web server name and folder tmweb.
location of tmweb.net. net
Rename [Indicates that you want the new application to have a different name than the Selecte
Copy original application. d
New Enter the name of the new application. Dataca
Name p
Accoun
ts
Payable
exampl
e:
C
o
m
p
a
n
y
I
n
v
o
i
c
e
s
Medical
Claims
exampl
e:
H
o
s
p
it
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Exampl
Field Description e
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TravelD
ocs
exampl
e:
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You should rename an application when you are making a copy. When you provide a New Name, it
cannot be a substring of the original application and it can be composed of only alphabetic, numeric, and
underscore characters. For TravelDocs, the name cannot be longer than 50 characters.

5. Click Next. The Application Wizard Finish window opens.
6. Click Finish to start the copying process.

The wizard makes a copy of the application in the new location on the server. The wizard then runs
search-and-replace operations throughout the application to make all changes. Messages and progress
bars are displayed, and when the process is complete, the Application Wizard Summary window is
displayed with one or more of the following messages:

o Warnings: Indicate that the wizard encountered something unexpected, but might continue.
o General: Shows the results that completed successfully.
o Errors: Indicate that the wizard encountered a problem that must be corrected.
7. Click View Logs to open the appwiz.log file, found in the application folder. The application folders are
located in the \\Server\Datacap directory on the server:

Datacap Accounts Payable:
\APT
Medical Claims:
\MClaims
TravelDocs:
\TravelDocs
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Search the log for the words error, warning, and not copied to locate the issues that you must
address. The appwiz.log contains a list of the changes to the application made by the wizard:

Type of Change Information Logged

Rename databases | Before and After values are displayed

Rename files Shows Before and After values are displayed
within folders

Update contents of | Messages are displayed that identify what was updated, Before and After values
databases are displayed

Update strings Before and After values are displayed
within project files

Update parameters | When changed:

in rule files (.rul) The Before and After values are displayed.

When not changed:
Information Messages are displayed - Depending on the message, you
decide whether it must be changed, and if so, you change it manually.

Updates Application.xml is displayed
Fingerprint
database name

8. Click Exit to close Datacap Studio.

Parent topic: Copying the application to the Datacap Server

Copying the Datacap.xml file from the developer workstation
to the Datacap Server

The datacap.xml file on the developer workstation contains information about the application that you copied
and the location of the application's files on the Datacap Server.

Procedure

1. On the developer workstation, start Windows Explorer, browse to, and open the C:\Datacap folder.

2. On the developer workstation, start another instance of Windows Explorer, browse to the Datacap
Server, and open the \\Server\Datacap folder.

3. Copy the developer workstation's datacap.xml file and paste it into the \\Server\Datacap folder.

What to do next

After you copy the datacap.xml file to the Datacap Server, update it following the instructions in Updating the
datacap.xml file on the Datacap server.
Parent topic: Copying the application to the Datacap Server

Setting the location of the Datacap Server and the Datacap.xml
file

You must define the location of the datacap.xml and the location of the Datacap Server for the application that
you want to run.
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Procedure

To define the location of the server and the datacap.xml file:

1.

8.

On the developer workstation, in the Start menu, click IBM Datacap Services>Datacap Application
Manager. When User Account Control (UAC) is on, the User Account Control window opens. Click Yes.

. Select the application to which you want to set the location, such as TravelDocs, or APT. The paths are

displayed in the fields on the Main tab.

. Ensure that all workflows are displayed. Check that all of the paths reflect the correct UNC paths to the

various files and databases by using the Datacap Server name rather than C:\.

. Click Locale. Select the option that is associated with the language and regional settings that are used

on most of the documents to be processed by the application. If you do not select a locale, the value
that is set on the Regional and Language property sheet of the operating system is used.

. Click the Datacap tab and change the Name or IP address field to the IP address or the name of the

Datacap Server without using backslashes.

. In the Protocol field, select the TCP/IP version that is used on your network. If you do not select a

protocol, Datacap defaults to TCP IPv4.

. Click the Service tab and verify that the path reflects the correct UNC location of the datacap.xml on the

server, such as \\Server\Datacap\datacap.xml.
Close Datacap Application Manager.

Parent topic: Copying the application to the Datacap Server

Complete the Datacap server configuration

You must update the datacap.xml file on the Datacap server to add references to applications. You must also
set up security on the folder that contains the applications.

Complete the Datacap server configuration by updating the datacap.xml file on the Datacap server to reflect
the locations of your applications. You must also set up security on the C:\Datacap\Application folder that
contains your newly copied application.

Updating the datacap.xml file on the Datacap server

The datacap.xml file on the Datacap server must contain references to the applications. The datacap.xml
file must also contain the locations that you are configuring for use.

Setting up security on the Datacap\Application folder

You must set up security for the shared C:\Datacap\Application folder by setting security permissions in
the Datacap Properties Securities window.

Parent topic: Datacap installation and configuration in a client/server environment

Updating the datacap.xml file on the Datacap server

The datacap.xml file on the Datacap server must contain references to the applications. The datacap.xml file
must also contain the locations that you are configuring for use.

About this task

Before you begin, identify the names and locations of the applications that you want the Datacap Application
Service to be aware of.

Important: The Datacap Application Service is case-sensitive. When you add or change entries in the
datacap.xml file, make sure that the case matches the case of the UNC paths, folders, and file names.
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Procedure

1. Open the C:\Datacap\datacap.xml file in a text editor on the Datacap server. It contains lines that look

3.

4.

like this example:

<datacap ver="8.0">
<app name="Flex" ref="Flex"/>
<app name="TravelDocs" ref="\\ServerName\Datacap\TravelDocs"/>
<app name="APT" ref="APT"/>
<app name="AppWizard" ref="DStudio\AppWizard"/>
<app name="NENU" ref="NENU"/>
</datacap>

. To delete references to applications that do not exist or are not configured, delete the corresponding

<app name= lines. When the only application on the Datacap server is the TravelDocs application,
delete all of the lines except the line for the TravelDocs application. The result looks like this example:

<datacap ver="8.0">
<app name="TravelDocs" ref="\\ServerName\Datacap\TravelDocs"/>
</datacap>

To add references to applications that exist, add a line with the name of the application and the full UNC
path to the application folder. When you add a line for the Maintenance Manager application, your result
looks like this example:

<datacap ver="8.0">
<app name="TravelDocs" ref="\\ServerName\Datacap\TravelDocs" />
<app name="NENU" ref="\\ServerName\Datacap\NENU"/>

</datacap>

Save and then close the datacap.xml file.

Parent topic: Complete the Datacap server configuration

Setting up security on the Datacap\Application folder

You must set up security for the shared C:\Datacap\Application folder by setting security permissions in the
Datacap Properties Securities window.

About this task

Repeat these instructions for each C:\Datacap\Application folder on the server. By setting up these security
permissions at this level, you grant access to different applications to specific developers and users.

Procedure
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. On the server, start Windows Explorer, navigate to, and right-click the C:\Datacap\Application folder and

select Properties.

. Click the Security tab, and then click Edit.

. Add NETWORK SERVICE and local IUSR and set both to allow Full Control.

. Ensure that the domain/Windows user ID of Datacap Web Client is set to allow Read & Execute.

. Ensure that the domain/Windows user ID of developer is set to allow Full Control.

. Ensure that the domain/Windows user ID of Datacap server service is set to allow Full Control.

. When the batches folders are staying on Server in the C:\Datacap\Application path, add or ensure that

the domain/Windows user IDs of Datacap users are set to allow Full Control.

Parent topic: Complete the Datacap server configuration
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Complete the Datacap Web Client server configuration

To complete the Datacap Web Client server configuration, you must set the location of the Datacap.xml file.
Then, you must restart Internet Information Services.

e Setting the location of the datacap.xml file
You must define the location of the Datacap application settings by using the Datacap Application
Manager. The datacap.xml file contains the application settings.

e Restarting Internet Information Services (IIS)
After you set the location of the datacap.xml file on a web server, you must restart Internet Information
Services (IIS).

Parent topic: Datacap installation and configuration in a client/server environment

Setting the location of the datacap.xml file

You must define the location of the Datacap application settings by using the Datacap Application Manager. The
datacap.xml file contains the application settings.

About this task

The datacap.xml file that contains the application settings is on the Datacap server.

Procedure

To set the location of the datacap.xml file:

1. In the Start menu, select IBM Datacap Services>Datacap Application Manager. If the User Account
Control window opens, click Yes.

2. Click the Service tab to display it.

3. Change or ensure that the path reflects the correct location of the datacap.xml file. For example,
\\Server\Datacap\datacap.xml

4, Close the Datacap Application Manager.

Parent topic: Complete the Datacap Web Client server configuration

Restarting Internet Information Services (IIS)

After you set the location of the datacap.xml file on a web server, you must restart Internet Information
Services (IIS).

Parent topic: Complete the Datacap Web Client server configuration

Configuring and testing the remote workstation

You can configure and test a remote workstation that uses Internet Explorer to access Datacap Web Client.

About this task

This section provides the instructions you need to configure a remote workstation that uses Internet Explorer
to access Datacap Web Client. You need to know the IP address or the server name of your Datacap Web
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Server before you can configure a remote workstation.

Procedure

Determine the way that you want to configure the remote workstation. There are two ways to configure a

remote workstation:

Option

Description

You can package the Datacap Web Client Configuration
Tool, send the package to the user, and have the user
run the tool to configure Internet Explorer.

To package theDatacap Web Client Configuration
Tool, follow the instructions in Packaging the
Datacap Web Client Configuration Tool.

The user can configure Internet Explorer manually.
Provide the user with these instructions.

Configuring Internet Explorer manually

Test Internet Explorer

e Packaging the Datacap Web Client Configuration Tool

You can create a package for a user to configure Internet Explorer on a remote workstation to access

Datacap Web Client.
e Adding the TMWeb.net address as a trusted site

You must add the TMWeb.net address as a trusted site in a client/server configuration to prevent
Internet Explorer from blocking access to the Datacap Web Client site.

e Configuring and testing Internet Explorer using the Web Client Configuration package
To ensure remote access with Datacap Web Client, you must enable the Internet Explorer security
option and set the configuration in the Datacap Web Client Configuration.

e Configuring Internet Explorer manually

You must configure Internet Explorer on each workstation with the Datacap Web Client.

e Testing Internet Explorer

You can test your Datacap Web Client configuration with the Internet Explorer test page.

Parent topic: Datacap installation and configuration in a client/server environment

Packaging the Datacap Web Client Configuration Tool

You can create a package for a user to configure Internet Explorer on a remote workstation to access Datacap

Web Client.

About this task

Package the Datacap Web Client Configuration Tool for a user to configure Internet Explorer to access the

Datacap Web Client.

Procedure

1. On any machine where Datacap software is installed, open Windows Explorer, go to the
C:\Datacap\support\WebConfiguration folder and open the folder.

2. Make a copy of the WebClientConfig.exe.config file.

3. With a text editor such as Notepad, open the WebClientConfig.exe.config file.

4., Locate the following line.

<value>http://localhost/tmweb.net</value>

5. Change localhost to the IP address or server name of your Datacap Web Client server.

6. Save and close the WebClientConfig.exe.config file.
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7.

Send the following three files to your user: WebClientConfig.exe.config, Datacap.Config.dll, and
WebClientConfig.exe. Also send the URL for the Datacap Web Client Internet Explorer test page, such as
http://WebServerName/tmweb.net/ietest.aspx.

Parent topic: Configuring and testing the remote workstation

Adding the TMWeb.net address as a trusted site

You must add the TMWeb.net address as a trusted site in a client/server configuration to prevent Internet
Explorer from blocking access to the Datacap Web Client site.

Procedure

1.
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On the computer on which you want to use Internet Explorer to access Datacap Web Client, start the 32-
bit version of Internet Explorer.

. On the Tools menu, select Internet Options. The Internet Options dialog opens.

. Click the Security tab.

. Select Trusted sites, then click Sites. The Trusted Sites dialog opens.

. Clear the Require server verification option when your Datacap Web Client URL begins with http://.

. Depending on whether you are running Internet Explorer on the same machine as Datacap Web Client,

do one of the following:
o When you are running Internet Explorer on the same machine, enter the default server address
(http://localhost) in the Add this website to the zone field, then click Add.
o When you are running Internet Explorer from a different machine, enter either the web server IP
address or name (http://WebServerName) in the Add this website to the zone field, then click
Add.

Parent topic: Configuring and testing the remote workstation

Configuring and testing Internet Explorer using the Web Client
Configuration package

To ensure remote access with Datacap Web Client, you must enable the Internet Explorer security option and
set the configuration in the Datacap Web Client Configuration.

Before you begin

Before you can begin, you must have or do all of the following:

A 32-bit version of Internet Explorer must be installed and running on your workstation.

You must have the instructions for Adding the TMWeb.net address as a trusted site.

You must have the complete URL for the Internet Explorer test page on your Datacap Web Client remote
access site, for example http://WebServerName/tmweb.net/ietest.aspx.

You must have three files from your Administrator named WebClientConfig.exe.config,
Datacap.config.dll, and WebClientConfig.exe.

Important: The login user must be a member of the local administrator group for WebClientConfig.exe to work
properly. If the login user is not a member of the local administrator group, then disable UAC, temporarily add
the login user to the local administrator group, and after configuration, remove the login user from the local
administrator group.

About this task
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Datacap Web Client can be accessed from a remote workstation using the 32-bit version of Internet Explorer.
This procedure provides instructions on how to configure Internet Explorer and test your access to Datacap
Web Client using the Web Client Configuration package provided to you by your Administrator.

Procedure
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10.

11.

12.
13.
14.

15.

. Start Internet Explorer on your workstation and ensure you can view web pages on the Internet.

. Follow the instructions to add the URL for Datacap Web Client as a trusted site.

. On the Tools menu, select Internet Options. The Internet Options dialog opens.

. Click the Security tab, select Trusted sites, then click the Custom level button.

. Scroll down until the Miscellaneous settings are displayed.

. The Include local directory path when uploading files to a server option should be Enabled.

. Click OK, click Yes if a warning is displayed, then click OK to close the Internet Options dialog.

. Close Internet Explorer.

. Place the three files on your workstation either in a folder on your desktop or in the location that is

recommended by your Administrator.

Double-click the WebClientConfig.exe file. When UAC is on, the User Access Control window opens. Click
Yes. The Datacap Web Client Configuration window opens and displays a URL.

Ensure that the web server name that is displayed matches the web server information (server name or
IP address) that you added to Internet Explorer as a trusted site. If it does not match, contact your
Administrator for the correct URL and enter it manually.

Click Configure, then click OK to close the message box that indicates the configuration was successful.
Click Exit.

Start Internet Explorer and enter the URL to the Internet Explorer test page, such as
http://WebServerName/tmweb.net/ietest.aspx then press Enter. When UAC is on, the first time you
access the test page, the User Access Control window opens. Click Yes each time you are prompted.
Clicking Yes downloads the required Datacap TIFF Viewer, Thumbnails, and DataEdit Controls. After the
downloads are complete, the IE Test Page is displayed.

Click Test. The red Xs change to green checkmarks when the test completes successfully. If the TIFF
viewer test does not pass, switch to the 32-bit version of Internet Explorer and repeat this procedure
from step 1.

Parent topic: Configuring and testing the remote workstation

Configuring Internet Explorer manually

You must configure Internet Explorer on each workstation with the Datacap Web Client.

Procedure

To configure Internet Explorer manually:
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. Start Internet Explorer and ensure you can view web pages on the Internet.

. On the Tools menu, select Internet Options. The Internet Options dialog opens.

. Click the Security tab.

. Select Trusted Sites, then click Sites. The Trusted Sites dialog opens.

. Clear the Require server verification option when your Datacap Web Client URL begins with http://.

. When you are running Internet Explorer on the same machine as Datacap Web Client, enter the default

web server address (http://localhost) in the Add this website to the zone field, then click Add. The URL is
added to the pane. When you are running Internet Explorer from a different machine, enter either the
web server IP address or name (http://WebServerName) in the Add this website to the zone field, then
click Add. The URL is added to the pane.

. Click Close. The Internet Options dialog is displayed.
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8. On the Security tab, click the Custom level button. The Security Settings dialog appears.
9. Scroll down to the ActiveX controls and plug-ins settings.
10. Set the following options to Enabled.
o Download signed ActiveX controls
o Initialize and script ActiveX controls not marked as safe for scripting
11. Scroll down to the Miscellaneous settings.
12. Sent the Include local directory path when uploading files to a server option to Enabled.
13. Click OK to confirm your changes.

Parent topic: Configuring and testing the remote workstation

Testing Internet Explorer

You can test your Datacap Web Client configuration with the Internet Explorer test page.

About this task

This procedure provides instructions on how to test your configuration of Internet Explorer with Datacap Web
Client.

Procedure

1. Start Internet Explorer.

2. When you are running Internet Explorer on the same machine as Datacap Web Client, enter the URL for
Datacap Web Client (http://localhost) followed by the tmweb.net virtual directory and the test page,
http://localhost/tmweb.net/ietest.aspx. When you are running Internet Explorer from a different
machine, enter either the web server address or name, followed by the tmweb.net virtual directory and
the test page, such as http://WebServerName/tmweb.net/ietest.aspx. When UAC is on, the first
time you access the test page, the User Access Control window opens. Click Yes to download the
Datacap TIFF Viewer, Thumbnails, and DataEdit Controls. The Internet Explorer test page is displayed.

3. Click Test. The red Xs change to green check marks when the test completes successfully. If the Datacap
TIFF Viewer does not download, switch to the 32-bit version of Internet Explorer and repeat this
procedure from step 1.

Parent topic: Configuring and testing the remote workstation

Installing the Datacap client on the user workstation

You can run the Datacap installation program wizard on a user workstation to install the necessary Datacap
client software.

About this task

This procedure provides instructions on how to run the Datacap installation program wizard on an user
workstation to install the necessary Datacap software components. The components that you install include
the Datacap client and the separately licensed connectors for which you have a license.

Procedure

1. Make the installation package available on your network or insert the Datacap CD in the Workstation’s
CD/DVD drive. If the installation process does not start automatically, or if the package is on the
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network, open Windows Explorer, navigate to and double-click the Setup.exe. When User Access Control
(UAC) is on, the User Account Control window opens. Click Yes.
2. Select the appropriate language, then click OK. The language that you select determines the language
that is displayed by the installation program wizard during the installation process.
3. When additional, redistributable software is required, the installation program wizard displays a list of
the items that must be installed. Click Install.
4. Click Next.
5. Accept the license agreement. Then, click Next.
6. Select the Custom option. Then, click Next.
7. Exclude all components except Datacap client and the separately licensed connectors for which you
have a license.
8. Expand the Datacap client software component and exclude the Applications, Datacap Studio, and
Maintenance Manager components. If you are not using the FastDoc user interface, exclude that as well.
9. Click Next.
10. Click Install.
11. Click Finish.

e Ensure that accounts exist for users
Ensure that a domain/Windows account exists for each Datacap user. Datacap does not require that a
unique Windows account is set up for each user. A user can use any Windows account that is set up with
the appropriate sharing and security permissions.

e Importing encryption keys to Datacap computers
In a client/server configuration, you must import security encryption keys to the computer where you
are installing and configuring each Datacap component. This requirement secures passwords that are
sent across the network between Datacap servers and clients.

e Setting up sharing and security permissions for users
You must set up sharing and security permissions to Datacap folders for each Datacap user.

e Setting up the scanner
When a computer is to be used as a scan station, follow the manufacturer’s instructions to attach the
scanner to the computer. Install and configure the required scanner drivers and software. Be sure you
can scan successfully with an image capture software product other tha Datacap. If you are unable to
scan documents with software that is not Datacap, you cannot scan documents with Datacap.

e Setting the location of the datacap.xml file
You must define the location of the Datacap application settings by using the Datacap Application
Manager. The datacap.xml file contains the application settings.

Parent topic: Datacap installation and configuration in a client/server environment

Ensure that accounts exist for users

Ensure that a domain/Windows account exists for each Datacap user. Datacap does not require that a unique
Windows account is set up for each user. A user can use any Windows account that is set up with the
appropriate sharing and security permissions.

Parent topic: Installing the Datacap client on the user workstation

Importing encryption keys to Datacap computers

In a client/server configuration, you must import security encryption keys to the computer where you are
installing and configuring each Datacap component. This requirement secures passwords that are sent across
the network between Datacap servers and clients.
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Before you begin

You must generate the encryption keys in the keystore on a server on which the Datacap server software
component is installed. You export the new keys to a key transport file.

Procedure

To import encryption keys to Datacap computers:

1. Find the dc_KTF.xml key transport file in the c:\Datacap\Taskmaster folder on the Datacap server where
you generated and exported the encryption keys.

2. Copy the dc_KTF.xml key transport file to the appropriate folder on the computer where you installed
the new component. The encryption keys are automatically applied to the keystore the next time you
start the Datacap component.

Table 1. Encryption key folder locations by

compone nt
Component Folder
Datacap Server C:\Datacap\Taskmaster

Datacap applications | C:\Datacap\Taskmaster

Datacap Desktop C:\Datacap\DcDesktop
Datacap Studio C:\Datacap\DStudio
Datacap FastDoc C:\Datacap\FastDoc

Datacap Report Viewer | C:\Datacap\RV2\bin

Datacap Web Client C:\Datacap\tmweb.net\bin

Datacap Web Services |C:\Datacap\wTM\bin

Parent topic: Installing the Datacap client on the user workstation

Setting up sharing and security permissions for users

You must set up sharing and security permissions to Datacap folders for each Datacap user.

About this task

This procedure provides instructions on how to grant the appropriate permissions to Datacap user accounts.

Procedure

1. Set up sharing permissions on the \Datacap folder.
a. On the Server, start Windows Explorer, navigate to and right-click the C:\Datacap folder and select
Properties.
b. Click the Sharing tab and then click Advanced Sharing.
c. Click Permissions.
d. When the batches folders are staying on server in C:\Datacap\Application path, add or ensure
that the domain/Windows user IDs of Datacap users are set to allow Full Control.
2. Set up security on the \Datacap folder.
a. On the server, start Windows Explorer, navigate to, and right-click the C:\Datacap folder and
select Properties.
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b. Click the Security tab.

c. When the batches folders are staying on server in C:\Datacap\Application path, add or ensure
that the domain/Windows user IDs of Datacap users are set to allow Read & Execute.

3. Set up security on the \Datacap\Application folder.

a. On the server, start Windows Explorer, navigate to, and right-click the C:\Datacap\Application
folder and select Properties.

b. Click the Security tab and click Edit.

c. When the batches folders are staying on server in the C:\Datacap\Application path, add or ensure
that the domain/Windows user IDs of Datacap users are set to allow Full Control.

Parent topic: Installing the Datacap client on the user workstation

Setting up the scanner

When a computer is to be used as a scan station, follow the manufacturer’s instructions to attach the scanner
to the computer. Install and configure the required scanner drivers and software. Be sure you can scan
successfully with an image capture software product other tha Datacap. If you are unable to scan documents
with software that is not Datacap, you cannot scan documents with Datacap.

About this task

Tip: A physical scanner is not required for running the Datacap that is separately licensed or sample
applications because those applications can process the prescanned, sample images that are included during
installation.

Parent topic: Installing the Datacap client on the user workstation

Setting the location of the datacap.xml file

You must define the location of the Datacap application settings by using the Datacap Application Manager. The
datacap.xml file contains the application settings.

About this task

The datacap.xml file that contains the application settings is on the Datacap server.

Procedure

To set the location of the datacap.xml file:

1. In the Start menu, select IBM Datacap Services>Datacap Application Manager. If the User Account
Control window opens, click Yes.

2. Click the Service tab to display it.

3. Change or ensure that the path reflects the correct location of the datacap.xml file. For example,
\\Server\Datacap\datacap.xml

4. Close the Datacap Application Manager.

Parent topic: Installing the Datacap client on the user workstation

Installing and configuring Datacap Report Viewer

You can install and configure Report Viewer to run locally or in a Datacap client/server environment so you can
use the browser-based Datacap Web Client for processing.
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e Datacap Report Viewer
The Datacap Report Viewer web application displays real-time reports of activity that is related to your
Datacap applications.

e Client/server environment: Overview of Datacap Report Viewer installation and configuration
You must complete the required tasks to install and configure the Datacap Report Viewer reporting
component.

e Creating or ensuring an account exists for Report Viewer
If a domain/Windows account does not exist for Report Viewer, you must create one.

e Installing and configuring Datacap Report Viewer on a web server
You can install and configure Report Viewer on a Windows 2008 web server.

e Adding the Datacap Report Viewer address as a trusted site
Add the Report Viewer web address as a trusted site to prevent Internet Explorer from blocking access
to the site.

Parent topic: Datacap installation and configuration in a client/server environment

Datacap Report Viewer

The Datacap Report Viewer web application displays real-time reports of activity that is related to your Datacap
applications.

For a list of the standard reports, see Standard reports.

Parent topic: Installing and configuring Datacap Report Viewer

Client/server environment: Overview of Datacap Report
Viewer installation and configuration

You must complete the required tasks to install and configure the Datacap Report Viewer reporting component.
Before you start, ensure that you met the installation and configuration prerequisites.
In a client/server environment:

. Create or ensure that an account exists for Report Viewer.

. Ensure that you have the required Microsoft Internet Information Services (IIS) components installed.
. Set up various Report Viewer permissions.

. Install Report Viewer on the web server.

. Import encryption keys on the web server.

. Add an Application Pool for Report Viewer.

. Set up the Report Viewer website and Application Pool advanced settings.
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Parent topic: Installing and configuring Datacap Report Viewer

Creating or ensuring an account exists for Report Viewer

If a domain/Windows account does not exist for Report Viewer, you must create one.

About this task

Datacap does not require you to set up a unique Windows account for Report Viewer. Report Viewer can use
any Windows account if an account can be set up with the appropriate sharing and security permissions.
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Important: When Report Viewer and Datacap Web Client are installed on the same web server, they must use
the same domain/Windows account.
Parent topic: Installing and configuring Datacap Report Viewer

Installing and configuring Datacap Report Viewer on a web
server

You can install and configure Report Viewer on a Windows 2008 web server.

Before you begin

Before installing Datacap Report Viewer, stop or ensure the Datacap Server Service is stopped.

e Verifying that IIS components are installed
Ensure that the IIS Web Server Role Services are installed for the Datacap Web Client server
components, such as Datacap Web Client, Report Viewer, Fingerprint Service, and Datacap Web
Services.

e Setting up sharing permissions for Datacap Report Viewer on the Datacap folder
You must set up the appropriate sharing permissions for the Report Viewer account on the Datacap
Server shared C:\Datacap folder.

e Setting up security for Datacap Report Viewer on the Datacap folder
You must set up the appropriate security permissions on the C:\Datacap folder on the server when the
Datacap Server operating system is Windows 2008. Other accounts were granted security permissions
during the installation and configuration of Datacap.

e Installing Datacap Report Viewer on the web server
Run the Datacap installation wizard on a web server to install the Datacap Report Viewer software
component.

e Importing encryption keys to Datacap computers
In a client/server configuration, you must import security encryption keys to the computer where you
are installing and configuring each Datacap component. This requirement secures passwords that are
sent across the network between Datacap servers and clients.

e Adding an application pool for Report Viewer
When you are running on Windows 7 or Windows 2008, you must add a Microsoft Internet Information
Services (IIS) Application Pool for use by Report Viewer.

e Client/server environment: Setting up the Datacap Report Viewer website
You must set up the Report Viewer website on Microsoft Internet Information Services (IIS) 7.5.

e Setting the location of the datacap.xml file
You must define the location of the Datacap application settings by using the Datacap Application
Manager. The datacap.xml file contains the application settings.

Parent topic: Installing and configuring Datacap Report Viewer

Verifying that IIS components are installed

Ensure that the IIS Web Server Role Services are installed for the Datacap Web Client server components, such
as Datacap Web Client, Report Viewer, Fingerprint Service, and Datacap Web Services.

About this task

The Datacap Web Client server components must have specific IIS Web Server Role Services installed.
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Procedure

Ensure that the IIS components are installed.

1. From the Start menu on the web server, select Administrative Tools > Server Manager.

2. In the Server Manager hierarchy pane, expand Roles and select Web Server (IIS).

3. In the Web Server (IIS) pane, expand Role Services. Under Common HTTP Features ensure that Static
Content, Default Document, Directory Browsing, and HTTP Errors are installed. If you are installing wTM,
do not install the WebDAV Publishing role service because it prevents the Datacap web services PUT
method from functioning.

4. In the Role Services pane under Application Development, ensure that the ASP.NET, .NET Extensibility,
ASP, ISAPI Extensions, and ISAPI Filters are installed.

5. In the Role Services pane, under Health and Diagnostics ensure that HTTP Logging and Request Monitor

are installed.

. In the Role Services pane, under Security ensure that Request Filtering is installed.

. In the Role Services pane, under Performance ensure that Static Content Compression is installed.

. In the Role Services pane, under Management Tools ensure that IIS Management Console is installed.

. (Windows Server 2012 R2) In Server Manager, click Dashboard, and click Add roles and features.

a. In the Add Roles and Features Wizard, go to the Features section.
b. In .NET Framework 4.5 Features > WCF Services, select the HTTP Activation check box.

10. Close the Server Manager window.
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Parent topic: Installing and configuring Datacap Report Viewer on a web server

Setting up sharing permissions for Datacap Report Viewer on
the Datacap folder

You must set up the appropriate sharing permissions for the Report Viewer account on the Datacap Server
shared C:\Datacap folder.

About this task

These instructions apply when the operating system of the Datacap Server is Windows 2008. Other accounts
were already granted sharing permissions during the installation and configuration of Datacap.

Procedure

To set up sharing permissions for Report Viewer on the Datacap folder:

1. On the Datacap Server, start Windows Explorer, go to and right-click the C:\Datacap folder and select
Properties.

2. Click the Sharing tab and click Advanced Sharing. If the User Account Control window opens, click Yes.

3. Click Permissionsand ensure the domain/Windows user ID of Report Viewer is set to allow Read.

Parent topic: Installing and configuring Datacap Report Viewer on a web server

Setting up security for Datacap Report Viewer on the Datacap
folder

You must set up the appropriate security permissions on the C:\Datacap folder on the server when the Datacap
Server operating system is Windows 2008. Other accounts were granted security permissions during the
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installation and configuration of Datacap.

Procedure

To set up security for Report Viewer on the Datacap folder:

1. On the Server, start Windows Explorer, go to and right-click theC:\Datacap folder and select Properties.
2. Click the Security tab and click Edit. If the User Account Control window opens, click Yes.
3. Add or ensure that the domain/Windows account for Report Viewer is set to allow Read & Execute.

Parent topic: Installing and configuring Datacap Report Viewer on a web server

Installing Datacap Report Viewer on the web server

Run the Datacap installation wizard on a web server to install the Datacap Report Viewer software component.

About this task

These instructions apply to servers that are running on Windows 2008.

Procedure

To install Report Viewer on the web server, follow this procedure.

1. Put the installation package on your network, or insert the Datacap CD in the CD/DVD drive on the server.
If the installation process does not start automatically, or if the package is on the network, open
Windows Explorer, go to and double-click the Setup.exe. If the User Account Control window opens,
click Yes.

2. Select the appropriate language and click OK. The language that you select determines the language
that is displayed by the installation program during the installation process.

3. When the installation requires other software, the installation program displays a list of the items to be

installed. Click Install.

. Click Next.

. Accept the license agreement and click Next.

. Select the Custom option and click Next.

. Exclude all components from the installation process except Report Viewer.

. Click Next.

. Click Install.

10. Click Finish.
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e Enabling ADSI or LDAP authentication with Report Viewer
In addition to any configuration on the Datacap Server, Report Viewer has its own requirement for using
ADSI or LDAP authentication. Report Viewer includes an EnableLDAP setting that is used for ADSI and
LDAP authentication.

Parent topic: Installing and configuring Datacap Report Viewer on a web server

Enabling ADSI or LDAP authentication with Report Viewer

In addition to any configuration on the Datacap Server, Report Viewer has its own requirement for using ADSI
or LDAP authentication. Report Viewer includes an EnableLDAP setting that is used for ADSI and LDAP
authentication.
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About this task

If the default EnableLDAP value of false is unchanged, then the login to Report Viewer requires the operator
to enter a non-blank password.

Procedure

To change the default EnableLDAP value:

. Confirm that no operators are using Report Viewer.

. Log in to the Report Viewer web server.

. Make a backup copy of the \Datacap\RV2\web.config file.

. Open web.config in a text editor and locate the following line.

A WD P

<add key="EnableLDAP" value="false"/>

5. Change false to true:

<add key="EnableLDAP" value="true"/>
6. Save the web.config file.

Parent topic: Installing Datacap Report Viewer on the web server

Importing encryption keys to Datacap computers

In a client/server configuration, you must import security encryption keys to the computer where you are
installing and configuring each Datacap component. This requirement secures passwords that are sent across
the network between Datacap servers and clients.

Before you begin

You must generate the encryption keys in the keystore on a server on which the Datacap server software
component is installed. You export the new keys to a key transport file.

Procedure

To import encryption keys to Datacap computers:

1. Find the dc_KTF.xml key transport file in the c:\Datacap\Taskmaster folder on the Datacap server where
you generated and exported the encryption keys.

2. Copy the dc_KTF.xml key transport file to the appropriate folder on the computer where you installed
the new component. The encryption keys are automatically applied to the keystore the next time you
start the Datacap component.

Table 1. Encryption key folder locations by

component
Component Folder
Datacap Server C:\Datacap\Taskmaster

Datacap applications | C:\Datacap\Taskmaster

Datacap Desktop C:\Datacap\DcDesktop

Datacap Studio C:\Datacap\DStudio
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Component Folder

Datacap FastDoc C:\Datacap\FastDoc

Datacap Report Viewer | C:\Datacap\RV2\bin

Datacap Web Client C:\Datacap\tmweb.net\bin

Datacap Web Services | C:\Datacap\wTM\bin

Parent topic: Installing and configuring Datacap Report Viewer on a web server

Adding an application pool for Report Viewer

When you are running on Windows 7 or Windows 2008, you must add a Microsoft Internet Information
Services (IIS) Application Pool for use by Report Viewer.

Procedure

To add an Application Pool for Report Viewer:

1.

N
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From the Windows Start menu, select Administrative Tools > Internet Information Services (IIS)
Manager.

. In the Connections pane, expand the computer, right-click Application Pools and select Add Application

Pool.

. Set the Name to Report Viewer.

. Set the .NET Framework version to .NET Framework v4.0.303109.
. Set the Managed pipeline mode to Integrated.

. Select the Start application pool immediately option and click OK.

Parent topic: Installing and configuring Datacap Report Viewer on a web server

Client/server environment: Setting up the Datacap Report
Viewer website

You must set up the Report Viewer website on Microsoft Internet Information Services (IIS) 7.5.

Procedure

To set up the Report Viewer website:

1.
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From the Windows Start menu on the web server, select Administrative Tools > Internet Information
Services (IIS) Manager.

. In the Connections pane, expand the computer and expand Sites. Then, right-click the Default Web Site

and select Add Application.

. Set the Alias to Report Viewer.
. Click Select and select the Report Viewer Application Pool that you added, then click OK.
. Set the Physical path by entering or browsing to the Report Viewer installation folder. The default

location is C:\Datacap\RV2.

. Click OK to close the Add Application dialog.

. In the Connections pane, select Application Pools.

. In the Application Pools pane, select the Report Viewer application pool.

. In the Actions pane, in the Edit Application Pool section, click Advanced Settings.
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10. Ensure that the Microsoft .NET version is set to v4.0.

11. Ensure that Enable 32-Bit Applications is set to True.

12. In the Process Model section, click Browse next to Identity.

13. In the Application Pool Identity window, select Custom account and click Set.

14. In the Set Credentials window, enter the Report Viewer domain/Windows account information (the same
account that you added to the web server Administrators Group) in the format
accountname@domainname. Then, enter the account password twice and click OK.

15. In the Process Model section, set Load User Profile to True.

16. Click OK.

17. In the Connections pane, expand the computer and expand Sites. Then, expand the Default Web Site
and select the Report Viewer site, and in the middle pane, double-click Session State.

18. Under Cookie Settings, change the Name to Report Viewer or another unique name, then, in the
Actions pane, click Apply.

19. In the Connections pane, select the Default Web Site, then, in the Actions pane, under Manage Web Site,
click Restart.

20. Confirm that the Web Server, Application Pool, and Default website are started.

Parent topic: Installing and configuring Datacap Report Viewer on a web server

Setting the location of the datacap.xml file

You must define the location of the Datacap application settings by using the Datacap Application Manager. The
datacap.xml file contains the application settings.

About this task

The datacap.xml file that contains the application settings is on the Datacap server.

Procedure

To set the location of the datacap.xml file:

1. In the Start menu, select IBM Datacap Services>Datacap Application Manager. If the User Account
Control window opens, click Yes.

2. Click the Service tab to display it.

3. Change or ensure that the path reflects the correct location of the datacap.xml file. For example,
\\Server\Datacap\datacap.xml

4, Close the Datacap Application Manager.

Parent topic: Installing and configuring Datacap Report Viewer on a web server

Adding the Datacap Report Viewer address as a trusted site

Add the Report Viewer web address as a trusted site to prevent Internet Explorer from blocking access to the
site.

Procedure

To add the Report Viewer address as a trusted site:

1. Open Internet Explorer.
2. On the Tools menu, select Internet Options.
3. Click the Security tab.
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4, Select Trusted sites, then click Sites.
5. Clear the Require server verification option when your Datacap Web URL begins with http://.
6. Depending on whether you are running Internet Explorer on the same computer as Report Viewer, do

one or both of the following steps.
o Enter the default server address (http://127.0.0.1) in the Add this website to the zone field and
click Add.
o Enter the web server IP address or name (http://WebServerName) in the Add this website to the
zone field and click Add.

7. Click Close.
8. Click OK.

Parent topic: Installing and configuring Datacap Report Viewer

Installing and configuring the Rulerunner Service

The Rulerunner Service is a Datacap component that runs Datacap Studio application tasks in the background.

Background tasks are run without any human interaction. Background tasks are typically vScan, recognition,
image pre-processing, validation, and export tasks.

Rulerunner supports simultaneous processes running on a single multiprocessor or multi-core equipped
computer.

The ability to configure Rulerunner to run a single process is included as part of the standard Datacap licensing.
Configuring Rulerunner to run multiple processes requires additional licensing.

With Rulerunner you can:

Complete your document processing work faster. Faster turn-around of documents such as claims,
contracts, tax returns and invoices improves responsiveness and shortens capture cycle times.
When Rulerunner runs multiple processes, more of the physical resources of each machine are used
which can reduce the total number of servers dedicated to the capture process.

Rulerunner configuration assumptions

You must prepare your environment before you can install, configure, and run Datacap background tasks
by using Rulerunner.

Overview of Rulerunner installation in a client/server environment

You can install and configure the Rulerunner Service to run on one or more Rulerunner servers that are
separate from the Datacap Server.

Configuring Rulerunner authentication

When you install Rulerunner on one or more servers to run background Datacap tasks, you must
authenticate Rulerunner as a user.

Installing and configuring the Rulerunner Service

You can install and configure the Rulerunner Service in an environment where Datacap is running
successfully. Where the Workstation and Server are separate machines. And where you are adding one
or more additional Rulerunner servers to host instances of the Rulerunner Service.

Configuring Rulerunner to run your applications

You can configure one or more instances of Rulerunner to run background tasks from your applications
or workflows.

Parent topic: Datacap installation and configuration in a client/server environment

Rulerunner configuration assumptions
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You must prepare your environment before you can install, configure, and run Datacap background tasks by
using Rulerunner.

The instructions assume that all of the applications that you want Rulerunner to process have already been
installed, configured, and run successfully using the Datacap client software. The instructions also assume you
have one or more separate servers (Rulerunner server) on which you will install the Rulerunner Service.

Before you begin installing Rulerunner, ensure:

e You have a working Datacap 9.0.1 or later client/server environment.

e At aminimum, ensure that Datacap runs correctly in a client/server environment where the application
files are located on the Datacap Server and the application runs correctly from a Workstation. This
makes troubleshooting easier, and narrows down the sources of potential problems.

e If you want Datacap Rulerunner to run tasks from two or more Datacap applications, ensure that those
applications are working and that you have manually processed batches from start to finish successfully.

e When installing on client and server computers, ensure that you have administrator access to all
computers on which Datacap software is installed and to the servers running Windows Server 2008 on
which you will install the Rulerunner Service.

Parent topic: Installing and configuring the Rulerunner Service

Overview of Rulerunner installation in a client/server
environment

You can install and configure the Rulerunner Service to run on one or more Rulerunner servers that are
separate from the Datacap Server.

You can also configure Rulerunner to run tasks from a single or multiple Datacap applications on multiple
threads.

Depending on how your Datacap environment does authentication, you must authenticate Rulerunner the
same way. Instructions are provided for authenticating Rulerunner by using either Datacap authentication or an
external authentication system (ADSI, LDAP, ADLDS, LLLDAP).

Depending on your overall Datacap configuration, you might need to repeat one or more sets of instructions:

e Multiple Rulerunner servers - When you are installing the Rulerunner Service on more than one server,
repeat the instructions for each Rulerunner server in the section titled Installing and configuring the
Rulerunner Service.

e Multiple Datacap applications - When you are configuring the Rulerunner Service to run tasks from more
than one application, repeat the instructions for setting up an application in the section titled
Configuring Rulerunner to run your applications.

e Multiple workflows in a single application - When you are configuring the Rulerunner Service to run tasks
from multiple workflows in a single application, configure each workflow as if it is its own application.
You can refer to the instructions for setting up an application in the section titled Configuring Rulerunner
to run your applications.

The installation of Rulerunner in a client/server environment requires the following steps:

1. Ensure that you meet the prerequisites that are detailed in Installation and Configuration Prerequisites.

2. Ensure that you can manually run all application tasks in all applications before you begin this
installation process.

3. Determine which Datacap tasks from which applications you want Rulerunner to process.
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4, Regardless of whether you are using the Datacap authentication or an external authentication system,
create or ensure that a domain/Windows account exists for Rulerunner. All instances of Rulerunner can
use the same domain/Windows account. Follow the setup steps for your Datacap applications that are
relevant to the type of authentication in use.

5. Configure Rulerunner permissions on the Datacap Server.

6. Install the Rulerunner Service on each Rulerunner server.

7. Install all of the Datacap software components that are required by the tasks that Rulerunner runs on
each Rulerunner server.

8. On each Rulerunner server, set the location of the datacap.xml file on the Datacap Server.

9. Update the Rulerunner tab in the Application Manager with the appropriate Task profile names.

10. Complete the Rulerunner Service authentication setup.
11. Configure the Rulerunner Service account and permissions on each Rulerunner server.

Configuring the Rulerunner Service to process specific application tasks involves the following steps:

1. Configure the Rulerunner Service to run the appropriate applications and tasks.

2. Configure the security permissions for the Rulerunner Service on the various folders.
3. Create batches with the Datacap client.

4, Start the Rulerunner Service on the Rulerunner server.

5. Monitor the batches that the Rulerunner Service is processing.

6. Restart previously running Datacap software.

Parent topic: Installing and configuring the Rulerunner Service
Related concepts:
Installation and configuration prerequisites

Configuring Rulerunner authentication

When you install Rulerunner on one or more servers to run background Datacap tasks, you must authenticate
Rulerunner as a user.

About this task

You must use the same authentication method that is currently used by Datacap.

e (Creating or ensuring an account exists for Rulerunner
You must create or ensure that a domain/Windows account exists for the Rulerunner Service.
e Authenticate Rulerunner Service
You must set up the Rulerunner Service to use one of the authentication systems that are supported by
Datacap.
e Authenticating Rulerunner using Datacap authentication
You must prepare Rulerunner to use Datacap authentication.

Parent topic: Installing and configuring the Rulerunner Service

Creating or ensuring an account exists for Rulerunner

You must create or ensure that a domain/Windows account exists for the Rulerunner Service.

About this task

Datacap does not require that a unique Windows account be set up for Rulerunner. Rulerunner can use any
Windows account provided that account can be set up with the appropriate sharing and security permissions.
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For example, all instances of Rulerunner can use the same account.

Parent topic: Configuring Rulerunner authentication

Authenticate Rulerunner Service

You must set up the Rulerunner Service to use one of the authentication systems that are supported by
Datacap.

TMA authentication

You must do the following when Datacap is set up to use the TMA authentication method.

Ensure that a Datacap user exists in your application that the Rulerunner Service can use. All instances
of Rulerunner can use the same user. For details, see Adding a Datacap user to your application.

Ensure that a Datacap station exists in your application that the Rulerunner Service can use. All
instances of Rulerunner can use the same station. For details, see Adding a Datacap station to your
application.

In the Rulerunner Manager, set up each instance of Rulerunner to use Datacap Authentication and enter
the Datacap user, password, and Datacap station information.

ADSI and LDAP authentication

You must do the following when Datacap is set up to use the ADSI or LDAP authentication method.

Obtain the name of the domain in which Datacap and your authentication server are located. For details,
see Obtaining the name of the domain.

Obtain the name of the Datacap Active Directory (AD) or Lightweight Directory Access Protocol (LDAP)
security group that is used to authenticate Rulerunner. For details, see Obtaining the name of the
AD/LDAP security group

Ensure that at least one domain/Windows account exists that the Rulerunner Service can use, and that
the Windows account is part of the Datacap AD/LDAP security group. All instances of the Rulerunner
Service can use the same Windows account. When you install and configure Rulerunner, be sure to use
this Windows account for the Rulerunner Service.

Add a Datacap group to your application with a name that corresponds to the AD/LDAP security group
and short domain name. For details, see Adding a Datacap group to your application for Rulerunner.
Add a Datacap station for each Rulerunner server. The station name must be the same name as the
Rulerunner server to your Datacap application. For details, see Adding a Datacap station to your
application for Rulerunner.

In the Rulerunner Manager, set up each instance of Rulerunner to use Windows Authentication.

ADLDS and LLLDAP authentication

You must do the following when Datacap is set up to use the ADLDS or LLLDAP authentication method.

Ensure that an account exists for the Rulerunner Service and that the account is set up in the ADLDS or
LLLDAP authentication system. All instances of the Rulerunner Service can use the same account.
Ensure that a Datacap user exists that corresponds to the ADLDS or LLLDAP account. All instances of
Rulerunner can use the same user.

Ensure that a Datacap station exists that the Rulerunner Service can use. All instances of Rulerunner can
use the same station.

In the Rulerunner Manager, set up each instance of Rulerunner to use Datacap Authentication and enter
the Datacap user, password, and Datacap station information.
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e QObtaining the name of the domain
When the Datacap Server Service is configured to use external AD (ADSI) or LDAP authentication, you
need a short domain name of a domain. This domain is where the Datacap-specific Active Directory (AD)
or Lightweight Directory Access Protocol (LDAP) security group was created.

e Obtaining the name of the AD/LDAP security group
If you use ADSI or LDAP authentication, the domain/Windows account that is used by the Rulerunner
Service must be part of a Datacap-specific Active Directory (AD) or Lightweight Directory Access
Protocol (LDAP) security group.

e logging in to Datacap Web Client
You must log in to Datacap Web Client to authenticate Datacap groups, stations, and users to
Rulerunner.

e Adding a Datacap group to your application for Rulerunner
You can add a Datacap group to your application for Rulerunner when you use either the AD (ADSI) or
LDAP external authentication system.

e Adding a Datacap station to your application for Rulerunner
You can add a Datacap station to your application for Rulerunner when you use the AD (ADSI) or LLLDAP
external authentication system.

e Adding a Datacap user to your application for Rulerunner
You can add a Datacap user to your application for the Rulerunner Service when you are using ADLDS or
LLLDAP external authentication.

Parent topic: Configuring Rulerunner authentication

Obtaining the name of the domain

When the Datacap Server Service is configured to use external AD (ADSI) or LDAP authentication, you need a
short domain name of a domain. This domain is where the Datacap-specific Active Directory (AD) or
Lightweight Directory Access Protocol (LDAP) security group was created.

About this task

You use the short domain name to set up the corresponding Datacap group in your Datacap application. You
must know the exact spelling of the domain.

Parent topic: Authenticate Rulerunner Service

Obtaining the name of the AD/LDAP security group

If you use ADSI or LDAP authentication, the domain/Windows account that is used by the Rulerunner Service
must be part of a Datacap-specific Active Directory (AD) or Lightweight Directory Access Protocol (LDAP)
security group.

About this task

Obtain the name of Datacap-specific Active Directory (AD) or Lightweight Directory Access Protocol (LDAP)
security group.

Parent topic: Authenticate Rulerunner Service

Logging in to Datacap Web Client

You must log in to Datacap Web Client to authenticate Datacap groups, stations, and users to Rulerunner.
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Before you begin

Before logging in to Datacap Web Client, start or ensure the Datacap Server Service is started.

Procedure

To log in to Datacap Web Client:

1. Open Internet Explorer, and enter the address of the Datacap web server (http://WebServerName). After
a pause, the Datacap Login window opens.
Tip: You might have to turn off Internet Explorer popup blocker the first time you display the Login page.
2. On the Datacap Web Client Login page, select the appropriate application, enter your User ID, Password,
and Station, then click Login.

Parent topic: Authenticate Rulerunner Service

Adding a Datacap group to your application for Rulerunner

You can add a Datacap group to your application for Rulerunner when you use either the AD (ADSI) or LDAP
external authentication system.

About this task

The Datacap group name must correspond to the security group name set up in the authentication system.

Procedure

To add a Datacap group to your application:

1. On the Datacap Web Client Administrator tab, select the Groups tab.
2. Click New and replace the default text in the Name and Description fields. The Group ID for the
Rulerunner Service requires the following structure.
o Your Datacap security group name, such as TMUsers.
o Adot

o The short name of the domain in which your Datacap security group is located, such as the XYZ
domain.

In this example, TMUsers . XYz would be the Datacap Group ID.
Each field can contain a maximum of 100 characters.

3. Since you are using this group to grant permissions to Rulerunner to process background tasks, under
Permissions, select the appropriate background tasks in each job, then click Save group.

Parent topic: Authenticate Rulerunner Service

Adding a Datacap station to your application for Rulerunner

You can add a Datacap station to your application for Rulerunner when you use the AD (ADSI) or LLLDAP
external authentication system.

About this task
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Use the name of the Rulerunner server as the station name. You must enter the Rulerunner server name
exactly as it was identified to the Domain Controller. For example, if the Rulerunner server name that is
identified in the Domain Controller is in all capital letters, be sure to enter the station name in all capitals.

If you are setting up more than one Rulerunner server, repeat these instructions to add a station for each
Rulerunner server.

Procedure

To add a Datacap station to your application:

1. On the Datacap Web Client Administrator tab, select Stations.

2. Click New and enter the name of the Rulerunner server name exactly as it was identified to the Domain
Controller. Enter a Description.

3. Set the Maximum number of virtual stations to 9999, then click Save.

4, Since you are using theRulerunner server as the station to run background jobs with Rulerunner, under
Permissions, select the appropriate background tasks in each job, then click Save.

Parent topic: Authenticate Rulerunner Service

Adding a Datacap user to your application for Rulerunner

You can add a Datacap user to your application for the Rulerunner Service when you are using ADLDS or
LLLDAP external authentication.

About this task

The Datacap user name must correspond to the name of the account that you set up for Rulerunner in the
ADLDS or LLLDAP authentication system.

Procedure

To add a Datacap user to your application:

1. On the Datacap Web Client Administrator tab, select Users.

2. Click New and replace the default text in the Name field with the account name exactly as it was set up
in the ADLDS or LLLDAP authentication system. Enter the Description. Then, enter the password of the
ADLDS or LLLDAP account in both password fields and click Save user.

3. Because you are using this user to grant permissions to Rulerunner to process background tasks, under
Permissions, select the appropriate background tasks in each job, then click Save user.

Parent topic: Authenticate Rulerunner Service

Authenticating Rulerunner using Datacap authentication

You must prepare Rulerunner to use Datacap authentication.
Before you configure Rulerunner Service to use Datacap authentication:

e Create or ensure that a domain/Windows account exists for the Rulerunner Service.
e Add a User ID and Station ID to your Datacap application for the Rulerunner Service.
e Configure the Rulerunner Service to use Datacap authentication.
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e Grant the Rulerunner Service domain/Windows account the appropriate sharing and security
permissions to the Datacap folders.

Parent topic: Configuring Rulerunner authentication

Installing and configuring the Rulerunner Service

You can install and configure the Rulerunner Service in an environment where Datacap is running successfully.
Where the Workstation and Server are separate machines. And where you are adding one or more additional
Rulerunner servers to host instances of the Rulerunner Service.

For the purpose of these instructions, the scenario includes computers in this configuration:

e A Windows Server 2008 hosts the Datacap Server, application files, batch files, and databases.

e One or more Windows 2008 Rulerunner servers each host an instance of the Rulerunner Service.
e One or more Workstations host either a browser or the Datacap Client software.

e At least one developer workstation hosts the complete Datacap Client software component.

e Shutting down the Datacap software
Before you start the installation and configuration process, you might want to identify which Datacap
software is running so that you can restart it after you install Rulerunner.

e Configuring Rulerunner security and permissions on the Datacap server
You must to set up sharing permissions and security for the Rulerunner Service domain/Windows
account on various folders when the Datacap Server is running on Windows 2008.

e Installing Rulerunner on the Rulerunner server
You run the Datacap installation program wizard on the Rulerunner server to install the necessary
Datacap software components.

e Installing third party software components on Rulerunner server
Each Rulerunner server that hosts Rulerunner requires that the appropriate Datacap and related third
party software components be installed if you want Rulerunner to run tasks that use those components.

e Importing encryption keys to Datacap computers
In aclient/server configuration, you must import security encryption keys to the computer where you
are installing and configuring each Datacap component. This requirement secures passwords that are
sent across the network between Datacap servers and clients.

e Setting the location of the datacap.xml file
You must define the location of the Datacap application settings by using the Datacap Application
Manager. The datacap.xml file contains the application settings.

e Granting permissions to the Rulerunner account on the Rulerunner server
You must grant the Rulerunner domain/Windows account the appropriate permissions on its host
Rulerunner server using DCOM Config.

e Setting up security on the systemprofile\AppData folder for Rulerunner
You can set up the appropriate security permissions for Rulerunner on the
c:\Windows\SysWOWeé4\config\systemprofile\AppData folder on the Rulerunner server when the
operating system is Windows 2008.

e Granting Rulerunner the Log On as Service privilege
You can ensure the domain/Windows account used by Rulerunner has been granted the Log On as a
Service privilege on its Rulerunner server.

Parent topic: Installing and configuring the Rulerunner Service

Shutting down the Datacap software
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Before you start the installation and configuration process, you might want to identify which Datacap software
is running so that you can restart it after you install Rulerunner.

About this task

Shut down all of the Datacap software that is running in your environment in the following sequence.

Procedure

To shut down the Datacap software:

1. Shut down all Datacap client software such as Datacap Desktop, Datacap Studio, Maintenance Manager,
FastDoc, and all Datacap web clients.

2. Shut down Datacap Web Services and all other web services, such as Report Viewer, Fingerprint Service,
and the Datacap Web Client Upload Service.

3. Shut down Datacap Server Service.

4. Stop or ensure the Datacap Server Service is stopped.

Parent topic: Installing and configuring the Rulerunner Service

Configuring Rulerunner security and permissions on the
Datacap server

You must to set up sharing permissions and security for the Rulerunner Service domain/Windows account on
various folders when the Datacap Server is running on Windows 2008.

e Setting up sharing permissions for Rulerunner on the Datacap folder
You must set up the appropriate sharing permissions for the Rulerunner Service account on the Datacap
Server shared c:\Datacap folder.

e Setting up security for Rulerunner on the Datacap folder
You must set up the appropriate security for the Rulerunner Service account on the Datacap Server
shared c:\Datacap folder.

e Setting up security on the RRS folder
You must set up the appropriate security permissions for the RRS folder on the Datacap Server when the
Server is running on Windows 2008. The other accounts were granted security permissions during the
installation and configuration of Datacap.

e Setting up security on the Datacap\Application folder for Rulerunner
You must set up the appropriate security permissions for Rulerunner on the c:\Datacap\Application
folder on the Datacap Server when the Server is running on Windows 2008.

Parent topic: Installing and configuring the Rulerunner Service

Setting up sharing permissions for Rulerunner on the Datacap
folder

You must set up the appropriate sharing permissions for the Rulerunner Service account on the Datacap Server
shared c:\Datacap folder.

About this task
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These instructions apply when the Server's operating system is Windows 2008. Note that other accounts were
already granted sharing permissions during the installation and configuration of Datacap.

Procedure

1. On the Server, start Windows Explorer, navigate to and right-click the c:\Datacap folder and select
Properties.

2. Click the Sharing tab to display it. The folder should already be shared with the Share name of Datacap.

3. Then, click Advanced Sharing. When User Account Control (UAC) is on, the User Account Control window
is displayed. Click Yes.

4. Click Permissions. Add or ensure that the domain/Windows User ID of the Rulerunner Service is set to
allow Full Control.

Parent topic: Configuring Rulerunner security and permissions on the Datacap server

Setting up security for Rulerunner on the Datacap folder

You must set up the appropriate security for the Rulerunner Service account on the Datacap Server shared
c:\Datacap folder.

About this task

These instructions apply when the operating system is Windows 2008. Note that other accounts were already
granted security permissions during the installation and configuration of Datacap.

Procedure

1. On the Server, start Windows Explorer, navigate to and right-click the c:\Datacap folder and select
Properties.

2. Click the Security tab to display it. Then, click Edit. When User Account Control (UAC) is on, the User
Account Control window is displayed. Click Yes.

3. Add or ensure that the domain/Windows User IDs of Rulerunner Service account is set to allow Full
Control.

Parent topic: Configuring Rulerunner security and permissions on the Datacap server

Setting up security on the RRS folder

You must set up the appropriate security permissions for the RRS folder on the Datacap Server when the Server
is running on Windows 2008. The other accounts were granted security permissions during the installation and
configuration of Datacap.

Procedure

To set up security on the RRS folder:

1. On the Server, start Windows Explorer, navigate to and right-click the c:\Datacap\RRS folder and select
Properties.

2. Click the Security tab, then click Edit.

3. Add or ensure that the Domain/Windows User ID of the Rulerunner Service is set to allow Full Control.

Parent topic: Configuring Rulerunner security and permissions on the Datacap server
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Setting up security on the Datacap\Application folder for
Rulerunner

You must set up the appropriate security permissions for Rulerunner on the c:\Datacap\Application folder on
the Datacap Server when the Server is running on Windows 2008.

About this task

If you are setting up Rulerunner to run tasks from more than one application, repeat these instructions for each
C:\Datacap\Application folder, where Application is the application installation subdirectory. For example:

Datacap Medical Claims
C:\Datacap\Medical Claims\

Datacap Accounts Payable
C:\Datacap\APT\

Datacap TravelDocs
C:\Datacap\TravelDocs\

Note that other accounts were already granted security permissions during the installation and configuration of
Datacap.

Procedure

1. On the Server, start Windows Explorer, navigate to and right-click the c:\Datacap\Application folder and
select Properties.

2. Click the Security tab, then click Edit.

3. Add or ensure that the domain/Windows User ID of the Rulerunner Service is set to allow Full Control.

Parent topic: Configuring Rulerunner security and permissions on the Datacap server

Installing Rulerunner on the Rulerunner server

You run the Datacap installation program wizard on the Rulerunner server to install the necessary Datacap
software components.

About this task

The components that you install include the Rulerunner software component, the Datacap Client software
component, and the separately licensed Datacap connectors for which you have a license.

These instructions apply to servers that are running on Windows 2008.

If you have multiple Rulerunner servers, repeat this process for each server.

Procedure

To install Rulerunner on the Rulerunner server:

1. Make the installation package available on your network, or insert the Datacap CD in the Rulerunner
server’s CD/DVD drive. If the installation process does not start automatically, or if the package is on the
network, open Windows Explorer, navigate to and double-click the Setup.exe. When User Account
Control (UAC) is on, the User Account Control window opens. Click Yes.
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2. Select the appropriate language, then click OK. The language that you select determines the language
that is displayed by the installation program wizard during the installation process.

3. When more, redistributable software is required, the installation program wizard displays a list of the
items to be installed. Click Install.

4. Click Next.
5. Accept the license agreement. Then, click Next.
6. Select the Custom option. Then, click Next.
7. Exclude all components from the installation process except the Datacap Client, Rulerunner, and the
separately licensed connectors for which you have a license.
8. Click Next.
9. Click Install.
10. Click Finish.

Parent topic: Installing and configuring the Rulerunner Service

Installing third party software components on Rulerunner
server

Each Rulerunner server that hosts Rulerunner requires that the appropriate Datacap and related third party
software components be installed if you want Rulerunner to run tasks that use those components.

When you installed Rulerunner, you were instructed to install Rulerunner as well as other Datacap software
components.

If you are setting up Rulerunner to export to IBM® or third party repositories, ensure that you have installed
whatever additional software is required by those repositories or third party software on each Rulerunner
server.

Parent topic: Installing and configuring the Rulerunner Service

Importing encryption keys to Datacap computers

In a client/server configuration, you must import security encryption keys to the computer where you are
installing and configuring each Datacap component. This requirement secures passwords that are sent across
the network between Datacap servers and clients.

Before you begin

You must generate the encryption keys in the keystore on a server on which the Datacap server software
component is installed. You export the new keys to a key transport file.

Procedure

To import encryption keys to Datacap computers:

1. Find the dc_KTF.xml key transport file in the c:\Datacap\Taskmaster folder on the Datacap server where
you generated and exported the encryption keys.

2. Copy the dc_KTF.xml key transport file to the appropriate folder on the computer where you installed
the new component. The encryption keys are automatically applied to the keystore the next time you
start the Datacap component.

Table 1. Encryption key folder locations by
component
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Component Folder

Datacap Server C:\Datacap\Taskmaster

Datacap applications [ C:\Datacap\Taskmaster

Datacap Desktop C:\Datacap\DcDesktop
Datacap Studio C:\Datacap\DStudio
Datacap FastDoc C:\Datacap\FastDoc

Datacap Report Viewer | C:\Datacap\RV2\bin

Datacap Web Client C:\Datacap\tmweb.net\bin

Datacap Web Services |C:\Datacap\wTM\bin

Parent topic: Installing and configuring the Rulerunner Service

Setting the location of the datacap.xml file

You must define the location of the Datacap application settings by using the Datacap Application Manager. The
datacap.xml file contains the application settings.

About this task

The datacap.xml file that contains the application settings is on the Datacap server.

Procedure

To set the location of the datacap.xml file:

1. In the Start menu, select IBM Datacap Services>Datacap Application Manager. If the User Account
Control window opens, click Yes.

2. Click the Service tab to display it.

3. Change or ensure that the path reflects the correct location of the datacap.xml file. For example,
\\Server\Datacap\datacap.xml

4, Close the Datacap Application Manager.

Parent topic: Installing and configuring the Rulerunner Service

Granting permissions to the Rulerunner account on the
Rulerunner server

You must grant the Rulerunner domain/Windows account the appropriate permissions on its host Rulerunner
server using DCOM Config.

Procedure

To grant permissions to the Rulerunner account on the Rulerunner server:

1. From the Rulerunner server's Windows Start menu, select Administrative Tools > Component Services >
Computers > My Computer > DCOM Config.
2. In the middle pane, locate, right-click the DCOProcessor application, then select Properties.
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. Click the Security tab to display it.

. Under Launch and Activate Permissions, select Customize, then click Edit.

. Add the Rulerunner domain/Windows account and set Local Launch and Local Activation to Allow.
. Click OK.

. Click OK.

. In the middle pane, locate, right-click the RRProcessor application, then select Properties.

. Click the Security tab to display it.

10. Under Launch and Activate Permissions, select Customize, then click Edit.

11. Add the Rulerunner domain/Windows account and set Local Launch and Local Activation to Allow.
12. Click OK.

13. Click OK.

14. Close the Component Services window.
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Parent topic: Installing and configuring the Rulerunner Service

Setting up security on the systemprofile\AppData folder for
Rulerunner

You can set up the appropriate security permissions for Rulerunner on the
c:\Windows\SysWOWeé4\config\systemprofile\AppData folder on the Rulerunner server when the operating
system is Windows 2008.

About this task

If you are setting up multiple Rulerunner servers, repeat these instructions on each Rulerunner server.

Procedure

To set up security for Rulerunner:

1. On the Rulerunner server, start Windows Explorer, navigate to and right-click the
c:\Windows\SysWOW&é4\config\systemprofile\AppData folder and select Properties.

2. Click the Security tab, then click Edit.

3. Add or ensure that the domain/Windows User ID of the Rulerunner Service is set to allow Modify.

Parent topic: Installing and configuring the Rulerunner Service

Granting Rulerunner the Log On as Service privilege

You can ensure the domain/Windows account used by Rulerunner has been granted the Log On as a Service
privilege on its Rulerunner server.

About this task

This privilege allows Datacap Rulerunner Service to run as a service.

If you have multiple Rulerunner servers, repeat this process on each server.

Procedure

To grant Rulerunner the Log On as Service privilege:
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4.
5.
6.

. From the Rulerunner server's Windows Start menu, select Administrative Tools > Services. Then right-

click Datacap Rulerunner Service and select Properties.

. Click the Log On tab and select This account.
. Click Browse and select the domain/Windows account for Datacap Rulerunner Service. Enter the

password of the account twice, and click Apply.
Click OK to close the message box.

Click OK to close the Properties dialog.

Close the Services window.

Parent topic: Installing and configuring the Rulerunner Service

Configuring Rulerunner to run your applications

You can configure one or more instances of Rulerunner to run background tasks from your applications or
workflows.

About this task

Rulerunner can run a Datacap Studio application task that has the following characteristics:

Rules-based
Can be run without human interaction (and therefore does not need a user interface)

Tasks that are typically run by Rulerunner are recognition, image pre-processing, validation, and export tasks.
Virtual scan tasks (VScan) can also be run if they are designed to pick up images automatically, rather than
requiring a user to select images manually.

This section assumes that you have:

Working versions of your Datacap applications, and that you have manually run all of the tasks
successfully.

Configured Rulerunner authentication by following the instructions in either Authenticate Rulerunner
Service or Authenticating Rulerunner using Datacap authentication.

Installed Rulerunner following the instructions in Installing and configuring the Rulerunner Service on at
least one Rulerunner server.

For the purposes of illustration, the configuration used in this scenario includes the following computers:

The Server hosts the Datacap Server Service, the application files for one or more applications, batch
files, and databases.

One or more Rulerunner servers host Rulerunner

One or more Workstations host either a browser or Datacap Client software for your applications.

Gathering information that you need to set up Rulerunner

Before you begin setting up Rulerunner, you must gather the detailed information that is needed to set
up Rulerunner.

Configuring the task profiles for Rulerunner to run

Rulerunner runs the task profiles on the Datacap Application Manager. You must ensure the Datacap
Application Manager lists the task profiles to be run by Rulerunner.

Configuring Rulerunner to run tasks

You can set up one or more threads and configure Rulerunner to run tasks by using that thread. Repeat
the instructions as many times as required to set up tasks from multiple applications.

Starting the Rulerunner Service

After you set up or change the Rulerunner Service, go to the Rulerunner Manager and start the
Rulerunner service.
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Monitoring batches during Rulerunner processing

Monitor your batches using the Datacap Web Job Monitor to watch batches change status as they are
processed by Rulerunner.

Restart Datacap software

After successfully installing, configuring, and by using Datacap Rulerunner to run more tasks, you can
restart the Datacap software that was previously running on other computers.

Rulerunner thread configuration

The number of Rulerunner threads to configure for an application depends on the type of tasks that your
application performs.

Parent topic: Installing and configuring the Rulerunner Service

Gathering information that you need to set up Rulerunner

Before you begin setting up Rulerunner, you must gather the detailed information that is needed to set up
Rulerunner.

Before you begin

You will need to start or ensure the Datacap Server Service is started in order to gather some of the information
needed to set up Rulerunner.

About this task

For each of your applications or workflows, make a list that includes all of the following information. Be sure to
copy the names of these items exactly because they are case-sensitive and the Rulerunner names must match.

Procedure

1.

w

Identify whether Datacap is using Datacap authentication or Windows authentication. If Datacap is
using Windows authentication, identify the type of authentication that being used, such as ADSI, LDAP,
ADLDS, or LLLDAP.

. Identify the externally visible names of your Rulerunner servers and your Datacap Server. These names

are the server names that are maintained by your DNS.

. Identify the number of processors available on each Rulerunner server.
. For each of your Datacap applications, obtain the full UNC path and file names of the Administration

Database and Engine Database.

. For each of your Datacap applications, obtain the full path and folder name of the application or

workflow folder on the server.

. For each of your Datacap applications, obtain the workflow, job, and task name of each background task

that you want Rulerunner to process.
a. To see these names, start your browser and log in to your application by using Datacap Web
Client.
b. Select the Administrator tab, and make a note of the workflow name.
c. Expand the workflow, select the job, and make a note of the Job Name.
d. Expand the job, select the task, and make a note of the Task Name.

. Identify the Task Profile Name of each background task that you want Rulerunner to process. Normally,

the Task Profile Name is the same as the Task Name.
a. To see these names, start Datacap Studio, log in to your application and select the Test tab.
b. On the Workflow tab, expand the job, and make a note of the Task Profile Name.

. Process documents that represent your typical production batches through your application. Identify

approximately how long each potential Rulerunner task takes to process a typical batch. Identify any
peaks or lulls that typically happen during specific time periods, such as daily, weekly, monthly,
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10.

11.

quarterly. Identify whether your input documents must be placed into batches immediately, or if it input
documents can be queued up without being turned into batches immediately. You must collect enough
information to determine the batch creation volumes that your production system must process. This
information helps you determine how many threads must be set up for each batch creation task and
each background task so that your processing capability is maximized. For example, if you have an
application that has one workflow that includes an email batch creation task and a background Profiler
(PagelD and recognition) task, run enough batches to gather the following type of information:

a. Typical batches are processed by email batch creation in 5 seconds.

b. The same batches are processed by Profiler in 100 seconds.

. You can experiment with increasing or decreasing the size of the batches that are produced by the email

batch creation. If you are licensed to use multiple Rulerunner threads, you can calculate the number of
threads that must be dedicated to the longest running tasks to process the pending batches in a timely
manner. Depending on how quickly you want the newly created batches to be processed, you can have
more threads for processing batches than for creating batches. Using the example in step 8, it takes 20
times longer for Profiler to process a batch than for your email batch creation task to create a batch. To
maximize the number of batches that are processed, you might set up 20 Profiler threads for each email
batch creation thread.

You might also want to experiment with changing one or more of the available Datacap priority settings.
Rulerunner priority settings are set at the task level using the Rulerunner Manager. Outside of
Rulerunner, a batch priority can be assigned to batches produced by specific jobs and can be changed in
the Datacap Web Client. On the Administrator tab, select the job and change the value in the Priority
field. You can also enhance your applications to set or change priorities that are based on conditions or
flags by using rules and the @PILOT(PRIORITY) Smart Parameter.

Considering the number of threads that are allowed by your license agreement, and the number of
processors available on each Rulerunner server, identify which tasks from the workflows or applications
that you want to run on specific threads. For more information, see Rulerunner thread configuration.

Parent topic: Configuring Rulerunner to run your applications

Configuring the task profiles for Rulerunner to run

Rulerunner runs the task profiles on the Datacap Application Manager. You must ensure the Datacap
Application Manager lists the task profiles to be run by Rulerunner.

About this task

Before, you begin you must know which tasks and task profiles you want Rulerunner to process. You must have
the exact spelling of each task name and task profile name. Gather the information that you need to set up
Rulerunner before you continue with this procedure.

Procedure

To configure the task profiles for Rulerunner to run:

1.
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o

From the Windows Start menu on the developer workstation, select IBM Datacap Services>Datacap
Application Manager. When User Account Control (UAC) is on, the User Account Control window opens,
click Yes.

. Select your application. Paths display in the fields on the Main tab.

. Ensure that all of the paths are correct.

. Click the Rulerunner tab. This tab displays only the task profiles that Rulerunner is to process.

. To remove a task profile, click the red X next to the profile name. Then, click Yes to confirm you want to

remove the task.

. To add a task profile, click Add new Task.
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7. Enter the name of the task in the first field and enter the name of the task profile in the second field.
Ensure that the spelling and case are correct.

8. Close the Datacap Application Manager.

9. Stop and restart the Datacap Server Service.

Parent topic: Configuring Rulerunner to run your applications

Configuring Rulerunner to run tasks

You can set up one or more threads and configure Rulerunner to run tasks by using that thread. Repeat the
instructions as many times as required to set up tasks from multiple applications.

About this task

Important: You can use this procedure to temporarily set up Datacap authentication and the Datacap admin
user ID and password to make your configuration changes. Be sure to follow the final steps of this procedure to
reset the user ID, password, and authentication method before you disconnect from the Datacap Application
Service.

Procedure

To configure Rulerunner to run tasks:

1. From the Start menu, select IBM Datacap Services > Datacap Rulerunner Manager. If the User Account
Control window opens, click Yes.
. If the Status displayed is Stopped, continue to the next step. If the Status displayed is Running, click
Stop.
. Click the Rulerunner Login tab.
. Select the Datacap Authentication option to enable the login credential fields.
. Enter the User ID, admin, Password, admin, and Station ID, 1. Click Connect.
. Click the Workflow:Job:Task tab. The names of the applications from the datacap.xml file are displayed.
The other pane does not contain threads the first time you use Rulerunner Manager.
7. Click the check box to select your application. The application tree expands with the server, the
Administration database, and the Engine database selected.
8. Right-click in the other pane to display the menu items.
o Expand all - Expands the details of all existing threads.
o Collapse all - Collapses the details of all existing threads.
o Threads
m Clear - Deletes all existing threads.
= Add Thread - Adds a new, empty thread.
®  Add Threads - Adds multiple threads or copies a setting from an existing thread.
o Copy - Copies a selected thread.
o Paste - Adds a copied thread.
o Remove - Deletes the selected thread.
9. Right-click to select Threads and Add Thread. A new thread is added to the pane. For information about
multiple-thread limitations, see Rulerunner thread configuration.
10. To configure the individual thread to run one or more tasks, do one or more of the following actions.

Table 1. Thread configuration options

N
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Option Procedure
Configure a thread to run all job Click the check box next to the workflow name, then click and
tasks in a workflow drag the workflow name onto a thread in the other pane.
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11.
12.

13.
14.
15.
16.
17.

18.
19.
20.
21.
22.
23.
24.

25.
. Close the Rulerunner Manager window.

26

Option

Procedure

Configure a thread to run all tasks
in a single job

Click the check box next to the job name, then click and drag the
job name onto a thread in the other pane.

Configure a thread to run two or
more tasks from a job

Click the check box next to each task, then click and drag the job
onto a thread in the other pane.

Configure a thread to run a single
task

Click the check box next to the task, then click and drag the task
onto a thread in the other pane.

To configure a thread to run more
than one job in the same
application

Click the check box next to each job, then click and drag the
workflow onto a thread in the other pane.

To configure a thread to run tasks
from more than one application

Click the check box next to each task in each application, then
click and drag each job onto a thread in the other pane.

Remove a task from a thread

In the other pane, right-click the task and select Remove to delete
it.

Disable a thread

Click the check box next to the thread (the check mark
disappears), or right-click the thread and select Remove to delete
it entirely.

Remove a thread

Right-click the thread and select Remove.

Remove all threads

Select Threads and Clear.

Click Save or CTRL+S to save your changes. Click Yes to create and save the configuration file.
To set a batch processing task to a higher priority than a batch creation task, select the task. The task ID

appears in the bottom pane.

Change the value in the priority field.

When the task is a batch creation task like VScan, increase the value for the skipsamebatch field.

Click the Settings tab to make settings changes.

Click Save or CTRL+S to save your changes.

Click the Logging tab. When you select the Number of Messages setting on the Quick Log tab, the same
level of logging is automatically applied to the ATM Log, Rulerunner Log, and the RRS Log tabs.

Click the ATM Log tab and select the settings.

Click the Rulerunner Log tab and select the settings.

Click the RRS Log tab and select the settings.

Click Save to save your changes.

When you complete the changes, click the Rulerunner Login tab.

Click Disconnect.

You must complete the following steps to ensure that the authentication credentials for Rulerunner are

set properly.

o Windows authentication - Select the Windows Authentication option.
o Datacap authentication - Select the Datacap Authentication option, enter the User ID of the
Rulerunner domain/Windows account, the Password, and the name of the Rulerunner server as

the Station ID.
Click Save.

What to do next

From a workstation, start your Datacap client application using your admin user ID, password and station ID.
Run your application or applications so that there are batches pending for the tasks that Rulerunner is
configured to process.
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Parent topic: Configuring Rulerunner to run your applications

Starting the Rulerunner Service

After you set up or change the Rulerunner Service, go to the Rulerunner Manager and start the Rulerunner
service.

Procedure

Follow this procedure to start the Rulerunner Service.

1. Go to Start > IBM Datacap Services > Datacap Rulerunner Manager. If the User Account Control window
opens, click Yes.

2. If the Status is Stopped, click Start. The Status changes to Running.

3. Close the Rulerunner Manager window.

Parent topic: Configuring Rulerunner to run your applications

Monitoring batches during Rulerunner processing

Monitor your batches using the Datacap Web Job Monitor to watch batches change status as they are
processed by Rulerunner.

Parent topic: Configuring Rulerunner to run your applications
Related information:
Troubleshooting Rulerunner

Restart Datacap software

After successfully installing, configuring, and by using Datacap Rulerunner to run more tasks, you can restart
the Datacap software that was previously running on other computers.

Restart Datacap software on all computers in the following sequence:

1. Datacap Server Service

2. Datacap Web Client and any Datacap Web Services, such as Report Viewer, wTM, and Fingerprint Service

3. Datacap Client software that includes Datacap Client, Datacap Web Client, Datacap Studio, and any of
the other Datacap Clients

Parent topic: Configuring Rulerunner to run your applications

Rulerunner thread configuration

The number of Rulerunner threads to configure for an application depends on the type of tasks that your
application performs.

Table 1. Thread considerations

Single threads for | When your application's tasks do one or more of the following activities, use one
export tasks Rulerunner thread only:

e Export to a text file or a Microsoft Access database.
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e Export files at the same time to a downstream system (when it is not possible to
predict the effect of multiple threads).

For both the Setup DCO and Fingerprint database, a locking mechanism exists to
prevent two processes from performing updates at the same time. Nevertheless, for
the following task activities, you might want to use a single thread to avoid delays that
are caused by contention:

e Update field positions in the Setup DCO at run time (includes Intellocate).
e Update a Fingerprint database.

Single threads for | Depending on the circumstances, the following action libraries can be run in a single-
other tasks theaded Rulerunner configuration only:

e DatacapBox actions
e Email actions

e Ewsmail actions

e Imail actions

e \/scan actions

For example, each VScan task that looks in a particular folder for the input files must be
set up to run on a single thread. Also, if an email or fax batch creation task is set up to
look in a single mailbox, that task can run on one thread only. The following batch
creation tasks can run concurrently in multiple threads:

e Vscan tasks from two different applications if the tasks look in two different
input folders

e Vscan tasks from a single application but in separate jobs if the tasks look in two
different input folders

e Email or fax tasks from a single application but in separate jobs if the tasks look
in different mailboxes

Multiple threads Apart from those situations in which single threading is required, enable at least the
same number of threads as there are processors in your Rulerunner server. In some
cases, more threads might be possible without diminishing performance. The
maximum number of threads is 150% of the number of processors.

For example, when Rulerunner is installed on a quad core server, enable a minimum of
four threads and a maximum of six threads.

Restriction: The appropriate licensing is required to configure Rulerunner to run
multiple threads.

Parent topic: Configuring Rulerunner to run your applications

Installing and configuring the Datacap Fingerprint Service

The Datacap Fingerprint Service, with actions in the Autodoc actions library, supports the ability to cache and
use the fingerprints from one or multiple Datacap applications simultaneously. The Fingerprint Service
eliminates the fingerprint load time for all but the first batch that is processed by an application.

About this task

The first time that a match is requested by an application, the Fingerprint Service loads the fingerprints for that
application. When more than one application is set up to use a single Fingerprint Service, the first time each
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application requests fingerprint matching, the fingerprints for that application are loaded into memory.
Subsequent requests for matching work with the fingerprints in the cache in memory. When a matching
fingerprint is not found and the application creates a new fingerprint, that new fingerprint is loaded into the
cache.

The Datacap Fingerprint Service is a web service that is based on Microsoft Internet Information Services (IIS).
The service can service multiple client requests simultaneously. The Datacap Fingerprint Service cache is
shared by all threads. Therefore, the single load of fingerprints into the cache for an application is all that is
required even when multiple threads are running.

Any application that uses the FindFingerprint action (from the Autodoc.RRX action library) to perform
fingerprint matching can use the Fingerprint Service. To use the Fingerprint Service, add the
SetFingerprintWebServiceURL action to the application at the batch level before you call the SetFingerprintDir
action.

The Datacap Fingerprint Service is installed as part of the Rulerunner component and requires additional
licensing.

This section provides the information that you need to install and configure the Datacap Fingerprint Service in a
client/server environment.

e Fingerprint Service configuration assumptions
To install, configure, and test the configuration of the Fingerprint Service, you must ensure that certain
requirements are met.

e (Creating or ensuring a Fingerprint Service account exists
Create or ensure a domain/Windows account exists for the Fingerprint Service.

e Setting up sharing permissions for the Fingerprint Service on the Datacap folder
You must set up the appropriate sharing permissions for the Fingerprint Service account on the Datacap
Server's shared c:\Datacap folder.

e Setting up security on the Datacap\application\fingerprint folder for the Fingerprint Service
Set up the appropriate security permissions for the Fingerprint Service account. The security
permissions must be set up on the Datacap Server c:\Datacap\application\fingerprint folder, such as
c:\Datacap\TravelDocs\batches.

e Setting up security on the Datacap\application\batches folder for the Fingerprint Service
Set up the appropriate security permissions for the Fingerprint Service account. The security
permissions must be set up on the Datacap Server c:\Datacap\application\batches folder, such as
c:\Datacap\TravelDocs\batches.

e Installing the Fingerprint Service on the Fingerprint Service server
Run the Datacap installation wizard on the Fingerprint Service server to install software components.
Install the Rulerunner software component that contains the Fingerprint Service software.

e Setting up security on the Datacap\FingerprintService folder for the Fingerprint Service
This procedure provides instructions on how to set up the appropriate security permissions for the
Fingerprint Service account on the c:\Datacap\FingerprintService folder on the Fingerprint Service
server.

e Adding the Fingerprint Service account to the IIS_IUSRS group
You must add the domain/Windows account used by the Fingerprint Service to the IIS_IUSRS group on
its host Fingerprint Service server.

e Adding an Application Pool for the Fingerprint Service
This procedure provides instructions on how to add a Microsoft Internet Information Services (IIS)
Application Pool on the Fingerprint Service server for use by Fingerprint Service.

e Setting up the Fingerprint Service on the Fingerprint Service server
Set up the Fingerprint Service on a web server with Microsoft Internet Information Services (IIS) 7.5.

e Validating the Fingerprint Service installation
This procedure provides instructions on how to confirm that the Datacap Fingerprint Service is
configured properly.
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e Verifying that the Fingerprint Service can load fingerprints from your application
You can verify that the Datacap Fingerprint Service can load fingerprints from your application by using
the Try Fingerprint Service tool and confirming that it loaded the correct fingerprints during the test.

Parent topic: Datacap installation and configuration in a client/server environment

Fingerprint Service configuration assumptions

To install, configure, and test the configuration of the Fingerprint Service, you must ensure that certain
requirements are met.

Before you install the Fingerprint Service, ensure that the following conditions are met.

e All of the applications that you want the Fingerprint Service to support must be installed, configured,
and run successfully without the Fingerprint Service.

e The environment in which these applications are run is an environment where the workstation and
server are separate machines.

e You add a Fingerprint Service server to host the Fingerprint Service.

The scenario includes computers in the following configuration:

e A Windows server hosts the Datacap Server, application files, batch files, and databases.

e A Windows Fingerprint Service server hosts Microsoft Internet Information Services (IIS) and the
Fingerprint Service.

e At least one developer workstation hosts the complete Datacap client software component, including
Datacap Studio.

Before you begin installing the Fingerprint Service, ensure the following conditions.

e You have a working Datacap client/server environment.

e Datacap runs correctly in a client/server environment where the application files are on the Datacap
Server and the application runs correctly from a workstation. This step makes troubleshooting easier,
and narrows down the sources of potential problems.

e If you want the Fingerprint Service to cache fingerprints from two or more Datacap applications, ensure
that those applications are working. In addition, ensure that you manually process batches from start to
finish.

e When you install on client and server computers, ensure that you have administrator access to all
computers on which Datacap software is installed. In addition, ensure that you have administrator
access to the Windows server on which you intend to install the Fingerprint Service.

Parent topic: Installing and configuring the Datacap Fingerprint Service

Creating or ensuring a Fingerprint Service account exists

Create or ensure a domain/Windows account exists for the Fingerprint Service.

About this task

Datacap does not require you to set up a unique Windows account for the Fingerprint Service. The Fingerprint
Service can use any Windows account that you can set up with the appropriate sharing and security
permissions. When the Fingerprint Service is installed on the same web server as Datacap Web Client or Report
Viewer, the Fingerprint Service can use the same Windows account or a different one.

Parent topic: Installing and configuring the Datacap Fingerprint Service
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Setting up sharing permissions for the Fingerprint Service on
the Datacap folder

You must set up the appropriate sharing permissions for the Fingerprint Service account on the Datacap
Server's shared c:\Datacap folder.

About this task

These instructions apply when the Server's operating system is Windows 2008. Other accounts were already
granted sharing permissions during the installation and configuration of Datacap.

Procedure

1. On the Server, start Windows Explorer, navigate to and right-click the c:\Datacap folder and select
Properties.

2. Click the Sharing tab to display it. The folder should already be shared with the Share name of Datacap.

3. Then, click Advanced Sharing. When User Account Control (UAC) is on, the User Account Control window
is displayed. Click Yes.

4. Click Permissions. Add or ensure that the domain/Windows user ID of the Datacap Fingerprint Service is
set to allow Full Control.

Parent topic: Installing and configuring the Datacap Fingerprint Service

Setting up security on the Datacap\application\fingerprint
folder for the Fingerprint Service

Set up the appropriate security permissions for the Fingerprint Service account. The security permissions must
be set up on the Datacap Server c:\Datacap\application\fingerprint folder, such as
c:\Datacap\TravelDocs\batches.

About this task

Other accounts were already granted security permissions during the installation and configuration of Datacap.

Procedure

1. On the server, start Windows Explorer, go to the c:\Datacap\application\fingerprint folder, where
application is the name of your application. Right-click, and select Properties.

2. Click the Security tab, then click Edit.

3. Add or ensure that the domain/Windows user ID of the Fingerprint Service is set to allow Read &
Execute.

Parent topic: Installing and configuring the Datacap Fingerprint Service

Setting up security on the Datacap\application\batches folder
for the Fingerprint Service

Set up the appropriate security permissions for the Fingerprint Service account. The security permissions must
be set up on the Datacap Server c:\Datacap\application\batches folder, such as
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c:\Datacap\TravelDocs\batches.

About this task

Other accounts were already granted security permissions during the installation and configuration of Datacap.

Procedure

1. On the server, start Windows Explorer, go to the c:\Datacap\application\batches folder, where
application is the name of your application. Right-click, and select Properties.

2. Click the Security tab, then click Edit.

3. Ensure that the domain/Windows user ID of the Fingerprint Service is set to allow Read & Execute.

Parent topic: Installing and configuring the Datacap Fingerprint Service

Installing the Fingerprint Service on the Fingerprint Service
server

Run the Datacap installation wizard on the Fingerprint Service server to install software components. Install
the Rulerunner software component that contains the Fingerprint Service software.

Procedure

1. Make the installation package available on your network, or insert the Datacap CD in the Fingerprint
Service server CD/DVD drive. If the installation process does not start automatically, or if the package is
on the network, open Windows Explorer, go to Setup.exe. When User Account Control (UAC) is on, the
User Account Control window opens. Click Yes.

2. Select the appropriate language, then click OK. The language that you select determines the language
that is displayed by the installation wizard during the installation process.

3. When additional software is required, the installation wizard displays a list of the items to be installed.

Click Install.

. Click Next.

. Accept the license agreement. Then, click Next.

. Select the Custom option. Then, click Next.

. Exclude all components from the installation process except the Rulerunner component.

. Click Next.

. Click Install.

10. Click Finish.
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Parent topic: Installing and configuring the Datacap Fingerprint Service

Setting up security on the Datacap\FingerprintService folder
for the Fingerprint Service

This procedure provides instructions on how to set up the appropriate security permissions for the Fingerprint
Service account on the c:\Datacap\FingerprintService folder on the Fingerprint Service server.

Procedure
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1. On the Fingerprint Service server, start Windows Explorer, go to the c:\Datacap\FingerprintService
folder, and right-click to select Properties.

2. Click the Security tab, then click Edit.

3. Add the NETWORK SERVICE and local IUSR and set both to allow Read & Execute.

Parent topic: Installing and configuring the Datacap Fingerprint Service

Adding the Fingerprint Service account to the IIS_IUSRS group

You must add the domain/Windows account used by the Fingerprint Service to the IIS_IUSRS group on its host
Fingerprint Service server.

Procedure

1. From the Fingerprint Service server Windows Start menu, select Administrative Tools > Computer
Management, expand Local Users and Groups, and then select Groups.

2. In the middle pane, right-click the IIS_IUSRS group, and then select Properties.

3. Add the Fingerprint Service domain/Windows account, then click OK to close the Properties window.

4. Close the Computer Management window.

Parent topic: Installing and configuring the Datacap Fingerprint Service

Adding an Application Pool for the Fingerprint Service

This procedure provides instructions on how to add a Microsoft Internet Information Services (IIS) Application
Pool on the Fingerprint Service server for use by Fingerprint Service.

Procedure

1. From the Windows Start menu, select Administrative Tools > Internet Information Services (IIS)
Manager.

. In the Connections pane, expand the computer, right-click Application Pools and select Add Application
Pool.

. Set the Name to fpservice.

. Set the .NET Framework version to .NET Framework v4.0.30319.

. Set the Managed pipeline mode to Integrated.

. Select the Start application pool immediately option, then click OK.
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Parent topic: Installing and configuring the Datacap Fingerprint Service

Setting up the Fingerprint Service on the Fingerprint Service
server

Set up the Fingerprint Service on a web server with Microsoft Internet Information Services (IIS) 7.5.

Procedure

To set up the Fingerprint Service on the Fingerprint Service server:

1. From the Windows Start menu, select Administrative Tools > Internet Information Services (IIS)
Manager.
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2. In the Connections pane, expand the computer and expand Sites. Right-click the Default Web Site, and
then select Add Application.
3. Set the Alias to fpservice.
4, Click Select and select the fpservice Application Pool that you added, then click OK.
5. Set the Physical path by entering or browsing to the installation folder for the Fingerprint Service. The
default location is C:\Datacap\FingerprintService.
6. Click OK to close the Add Application dialog.
7. Click Test Settings.
o If the test of the connection fails, click Close. Ensure that the permissions for the
domain/Windows account are set up correctly, and that the application pool is set up correctly.
Then, begin this procedure again.
o If the test of the connection is successful, click Close, then click OK and continue with the next
step.
8. In the Connections pane, select Application Pools.
9. In the Application Pools pane, select the fpservice application pool.

10. In the Actions pane, click Advanced Settings.

11. Ensure that Enable 32-Bit Applications is set to True.

12. In the Process Model section, click Browse next to Identity.

13. In the Application Pool Identity window, select Custom account and click Set.

14. In the Set Credentials window, enter the Fingerprint Service domain/Windows account information (the
same account that you added to theFingerprint Service server's IIS_IUSRS group) in the format:
accountname@domainname, enter the account password twice, then click OK.

15. In the Process Model section, set Idle Time-out to zero.

16. Click OK.

Parent topic: Installing and configuring the Datacap Fingerprint Service

Validating the Fingerprint Service installation

This procedure provides instructions on how to confirm that the Datacap Fingerprint Service is configured
properly.

Procedure

On the Fingerprint Server, from the Windows Start menu, start Internet Explorer and connect to the Fingerprint
Service test page by entering: http://127.0.0.1/fpservice/Service.asmx?WSDL

Results

If the Service CCO Fingerprints DB Service page is displayed, the Fingerprint Service is configured properly.
Parent topic: Installing and configuring the Datacap Fingerprint Service

Verifying that the Fingerprint Service can load fingerprints
from your application

You can verify that the Datacap Fingerprint Service can load fingerprints from your application by using the Try
Fingerprint Service tool and confirming that it loaded the correct fingerprints during the test.

Before you begin

Before you begin the verification, gather the following information:
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e The full URL of the Fingerprint Service, for example:

http://127.0.0.1/fpservice/Service.asmx?WSDL

e The name of your application, for example: TravelDocs

e The full UNC path to fingerprint directory of your application, for
example:\\ServerName\Datacap\TravelDocs\fingerprint

e The number of fingerprints currently in the fingerprint directory

e The names of some or all of the fingerprint files (.cco files) currently in the fingerprint directory

Procedure

To verify that the Fingerprint Service can load fingerprints from your application:

1. On the Fingerprint Service server, from the Windows Start menu, select IBM Datacap Developer Tools >
Datacap Fingerprint Service Test Tool .

2. Enter the name of your application in the Application Name field.

3. Ensure that the full URL in the Fingerprints URL field is correct. An example of a full URL is
http://127.0.0.1/fpservice/Service.asmx?WSDL.

4. Enter the full UNC path to fingerprint directory of your application in the Fingerprint Directory field, then
click Upload All Fingerprints From Directory.

5. Confirm that the number in the Fingerprints Loaded field is correct, and that the names of the fingerprint
files that are displayed in the pane are correct.

6. Confirm that the Fingerprint Service can match a fingerprint (.cco file) to one of the loaded fingerprints.
In the Find Fingerprint field, browse to or enter the full path to one of the fingerprints that is displayed,
and then click Find Fingerprint. The results of the fingerprint search and matching process are displayed.
The match results are displayed in the format: '1.00;1;0;0' where:

o The first number (1.00;) is from 0.0 to 1.00 where 0.0 means no match was found, and 1.00
means that an exact match was found.

o The second number (1;) is the index of the matching fingerprint in the Fingerprint database.

o The third and fourth numbers (0;0) are the X and Y offset of the test image relative to the stored
fingerprint.

7. Close the Try Fingerprint Service window.

Parent topic: Installing and configuring the Datacap Fingerprint Service

Installing and configuring the Datacap Web Client upload
service

After you scan files and create batches with Datacap, you can upload the files by using the Datacap Web Client
upload service.

About this task

You can upload the files immediately or schedule an upload for a specific time. You can configure the service to
upload the files at a time when network usage is less busy.

You can upload batches with the Datacap Web Client upload service in the following ways:

e Upload batches that are scanned by using the Datacap Web Client.

e Upload batches that are configured to use strict upload. With this method, batches initially are created
on the client with Datacap Desktop, Rulerunner, or FastDoc. The Datacap Web Client upload service
processes strict upload batches by creating batch folders in a shared location and then transfers images
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and the page file. During the scan, the images are stored locally by Datacap Desktop, Rulerunner, or
FastDoc, then the Datacap Web Client upload service uploads them.

e Upload batches with FastDoc by setting the StrictUpload parameter to False and entering an
FDPathMask. The Datacap Web Client upload service runs a batch-creation task, which creates a batch
and then uploads images and XML files. The Datacap Web Client upload service sets the batch level
variable FDBatchID to track the original batch number. It then writes a line for each uploaded batch in
the parent batch in the dir \dc2run.log file. After the batch is successfully processed, the FastDoc page
file is removed.

Procedure

Follow this procedure to set up the Datacap Web Client upload service to run Datacap Web Client uploads in
the background on remote scan stations.

1. Ensure that you are using the correct Datacap software version on all servers and workstations.

2. Install the Datacap files.

3. Edit the configuration file to match your environment and application. Configure the intervals at which
you want the Datacap Web Client upload service to run background uploads.

4. Copy the files to each remote scan station. Edit individual configuration files to reflect the correct scan
operator user ID, password, and station ID. Install the service on each scan station.

5. Configure the service to start automatically and start the service on each remote scan station.

6. Begin or continue scanning.

The Datacap Web Client upload service uses the Local Account to access scanned batches for that scan
station. The upload service accesses the scanned batches in the Datacap Web Client Scan Into folder.
The service also uses that account to upload the scanned batches and delete the batches from that
folder after a successful upload.

If the Scan Into folder is not on the scan station, configure or ensure there is a domain account that
Datacap Web Client Service can use. Set up the appropriate sharing, sharing permissions, and folder
security, and grant the Datacap Web Client Service domain account Full Control on the Scan Into folder.

e Editing the configuration file
The Datacap Web Client upload service configuration file is installed in the Datacap folder after you
configure the system.

e Installing the Datacap Web Client upload service
You can install the Datacap Web Client upload service from the Datacap server, or by copying the
setup.exe file from another computer.

e Configuring applications for the Datacap Web Client upload service
After you install the Datacap Web Client upload service, you must specify which application to use when
you upload batches.

e Uploading batches scanned by using Datacap Web Client
To upload batches that are scanned by using Datacap Web Client, you must change the
dc2Run.exe.config file.

e Uploading batches stored locally by connecting to the Datacap server
When you use Datacap Desktop, Rulerunner, or FastDoc, you can create and store batches locally when
you scan while your system is connected to the Datacap server.

e Uploading completed offline batches by using FastDoc
When you upload batches by using Datacap Web Client or by using StrictUpload=True, you use a
scan task and an upload task.

e Using Datacap Web Client upload service with Datacap Desktop
This section provides information about how to create a working configuration for using Datacap
Desktop, storing the scanned image files locally, and then uploading them automatically to the Datacap
Server using the Datacap Web Client Upload Service.
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e Starting the Datacap Web Client upload service
You configure the Datacap Web Client upload service differently depending on where the Scan Into is
located.

e Viewing the Event Log
If you do not get the results you expect when you use the Datacap Web Client upload service, view the
Application level log in the Event Viewer for the scan station. The log is where any issues or successfully
completed tasks are logged.

e Disabling the Datacap Web Client upload service
You can disable the Datacap Web Client upload service if you are not using the service.

Parent topic: Datacap installation and configuration in a client/server environment

Editing the configuration file

The Datacap Web Client upload service configuration file is installed in the Datacap folder after you configure
the system.

About this task

You configure the system by running the \support\webclientservice\setup.exe script. The configuration file is
an XML file that contains default name-value pairs that must be changed to match your environment and your
requirements.

Ensure that you have a backup copy of the original dc2run.exe.config file. Some of the required changes are
global and affect all copies of the configuration file. Other changes are unique to each scan station. Make the
global changes to a master copy of the configuration file before you copy it to the individual scan stations and
make the station-specific changes.

e Before copying the configuration file to each remote scan station, change the settings required for your
environment and application. Set up the intervals at which you want the Datacap Web Client Service to
run background uploads.

e After copying the file to each individual remote scan station, edit the correct scan operator, user ID,
password, and station ID. The password is saved by using the Datacap Application Manager.

Procedure

To edit the configuration file:

1. Open the dc2Run.exe.config file in Notepad or an XML editor.

2. Before copying the configuration file to each remote scan station, change the settings required for your
environment and application. Set up the intervals at which you want the Datacap Web Client Service to
run background uploads.

3. After copying the file to each individual remote scan station, edit the correct scan operator, user ID,
password, and station ID. The password is saved by using the Datacap Application Manager.

An example of the dc2run.exe configuration file. Some line breaks are used to fit the printed page.

<?xml version="1.0"?>
<configuration>

<configSections>

<sectionGroup name="applicationSettings"
type="System.Configuration.ApplicationSettingsGroup, System,
Version=2.0.0.0, Culture=neutral, PublicKeyToken=b77a5c561934e089">
<section name="dc2Run.Properties.Settings"

type="System.Configuration.ClientSettingsSection, System,
Version=2.0.0.0, Culture=neutral, PublicKeyToken=b77a5c561934e089"
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requirePermission="false"/>
</sectionGroup>
</configSections>
<applicationSettings>
<dc2Run.Properties.Settings>
<setting name="dc2Run localhost utility" serializeAs="String">
<value>http://127.0.0.1/Task/utility.asmx</value>
</setting>
<setting name="Application" serializeAs="String">
<value>APT</value>
</setting>
<setting name="User" serializeAs="String">
<value>admin</value>
</setting>
<setting name="Delay" serializeAs="String">
<value>3000</value>
</setting>
<setting name="RetryDelay" serializeAs="String">
<value>15000</value>

</setting>

<setting name="Station" serializeAs="String">
<value>1</value>

</setting>

<setting name="ShortcutIndex" serializeAs="String">
<value>13</value>

</setting>

<setting name="WorkTimes" serializeAs="String">
<value>15:00-15:00</value>
</setting>
<setting name="StrictUpload" serializeAs="String">
<value>False</value>
</setting>
<setting name="FDPathMask" serializeAs="String">
<value>C:\Datacap\FastDoc\batches\APT\*\finished.xml</value>
</setting>
</dc2Run.Properties.Settings>
</applicationSettings>
<startup><supportedRuntime version="v4.0" sku=".NETFramework,Version=v4.0"/>
</startup></configuration>

Parent topic: Installing and configuring the Datacap Web Client upload service

Installing the Datacap Web Client upload service

You can install the Datacap Web Client upload service from the Datacap server, or by copying the setup.exe file
from another computer.

Procedure

To install the Datacap Web Client upload service:

. On the Datacap server, navigate to the following folders: Datacap > Support > Web Client Service.
. Run the setup.exe file.
. At the User Account Control window, click Yes to start the installation.
. Click Next to continue the installation program.
. Create a Web Client upload service destination folder and then click Next.
. Click Install.
. Click Finish when the installation is complete.
Note:
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When WTM is hosted as a Windows service, an IOException is thrown when either the temporary file
count exceeds 65535 within the user's temporary folder, or if no unique temporary file name is
available. To avoid this exception, any unnecessary temporary files created by the "original file name"
response variable are deleted from memory.

Parent topic: Installing and configuring the Datacap Web Client upload service

Configuring applications for the Datacap Web Client upload
service

After you install the Datacap Web Client upload service, you must specify which application to use when you
upload batches.

About this task

You must also specify the user password for that application and configure these settings on every scanning
client where you installed the Datacap Web Client upload service.
Tip: You must configure your applications regardless of the method that you use to upload batches:

e Uploading batches by using Datacap Web Client
e Uploading batches by using a strict upload
e Uploading batches by using FastDoc

Procedure

To configure applications to use the Web Client upload service

1. From the Datacap folder, open the dc2Run.exe.config file in a text editor.
2. For the setting name parameter, enter the name of the application that you will use to upload the batch
files. For example, if you are uploading batch files to the APT application, enter APT.

<setting name="Application" serializeAs="String">
<value>APT</value>
</setting>

3. Set the user password that is used to authenticate the Datacap application.

a. In Datacap Application Manager, open the application that you are uploading the batches to, such
as APT.

b. From the Custom Values tab, enter the Value name dc2run.User in the Advanced Values
section. The value for User must be the Datacap user and must be the same user in the
dc2Run.exe.config file. The username is case sensitive. For example, if the user is admin, the
name must be dc2run.admin. In the case of a domain user, for example
DEVADO002\ScanUpload, the name must be dc2run.DEVAD002\ScanUpload.

c. In Value field, enter the user password. For example, enter admin. The value name 1: in the
Advanced values section must match the user that is specified in the dc2Run.exe.config file.

d. Click Add Now.

4. From the dc2Run.exe.config file, configure the following settings:

dc2Run_localhost_utility
Change the value of the URL value to reflect the IP address or UNC name of theDatacap Web
Client server and pathtoutility.asmnx.

<setting name="dcZRun_ localhost utility" serializeAs="String">
<value>http://localhost/tmweb.net/Task/utility.asmx</value>

158 Datacap 9.1.3



</setting>

http
Change this setting to https if you are using SSL. This change is made in the master copy of the
configuration file.
<setting name="dc2Run_ localhost utility" serializeAs="String">
<value>http://localhost/tmweb.net/Task/utility.asmx</value>
</setting>

Application
The name of the application to be processed by the Datacap Web Client. This change is made in
the master copy of the configuration file.
<setting name="Application" serializeAs="String">
<value>TravelDocs</value>
</setting>

User

The Datacap User for this application. This change is made in the scan station-specific copy of the
configuration file.

<setting name="User" serializeAs="String">
<value>admin</value>
</setting>

Tip: You can also specify a domain user. For example,
<value>DEVAD002\ScanUpload</value>.

Station
The Datacap Station ID of the User. This change is made in the scan station-specific copy of the
configuration file.

<setting name="Station" serializeAs="String">
<value>remote</value>
</setting>

ShortcutIndex
The btn_ButtonNumber value for the upload task. This change is made in the master copy of the
configuration file.

<setting name="ShortcutIndex" serializeAs="String">
<value>3</value>
</setting>

To determine the appropriate ShortcutIndex value to use:
a. On the Datacap Server, open Windows Explorer and navigate to the Admin database for the
application, which is typically in the application \process folder.
b. Use the appropriate database Client software to open the Admin database.
c. Open the Buttons table, find the upload task in the btn_ButtonName column, and find the
number for the upload task in the btn_ButtonNumber column.
Delay
The amount of time for the service to wait after finishing a successful upload and beginning the
next upload. The value is in milliseconds. This change is made in the master copy of the
configuration file.
<setting name="Delay" serializeAs="String">
<value>3000</value>
</setting>

RetryDelay
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The amount of time for the service to wait between attempts to complete an upload. The value is
in milliseconds. This change is made in the master copy of the configuration file.

<setting name="RetryDelay" serializeAs="String">
<value>15000</value>
</setting>

WorkTimes
Defines the StartTime and StopTime pairs in which the service is to run. Each Start and Stop pair
is defined by using a 24 hour clock or 12 hour clock. You can use a mix of both types of clocks.
Define as many pairs as you need. Within a pair, be sure the StartTime is earlier than the
StopTime, for example:
0 <value>15:02-15:04</value>: An interval defined by using the 24-hour clock
0 <value>3:05 PM-3:07 PM</value>:An interval defined by using the 12-hour clock
0 <value>15:58-16:00;4:06 PM-4:08 PM</value>: Aninterval defined by using the
24-hour clock followed by an interval defined by using the 12-hour clock. To run the
service around the clock, use: <value>0:00-23:59</value>.

<setting name="WorkTimes" serializeAs="String">
<value>14:25-14:27;2:29 PM-2:29 PM</value>
</setting>

Important: The default StartTime and StopTime value is 15:00-15:00. Be sure that you
change the default to an appropriate value for your environment.
StrictUpload
Defines how the batch files are uploaded. Change the value based on the uploading method:

o Set the StrictUpload parameter to True when you upload batches that are created locally
by using Datacap Desktop, Rulerunner, or FastDoc on to distributed systems with a slow or
irregular network connection.

o Set the StrictUpload parameter to False when you upload offline batches by using FastDoc.

<setting name="StrictUpload" serializeAs="String">
<value>True</value>
</setting>

FDPathMask
This value is based on how you upload batches. Clear the FDPathMask setting when you upload
batches with Datacap Web Client or if you are uploading batches that are created locally by using
Datacap Desktop, Rulerunner, or FastDoc. You must set the FDPathMask setting when you upload
offline batches by using FastDoc.

<setting name="FDPathMask" serializeAs="String">
<value>c:\\datacap\FastDoc\batches\*\*\finished.xml</value>
</setting>

5. Save and close the dc2Run.exe.config file.

Parent topic: Installing and configuring the Datacap Web Client upload service

Uploading batches scanned by using Datacap Web Client

To upload batches that are scanned by using Datacap Web Client, you must change the dc2Run.exe.config file.

Procedure

To configure the Web Client upload service to upload batches that are scanned with Datacap Web Client:
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Open the dc2Run.exe.config file in a text or XML editor and change the following settings:

ShortcutIndex
Change the value of ShortcutIndex setting to reflect the btn_ButtonNumber for the upload task. The

change is made in the master copy of the configuration file.

<setting name="ShortcutIndex" serializeAs="String">
<value>3</value>
</setting>

To determine the appropriate ShortcutIndex value to use:

a. On the Datacap Server, open Windows Explorer and navigate to the Admin database for the
application, which is typically in the application \process folder.

b. Use the appropriate database Client software to open the Admin database.

c. Open the Buttons table, find the upload task in the btn_ButtonName column, and find the number
for the upload task in the btn_ButtonNumber column.

StrictUpload
Set the StrictUpload setting to False.
<setting name="StrictUpload" serializeAs="String">
<value>False</value>

</setting>

FDPathMask
Remove the value for the FDPathMask setting.

<setting name="FDPathMask" serializeAs="String">
<value></value>
</setting>

Parent topic: Installing and configuring the Datacap Web Client upload service

Uploading batches stored locally by connecting to the Datacap
server

When you use Datacap Desktop, Rulerunner, or FastDoc, you can create and store batches locally when you
scan while your system is connected to the Datacap server.

About this task

You can use the Web Client upload service to upload those batches to the Datacap server. You must copy the
Application file locally to each scan client where you want to use the dc2run script and set the StrictUpload
setting to True. For example, the local version of the APT.app application uses the C:\Datacap\APT\batches
directory. The main versions used by Datacap Web Client and the verified clients use the shared location. You
must duplicate the Application file locally on the scan client so that you can change the batch folder location.

Procedure

To connect with Datacap directly, and upload the images stored locally:

1. On the scanning workstation, open the dc2run.exe.configfile.
2. Set the following setting: StrictUpload=True.
3. Remove the FDPathMask value.
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4, Copy your application file, such as \\myServer\myShare\datacap.xml, to a different shared directory to
be used by all scan stations or copy it to each scan station. Add the application to the datacap.xml file.
The application entry in the datacap.xml file, such as TravelDocs, must point to the correct location for
TravelDocs.app. If the application file is in a subfolder with the same name, you can use a relative
reference. Otherwise, you can enter the full path, for example:

<app name="APT" ref="APT"></app>
<app name="TravelDocs" ref="c:\datacap\TravelDocs"></app>

5. Copy your application file, such as \\myServer\myShare\TravelDocs\TravelDocs.app, to a different
shared directory to be used by all scan stations or copy it to each scan station to change the batch folder
location.

6. Open the Datacap Application Manager, and click your application.

7. From the Service tab, change the Path to the application management file field to a path to the shared
directory for the scan station clients or to a local path. The Path to the application management file
setting currently points to the datacap.xml file, which populates the list of application names on the
Datacap Application Manager window. Changing the path eliminates changing the settings on each
client. The settings are all saved in one place.

8. From the Main tab, change the Batch folder to point to the local directory where files are to be stored
prior to uploading.

9. Enable Create Batch Directory in Datacap Web Client.

a. Start Datacap Web Client and log in to the application that contains the Upload task.
b. Select Administrator > Workflow and the job that contains the Upload task.
c. Select Upload > Setup > Create Batch Directory and click Save.

Results

When you run the upload task, the upload task creates a batch folder in the shared location and moves files to
it. So the Application file must be saved locally to the Datacap Desktop, Rulerunner, or FastDoc station.
Parent topic: Installing and configuring the Datacap Web Client upload service

Uploading completed offline batches by using FastDoc

When you upload batches by using Datacap Web Client or by using StrictUpload=True, you use a scan task
and an upload task.

About this task

One is a scan task for batch creation, and one is an upload task to upload the batches. However, this scenario,
uploading completed batches offline by using FastDoc, uses only one task, a scanning task. Because there is no
separate upload task, you must go to the Datacap workflow in Datacap Web Client and set the batch creation
task to use the uplBFcl.aspx file.

Procedure

To enable uploading a FastDoc batch with the Web Client upload service:

1. In Datacap, click the Administrator tab and then click Workflow

2. In the Parameters section, set the Program value to up1BFcl.aspx.

3. Click Apply.

4. On the scanning station, open the dc2run.exe.configfile in a text editor.
5. Set the StrictUpload setting to False:
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<setting name="StrictUpload" serializeAs="String">
<value>False</value>
</setting>

6. Set the FDPathMask setting. For example:
<setting name="FDPathMask" serializeAs="String">
<value>c:\\datacap\FastDoc\batches\*\*\finished.xml</value>

</setting>

The service looks for any page files of the specified name.FastDoc saves a page file with the name
finished.xml when the offline workflow is complete.

Parent topic: Installing and configuring the Datacap Web Client upload service

Using Datacap Web Client upload service with Datacap
Desktop

This section provides information about how to create a working configuration for using Datacap Desktop,
storing the scanned image files locally, and then uploading them automatically to the Datacap Server using the
Datacap Web Client Upload Service.

For detailed procedure to install and configure the Datacap Web Client Upload Service, see Installing and
configuring the Datacap Web Client upload service

Overview

One way to increase the performance of using Datacap Desktop (DcDesktop) is to configure it to store the
scanned image files locally, the upload, instead of DcDesktop saving them as it goes over the WAN to the run-
time batch directory. This approach is completely optional and DcDesktop can work without using this
approach.

Note: This configuration adds complexity to the implementation, adds additional configuration to maintain, and
adds more “active” Taskmaster components to each client PC. You might want to try the approach as it
provides more benefits.

Configuration

This functionality involves at least three different "servers": Datacap Server, Datacap Web Server, at least one
“client" PC running DcDesktop. There can be any number of client PCs running DcDesktop. All of these client
PCs must run its own copy of the Datacap Web Client Upload Service. This is a "push" delivery design when the
many client machines individually push their batch images to the Datacap Server.

There is work to be accomplished on both the central system and work to be accomplished on each Datacap
client machine.

One-time procedure

1. On the network share, typically the Datacap share, create a shared network directory with a name
something like "[servername]\Datacap\UploadClientConfig”. This is where a special copy of the
datacap.xml file resides that is leveraged by all client PCs that participate in this DcDesktop-Upload
configuration.

2. Into this network shared directory "UploadClientConfig" copy the current "datacap.xml" file. This shared
file contains UNC-based paths to the various TM applications (in a multi-server environment) and is
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where the Datacap Application Manager on the client PCs usually reference. In this special situation, the
"standard" datacap.xml file is not used because of the changes to be described next.

3. Text-edit the datacap.xml in the shared "UploadClientConfig" directory to change the UNC path
reference to the new share directory described above ("[local drive letter]:\Datacap\[application
name]”).

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<datacap ver="8.0">

<app name="DotScanUploader" ref="C:\Datacap\DotScanUploader "/>
</datacap>

4, The web client Admin configuration for the service feature to work requires a "Scan" task for DcDesktop.
And an "Upload" task for the web client upload service.

Details for the scan task:

This is a Batch Creation task and uses the "DcDesktop" program. Make sure to select:

o “Mode” to “Batch creation”

o “Store” to “Station ID”
In the "Setup" configuration menu, set any Page file name. Enable the "Create batch directory" option.
Set a Main task profile value. In the "DcDesktop" configuration area, set the appropriate option
(ISSScan, TWAINScan, VScan, and so on.)

Details for the Upload task:

Next, configure the Upload task. The important items are:
o The "UplBFcl.aspx" selection
o The “Queue by” must be “Station” (or “Station ID” depending on the version)
The Setup configuration is as below. Enable the option "Create batch directory".
5. The Datacap Studio configuration for the sample project demonstrates what is required for the upload
service feature to work.
Note: No configuration items are actually required for either the DcDesktop or client upload
functionality.
6. Open the Admin database. View the Buttons table. Find the "Upload" row. If the "btn_FileName" column
is blank, enter the value as "tmclient.exe". The required information is the value for that row in the
"btn_ButtonNumber" column. Record this value for use in a later step.

On First Client machine

Perform the following steps:

1. Install TM Web Client Upload Service. For details, see Installing and configuring the Datacap Web Client
upload service

2. Create a directory anywhere on the client PC where DotScan with temporarily save the scanned image
files. In this example "C:\BatchesToUpload".

3. Create a directory under the local Datacap installation directory, that shows the name of the selected TM
application. In this example “DotScanUploader”. (i.e. “C:\Datacap\DotScanUploader”)

4. Copy into this directory a copy of the selected TM application’s .APP file (that is, copy
\\TMServerl\Datacap\DotScanUploader\DotScanUploader.app to
C:\Datacap\DotScanUploader\DotScanUploader.app)

5. Open the TM App Manager and on the Service tab browse to the shared directory described in the
previous instructions to find the datacap.xml. This leverages the edited copy of the selected TM
application’s APP file in the "[servername]\Datacap\UploadClientConfig” directory.

Complete the configuration items on the Main tab, setting the "Batch folder" value to the local directory
created in a previous step (that is, "C:\BatchesToUpload"). The remaining values must be UNC-based to

164 Datacap 9.1.3



match the corresponding values in the primary .APP file.

On the Taskmaster tab check that the connection string values are NOT blank. If they are blank, that
means that the encryption keys (dc_KTF.xml and Windows keystore) on the client machine don’t match
the keys on the TM Server. Update the encryption keys by using the dcskey.exe utility.

Important: When you close the TM App Manager, the “blank” connection strings overwrite the earlier
entries, so a new copy of the .APP file should be created from the original and used again after
correcting the encryption keys.

The Rulerunner tab requires no values for the upload service to work.
On the Custom values tab, in the Advanced values area, create a dc2run user log-in.

The Datacap App Manager configuration is now complete. Close and reopen the App Manager to confirm
that the configuration was correctly saved.

. Edit the file "dc2Run.exe.config" file. The critical configuration items are:

o "dc2Run_localhost_utility" value is your TM web server.

o "Application" value is the name of the TM application to upload.

o "User"is the name of the user that is used by the web client upload service. This is the name of
the user that is included in the TM App Manager's Advanced custom variable (in this case,
"dc2run.admin").

"Station" is the station name under which the upload service is running.

"ShortcutIndex" is the number from the "Upload" row of the Buttons table in the Admin database.
"StrictUpload" is value "True" for uploading the documents that are saved after DotScan.
“Worktimes” is value 00:01-23:59 for the entire day.

"FDPathMask" must be blank.

O O O O ©O

<?xml version="1.0"?>
<configuration>
<configSections>
<sectionGroup name="applicationSettings"
type="System.Configuration.ApplicationSettingsGroup, System, Version=2.0.0.0,
Culture=neutral, PublicKeyToken=b77a5c561934e089">
<section name="dc2Run.Properties.Settings"
type="System.Configuration.ClientSettingsSection, System, Version=2.0.0.0,
Culture=neutral, PublicKeyToken=b77a5c561934e089" requirePermission="false"/>
</sectionGroup>
</configSections>
<applicationSettings>
<dc2Run.Properties.Settings>
<setting name="dc2Run localhost utility" serializeAs="String">
<value>http://tmwebl/tmweb.net/Task/utility.asmx</value>
</setting>
<setting name="Application" serializeAs="String">
<value>DotScanUploader</value>
</setting>
<setting name="User" serializeAs="String">
<value>admin</value>
</setting>
<setting name="Delay" serializeAs="String">
<value>3000</value>
</setting>
<setting name="RetryDelay" serializeAs="String">
<value>15000</value>

</setting>

<setting name="Station" serializeAs="String">
<value>1</value>

</setting>

<setting name="ShortcutIndex" serializeAs="String">
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<value>16</value>

</setting>

<setting name="WorkTimes" serializeAs="String">
<value>00:01-23:59</value>

</setting>

<setting name="StrictUpload" serializeAs="String">
<value>True</value>

</setting>

<setting name="FDPathMask" serializeAs="String">
<value></value>

</setting>

</dc2Run.Properties.Settings>
</applicationSettings>
<startup><supportedRuntime version="v4.0" sku=".NETFramework,Version=v4.0"/>
</startup></configuration>

7. Open DcDesktop and create a batch. After creating the new batch, look in the local scan directory. There
should be a batch sub-directory containing TIF files and an XML file. If not, back up and reconfigure.
8. Open the Event Viewer. Select the Windows Logs, Application. The select Clear Log...
9. Open the Windows Services and set the Log On account.
10. Start the Datacap Web Client Upload Service to perform a test upload. For details, see Starting the
Datacap Web Client upload service
11. Refresh the Event Viewer. A successful upload is indicated by entries and the local batch directory is
emptied.

On subsequent client machines

Complete the following, which includes references to instruction steps of the previous section; see details for
each step there.

1. Install TM Web Client Upload Service. For details, see Installing and configuring the Datacap Web Client
upload service

2. Create temp image folder.

. Create selected TM application folder under [driveletter]:\Datacap

4. Copy the .APP file from the first client machine’s folder listed in the previous step. The .APP need not be
created again.

5. Open the Datacap App Manager and in the Service tab select the same datacap.xml file as in the first
client machine. Verify the Datacap App Manager settings that appear preconfigured.

6. Copy the file "dc2Run.exe.config" file created in the previous section, step 7 to this client PC,
[driveletter]:\Datacap\Taskmaster directory.

7. Perform the Steps 8 to 12 from the previous section to test the upload on this client machine.
Tip: You can also automate many of these steps with a batch file pointing to the appropriate
files/directories to copy.

w

Parent topic: Installing and configuring the Datacap Web Client upload service

Starting the Datacap Web Client upload service

You configure the Datacap Web Client upload service differently depending on where the Scan Into is located.

About this task

You can configure the service to start automatically when the scan station is started.

Procedure
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To start the Datacap Web Client upload service:

1. From the Windows Start menu on the scan station, click Control Panel > Administrative Tools > Services.
2. Right-click Datacap Datacap Web Client Service and select Properties.

3. Change the Startup type to Automatic. Then, click Apply.

4, Start the service:

Option Description

If the Scan Into a. Click Start to start the service.

folder is on the scan b. After the service starts, click OK to close the Property dialog box. The
station service is now functional.

c. Close the Services window.

If the Scan Into a. Click the Log On tab and select This account.
folder is not on the b. Locate or enter the domain name, user name, and password of the
scan station account that the Datacap Web Client Service is to use, and click Apply.

c. Click OK to close the message box. Then, click Start to start the service.
After the service starts, click OK to close the Property dialog box. The
service is now functional.

d. Close the Services window.

Parent topic: Installing and configuring the Datacap Web Client upload service

Viewing the Event Log

If you do not get the results you expect when you use the Datacap Web Client upload service, view the
Application level log in the Event Viewer for the scan station. The log is where any issues or successfully
completed tasks are logged.

Procedure

To view the Event Log:

1. From the Windows Start menu for the scan station, click Control Panel > Administrative Tools > Event
Viewer.

2. Click Application to view a list of log entries. Log entries that are created by the Datacap Web Client
Service show a Source name of Datacap Web Client Service.

3. Double-click a log entry to view it.

Parent topic: Installing and configuring the Datacap Web Client upload service

Disabling the Datacap Web Client upload service

You can disable the Datacap Web Client upload service if you are not using the service.

About this task

Procedure

To disable the Datacap Web Client Web Client upload service:

1. Log on to the scan station.
2. Click Start > Administrative Services > Services, then click Datacap Web Client Service.
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3. Right-click on the highlighted Datacap Datacap Web Client Service service, and click Stop.

Parent topic: Installing and configuring the Datacap Web Client upload service

Starting Datacap Studio

This procedure provides instructions on how to start the Datacap Studio software component.

Before you begin

Before starting Datacap Studio, start or ensure the Datacap Server Service is started.

Procedure

To start Datacap Studio:

1. From the developer workstation's Windows Start menu, select IBM Datacap Developer ToolsDatacap
Studio. When User Account Control (UAC) is on, the User Account Control window opens. Click Yes.

2. Select the application that you want to work with, then click Next.

3. The Datacap Login window opens.

4. Enter a valid Datacap user ID, Password, and Station ID, then click Finish. The Datacap Studio main
window opens with the Rulemanager tab displayed.

Parent topic: Datacap installation and configuration in a client/server environment

Installing and configuring Datacap Maintenance Manager

Datacap Maintenance Manager is a Datacap software component that sets up batch monitoring, status
notification, and automatic deletion of completed batches.

You can use Datacap Maintenance Manager to monitor the status of your Datacap applications.

e Identify batches that meet certain criteria, such as batches that stopped running

e Change the status or order of batches in the job queue to correct problems that occur regularly. For
example, reset a batch status from aborted to pending

e Delete batches or archive batches that completed processing, replaces AutoDelete

e Generate data for reporting with Datacap Report Viewer. For example, you can take a snapshot of the
number of current users

e Notify an administrator that something went wrong with a background server, such as a Rulerunner
server

e Send email notifications or take other actions.

Maintenance Manager includes the following components:

Maintenance Manager
A configuration utility for creating the required settings file and running Maintenance Manager rulesets
manually.

Maintenance Manager actions
A library of actions that you can use to connect to a Datacap application and query the database for
batch information. Modify information in the database, move or delete batches, and send notifications.
You can use these actions in rulesets in an existing Datacap application or you can create a new
application specifically for batch monitoring.
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You can run Maintenance Manager manually by using Maintenance Manager or automatically at scheduled
times by using the Windows Task Scheduler.

To install and configure Maintenance Manager, you must complete the following steps.

1. Create or ensure that an account exists for Maintenance Manager, and grant that account the
appropriate sharing and security permissions on the Datacap Server.

2. On the computer on which the Maintenance Manager process (NENU.exe) is run, add the Maintenance
Manager domain/Windows account to either the Administrators or Backup Operators group.

3. Ensure that the developer was granted sharing and security permissions on the Datacap Server by
following the instructions in the section titled Configure Datacap on Server.

4. Install Maintenance Manager on the developer workstation.

5. After you install and configure Maintenance Manager in a client/server environment, follow the
instructions in Creating a Maintenance Manager application to develop your custom Maintenance
Manager application and set up Windows Task Scheduler to run your Maintenance Manager application.

e (Creating or ensuring an account exists for Datacap Maintenance Manager
Ensure a domain/Windows account exists for Datacap Maintenance Manager. If a domain/Windows
account does not exist for Maintenance Manager, you must create one.

e Setting Datacap Maintenance Manager account permissions for sharing
You set up the appropriate sharing permissions for theDatacap Maintenance Manager account on the
Datacap Server shared c:\Datacap folder.

e Setting Datacap Maintenance Manager account security permissions on the Datacap folder
You must set up the appropriate security for the Datacap Maintenance Manager account on the Datacap
Server shared c:\Datacap folder.

e Setting Datacap Maintenance Manager account security permissions on the Datacap\RRS folder
You must set up the appropriate security for the Datacap Maintenance Manager account on the Datacap
Server shared c:\Datacap\RRS folder.

e Installing the developer workstation software components
Run the Datacap installation program wizard on the workstation of a developer to install the Datacap
software components.

e Importing encryption keys to Datacap computers
In aclient/server configuration, you must import security encryption keys to the computer where you
are installing and configuring each Datacap component. This requirement secures passwords that are
sent across the network between Datacap servers and clients.

Parent topic: Datacap installation and configuration in a client/server environment

Creating or ensuring an account exists for Datacap
Maintenance Manager

Ensure a domain/Windows account exists for Datacap Maintenance Manager. If a domain/Windows account
does not exist for Maintenance Manager, you must create one.

About this task

Datacap does not require that you set up a unique domain/Windows account for Datacap Maintenance
Manager. Maintenance Manager can use any Windows account if account can be set up with the appropriate
sharing and security permissions.

Parent topic: Installing and configuring Datacap Maintenance Manager
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Setting Datacap Maintenance Manager account permissions for
sharing

You set up the appropriate sharing permissions for theDatacap Maintenance Manager account on the Datacap
Server shared c:\Datacap folder.

About this task

These instructions are intended for server environments that are running on supported versions of Microsoft
Windows. Other accounts were granted sharing permissions during the installation and configuration of
Datacap.

Procedure

To set Maintenance Manager account permissions for sharing:

1. On the Datacap Server computer, start Windows Explorer.

. Go to c:\Datacap, right-click on the c:\Datacap folder and select Properties.

. On the Properties dialog, click the Sharing tab. The folder must already be shared with the Share name
of Datacap.

. On the Sharing tab, click Advanced Sharing.

. If the User Account Control window displays, click Yes.

. On the Advanced Sharing dialog, click Permissions.

. On the Permissions for, verify the domain/Windows user ID of Maintenance Manager is set to allow Full
Control.

w N
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Parent topic: Installing and configuring Datacap Maintenance Manager

Setting Datacap Maintenance Manager account security
permissions on the Datacap folder

You must set up the appropriate security for the Datacap Maintenance Manager account on the Datacap Server
shared c:\Datacap folder.

About this task

These instructions are intended for server environments that are running on supported versions of Microsoft
Windows. Other accounts were granted security permissions during the installation and configuration of
Datacap.

Procedure

To set Maintenance Manager account security permissions on the Datacap folder:

1. On the Datacap Server computer, start Windows Explorer.

2. Go to c:\Datacap, right-click on the c:\Datacap folder and select Properties.

3. On the Properties dialog, click the Security tab.

4. Verify the Domain/Windows user ID of Maintenance Manager is set to allow Read & Execute.

Parent topic: Installing and configuring Datacap Maintenance Manager
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Setting Datacap Maintenance Manager account security
permissions on the Datacap\RRS folder

You must set up the appropriate security for the Datacap Maintenance Manager account on the Datacap Server
shared c:\Datacap\RRS folder.

About this task

These instructions are intended for server environments that are running on supported versions of Microsoft
Windows. Other accounts were granted security permissions during the installation and configuration of
Datacap.

Procedure

To set Maintenance Manager account security permissions:

1. On the Datacap Server, start Windows Explorer.

2. Go to c:\Datacap\RRS, right-click on the c:\Datacap\RRS folder and select Properties.

3. On the Properties dialog, click the Security tab.

4. Verify the Domain/Windows user ID of Maintenance Manager is set to allow Read & Execute.

Parent topic: Installing and configuring Datacap Maintenance Manager

Installing the developer workstation software components

Run the Datacap installation program wizard on the workstation of a developer to install the Datacap software
components.

About this task

The software components that you install include the Datacap client and sample applications. Also, the
separately licensed applications, and connectors for which you have a license, the Datacap Studio, FastDoc,
and Maintenance Manager software components.

These instructions apply to workstations that run on Windows 7.

Procedure

To install the developer workstation components:

1. Put the installation package on your network, or insert the Datacap CD in the developer workstation
CD/DVD drive. If the installation process does not start automatically, or if the package is on the
network, open Windows Explorer, go to and double-click the Setup.exe. Click Yes at the User Account
Control window.

2. Select the appropriate language and click OK. The language that you select is displayed on the
installation program screens during the installation.

3. When more, redistributive software is required, the installation program wizard displays a list of the
items that must be installed, click Install.

4, Click Next.

. Click to accept the license agreement and click Next.

6. Select the Custom option and click Next.

[62]
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7. Exclude all of the components except the Datacap Client and the separately licensed applications and
connectors for which you have a license. Be sure the FastDoc, Datacap Studio, and Maintenance
Manager components are included.

8. Click Next.

9. Click Install.

10. Click Finish.

Parent topic: Installing and configuring Datacap Maintenance Manager

Importing encryption keys to Datacap computers

In a client/server configuration, you must import security encryption keys to the computer where you are
installing and configuring each Datacap component. This requirement secures passwords that are sent across
the network between Datacap servers and clients.

Before you begin

You must generate the encryption keys in the keystore on a server on which the Datacap server software
component is installed. You export the new keys to a key transport file.

Procedure

To import encryption keys to Datacap computers:

1. Find the dc_KTF.xml key transport file in the c:\Datacap\Taskmaster folder on the Datacap server where
you generated and exported the encryption keys.

2. Copy the dc_KTF.xml key transport file to the appropriate folder on the computer where you installed
the new component. The encryption keys are automatically applied to the keystore the next time you
start the Datacap component.

Table 1. Encryption key folder locations by

compone nt
Component Folder
Datacap Server C:\Datacap\Taskmaster

Datacap applications [ C:\Datacap\Taskmaster

Datacap Desktop C:\Datacap\DcDesktop
Datacap Studio C:\Datacap\DStudio
Datacap FastDoc C:\Datacap\FastDoc

Datacap Report Viewer | C:\Datacap\RV2\bin

Datacap Web Client C:\Datacap\tmweb.net\bin

Datacap Web Services |C:\Datacap\wTM\bin

Parent topic: Installing and configuring Datacap Maintenance Manager

Configuring authentication for Datacap

You can configure Datacap to use Datacap authentication or to use one of the external authentication methods.
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About this task

The authentication system that you choose affects whether you set up and maintain individual users or groups
in your Datacap applications. The following five authentication systems are supported:

Datacap authentication (referred to as TMA)

Windows Active Directory (referred to as ADSI)

Windows Active Directory Lightweight Directory Services (referred to as ADLDS)

Lightweight Directory Access Protocol (referred to as LDAP)

Low-Level Lightweight Directory Access Protocol (referred to as LLLDAP)

Important: For Datacap Navigator authentication, you can use ADSI (password required), ADLDS, LDAP
(password required), and LLLDAP. Datacap Navigator does not support LDAP and ADSI authentication
using Windows account credentials.

For a planning overview related to domains, Windows accounts, authentication systems, Datacap users,
groups, stations, and databases, see Planning your Datacap system.

Datacap Server service settings

The Datacap Server runs as a Windows service that you can start, pause, or stop in the Datacap Server
Manager window. When you open the Datacap Server Manager dialog window, you can also configure
authentication, database access, batch processing, and the logging level.

TMA authentication system

The Datacap TMA authentication system supports both user and group authentication. You can select
the TMA option from the Datacap Server Manager list of authentication systems. When you select the
TMA authentication system option, the group names, user names, and passwords that you set up in the
Datacap applications are used for authentication. You can set up user authentication credentials for the
Maintenance Manager application, Rulerunner service, Datacap Web Client Upload service, and Datacap
web services.

Active Directory ADSI and LDAP authentication systems

The Active Directory ADSI and LDAP systems authenticate at the group level. You can select the ADSI or
LDAP authentication system option from the Datacap Server Manager list of authentication systems.
When you select the ADSI or LDAP authentication option, the credentials from the Windows account are
used for authentication. For Active Directory domains that have a mutual trust relationship, ADSI and
LDAP systems support the authentication of users in multiple domains.

ADLDS and LLLDAP authentication systems

When the ADLDS or LLLDAP authentication system is used, the user names and passwords that are
entered on Datacap login windows or passed to Datacap by background services and processes are used
for authentication.

LLLDAP group authentication

In the Datacap Server Manager, you can select LLLDAP as your group authentication system. When you
select LLLDAP as your group authentication system, you must set up the Authentication path template
with customized directory configuration properties.

Configuring the Datacap Server service to use an external authentication system

You can configure the Datacap Server service for external authentication. When you open the Datacap
Server Manager, you can select the ADSI, ADLDS, LDAP, or LLLDAP authentication method.
Authenticating Datacap Web Client users with IBM Security Access Manager

Datacap Web can decode WebSEAL directed headers and use the information that is provided in the
headers to authenticate the Datacap user. The extracted identity information is used to retrieve the
LDAP group information for that user by using an LDAP directory bind. Complete the following steps to
authenticate users who are authenticated in Security Access Manager.

Configuring single sign-on (SS0) for Datacap Navigator

You can configure single sign-on (SSO) for Datacap Navigator by using IBM Security Access Manager,
SPNEGO/Kerberos, or container-managed authentication.
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Parent topic: Datacap installation and configuration in a client/server environment
Related concepts:

Datacap Web Services authentication

Related tasks:

Planning your Datacap system

Datacap Server service settings

The Datacap Server runs as a Windows service that you can start, pause, or stop in the Datacap Server Manager
window. When you open the Datacap Server Manager dialog window, you can also configure authentication,
database access, batch processing, and the logging level.

Datacap Server Manager

There are four tabs in the Datacap Server Manager dialog window from which you can configure the Datacap
Server service.

Table 1. Datacap Server Manager configuration dialog window

Name Description

Service tab The Service name of the Windows service is Datacap Server.
TheStatus options are shown as Running, Paused, or Stopped.

You can start, pause, or stop the Datacap server service by selecting the
appropriate icon that is shown under the Status area.

Datacap tab From the Queue by list, select job or task to determine whether queued batches
are processed first by job or by task.

Select the Save deleted batch info in debug table check box to ensure that
information from deleted batches is stored in the debug table of the Engine
database of the application.

Select the Child job inherits priority check box to ensure the priority property of
a child job, such as Fixup, is the same priority as its parent job.

In the Advanced settings pane, you can configure the port connection, set the
database command timeout, select the type of authentication, and configure the
Batch naming template. For more information about Advanced settings, see
Advanced settings for the Datacap Server service.

File system access mask You can add, remove, and edit folders, files, and file categories to which the
tab Datacap Server service is allowed or denied access.

Logging tab The System event log records Windows events. Your placement of the slider in
the Messaging Level area determines the volume and criticality of messages
that are logged.

In the Datacap log pane, you can select the type and volume of Datacap
messages that are logged. The Number of Messages slider indicates the volume
and criticality of messages that are logged. Select the Output to file check box to
specify the file name and location of the Datacap log file.

e Advanced settings for the Datacap Server service
In the Advanced settings pane of the Datacap Server Manager, you can configure the Datacap Server
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service connections port and set the database command timeout. You can also select your
authentication method and configure the batch naming template.

Parent topic: Configuring authentication for Datacap

Advanced settings for the Datacap Server service

In the Advanced settings pane of the Datacap Server Manager, you can configure the Datacap Server service
connections port and set the database command timeout. You can also select your authentication method and
configure the batch naming template.

Datacap Server Manager Advanced settings

Table 1. Advanced settings

Name

Description

Accept connections on port
Field

Designates the TCP/IP port from which the Datacap Server service accepts
connections.

Database command
timeout Field

The timeout value for ADO and OLEDB calls. The value that you enter represents
the number of seconds the Datacap Server service waits for a connection before
the call attempt is terminated.

Authentication system List

Select TMA for the Datacap authentication system or select one of the external
authentication systems. For more information about configuring for external
authentication, see Configuring the Datacap server service to use an external
authentication system.

Authentication path
template Field

Enter the string in the Authentication path template field that is appropriate for
your authentication type. You can modify the default path that is based on the
specific address requirements in your environment.

For ADSI and LDAP, the user password verification can be enabled by adding a
value in the authentication template, ?password:enabled. For ADSI, the
template is WinNT://<%domain%>/<%user%>?password:enabled and for
LDAP the template is LDAP: //<%domain%>.com?password:enabled.

Batch naming template
Field

The batch ID generation is defined in the Batch naming template setting. The
batch ID can be up to 50 characters long and can contain a mix of string
constants and variable fields. A typical batch ID combines a date with a
sequential number.

The default value for the Batch naming template settingis [Y] [m] [d] . [n:6].
For example, if the date of a batch generation is December 16, 2013, the first
batchIDis 20131216.000000 and the second batch ID is 20131216.000001.

The batch ID can contain other text. For example, the Batch naming template
setting, a[Y]bc[m]d[d] [N:6], generates the batch ID,
a2013bcl2dle_000000.

Sample batch Field

When you enter the Batch naming template setting, the Sample batch field
automatically shows the structure of the batch ID that is generated.

Parent topic: Datacap Server service settings

Related tasks:

Configuring the Datacap Server service to use an external authentication system
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TMA authentication system

The Datacap TMA authentication system supports both user and group authentication. You can select the TMA

option from the Datacap Server Manager list of authentication systems. When you select the TMA

authentication system option, the group names, user names, and passwords that you set up in the Datacap
applications are used for authentication. You can set up user authentication credentials for the Maintenance
Manager application, Rulerunner service, Datacap Web Client Upload service, and Datacap web services.

TMA Authentication

&h Datacap
- UseriD Admin DB
Password
Permissions
Run Datacap client Dt
and enter UserlD Acap: I—
- UserlD === | Datacap
Password, and Station Password —_ Server
Statton —
'E n
—i oy
Rulerunner, Datacap Web
Services, Maintenance
Manager, or Client Upload
Service configured with
UserlD, Password, and
Station
f”f ﬂx“‘m
T Does user exist? H'm

Authenticate user via
TMA - Datacap
Admin DB Authentication

T
T

TMA Datacap Server Service

-~ Does password match in Admin DB? ™
.. Does Station exist in Admin DB and
station limit not reachei?f T

T

Login Succeeded.
Grant Permissions by
Lser and groups,

e limited by station.

( Login
failed

e

In Datacap Server Manager, set the Authentication system to TMA.

TMA Datacap users, groups, stations in each application

Add Datacap users to your application. The name and password that you specify when you create the Datacap
user are the credentials that the user and background service or process uses when logging in to Datacap.
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Datacap groups are optional. Add Datacap groups to your application when you want to manage permissions at
the group level. You can add groups to Datacap for users, automatic users, and background services and
processes. The Datacap group hame can be any name that you want. There is no need to create Datacap
groups for Datacap server service, Datacap Web Services, or application pools.

You can add Datacap users to one or more Datacap group. You must be a member of a group to modify
membership of that group.

Add Datacap stations to your application with the appropriate permissions. Station names can be any name
that you want.

TMA Maintenance Manager

The Windows Scheduler runs the Maintenance Manager application automatically and the Maintenance
Manager application supplies its credentials automatically. When a Maintenance Manager rule set is added to a
Datacap application, the rules supply credentials automatically.

Add a Datacap user and password to your application for Maintenance Manager or use an existing
Datacap user with appropriate permissions.
Add a Datacap station to your application for Maintenance Manager and assign appropriate permissions
or use an existing Datacap station with appropriate permissions.
To set up Maintenance Manager credentials for TMA, add a custom name and value pair in the
Application Manager Advanced values fields to hold the password for the Maintenance Manager Datacap
user.

o Value name: Create a value name that is recognizable or can be associated with the Maintenance

Manager user password, such as Maintenance ManagerPassword.

o Value: Enter the Datacap password of the Datacap Maintenance Manager user.
In the Maintenance Manager application, set the parameter of the SetUser action to the Datacap user
name.
In the Maintenance Manager application, set the SetPassword action to use the APPVAR smart
parameter to retrieve the value of Maintenance ManagerPassword from the Datacap application
service.
In the Maintenance Manager application, use the SetStation action to provide the Datacap station name.
In Windows Scheduler, set the account in Security Options to the Windows account used by
Maintenance Manager to run with highest privileges.

TMA Rulerunner Service

The Rulerunner Service is a background service that supplies its credentials automatically.

Add at least one Datacap user for Rulerunner to the Datacap application or use an existing Datacap user
with appropriate permissions.

o If one instance of Rulerunner is set up to process tasks from multiple applications, the same

Datacap user name and password must be added to all applications.

o If multiple instances of Rulerunner are set up, they can all use the same Datacap user.
Add one Datacap station for each Rulerunner, create one Datacap station for the Rulerunner to share, or
use an existing Datacap station with appropriate permissions.
Set up the credentials in each Rulerunner Manager by selecting the Datacap Authentication option on
the Rulerunner Login tab. Enter the Datacap user name, password, and station for this instance of
Rulerunner.

TMA Datacap Web Client Upload Service

The Datacap Web Client upload service is a Windows service that supplies its credentials automatically.
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e Add at least one Datacap user for the upload service to the Datacap application or use an existing
Datacap user with appropriate permissions.
e Add at least one Datacap station for the upload service to the Datacap application or use an existing
Datacap station with appropriate permissions.
e Set up the credentials by adding a name and value pair in the Application Manager Advanced values
fields to hold the password of the Datacap upload service user.
o Value name: Must be dc2run.User
o Value: Enter the password of the Datacap upload service user.
e Inthe Datacap Web Client Upload configuration file, set the value of the <setting name="User" node
to the Datacap Upload Service user.
e Inthe Datacap Web Client Upload configuration file, set the value of the <setting name="Station"
node to the Datacap Upload Service station.

TMA Application Pools

Datacap uses application pools for Datacap Web Client, Report Viewer, and the Fingerprint Service. When
Datacap Web Client and Report Viewer are installed on the same web server, they must use the same Windows
account. When the Fingerprint Service is also installed on the same web server, it can use the same Windows
account or a different one. The Windows account that is assigned to the application pool allows the application
pool to function. When you assign the Windows account to the application pool, you provide the Windows
credentials that the application pool uses.

There is no need to set up Datacap users, stations, or groups for application pools.

TMA Datacap web services (WTM)

Datacap web services supplies its credentials automatically.

e Add a Datacap user for wTM to the Datacap application or use an existing Datacap user with appropriate
permissions.

e Add a Datacap station for wTM to the Datacap application or use an existing Datacap station with
appropriate permissions.

e Set up the credentials by adding a name and value pair in the Application Manager General string values
fields to hold the user name and station name. Add a name and value pair in the Advanced values fields
for the user password.

o Value name: wIMUser

Value: Set to the Datacap user name.

Value name: wTMStation

Value: Set to the Datacap station name.

Value name: wIMPassword

Value: Set to the Datacap user password.

O O O O O

Parent topic: Configuring authentication for Datacap

Active Directory ADSI and LDAP authentication systems

The Active Directory ADSI and LDAP systems authenticate at the group level. You can select the ADSI or LDAP
authentication system option from the Datacap Server Manager list of authentication systems. When you select
the ADSI or LDAP authentication option, the credentials from the Windows account are used for authentication.
For Active Directory domains that have a mutual trust relationship, ADSI and LDAP systems support the
authentication of users in multiple domains.
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When you log into a Datacap application, you enter a password only if the authentication template string
requires password entry. For information about authentication template strings, see Configuring the Datacap

Server service to use an external authentication system.

Active Directory ADSI or LDAP authentication in Datacap

Active Directory is referred to as ADSI in Datacap. You must ensure that the following tasks are completed

when you are using the ADSI or LDAP authentication system.

e Appropriate security groups in Active Directory are created.

¢ Windows accounts are created for Datacap users, background services and processes, and application

pools.

e The Windows accounts for Datacap are added to the appropriate Active Directory security groups.
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In Datacap Server Manager, set the Authentication system to ADSI or LDAP.

ADSI or LDAP Datacap groups and stations
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Depending on the number of ADSI or LDAP security groups you created, add corresponding groups to your
Datacap application and assign Datacap permissions to each group. The Datacap group name must be in the
following format:

e Active Directory security group name
e Adot
e Short domain name (domain without top level)

For example, if the Active Directory security group name is TMUsers and the full domain name is
domain02.com, then the Datacap Group name must be TMUsers.domain02.

There is no need to create Datacap groups for the Datacap server service or for the Datacap Web Client, Report
Viewer, and Fingerprint service application pools.

Add Datacap stations to your application with the appropriate permissions. Users of interactive Datacap
software components enter station names manually so the station names for these users do not need to match
their machine names.

For Maintenance Manager, Rulerunner, Datacap Web Services, and the Datacap Web Client Upload service, the
machine names are provided automatically as the station name. These machine names must be added to your
Datacap application as station names. Station names are case-sensitive.

When you are using ADSI or LDAP, authentication is performed at the group level and there is no need to add
Datacap users to your Datacap applications.

ADSI or LDAP Datacap users

If password entry is not required, the Windows account of the user, background service, or background process
is used for authentication. The following items apply when password entry is not required:

e Users that log in to interactive Datacap software components must enter a user name and station name.
The user must not enter a password even though the Windows account information is used for
authentication.

e Background services or processes must leave the user name, password, and station name blank
because the Windows account information is used for authentication and the machine name is used as
the station name.

For ADSI authentication, Internet Explorer users might need to add the Datacap Web Client tmweb.net address
as a trusted site in their internet security options (for example, add http://WebServerName).

ADSI or LDAP Datacap Studio users

If password entry is not required, users must select the NT Authentication check box to log into Datacap
Studio. Otherwise, if password entry is required, users must enter their full credentials.

ADSI or LDAP Maintenance Manager

The Windows Scheduler runs the Maintenance Manager application automatically. The Windows account that is
used by the Maintenance Manager application and the computer name is used for authentication.

e Add a Datacap station to your application for Maintenance Manager that has the same name as the
machine name and assign appropriate permissions.

e The Windows domain and user name must be used for SetUser to configure Maintenance Manager to
authenticate to the Datacap server service.
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e In Windows Scheduler, set the account in Security Options to the Windows account that is used by
Maintenance Manager to run with highest privileges.

ADSI or LDAP Rulerunner Service

The Rulerunner Service is a background service that supplies its credentials automatically.

e Add a Datacap station to your application for each Rulerunner server and assign appropriate
permissions. The station name in Datacap is case-sensitive and must match the machine name because
it is maintained in the domain controller.

e If password entry is not required, set up the credentials in each Rulerunner Manager by selecting the
Windows Authentication option on the Rulerunner Login tab. Otherwise, if password entry is required,
users enter their full credentials.

ADSI or LDAP Datacap Web Client Upload Service

The Datacap Web Client upload service is a Windows service that supplies its credentials automatically.

e Add a Datacap station for the upload service to the Datacap application and assign appropriate
permissions.
e Set up a blank password to be used by the upload service by adding a name and value pair in the
Application Manager Advanced values fields.
o Value name: Must be dc2run.User
o Value: Leave this field blank.
e Inthe Datacap Web Client Upload configuration file, set the value of the <setting name="User" node
to the domain and Windows account (for example DOMAIN\UserID) of the Datacap Upload Service user.
e Inthe Datacap Web Client Upload configuration file, set the value of the <setting name="Station"
node to the Datacap Upload Service station.

ADSI or LDAP Application Pools

Datacap uses application pools for Datacap Web, Report Viewer, and the Fingerprint Service. When Datacap
Web and Report Viewer are installed on the same web server, they must use the same Windows account. When
the Fingerprint Service is also installed on the same web server, it can use the same Windows account or a
different one. The Windows account that is assigned to the application pool allows the application pool to
function. When you assign the Windows account to the application pool, you provide the Windows credentials
that the application pool uses.

There is no need to set up ADSI or LDAP groups or Datacap users, stations, or groups for application pools.

ADSI or LDAP Datacap stations

Add a Datacap station to your application for wTM with the same name as the machine name and assign
appropriate permissions.

Set up credentials as indicated by the following table:

Value name Value Credentials location

wIMUser Leave this field blank. Application Manager General string values fields

wIMStation |Settothe Datacap station name. | Application Manager General string values fields

wIMPassword | Leave this field blank. Application Manager Advanced values fields

When you log into the station, you are prompted for credentials if password entry is required.
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Parent topic: Configuring authentication for Datacap

ADLDS and LLLDAP authentication systems

When the ADLDS or LLLDAP authentication system is used, the user names and passwords that are entered on
Datacap login windows or passed to Datacap by background services and processes are used for
authentication.

ADLDS or LLLDAP authentication in Datacap

You must create accounts in ADLDS or LLLDAP for Datacap users, background services, and background
processes. Users must enter the user names and passwords of these accounts on the Datacap login windows.
The background services and processes supply the account user names and passwords automatically.

You must also set up the same user names in your Datacap application. The user name and password is
authenticated against your directory server. When the directory server authenticates successfully, the user
name must match the user name in Datacap Administration Database.
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ADLDS or LLLDAP Datacap Server Service

In Datacap Server Manager, set the Authentication system to ADLDS or LLLDAP as appropriate.

ADLDS or LLLDAP Datacap users, groups, stations

Add Datacap users to your application with the same names and passwords that were set up in the ADLDS or
LLLDAP authentication system. The user or background service or process uses these credentials to log int to
Datacap.

Datacap groups are optional. Add Datacap groups to your application when you want to manage permissions at
the group level in addition to or instead of managing individual permissions. You can add groups to Datacap for
users, automatic users, and background services and processes. The Datacap group name can be any name
that you want. There is no need to create Datacap groups for the Datacap Server Service, Datacap Web
Services, or application pools.

When appropriate, add Datacap users to one or more Datacap group or groups.

Add Datacap stations to your application with the appropriate permissions. Station names can be any name
that you want.

ADLDS or LLLDAP Maintenance Manager

The Windows Scheduler runs the Maintenance Manager application automatically and the Maintenance
Manager application supplies its credentials automatically. When a Maintenance Manager rule set is added to a
Datacap application, the rules supply credentials automatically.

e Add a Datacap user and password to your application for Maintenance Manager, or use an existing
Datacap user with appropriate permissions. The user name and password must match a user name and
password that is set up in the ADLDS or LLLDAP authentication system.

e Add a Datacap station to your application for Maintenance Manager and assign appropriate permissions,
or use an existing Datacap station with appropriate permissions.

e Set up Maintenance Manager credentials when you are using ADLDS or LLLDAP. In Datacap Application
Manager, select the application.

o Add a General string name-value pair on the Custom values tab to hold the user name of the
Maintenance Manager user as found in Datacap.

o Add an Advanced values name-value pair on the Custom values tab to hold the password for the
Maintenance Manager Datacap user.

o Add one General string name-value pair on the Custom values tab to hold the Maintenance
Manager station name as found in Datacap.

¢ Inthe Maintenance Manager application, set the SetUser action to use the APPVAR smart parameter to
retrieve the value of the Maintenance Manager user name from Datacap application service.

e Inthe Maintenance Manager application, set the SetPassword action to use the APPVAR smart
parameter to retrieve the value of the Maintenance Manager password from Datacap application service.

e Inthe Maintenance Manager application, set the SetStation action to use the APPVAR smart parameter
to retrieve the value of the Maintenance Manager station name from Datacap application service.

e In Windows Scheduler, set the account in Security Options to the Windows account used by
Maintenance Manager to run with highest privileges.

ADLDS or LLLDAP Rulerunner Service

The Rulerunner Service is a background service that supplies its credentials automatically
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Add at least one Datacap user for Rulerunner to the Datacap application, or use an existing Datacap user
with appropriate permissions. The user name and password must match a user name and password that
is set up in the ADLDS or LLLDAP authentication system. If one instance of Rulerunner is set up to
process tasks from multiple applications, the same Datacap user name and password must be added to
all of the applications. If multiple instances of Rulerunner are set up, they can all use the same Datacap
user.

Add one Datacap station for each Rulerunner, or create one Datacap station for the Rulerunners to
share, or use an existing Datacap station with appropriate permissions.

Set up the credentials that are used by Rulerunner when you are using ADLDS or LLLDAP. In each
Rulerunner Manager, select the Datacap Authentication option on the Rulerunner Login tab. Enter the
Datacap user name, password, and station to be used for the instance of Rulerunner.

ADLDS or LLLDAP Datacap Web Client Upload Service

The Datacap Client Upload Service is a Windows service that supplies its credentials automatically.

Add at least one Datacap user for the Upload Service to the Datacap application, or use an existing
Datacap user with appropriate permissions. The user name and password must match a user name and
password that is set up in the ADLDS or LLLDAP authentication system.
Add at least one Datacap station for the Upload Service to the Datacap application, or use an existing
Datacap station with appropriate permissions.
Set up the credentials that are used by the Upload Service when you are using ADLDS or LLLDAP. In
Datacap Application Manager, select the application and add an Advanced values name and value pair
on the Custom values tab to hold the password for the Upload Service Datacap user.

o Value name — Must be dc2run.User

o Value — Enter the password of the Datacap Upload Service user.
In the Datacap Web Client Upload configuration file, set the value of the <setting name="User" node
to the Datacap Upload Service user.
In the Web Client Upload configuration file, set the value of the <setting name="Station" node to
the Datacap Upload Service station.

ADLDS or LLLDAP Application Pools

Datacap uses application pools for Datacap Web Client, Report Viewer, and the Fingerprint Service. When
Datacap Web Client and Report Viewer are installed on the same web server, they must use the same Windows
account. When the Fingerprint Service is also installed on the same web server, it can use the same Windows
account or a different one. The Windows account that is assigned to the application pool allows the application
pool to function. When you assign the Windows account to the application pool, you provide the Windows
credentials that the application pool uses.

There is no need to set up Datacap users, stations, or groups for application pools.

ADLDS or LLLDAP Datacap Web Services

Datacap Web Services supplies its credentials automatically.

Add a Datacap user for Datacap Web Services to the Datacap application, or use an existing Datacap
user with appropriate permissions. The user name and password must match a user name and
password that is set up in the ADLDS or LLLDAP authentication system.
Add a Datacap station for Datacap Web Services to the Datacap application, or use an existing Datacap
station with appropriate permissions.
Set up the credentials that are used by Datacap Web Services when you are using ADLDS or LLLDAP. In
Datacap Application Manager, select the application.

o Add a General string value name-value pair on the Custom values tab to hold the user name.
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= Value name —wTMUser
= Value — Enter the user name

o Add a General string value name-value pair on the Custom values tab to hold the station name.
= Value name —wTMStation
® Value - Enter the station name

o Enter an Advanced values name-value pair on the Custom values tab to hold the user password.
= Value name — wTMPassword
® Value - Enter the password

Parent topic: Configuring authentication for Datacap

LLLDAP group authentication

In the Datacap Server Manager, you can select LLLDAP as your group authentication system. When you select
LLLDAP as your group authentication system, you must set up the Authentication path template with
customized directory configuration properties.

LLLDAP authentication path template with customized directory configuration
properties

The Authentication path template for LLLDAP group authentication must start with the host : port parameters,
where host is the LDAP server name and port is the port number.

The Bind User and Bind Password can be encrypted by setting custom values the Application Manager.
Values that are specified in the Advanced values field in the Custom values tab are encrypted. You must specify
the application and the Value name in the Datacap Server Manager Authentication path template. For example,
a password that is stored with the Value name, MyBindPassword, in the APT application Advanced values
field, can be retrieved by the LLLDAP authenticator by specifying APT, MyBindPassword in the Authentication
path template.

List of LLLDAP Directory Configuration Properties

Table 1. List of Directory Configuration Properties
Property Name Description

GroupBaseDn Group Base Domain Name

The base domain name for searching for groups in the directory server.

GroupSearchFilter Group Search Filter

Specifies the search filter for groups, such as (& (objectclass=group)
(cn=<%user%>) ), where cn serves as the short name.

GroupSearchFilter and GroupDisplayNameAttribute must use the same LDAP
attribute

GroupShortNameAtr Group Short Name Attribute

Defines the directory server attribute to be used as the short name for a
group.
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Property Name

Description

GroupDisplayNameAttr

Group Display Name Attribute

Specifies the display name for a Group object that is generated by the
authentication provider. The default property value is dependent on the
authentication provider and is specified by the provider's configuration.

GroupMembershipSearchFilter

Group Membership Search Filter

The search filter for group membership queries.

GroupNestedSearch Group Nested Search Filter
Include nested groups for discovering group membership. Valid values are
On and Off. The default value is Off.
UserBaseDn User Base Domain Name
The base domain name for searching for users in the directory server.
UserSearchFilter User Search Filter
Specifies search filter for users, such as (& (objectclass=user)
(samAccountName=<%user%>) ), where samAccountName serves as the
short name.
UserShortNameAttr User Short Name Attribute
Defines the directory server attribute to be used as the short name for a user.
UserDisplayNameAttr User Display Name Attribute
Specifies the display name for a User object that is generated by the
authentication provider. The default property value is dependent on the
authentication provider and is specified by the provider's configuration.
BindUser Bind User

The user name for authenticating the users. This user must have permission
to search the area of LDAP where users are located. This user must have
permission to search outside of the user’s groups and authorization. The
login fails if the application user cannot bind. The bind user can be specified
in plain text or can be encrypted by using the Advanced values field in the
Custom values tab of the Application Manager. When the bind user is stored
in the Application Manager, you must specify the application name and the
Value name as Application,<value name>. For example, enter
APT,MyBindUserValue, where APT is the Datacap application name and
MyBindUser is the Value name in the Custom values field. You must specify
only the Value name. Do not specify the complete @APPVAR path in the
Advanced values field
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Property Name Description

BindPw Bind Password

The password for the Bind User. The bind password can be specified in plain
text or can be encrypted by using the Advanced values field in the Custom
values tab of the Application Manager. When the bind password is stored in
the Application Manager, you must specify the application name and Value
name as Application, <value name>. For example, enter

APT, MyPasswordValue where APT is the Datacapapplication name and
MyBindPassword is the Value name in the Advanced values field. You must
specify only the value name. Do not specify the complete @APPVAR path in
the Advanced values field

AuthAttribute Authorization Attribute

The AuthAttribute value tells Datacap server to authenticate a user with an
additional attribute value, such as AuthAttribute:carLicense=1234.
This value is optional.

Example 1 - LLLDAP group authentication path template

The following is an example of an Authentication path template with customized directory configuration
properties.

MyServer:389/
BindUser:cn=admin, dc=mydomain, dc=com?BindPw:APT, MyBindPassword?
UserBaseDn:ou=people, dc=mydomain,dc=com?UserSearchFilter: (

& (objectClass=inetOrgPerson) (cn=<%Suser

%>) ) ?UserShortNameAttr:cn?UserDisplayNameAttr:uid?GroupBaseDn:
ou=groups, dc=mydomain, dc=com?

GroupSearchFilter: (

& (objectClass=groupOfNames) ) ?GroupShortNameAttr:cn?GroupNestedSearch:on?
GroupDisplayNameAttr:cn?GroupMembershipSearchFilter: (

& (objectClass=groupOfNames) (member=<%user %>))

Example 2 - LLLDAP group authentication path template

The following is an example of an Authentication path template to authenticate a user with the
sAMAccountName attribute.

Server:389/
BindUser:cn=admin, dc=mydomain, dc=com?BindPw:BindPw:APT, MyBindPassword?
UserBaseDn:DC=mycomain, DC=com?UserSearchFilter: (

& (objectClass=user) (sAMAccountName=<%user%$>))?
UserShortNameAttr:cn?UserDisplayNameAttr:uid?GroupBaseDn:

DC=mydomain, DC=com?GroupSearchFilter: (& (objectClass=group))?
GroupShortNameAttr:cn?GroupNestedSearch:on?GroupDisplayNameAttr:cn?
GroupMembershipSearchFilter: (& (objectClass=group) (member=<$user%>))

Parent topic: Configuring authentication for Datacap

Configuring the Datacap Server service to use an external
authentication system
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You can configure the Datacap Server service for external authentication. When you open the Datacap Server
Manager, you can select the ADSI, ADLDS, LDAP, or LLLDAP authentication method.

About this task

In a client/server environment, you can configure Datacap Server service to use an external authentication
provider, rather than using the default Datacap authentication (TMA) option.

Procedure

To configure Datacap Server service to use external authentication:

1. With the Datacap Server Manager window open, stop the service.

2. Click the Datacap tab and click Show advanced.

3. In the Authentication system field, select the type of authentication that you want to use.
Opti
on |Description

ADS | Select this option if you are running Windows Active Directory for authentication. The Active

I Directory server must be part of the domain in which the Datacap computers are located. Select
auth | this option when you do not want all users that are logged in to a Windows domain to retype
enti |their passwords when they log in to Datacap.

cati
on

AD | Select this option if you are running Windows Active Directory Lightweight Directory Service for
LDS |authentication. The AD LDS server can be outside of the domain in which the Datacap

auth | computers are located.

enti
cati
on

LLL |Select this option, rather than LDAP, when you are using authentication providers other than
DAP | Windows Active Directory for authentication. Select this option when you are using providers
auth | such as Oracle Directory Server Enterprise Edition (formerly known as Sun Directory Server
enti |Enterprise Edition). The LLLDAP server can be outside of the domain in which the Datacap
cati | computers are located.

on

LDA | Select this option only if you require that your LDAP server is accessed by using the

P Distinguished Name (DN) of a directory object and the complete LDAP path name. The LDAP
auth | server must be part of the domain in which the Datacap computers are located.

enti
cati
on

4. Enter the string in the Authentication path template field that is appropriate for your authentication type.
You can modify the default path that is shown in the following table for each authentication option that
is based on the specific address requirements in your environment. The Datacap Server service reads
this path entry to determine the credentials for the particular account. For example, when you configure
Active Directory authentication, Datacap looks up the user in Active Directory by using syntax similar to
WInNT://<%domain%>/<%user%>. The <%domain%> and <%user%> entries are automatically
replaced with the login domain of the user account and the user account.

Important: As shown in the table, for ADLDS and LLLDAP options only, you must enter actual values in
the template path for %server%, %port%, and %domain%. The <%user%> variable entry must be
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retained as shown. As an example, you might enter a template path, server01:1099/uid=
<%user%>,dc=domain02,dc=Com.

Option Description
ADSI Select one of the following strings to enter based on whether you require
authentication password entry:

O WinNT://<%domain%>/<%user%>
O WinNT://<%domain%>/<%$user%$>?password:enabled

AD LDS Enter $server$: $port$/uid=<%user%>, dc=%domain%, dc=Com
authentication

LLLDAP Enter $server$: $port$/uid=<%user%>, dc=%domain%, dc=Com
authentication

LDAP Select one of the following strings to enter based on whether you require
authentication password entry:

© LDAP://<%domain%>.com

© LDAP://<%domain%>.com?password:enabled

5. Click Save to save your authentication path entry.
6. Click the Service tab and then click Start to start Datacap Server service.
7. Close the Datacap Server Manager window.

Parent topic: Configuring authentication for Datacap

Authenticating Datacap Web Client users with IBM Security
Access Manager

Datacap Web can decode WebSEAL directed headers and use the information that is provided in the headers to
authenticate the Datacap user. The extracted identity information is used to retrieve the LDAP group
information for that user by using an LDAP directory bind. Complete the following steps to authenticate users
who are authenticated in Security Access Manager.

Security Access Manager configuration

For Security Access Manager to be able pass the user information in the HTTP Header, you must configure a
path between the WebSEAL server and the IIS server that hosts Datacap Web Server. The WebSEAL server
uses the iv-user header value to send the user information.

To configure a path between WebSEAL and Datacap Web, type the following command on the WebSEAL side:

"server task default-webseald-server create -t tcp
-h mywebserver.com -p 80 -c iv-user, iv-groups/junction"

Alternatively, you can use an SSL connection to create a secure connection between WebSEAL and Datacap
Web by using the pdadmin command and typing the following on the WebSEAL side:

"server task default-webseald-server create -f -t
ssl -h mywebserver.com -p 443 -c iv-user,iv-groups/Jjunction"

where the SSL connection is configured on port 443 on the IIS server that hosts Datacap Web Server.

Datacap Web configuration

Datacap Web integration with WebSEAL requires the use of an LDAP bind. The Datacap LLLDAP plugin that is
used to retrieve the LDAP group information of the user requires the following LDAP information:
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e | DAP Server ID and Port Number
e LDAP Bind User ID and Password
e Group Search Filter Name

e Group Base Domain Name (DN)
e User Search Filter Name

e User Base Domain Name (DN)

This LDAP information is used to populate the Datacap Server LLLDAP Authentication path template.
For example:

Server:389/BindUser:cn=binduser?BindPw:mypassword?ValidateUser:0ff?
UserBaseDn:cn=mydomain?UserSearchFilter:

(& (objectClass=organizationalPerson) (uid=<%user%>)) ?UserShortNameAttr:cn?
UserDisplayNameAttr:uid?GroupBaseDn:cn=mydomain
?GroupSearchFilter: (& (objectClass=groupOfNames) ) ?GroupShortNameAttr:cn?
GroupDisplayNameAttr:cn
?GroupMembershipSearchFilter: (& (objectClass=groupOfNames) (member=<%user%>))

Attention: The ValidateUser:Off parameter directs the LLLDAP plug-in to skip authentication of the users
credentials and move to group retrieval. This flag is optional and is not required for WebSEAL integration. If this
flag is enabled, it applies to all of the users who are authenticated through the Datacap Server that are using
LLLDAP.

Datacap Security Access Manager authentication process

Datacap users are authenticated by using the iv-user header value in Security Access Manager instead of the
user name and password. The WebSEAL server controls the access to the Datacap Web URLs. After a
successful authentication of the user credentials, WebSEAL forwards the Datacap Web URL to the user.

The following steps describe the authentication process:

1. Datacap Web aspx page extracts user identity information from the iv-user value in the HTTP header and
passes the user id to Datacap Server. The Datacap Server processes the user id and passes it to Datacap
LLLDAP authentication plugin.

2. The Datacap LLLDAP plugin retrieves the LDAP group information of the user by using the directory
information that is listed in Datacap LLLDAP authentication template.

3. Once the LDAP group information is retrieved, the Datacap LLLDAP plugin populates the group list and
passes it to the Datacap Server.

4. The Datacap Server validates the group list against the Administration database.

5. Datacap Web presents the user with the login page with the user id and password fields greyed out. Only
the application and station fields are enabled. Once the user has selected the application, the
application name is matched against the user groups in the Administration database and the user is
presented with the validated workflows.

Switching between Datacap applications

To switch between Datacap applications:

1. Click Logout on the Datacap page. The Datacap Login page is displayed with the User ID and Password
fields greyed out. Select another Datacap application and enter the Station Number. WebSEAL passes
the same iv-user header value to the Datacap Web Login page where you are authenticated against the
selected Datacap application.

Installing the Datacap modules

You must copy the new Datacap dll files over the existing Datacap installation.

190 Datacap 9.1.3



1. Copy the new dctmlll.dll file with the LLLDAP changes to the C:\Datacap directory.
2. Open a command window and run the following command:

regsvr32 dctmlll.dll

3. Copy the new App_Web_edlogin.ascx.cdcab7d2.dll file with the Datacap Web changes to the
C:\Datacap\tmweb.net\bin directory.

Parent topic: Configuring authentication for Datacap

Configuring single sign-on (SSO) for Datacap Navigator

#You can configure single sign-on (SSO) for Datacap Navigator by using IBM Security Access Manager,
SPNEGO/Kerberos, or container-managed authentication.«

&

About this task

Datacap Navigator supports the following authentication methods:

IBM Security Access Manager
You can configure SSO for Datacap Navigator with IBM Security Access Manager. First, you need to set
up SSO in IBM® Content Navigator. For more information, see Configuring single sign-on for IBM Content
Navigator by using IBM Security Access Manager for Web on WebSphere Application Server (FileNet P8).

SPNEGO/Kerberos
Datacap Navigator supports SPNEGO/Kerberos authentication. In addition to configuring IBM Content
Navigator for SSO, you must configure your browser. For more information, see Configuring single sign-
on for IBM Content Navigator by using SPNEGO/Kerberos on WebSphere Application Server (IBM FileNet
P8).

Container-managed authentication
Using container-managed authentication, you can switch between repositories in the same instance of
IBM Content Navigator without logging in each time you access a repository. The container
authentication user is used to communicate with the Datacap application. For example, you can
authenticate initially in either IBM Content Navigator or Datacap Navigator, and then switch between the
two applications without logging in again.

For more information about configuring IBM Content Navigator for SSO, see Support for Single Sign-on (SSO)

Restriction: For Datacap Navigator, SSO is supported for IBM WebSphere® Application Server only.
&

Procedure

To configure SSO for a Datacap repository:

1. Set up LLLDAP authentication for Datacap Server; for instructions, see LLLDAP group authentication.
2. Enable SSO for your application.
a. Access the IBM Content Navigator administration tool. In a browser, enter a URL with the
following format:

http://host _name:port number/context root/?desktop=admin

By default, the context root is navigator.
b. Click Repositories in the left pane.
c. Select an application in the right pane and click Edit.
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d. Click Connect and log in to the application.

e. Click the Configuration Parameters tab.

f. Click Enable for the Single sign-on parameter.
g. Click Save and Close.

Parent topic: Configuring authentication for Datacap

Installing and configuring IBM Datacap Advanced Handwriting
Recognition 9.0.1

The IBM® Datacap Advanced Handwriting Recognition 9.0.1 is an add-on for handwriting recognition for
checks.

You can install and configure the IBM Datacap Advanced Handwriting recognition 9.0.1 and migrate the
existing ICR_P actions from the earlier versions to Datacap 9.0.1.

With IBM Datacap Advanced Handwriting Recognition you can:

Process a check with machine printed and handwritten data.

Extract data for supported data sets for supported countries (Brazil, Canada, France, India, United
Kingdom and United States).

Detect and validate signatures on checks.

Recognize cursive handwriting.

Installing IBM Datacap Advanced Handwriting Recognition 9.0.1

IBM Datacap Advanced Handwriting Recognition 9.0.1 is a separately licensed component that provides
intelligent character recognition (ICR) and Check Processing & Signature Validation to IBM Datacap
9.0.1.

Using IBM Datacap Advanced Handwriting Recognition 9.0.1

You can use the IBM Datacap Advanced Handwriting Recognition features using the action libraries.
Migrating from ICR_P to Advanced Handwriting Recognition actions

The versions prior to IBM Datacap 9.0.1 used the ICR_P actions to recognize the contents within zoned
fields that are configured for recognition. These actions use the Parascript FieldScript for IBM Datacap
recognition engine. The Parascript FieldScript can be installed with earlier versions of IBM Datacap but
not with new version of IBM Datacap 9.0.1.

Parent topic: Datacap installation and configuration in a client/server environment

Installing IBM Datacap Advanced Handwriting Recognition

9.0.1

IBM® Datacap Advanced Handwriting Recognition 9.0.1 is a separately licensed component that provides
intelligent character recognition (ICR) and Check Processing & Signature Validation to IBM Datacap 9.0.1.

Before you begin

You must install or upgrade to IBM Datacap 9.0.1.

About this task

You install IBM Datacap Advanced Handwriting Recognition 9.0.1 on all computers that process rules, such as
the Rulerunner server.
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Procedure

To download and install IBM Datacap Advanced Handwriting Recognition 9.0.1:

1. Sign in to Passport Advantage by using your IBM ID. If you are not a returning customer or you do not
have an IBM ID, you can register to obtain an IBM ID.

2. Download the IBM Datacap Advanced Handwriting Recognition 9.0.1 installation program.

3. Start the installation program on a computer that process rules, such as Rulerunner:

4. Choose which options you want to install:
Important: For the check processing feature to work correctly, you can install only one country in
addition to IBM Datacap Check Processing (US). Do not install more than one country in addition to the
US option.

o IBM Datacap Cursive Recognition

IBM Datacap Cursive Recognition for Non-Production Environment

IBM Datacap Check Processing (US)

IBM Datacap Check Processing (UK)

IBM Datacap Check Processing (Brazil)

IBM Datacap Check Processing (Canada)

IBM Datacap Check Processing (India)

IBM Datacap Check Processing (France)

IBM Datacap Signature Validation

IBM Datacap Signature Validation for Non-Production Environment

5. Complete the installation.

O 0O 0O 0O O O 0O 0 ©°

What to do next

Install the program with the same options on every computer that processes rules.
Parent topic: Installing and configuring IBM Datacap Advanced Handwriting Recognition 9.0.1

Using IBM Datacap Advanced Handwriting Recognition 9.0.1

You can use the IBM® Datacap Advanced Handwriting Recognition features using the action libraries.

Before you begin

You must install or upgrade to IBM Datacap 9.0.1.

What to do next

For more details on using the Advanced Handwriting Recognition actions, refer to the following actions:

e CheckProcessing actions
e HandwritingRecognition actions
e SignatureValidation actions

Parent topic: Installing and configuring IBM Datacap Advanced Handwriting Recognition 9.0.1

Migrating from ICR_P to Advanced Handwriting Recognition
actions
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The versions prior to IBM® Datacap 9.0.1 used the ICR_P actions to recognize the contents within zoned fields
that are configured for recognition. These actions use the Parascript FieldScript for IBM Datacap recognition
engine. The Parascript FieldScript can be installed with earlier versions of IBM Datacap but not with new
version of IBM Datacap 9.0.1.

Before you begin

You must install or upgrade to IBM Datacap 9.0.1.

About this task

During migration, you need to modify the application with the new actions which match old actions and discard
the actions which do not match.

Procedure

To migrate from ICR_P to Advanced Handwriting Recognition actions:

1. Install IBM Datacap Advanced Handwriting Recognition 9.0.1.
2. Open the application using Datacap Studio or Fastdoc.
3. Replace/Discard the actions of ICR_P library as per following table:

IBM Datacap 9.0.0 IBM Datacap 9.0.1

Library |icr_p HandwritingRecognition

Actions | AddWord Not supported
DeleteWord Not supported
ImportCSF Not supported
LoadFromFile SetVocabulary
NewDictionary Not supported

RecognizeFieldsICR_P | Recognize

SaveToFile Not supported

SetPostalDBPathICR_P | SetPostalDatabase

4. Save the application.
5. Run the application to test functionality.
Note: The new version does not support some actions, which may lead to loss of functionality.

Parent topic: Installing and configuring IBM Datacap Advanced Handwriting Recognition 9.0.1

Datacap Web Services installation steps

The Datacap Web Services installation in a client/server environment requires you to follow several steps,
including preparation, installation, configuration, and verification steps.

You can install Datacap Web Services on a dedicated web server or on a web server on which other Datacap
Web Services components are installed. You must have administrator access to all computers on which the
Datacap software is installed and to the server on which you install Datacap Web Services.

The following list is an overview of the steps that are required to install and configure Datacap Web Services in
a Datacap client/server environment.
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Ensure that you meet the prerequisites that are detailed in Installation and configuration prerequisites.
You can adjust the value of the maxAl1lowedContentLength and maxRequestLength settings in the
web.config file. The maximum size message that can be uploaded depends on your web server, proxy
server, and client.
Determine which Datacap applications you want Datacap Web Services to interact with and the type of
interactions you want Datacap Web Services to have with Datacap.
Ensure that you can run all of the application tasks manually before you configure Datacap Web Services
to run them.
Based on your authentication system, set up the Datacap Web Services authentication credentials in the
Application Manager for users and stations. Access to the Datacap Web Services HTTP IP address and
methods is limited to authorized computers and users by a firewall or other network devices.
Set up security permissions for Datacap Web Services on the Datacap shared folder on the Datacap
Server.
Set up security permissions for Datacap Web Services account on the Datacap folder that contains the
application with which Datacap Web Services is to be interacting.
Install and configure Datacap Web Services on the web server, including selecting the appropriate
language for installation purposes and selecting Datacap Web Service from the list of components.
You can host Datacap Web Services as a Windows Service or you can set up IIS to host Datacap Web
Services. Validate the Datacap Web Services installation by opening the help page.

o To host Datacap Web Services as a Windows Service, select the Datacap Windows Service option

in the installation wizard.
o To set up IIS to host Datacap Web Services, you must add the wTM website, configure the
application pool settings, and enable the ISAPI extension for All Verbs.

Import encryption keys to from the Datacap Server to the computer on which you are installing Datacap
Web Services to secure passwords that are sent across the network.
Set the location of the datacap.xml file.

Datacap Web Services authentication

The Datacap Web Services authenticates with the Datacap Server by using a configured user in the
Application Manager or by calling the \Session\Logon endpoint and providing the credentials. When
you use the Application Manager configured user, all authentication methods are supported. When you
use the \Session\Logon endpoint, the TMA, ADLDS, and LLLDAP authentication methods are
supported.

Setting up sharing permissions for Datacap Web Services

You must set up the sharing permissions for the Datacap Web Services account on the shared Datacap
folder.

Setting up shared folder security for Datacap Web Services

You must set up security permissions on the shared folder with which the Datacap Web Services account
is interacting.

Setting up application folders security for Datacap Web Services

You must set up security permissions on the application folders with which the Datacap web services
account is interacting.

Installing Datacap Web Services

You can install Datacap Web Services on the web server by using the installation wizard.

Datacap Web Services hosting options

You can host Datacap Web Services as a Windows service or by configuring Datacap Web Services on
Microsoft Internet Information Services (IIS).

Disabling security for the transaction endpoints

You can disable security for the transaction endpoints in the /Transaction/ URI path.

Enabling SSL for Datacap Web Services

You can enable Secure Sockets Layer (SSL) for Datacap Web Services by modifying settings in the
Datacap Web Services configuration file.

Importing encryption keys to Datacap computers

In a client/server configuration, you must import security encryption keys to the computer where you
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are installing and configuring each Datacap component. This requirement secures passwords that are
sent across the network between Datacap servers and clients.

Parent topic: Installing and configuring in a client/server environment
Related concepts:
Installation and configuration prerequisites

Datacap Web Services authentication

The Datacap Web Services authenticates with the Datacap Server by using a configured user in the Application
Manager or by calling the \Session\Logon endpoint and providing the credentials. When you use the
Application Manager configured user, all authentication methods are supported. When you use the
\Session\Logon endpoint, the TMA, ADLDS, and LLLDAP authentication methods are supported.

The Datacap Web Services configured user, password, and station information is retrieved from the Application
Manager for authentication. Configure the Application Manager Custom values settings with the name and
value pair for the user, password, and station authentication. Datacap Web Services uses settings in the
c:\Datacap\wTM\web.config file to determine the names of the keys that are stored in the Application Manager
from which the user name, password, and station information is retrieved. You must set up the wTMUser,
wTMPassword, and wIMStation name and value pairs in the Application Manager that is based on your
authentication method. The web.config file contains the following lines that identify the names of the keys.

<setting name="pathUser" serializeAs="String">
<value>values/gen/wTMUser</value>

</setting>

<setting name="pathPassword" serializeAs="String">
<value>values/adv/wTMPassword</value>

</setting>

<setting name="pathStation" serializeAs="String">
<value>values/gen/wTMStation</value>

</setting>

When you are using the Application Manager configured user, Datacap Web Services authenticates with the
Datacap Server when each endpoint is called. Each time an endpoint is called, Datacap Web Services sends a
request to the Datacap Server to log in the user, then processes the endpoint action, and logs off the user.

When you are using the \Session\Logon endpoint, a user session is persisted for subsequent calls to reduce
the number of calls to the Datacap Server. When the user is logged in, the session between Datacap Web
Services and the Datacap Server continues throughout all subsequent endpoints until the \Session\Logoff
endpoint is called or the session expires.

To avoid unauthorized user access when you use the \Session\Logon endpoint, ensure that a user is not
configured in the Application Manager. If you are using ADSI or LDAP for your application, configure a separate
instance of the Datacap Server for Datacap Web Services to use the TMA, ADLDS, or LLLDAP authentication
method.

e Configuring Datacap Web Services authentication
To set the Datacap Web Services credentials when your authentication system is TMA, you must add the
Datacap user, password, and station in the Application Manager.

e Configuring Datacap Web Services ADSI or LDAP authentication
To set the Datacap Web Services credentials when your authentication system is ADSI or LDAP, you
must add the name and value pair for the user, password, and station in the Application Manager.

e Configuring Datacap Web Services ADLDS or LLLDAP authentication
You can set the Datacap Web Services credentials when your authentication system is ADLDS or LLLDAP
by adding the user, password, and station in the Application Manager. If you are using the
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\Session\Logon endpoint to provide valid credentials and authenticate, you must not add the user,
password, and station in the Application Manager.

Parent topic: Datacap Web Services installation steps
Related tasks:

Configuring authentication for Datacap

Related reference:

Session/Logon

Session/Logoff

Configuring Datacap Web Services authentication

To set the Datacap Web Services credentials when your authentication system is TMA, you must add the
Datacap user, password, and station in the Application Manager.

About this task

When your authentication system is TMA, follow this procedure to set up the Datacap Web Services credentials
for your application. In Application Manager, add the name and value pair for a Datacap user, password, and
station.

Procedure

1. Add a name and value pair in General string values section of the Custom values tab for the Datacap
user name.
o Value name: wIMUser
o Value: Set to the Datacap user name.
2. Add a name and value pair in the General string values section of the Custom values tab for the Datacap
station name.
o Value name: wTMStation
o Value: Set to the Datacap station name.
3. Add a name and value pair in the Advanced values section of the Custom values tab for the Datacap user
password.
o Value name: wIMPassword
o Value: Set to the Datacap user password.

Parent topic: Datacap Web Services authentication

Configuring Datacap Web Services ADSI or LDAP
authentication

To set the Datacap Web Services credentials when your authentication system is ADSI or LDAP, you must add
the name and value pair for the user, password, and station in the Application Manager.

About this task

When your authentication system is ADSI or LDAP, follow this procedure to set up the Datacap Web Services
credentials for your application. In the Application Manager, add the name and value pair for a user, password,
and station.

Procedure
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1. Add a name and value pair in General string values section of the Custom values tab for the blank user
name.
o Value name: wIMUser
o Value: Leave this field blank.
2. Add a name and value pair in the General string values section of the Custom values tab for the Datacap
station name.
o Value name: wIMStation
o Value: Set to the Datacap station name.
3. Add a name and value pair in the Advanced values section of the Custom values tab for the blank user
password.
o Value name: wITMPassword
o Value: Leave this field blank.

Parent topic: Datacap Web Services authentication

Configuring Datacap Web Services ADLDS or LLLDAP
authentication

You can set the Datacap Web Services credentials when your authentication system is ADLDS or LLLDAP by
adding the user, password, and station in the Application Manager. If you are using the \Session\Logon
endpoint to provide valid credentials and authenticate, you must not add the user, password, and station in the
Application Manager.

About this task

When your authentication system is ADLDS or LLLDAP, you can configure the user in the Application Manager or
you can use the \Session\Logon endpoint for authentication.

When you use theDatacap Web Services \Session\Logon method, you force each client of the web service to
provide credentials and authenticate. The session between Datacap Web Services and the Datacap Server
continues throughout all subsequent endpoints until the \Session\Logoff endpoint is called or the session
expires. If you use the \Session\Logon method, you must not configure the user in the Application Manager.

If you configure the user, password, and station in the Application Manager, Datacap Web Services
authenticates with the Datacap Server when an endpoint is called. Each time an endpoint is called, Datacap

Web Services sends a request to the Datacap Server to log in the user, then processes the endpoint action, and
logs off the user.

Follow this procedure to set up the Datacap Web Services credentials for your application in the Application
Manager. Add the name and value pair for a user, password, and station. The user name and password must
match the user name and password that is set up in your ADLDS or LLLDAP authentication system.

Procedure

1. Add a name and value pair in General string values section of the Custom values tab for the Datacap
Web Services user name.
o Value name: wIMUser
o Value: Enter the user name.
2. Add a name and value pair in the General string values section of the Custom values tab for the Datacap
Web Services station name.
o Value name: wIMStation
o Value: Enter the station name.
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3. Add a name and value pair in the Advanced values section of the Custom values tab for the Datacap Web
Services user password.
o Value name: wIMPassword
o Value: Enter the password.

Parent topic: Datacap Web Services authentication

Setting up sharing permissions for Datacap Web Services

You must set up the sharing permissions for the Datacap Web Services account on the shared Datacap folder.

About this task

An example of the shared folder is the C:\Datacap folder on the Datacap Server. Note that other accounts were
already granted sharing permissions during the initial installation and configuration of the Datacap Server.

Procedure

1. On the server, start Windows Explorer, navigate to, and right-click the c:\Datacap folder and select
Properties.

2. Click the Sharing tab and ensure that the folder is shared with the Share name of Datacap.

3. Click Advanced Sharing. When User Account Control (UAC) is on, the User Account Control window is
displayed. Click Yes.

4. Click Permissions. Ensure that the domain/Windows user ID of Datacap Web Services is set to allow Full
Control.

Parent topic: Datacap Web Services installation steps

Setting up shared folder security for Datacap Web Services

You must set up security permissions on the shared folder with which the Datacap Web Services account is
interacting.

About this task

You must set up the security permissions for the Datacap Web Services account on the shared folder, such as
c:\Datacap. In the examples that are used in this material, the shared folder is the c:\Datacap folder on the
Datacap Server. Note that other accounts were already granted security permissions during the initial
installation and configuration of the Datacap Server.

Procedure

1. On the server, start Windows Explorer, navigate to, and right-click the c:\Datacap folder and select
Properties.

2. Click the Security tab and click Edit. When User Account Control (UAC) is on, the User Account Control
window is displayed. Click Yes.
3. Ensure that the domain Windows user ID of the Datacap Web Services account is set to Read.

Parent topic: Datacap Web Services installation steps
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Setting up application folders security for Datacap Web
Services

You must set up security permissions on the application folders with which the Datacap web services account
is interacting.

About this task

If you are setting up Datacap Web Services to run tasks from more than one application, you must set up
security permissions for each Datacap\Application folder. Note that other accounts were already granted
security permissions during the initial installation and configuration of the Datacap server. In the examples that
are used in this material, the application files are found on the Datacap server in the shared c:\Datacap folder.

Procedure

1. On the server, start Windows Explorer, navigate to, and right-click the c:\Datacap\Application folder and
select Properties.

2. Click the Security tab and click Edit.

3. Ensure that the domain Windows user ID of the Datacap Web Services account is set to Read.

Parent topic: Datacap Web Services installation steps

Installing Datacap Web Services

You can install Datacap Web Services on the web server by using the installation wizard.

About this task

Follow this procedure to install the Datacap Web Services software component on the web server. You can also
install the Datacap Windows Service, if you want to host Datacap Web Services as a Windows service.

Procedure

1. Make the installation package available on your network or insert the Datacap CD in the web server's
CD/DVD drive. If the installation process does not start automatically or if the package is on the network,
open Windows Explorer, navigate to and double-click the Setup.exe.

2. Select the appropriate language, then click OK. The language that you select determines the language
that is displayed by the installation program during the installation process.

3. When additional, redistributed software is required, the installation program displays a list of the items

to be installed. Click Install.
. Click Next.
. Accept the license agreement and click Next.
. Select the Custom option and click Next.
. Select the Datacap Web Service option from the list of components.
. Select the Datacap Windows Service option from the list of components, if you want to host Datacap
Web Services as a Windows service.
9. Click Next.

10. Click Install.

11. Click Finish.

0o o o~

Parent topic: Datacap Web Services installation steps
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Datacap Web Services hosting options

You can host Datacap Web Services as a Windows service or by configuring Datacap Web Services on Microsoft
Internet Information Services (IIS).

To host Datacap Web Services as a Windows service, select the custom option and choose the Datacap
Windows Service option in the installation wizard.

To host Datacap Web Services on Microsoft Internet Information Services (11S), add the wTM website and
configure the application pool settings.

Ensuring the required IIS components are installed

This topic identifies the set of Microsoft Internet Information Services (IIS) Web Server Role Services
that are required by the various Taskmaster web server components (Taskmaster Web, RV2, Fingerprint
Service, or Taskmaster Web Services).

Setting up the Windows service to host Datacap Web Services

To host Datacap Web Services as a Windows service, install the Datacap Windows Service by using the
installation wizard. You must start the Datacap Windows Service before you can validate the installation
by opening the Datacap Web Services help page.

Setting up IIS to host Datacap Web Services

Set up Datacap Web Services on Microsoft Internet Information Services (IIS) by adding the wTM
website, configuring the application pool settings, and enabling the ISAPI extensions for All verbs.

Parent topic: Datacap Web Services installation steps

Ensuring the required IIS components are installed

This topic identifies the set of Microsoft Internet Information Services (IIS) Web Server Role Services that are
required by the various Taskmaster web server components (Taskmaster Web, RV2, Fingerprint Service, or
Taskmaster Web Services).

About this task

This procedure provides instructions on how to ensure that the appropriate components are installed in
Microsoft Internet Information Services (IIS) when the WebServer’s operating system is Microsoft Windows
Server 2008 R2 or Microsoft Windows Server 2012,

Procedure

1.
2.
3.

O 00 N O

From the WebServer's Windows Start menu, select Administrative Tools > Server Manager.

In Server Manager, expand Roles, and then select Web Server (IIS).

In Web Server (I1S), expand Role Services, and under Common HTTP Features, ensure that Static
Content, Default Document, Directory Browsing, and HTTP Errors are installed.

Important: If you are installing wTM, do not install the WebDAV Publishing role service, as it prevents the
wTM PUT method from functioning.

. In the Role Services pane, under Application Development, ensure that the ASP.NET, .NET Extensibility,

ASP, ISAPI Extensions, and ISAPI Filters are installed.

. In the Role Services pane, under Health and Diagnostics, ensure that HTTP Logging and Request Monitor

are installed.

. In the Role Services pane, under Security, ensure that Request Filtering is installed.

. In the Role Services pane, under Performance, ensure that Static Content Compression is installed.

. In the Role Services pane, under Management Tools, ensure that IIS Management Console is installed.
. Close the Server Manager window.
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Parent topic: Datacap Web Services hosting options

Setting up the Windows service to host Datacap Web Services

To host Datacap Web Services as a Windows service, install the Datacap Windows Service by using the
installation wizard. You must start the Datacap Windows Service before you can validate the installation by
opening the Datacap Web Services help page.

Before you begin

Install Datacap Web Services by using the installation wizard.

About this task

Follow this procedure to install and start the Datacap Windows Service to host the Datacap Web Services.

Procedure

1. Install the Datacap Windows Service from the installation wizard.

a. Make the installation package available on your network or insert the Datacap CD in the web
server's CD/DVD drive. If the installation process does not start automatically or if the package is
on the network, open Windows Explorer, navigate to and double-click the Setup.exe.

b. Select the appropriate language, then click OK. The language that you select determines the
language that is displayed by the installation program during the installation process.

c. When additional, redistributed software is required, the installation program displays a list of the

items to be installed. Click Install.
. Click Next.
. Accept the license agreement and click Next.
. Select the Custom option and click Next.
. Select the Datacap Windows Service option from the list of components.
. Click Next.
. Click Install.
j- Click Finish
2. Start the Datacap Windows Service.

a. Go to Administrative Tools > Services.

b. Right-click Datacap Windows Service and select Start.

3. Validate the installation of Datacap Web Services by opening the help page.

a. Go to c:\Datacap\Taskmaster and open wTMservice.exe.config with Notepad.

b. Copy the baseAddress URL to your browser and add /help. The following is an example of a
baseAddress URL in the wTMservice.exe.config file.

— D00 —« O O

<host>
<baseAddresses>
<add baseAddress="http://localhost:82/service" />
</baseAddresses>
</host>

In this example, the URL of the help page is http://localhost:82/service/help,
c. When the Datacap Web Services help page opens, you can click one of the links in the Method
column to show detailed information about the REST API endpoint.

Parent topic: Datacap Web Services hosting options
Related tasks:
Installing Datacap Web Services
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Setting up IIS to host Datacap Web Services

Set up Datacap Web Services on Microsoft Internet Information Services (IIS) by adding the wTM website,
configuring the application pool settings, and enabling the ISAPI extensions for All verbs.

About this task

Follow this procedure to set up the Datacap Web Services wTM website on Microsoft Internet Information
Services (IIS).

Procedure

1. Add the Datacap Web Services in IIS.
a. From Start, select Administrative Tools > Internet Information Services (IIS) Manager.
b. In the Connections pane, right-click Sites and select Add Web Site.
c. Set Site name to wTM. The Application pool is automatically set to wTM.
d. Set the Physical path by entering or browsing to the installation folder for Datacap Web Services.
The default location is C:\Datacap\wTM.
e. Select the IP address of the Datacap Web Services server and assign a unique Port number and
click OK to close the Add Web Site dialog.
Note: The Datacap Web Client and Datacap Web Services must be assigned different port
numbers when they are installed on the same server. The Datacap Web Client does not work
unless Datacap Web Services is assigned a different port number.
2. Set up the Datacap Web Services I1IS application pool.
a. In the Connections pane, select Application Pools.
b. In the Application Pools pane, select the wTM application pool. Select Actions > Edit Application
Pool > Advanced Settings.
. Ensure that the .NET Framework Version is set to v4. 0.
. Ensure that Enable 32-Bit Applications is set to True.
. Ensure that Managed Pipeline Mode is set to Integrated.
. Ensure that Start Automatically is set to True.
. In the Process Model section, click the Browse button next to Identity.
. In the Application Pool Identity window, select Custom account and click Set.
. In the Set Credentials window, enter the wTM domain Windows account information in the
format, accountname@domainname. Enter the account password and click OK.
j- In the Process Model section, set Load User Profile to True and click OK.
k. In the Connections pane, select the wTM site. In the Actions pane under Manage Web Site, click
Restart.
L. Confirm that the Application Pools, Default Web Site, and wTM website are started.
3. Enable ISAPI extensions for All verbs and for execution on the Datacap Web Services server.
a. In the Connections pane, select the wTM site. In the wTM Home pane, double-click Handler
Mappings.
b. Scroll down, select svc-ISAPI-4.0_32bit, and ensure that it is enabled.
Tip: For Windows Server 2012 R2, the svc-ISAPI-4.0_32bit setting might be missing. To resolve
this problem, in your Windows system administrative tools, open Server Manager and click
Dashboard. Click Add roles and features. In the Add Roles and Features Wizard, go to the
Features section. In .NET Framework 4.5 Features > WCF Services, select the HTTP Activation
check box.
c¢. In the Actions pane, click Edit Feature Permissions, select Read, Script, and Execute, then click
OK.
d. In the Actions pane, click Edit, and on the Edit Script Map dialog, click Request Restrictions.
e. On the Request Restrictions dialog, click the Verbs tab, select All verbs, click OK, then click Yes.

— 0B - O O 0
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4, Validate the Datacap Web Services installation by opening the Datacap Web Services help page.
a. Open Internet Explorer and enter the following help page URL, http://<WebServerName or IP
address>:<port number>/ServicewTM.svc/help.
b. Click a link in the Method column to show detailed information about the REST API endpoint.

Parent topic: Datacap Web Services hosting options
Related concepts:
Installation and configuration prerequisites

Disabling security for the transaction endpoints

You can disable security for the transaction endpoints in the /Transaction/ URI path.

About this task

Security for transactional endpoints is enabled by default. The transactionSecurity parameter is set to true by
default. When true, you must first authenticate by using the Session/Logon endpoint.

When this parameter is set to false, the web service does not connect to Datacap Server for that endpoint.

Procedure

To disable security for the transaction endpoints:

1. Open the configuration file:
o When hosting the web services by using Microsoft Internet Information Services (IIS), open:
\Datacap\wTM\web.config
o When hosting the web services as a Windows Service: \Datacap\wTM\wTMservice.exe.config
2. Set the value for transactionSecurity to false, as follows:

<setting name="transactionSecurity" serializeAs="String">
<value>False</value>
</setting>

Parent topic: Datacap Web Services installation steps

Enabling SSL for Datacap Web Services

You can enable Secure Sockets Layer (SSL) for Datacap Web Services by modifying settings in the Datacap Web
Services configuration file.

Procedure

1. Import the SSL certificate.

For example, use the Microsoft Management Console (MMC) to import the certificate. After the import,
verify that the certificate is trusted, that the private key is in the store, and that it is not expired.

2. Update the port. The port is set in the binding in Internet Information Services (IIS) or in the
configuration file for the service.
o When hosting the web services by using IIS, see the following steps for configuring an IIS-hosted
Windows Communication Foundation (WCF) service with SSL https://msdn.microsoft.com/en-
us/library/hh556232
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o When hosting the web services as a Windows Service, see the following steps for configuring a
port with an SSL certificate: https://msdn.microsoft.com/en-us/library/ms733791
3. Enable SSL for Datacap Web Services:
o When hosting the web services by using Microsoft Internet Information Services (IIS), do the
following steps:
a. Open \Datacap\wTM\web.config.
b. Add the SecureWebHttpBinding binding by changing the following line:

<webHttpBinding />

to:

<webHttpBinding>
<binding name="SecureWebHttpBinding">
<security mode="Transport">
<transport clientCredentialType="Basic" />
</security>
</binding>
</webHttpBinding>

c. Change the following line:
<serviceMetadata httpGetEnabled="true" />

to:

<serviceMetadata httpGetEnabled="false" httpsGetEnabled="true"/>

d. Save your changes.

o When hosting the web services as a Windows Service, do the following steps:
a. Open \Datacap\wTM\wTMservice.exe.config.
b. Change the following line:

<serviceMetadata httpGetEnabled="true" />

to:

<serviceMetadata httpGetEnabled="false" httpsGetEnabled="true"/>

c. Change the following line:

<binding name="NewBindingl" maxBufferSize="104857600"
maxReceivedMessageSize="104857600" />

to:

<binding name="NewBindingl" maxBufferSize="104857600"
maxReceivedMessageSize="104857600">

<security mode="Transport" />

</binding>

d. Change http to https in the following attribute, as follows:
<add baseAddress="https://localhost:port/service" />

e. Save your changes.
4. If you have a Datacap Navigator configuration, deploy a client certificate on IBM® WebSphere®
Application Server for IBM Content Navigator:
a. Log in to the WebSphere Application Server administrative console on the IBM Content Navigator
server that acts as the SSL client.
b. Navigate to Security > SSL certificate and key management.
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c. In the Related Items section, click Key stores and certificates.
d. Select the default truststore:

Table 1. Truststores for IBM WebSphere Application Server

Configuration Truststore
Type

IBM WebSphere | CellDefaultTrustStore
Application
Server Network
Deployment

WebSphere NodeDefaultTrustStore
Application
Server base and
standalone

. In the Additional Properties section, click Signer certificates.

. Click Retrieve From Port.

. In the Host field, enter the hostname of the wTM server.

. In the Port field, enter the secure wTM port.

. In the Alias field, enter a name for this certificate.

. Click Retrieve Signer Information.

. Verify that the certificate information is for a certificate that you can trust.

. Click Apply, and click Save.

. Restart the IBM Content Navigator application.

. On IBM Content Navigator, update the Datacap repository with the Datacap Web Services HTTPS
URL.

0. On IBM Content Navigator, update the plug-in with the Datacap Web Services HTTPS URL.
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Parent topic: Datacap Web Services installation steps

Importing encryption keys to Datacap computers

In a client/server configuration, you must import security encryption keys to the computer where you are
installing and configuring each Datacap component. This requirement secures passwords that are sent across
the network between Datacap servers and clients.

Before you begin

You must generate the encryption keys in the keystore on a server on which the Datacap server software
component is installed. You export the new keys to a key transport file.

Procedure

To import encryption keys to Datacap computers:

1. Find the dc_KTF.xml key transport file in the c:\Datacap\Taskmaster folder on the Datacap server where
you generated and exported the encryption keys.

2. Copy the dc_KTF.xml key transport file to the appropriate folder on the computer where you installed
the new component. The encryption keys are automatically applied to the keystore the next time you
start the Datacap component.

Table 1. Encryption key folder locations by
component

Component Folder
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Component Folder

Datacap Server C:\Datacap\Taskmaster

Datacap applications [ C:\Datacap\Taskmaster

Datacap Desktop C:\Datacap\DcDesktop
Datacap Studio C:\Datacap\DStudio
Datacap FastDoc C:\Datacap\FastDoc

Datacap Report Viewer | C:\Datacap\RV2\bin

Datacap Web Client C:\Datacap\tmweb.net\bin

Datacap Web Services |C:\Datacap\wTM\bin

Parent topic: Datacap Web Services installation steps

Client/server installation checklist

This checklist provides a summary of the account and configuration settings that are required to run Datacap
software components in a client/server environment for demonstration, proof of concept, development and
test purposes.

This configuration uses a number of Windows accounts that must be in the authentication provider directory,
such as in a Window Active Directory domain. The implementer must have an account that has administrator
rights on every computer on which Datacap is to be installed.

The sections are sequenced deliberately because some items in later sections depend on steps in the previous
sections being completed successfully.

Datacap server setup

The checklists to set up the Datacap server include the tasks that are required to install and configure
Datacap on the server.

Configuring Datacap Web Server on a supported version of Windows Server

The checklist to configure Datacap Web Server includes ensuring that the .NET Framework is installed,
the application pool identity is set, and the encryption keys are imported.

Datacap developer workstation setup

The checklist to set up the Datacap developer workstation include the tasks to ensure the .NET
Framework and Datacap client components are installed.

Completing Datacap server setup

The checklists to complete the Datacap server setup include adding the list of applications to the
Datacap.xml file and setting security permissions on the application folder.

Complete the Datacap Web Client setup

The checklist to complete the Datacap Web Client setup includes adding the location of the Datacap.xml
file on the Datacap server.

Running a Datacap client on Developer Workstation

You can quickly test and confirm that each job a workflow is operating correctly by starting the Datacap
Server Service and running a task in Datacap Desktop

Remote workstation setup

The checklist includes tasks to add the TMWeb.net address as a trusted site, configure and test Internet
Explorer manually, and run theDatacap Web Client application. You can use the Web Client Configuration
tool to create a package for a user to configure and test Internet Explorer at the remote workstation.
User workstation and permissions setup

The checklist to set up the user workstation includes setting up sharing and security permissions,
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importing encryption keys, and installing the Datacap client components.

e Datacap Report Viewer setup
To install Report Viewer in a client server environment, you must perform the required set up tasks on
the server and the workstation.

e Rulerunner installation and configuration
The checklist includes tasks to set security and sharing permissions on the Datacap\RRS folder, install
Rulerunner, and import encryption keys.

e Fingerprint Service setup
The checklist includes tasks to configure the Fingerprint service application pool and set up security on
the Datacap and application folders.

e Datacap Maintenance Manager setup
You must complete the required account and configuration settings before you can runDatacap
Maintenance Manager on Datacap in a client/server environment. You can run Maintenance Manager for
demonstration, proof of concept, development, and test purposes.

Parent topic: Installing and configuring in a client/server environment

Datacap server setup

The checklists to set up the Datacap server include the tasks that are required to install and configure Datacap
on the server.

e Install the Datacap server
The checklist includes setting up the installer's user ID, ensuring the .NET Framework is installed, and
starting the installation wizard.

e Configuring Datacap on the server
The checklist includes configuring the Datacap server service, setting up security and sharing
permissions on the Datacap folder, and exporting encryption keys.

Parent topic: Client/server installation checklist

Install the Datacap server

The checklist includes setting up the installer's user ID, ensuring the .NET Framework is installed, and starting
the installation wizard.

On

Do This

Datacap
server

Set up the installer's user ID.

Add or ensure that the domain/Windows user ID of implementer is in the Administrators group on
every machine to allow the installer to run the installation program.

Datacap
server

Ensure that Microsoft .NET Framework 3.5.1 is installed.

e Start > Administrative Tools > Server Manager .

e Inthe Server Manager hierarchy pane, select Features.
e C(Click Add Features.

e Select .NET Framework 3.5.1 Features, click Next.

e Click Install.
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On Do This

server

Datacap | Start the installation program wizard by running setup.exe.

Install the Datacap server component and separately licensed connectors to which you are
entitled.

Parent topic: Datacap server setup

Configuring Datacap on the server

The checklist includes configuring the Datacap server service, setting up security and sharing permissions on
the Datacap folder, and exporting encryption keys.

About this task

On

Do This

Datacap server

Datacap server service.
Ensure that domain/Windows account exists for Datacap server service.
Grant Datacap server service the Log On as a Service privilege:

1. Go to Control Panel > Administrative Tools > Services and right-
click Datacap Server. Select Properties and click the Log On tab of
the Properties window.

2. Select This Account and enter the domain name, user name, and
password of the Datacap server service user that you just set up.
Click Apply to confirm that the user is granted the Log On as a
Service privilege.

Start Datacap server service automatically on reboot:

1. Go to Control Panel > Administrative Tools > Services and right-
click Datacap Server. Select Properties and click the General tab
of the Properties window.

2. Set the Startup Type to Automatic.
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On

Do This

Datacap server

Share Datacap folder and set up sharing permissions.

e Right-click C:\Datacap folder and select Properties.

e Click Sharing tab, click Advanced Sharing.

e Click Share this Folder (as Datacap).

e Click Permissions button.

e Add NETWORK SERVICE and local IUSR and allow Full Control.

e Add or ensure that the domain/Windows user IDs of developers
are set to allow Full Control.

e Add or ensure that the domain/Windows user ID of Datacap
server service is set to allow Full Control.

e Add or ensure that the domain/Windows user ID of Datacap Web
Client is set to allow Read.

e When Batches folders are staying on the Datacap server in
C:\Datacap\Application path, add or ensure that the
domain/Windows user IDs of Datacap users are set to allow Full
Control.

Datacap server

Set up security on shared folder.

e Right-click C:\Datacap folder and select Properties.

e Click Security tab.

e Add or ensure that the domain/Windows user IDs of developers
who can change existing Datacap applications are set to allow
Read & Execute. This developer cannot create new applications.

e Add or ensure that the domain/Windows user IDs of developers
who can create new Datacap applications in the C:\Datacap folder
are set to allow Full Control.

e Add or ensure that the domain/Windows user ID of Datacap
server service is set to allow Read & Execute.

e Add or ensure that the domain/Windows user ID of Datacap Web
Client is set to allow Read & Execute.

e When Batches folders are staying on the Datacap server in
C:\Datacap\Application path, add or ensure that the
domain/Windows user IDs of Datacap users are set to allow Read
& Execute.

Datacap server

Set up security on Datacap\RRS.

e Right-click C:\Datacap\RRS folder and select Properties.

e Click Security tab.

e Add NETWORK SERVICE and local IUSR and allow Read &
Execute.

Datacap server

Generate and export encryption keys.

e Open the command prompt and navigate to
C:\Datacap\Taskmaster.
e Enter the following command: dcskey.exe e <Enter>.

Parent topic: Datacap server setup
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Configuring Datacap Web Server on a supported version of

Windows Server

The checklist to configure Datacap Web Server includes ensuring that the .NET Framework is installed, the
application pool identity is set, and the encryption keys are imported.

On

Do This

Datacap Server

Ensure that a Domain/Windows Account exists for Datacap Web
Server.

When Datacap Web Server or Report Viewer are installed on the same
web server, they must use the same Domain/Windows account.

Datacap Web Server

Ensure that Microsoft .NET Framework 3.5.1 is installed.
Start > Administrative Tools > Server Manager

In the Server Manager hierarchy pane, select Features
Click Add Features.

Select .NET Framework 3.5.1 Feature, click Next.

Click Install

Datacap Server

Stop Datacap Server Service:

On Windows 2008 IIS 7.5 Server: Click Start > All Programs > IBM®
Datacap Services > Datacap Server Manager. In Datacap Server
Manager, click Stop.

On Windows Server 2012 R2: In your programs, click IBM Datacap
Services > Datacap Server Manager. In Datacap Server Manager, click
Stop.

Datacap Web Server

Ensure that the required IIS components are installed.
Start > Administrative Tools > Server Manager
Expand Roles, select Web Server (IIS)

In the Web Server (IIS) pane, ensure that you have the following
components:

e Under Common HTTP Features, ensure that Static Content is
installed.

e Scroll down to Role Services, under Application Development,
ensure that the ASP.NET module is installed.

e Under Application Development, ensure that the ASP module is
installed.

e Scroll down further to Management Tools, ensure that IIS
Management Console is installed.

Datacap Web Server

Install Datacap Web Server on the web server.

Install Datacap Web Server component and licensed connectors.
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On

Do This

Datacap Web Server

Import encryption keys
Navigate to the Datacap server on which you generated keys

Copy the dc_KTF.xml file from Datacap server to the
C:\Datacap\Taskmaster folder on the web server.

Datacap Web Server

Create the Datacap website.

In the Start menu, click IBM Datacap Web > Datacap Web Client
Configuration Tool.

Ensure that the setting values are appropriate or change them.

e Select alternate site if you set one up.

e Adjust ASP.NET Maximum File Upload Size and ASP Maximum
Requesting Entity Body Limit.

e Change App Pool Recycling Schedule.

e Change Connection time-out.

Click Configure, click OK, click Exit.
Start > Administrative Tools > IIS Manager.

Expand Sites > Default Web Site in Connections pane, select
tmweb.net site.

Double-click Session State. In the Cookie Settings pane, enter tmweb
in the Name field.

In the Connections pane, select the Default Web Site. In the Actions
pane under Manage Web Site, click Restart.

Datacap Web Server

Set Datacap Web Server Application Pool Identity.
Start > Administrative Tools > IIS Manager.

Select Application Pools. In the Actions pane, click Advanced
Settings.

In Process Model section, next to Identity, click browse, select
Custom account, click Set

Enter the Datacap Web Server domain/Windows account, such as
accountname@domainname and password.

Ensure that Enable 32-Bit Applications is set to True.
In Process Model section, set Load User Profile to True.
Click OK

Ensure that Web Server, Application Pool, and Default Web Site are all
started.
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On Do This

Datacap Server Start Datacap Server Service:

Click IBM Datacap Services > Datacap Server Manager. In Datacap
Server Manager, click Start.

Datacap Web Server Change the Secure Sockets Layer (SSL) Setting in Server.INI.
If using website SSL, also do the following:

Using Notepad, open c:\Datacap\tmweb.net\server.ini and ensure
UseSSL=1.

Parent topic: Client/server installation checklist

Datacap developer workstation setup

The checklist to set up the Datacap developer workstation include the tasks to ensure the .NET Framework and
Datacap client components are installed.

On Do This

Developer workstation Ensure that Microsoft .NET Framework 3.5.1 is installed.
Start > Control Panel > Programs > Programs and Features.
Select Turn Windows features on or off.

Select Microsoft .NET Framework 3.5.1 and click OK.

Reboot the machine, if prompted.

Developer workstation Run installation program wizard.

Install Datacap client components, including the separately
licensed applications and connectors to which you are entitled.
Ensure FastDoc, Datacap Studio, and Maintenance
Managercomponents are included.

Developer workstation Import encryption keys.
Navigate to the Datacap Server on which you generated keys.

Copy the dc_KTF.xml file from Datacap server to the
C:\Datacap\Taskmaster folder on the developer workstation.

e Add tmweb.net address as trusted site
The checklist to set up the Datacap server includes the task to add the Datacap Web Client tmweb.net
address as a trusted site.

e Configuring and testing IE manually
The checklist includes the tasks to configure and test Internet Explorer manually, if you do not have
access to the Datacap Web Client Configuration tool.

e Copy the application to the Datacap server
The checklist to copy an application to the Datacap server includes tasks for accessing the application
wizard in Datacap Studio and setting the location of the Datacap.xml file.

Parent topic: Client/server installation checklist
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Add tmweb.net address as trusted site

The checklist to set up the Datacap server includes the task to add the Datacap Web Client tmweb.net address
as a trusted site.

On Do This

Developer workstation, [ Add tmweb.net address as trusted site.

Workstation
Start IE > Tools > Internet Options > Security tab > Select Trusted sites > Click Sites

button > Trusted sites dialog.

On Trusted sites dialog, if the Datacap Web Client URL starts with http:, clear
Require server verification, and add either the default IP address of the Datacap
Web Client server (http://localhost) or the web server IP address or name as it is
defined in your network DNS (http://WebServerName or https://WebServerName).
Click Add.

Parent topic: Datacap developer workstation setup

Configuring and testing IE manually

The checklist includes the tasks to configure and test Internet Explorer manually, if you do not have access to
the Datacap Web Client Configuration tool.

About this task
If you do not have access to the Datacap Web Client Configuration tool, you can configure Internet Explorer
manually.
On Do This
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On

Do This

Developer workstation, Workstation

Configure IE.

Start Internet Explorer.

Tools > Internet Options > Security tab.
Select Trusted sites > click Sites button.

On Trusted sites dialog, clear Require server verification, and add
either the default IP address of the Datacap web server
(http://127.0.0.1) or the URL of the web server as it is defined in your
network's DNS (http://WebServerName or https://WebServerName).

Security tab > Click Custom level button > Security settings dialog -
Trusted Sites Zone:

Enable: Download signed ActiveX controls and Initialize and script
ActiveX controls not marked as safe for scripting.

Scroll down to Miscellaneous settings > Enable Include local
directory path when uploading files to a server.

Click OK, then close IE.

Developer workstation, Workstation

Test IE.

Start IE, enter the appropriate web server URL and test page
(http://127.0.0.7/tmweb.net/ietest.aspx,
http://WebServerName/tmweb.net/ietest.aspx, or
https://WebServerName/tmweb.net/ietest.aspx).

Click Yes to download Datacap TIFF Viewer, Thumbnails, and
DataEdit Controls.

Click Test. The red Xs change to green check marks.

Parent topic: Datacap developer workstation setup

Copy the application to the Datacap server

The checklist to copy an application to the Datacap server includes tasks for accessing the application wizard in
Datacap Studio and setting the location of the Datacap.xml file.

On

Do This
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On

Do This

Datacap Web Client server

Sharing the Datacap and tmweb.net folders on the Datacap Web Client server.

e On the Datacap Web Client server, Datacap > Properties > Sharing >
Advanced Sharing.

e Click Share this Folder, keep Datacap as Share Name, click Permissions.

e Add or ensure that the domain/Windows user ID of the developer is set
to Full Control.

e On the Datacap Web Client server, Datacap\tmweb.net > Properties > >
Security > Edit.

e Add or ensure that the domain/Windows user ID of developer is set to
Full Control.

Developer workstation

Start Datacap Studio to access the Datacap application wizard.

e In the Start menu, click IBM Datacap Developer ToolsDatacap Studio >
Close.

Developer workstation

Ensure that the correct Datacap.xml file is in use.

In Datacap Studio, click Settings.
Click the DCapp tab.

Set the path to the local datacap.xml.
Close and restart Datacap Studio.

Developer workstation

Copy the TravelDocs application to the Datacap server.

e Click Datacap application wizard > Next > Copy an existing RRS
application > Next.

e Application: TravelDocs.

e Root folder on target system: \\Server\Datacap.

e Datacap Web Client folder on the web server:
\\WebServer\Datacap\tmweb.net.

e Rename Copy: Not applicable.

e New Name: Not applicable.

e Click Next and Finish.

Developer workstation

Click View Logs to open log in \\Server\Datacap\TravelDocs and search for
errors and warnings that you need to fix.

Developer workstation

Copy datacap.xml from the developer workstation to the Datacap server.

e Windows Explorer > C:\Datacap.
e Windows Explorer > \\Server\Datacap.
e Copy datacap.xml file from C:\Datacap to \\Server\Datacap.
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On

Do This

Developer workstation Set the location of the Datacap server and the datacap.xml file.

e Inthe Start menu, click IBM Datacap Services> Datacap Application
Manager

e Select TravelDocs. Ensure that the paths are correct on the Main tab and
set Locale.

e C(Click the Datacap tab. Change the server name and address to the
correct Datacap server and set Protocol.

e Click Service tah. Ensure that the path is the correct location of the
datacap.xml file on the Datacap server.

Parent topic: Datacap developer workstation setup

Completing Datacap server setup

The checklists to complete the Datacap server setup include adding the list of applications to the Datacap.xml
file and setting security permissions on the application folder.

e Update Datacap.xml on the server

The checklist includes adding the list of applications and their locations to the Datacap.xml file.
e Set application folder security permissions

The checklist to add security to the application folder includes setting user permissions.

Parent topic: Client/server installation checklist

Update Datacap.xml on the server

The checklist includes adding the list of applications and their locations to the Datacap.xml file.

On Do This
Datacap |Update the Datacap.xml file.
server

e Make a list of the applications that exist and their locations on the server.

e Open \\Server\Datacap\datacap.xmlin Notepad.

e Edit the contents of datacap.xml to list only those applications that exist and are
configured for use. The contents are case-sensitive.

Parent topic: Completing Datacap server setup

Set application folder security permissions

The checklist to add security to the application folder includes setting user permissions.

On

Do This
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On

Do This

Datacap server

Set up security on Datacap\Application folder.
Right-click c:\Datacap\Application folder and select Properties.

On the Security tab, add NETWORK SERVICE and local IUSR and set to
allow Full Control.

Add or ensure that the domain/Windows user IDs of developers are set to
allow Full Control.

Add or ensure that the domain/Windows user ID of Datacap Web Client is
set to allow Read & Execute.

Add or ensure that the domain/Windows user ID of Datacap Server Service
is set to allow Full Control.

When Batches folders are staying on the server in C:\Datacap\Application
path, add or ensure that the domain/Windows user IDs of Datacap users
are set to allow Full Control.

Parent topic: Completing Datacap server setup

Complete the Datacap Web Client setup

The checklist to complete the Datacap Web Client setup includes adding the location of the Datacap.xml file on

the Datacap server.

On

Do This

Datacap Web Client server

Set the location of the Datacap.xml file.

e Inthe Start menu, click IBM Datacap Services>Datacap
Application Manager

e Click Service tab. Ensure the path is the correct location of the
datacap.xml on the Datacap server.

Datacap Web Client server

Restart Internet Information Services (IIS)

Parent topic: Client/server installation checklist

Running a Datacap client on Developer Workstation

You can quickly test and confirm that each job a workflow is operating correctly by starting the Datacap Server
Service and running a task in Datacap Desktop

On Do This

Server Start Datacap Server Service

In the Start menu, click IBM Datacap Services> Datacap Server Manager> Start
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On Do This

Developer Test client Application

Workstation
Start > Programs > IBM Datacap Clients > Datacap Desktop

Run and test the client and confirm that each job in the workflow is processing
correctly

Exit client

Parent topic: Client/server installation checklist

Remote workstation setup

The checklist includes tasks to add the TMWeb.net address as a trusted site, configure and test Internet
Explorer manually, and run theDatacap Web Client application. You can use the Web Client Configuration tool
to create a package for a user to configure and test Internet Explorer at the remote workstation.

e Packaging the Web Client Configuration tool
The checklist includes the tasks to create a package for a user to configure Internet Explorer on a
remote workstation to access Datacap Web Client.

e Add tmweb.net address as trusted site
The checklist to set up the Datacap server includes the task to add the Datacap Web Client tmweb.net
address as a trusted site.

e Configuring and testing IE using a package
The checklist includes the tasks to create a package for configuring and testing a remote connection
with Internet Explorer.

e Configuring and testing IE manually
The checklist includes the tasks to configure and test Internet Explorer manually, if you do not have
access to the Datacap Web Client Configuration tool.

e Run the Datacap Web Client application
The checklist to run the Datacap Web Client application includes starting the Datacap server service and
entering the appropriate web server URL address on your browser.

Parent topic: Client/server installation checklist

Packaging the Web Client Configuration tool

The checklist includes the tasks to create a package for a user to configure Internet Explorer on a remote
workstation to access Datacap Web Client.

About this task

On Do This
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On Do This

Any machine | Package the Web Client Configuration tool.
with Datacap

installed Open C:\Datacap\support\WebConfiguration folder.

Make backup copy of WebClientConfig.exe.config file.

Open WebClientConfig.exe.config file and change server name in
<value>http://localhost/tmweb.net</value>.

Save and close .config file.

Send WebClientConfig.exe.config, Datacap.Config.dll, and WebClientConfig.exe to the user
with instructions to add the TMWEb.net address as trusted site, and configure and test
Internet Explorer using the package.

Parent topic: Remote workstation setup

Add tmweb.net address as trusted site

The checklist to set up the Datacap server includes the task to add the Datacap Web Client tmweb.net address
as a trusted site.

On Do This

Developer workstation, | Add tmweb.net address as trusted site.

Workstation
Start IE > Tools > Internet Options > Security tab > Select Trusted sites > Click Sites

button > Trusted sites dialog.

On Trusted sites dialog, if the Datacap Web Client URL starts with http:, clear
Require server verification, and add either the default IP address of the Datacap
Web Client server (http://localhost) or the web server IP address or name as it is
defined in your network DNS (http://WebServerName or https://WebServerName).
Click Add.

Parent topic: Remote workstation setup

Configuring and testing IE using a package

The checklist includes the tasks to create a package for configuring and testing a remote connection with
Internet Explorer.

About this task

You can use these instructions if your Administrator sent you the appropriate files. Otherwise, follow the
instructions in Configuring and testing IE manually. On a 64-bit operating system, you must use 32-hit version
of Internet Explorer. On Windows 2008, when Internet Explorer Enhanced Security Configuration for Users is
ON, you must access Datacap Web Client from a different machine.

On Do This

Workstation Ensure that you add the tmweb.net address to IE as a trusted site.

220 Datacap 9.1.3



On Do This

Workstation In IE, on Tools > Internet Options > Security > Custom level

Scroll down to Miscellaneous settings, enable Include local
directory path when uploading files to a server.

Workstation Configure IE.
Extract the files your Administrator provided.
Double-click the WebClientConfig.exe file.

Enter or ensure that the URL is the web server IP address or name
(http://WebServerName/).

Click Configure, click OK, click Exit.

Workstation Test IE.

Start IE, enter the appropriate web server URL and test page
(http://127.0.0.7/tmweb.net/ietest.aspx,
http://WebServerName/tmweb.net/ietest.aspx, or
https://WebServerName/tmweb.net/ietest.aspx).

Click Yes to download Datacap TIFF Viewer, Thumbnails, and
DataEdit Controls.

Click Test - red Xs change to green check marks.

Parent topic: Remote workstation setup

Configuring and testing IE manually

The checklist includes the tasks to configure and test Internet Explorer manually, if you do not have access to
the Datacap Web Client Configuration tool.

About this task
If you do not have access to the Datacap Web Client Configuration tool, you can configure Internet Explorer
manually.
On Do This
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On

Do This

Developer workstation, Workstation

Configure IE.

Start Internet Explorer.

Tools > Internet Options > Security tab.
Select Trusted sites > click Sites button.

On Trusted sites dialog, clear Require server verification, and add
either the default IP address of the Datacap web server
(http://127.0.0.1) or the URL of the web server as it is defined in your
network's DNS (http://WebServerName or https://WebServerName).

Security tab > Click Custom level button > Security settings dialog -
Trusted Sites Zone:

Enable: Download signed ActiveX controls and Initialize and script
ActiveX controls not marked as safe for scripting.

Scroll down to Miscellaneous settings > Enable Include local
directory path when uploading files to a server.

Click OK, then close IE.

Developer workstation, Workstation

Test IE.

Start IE, enter the appropriate web server URL and test page
(http://127.0.0.7/tmweb.net/ietest.aspx,
http://WebServerName/tmweb.net/ietest.aspx, or
https://WebServerName/tmweb.net/ietest.aspx).

Click Yes to download Datacap TIFF Viewer, Thumbnails, and
DataEdit Controls.

Click Test. The red Xs change to green check marks.

Parent topic: Remote workstation setup

Run the Datacap Web Client application

The checklist to run the Datacap Web Client application includes starting the Datacap server service and
entering the appropriate web server URL address on your browser.

On Do This

Dataca | Start Datacap Server Service.

p

Server |Inthe Start menu, click IBM Datacap Services> Datacap Server Manager> Start
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On Do This
Workst | Run Datacap Web Client.
ation

Start IE, and enter the appropriate web server URL (http://127.0.0.7/tmweb.net,
http://WebServerName/tmweb.net, or https://WebServerName/tmweb.net).

Sign on as Datacap User Admin, Password admin, and Station 1.

Run and test the client using the images in the application's images folder. Confirm that each job in
the workflow is processing correctly. You have to switch back to thick client to run some jobs.

Parent topic: Remote workstation setup

User workstation and permissions setup

The checklist to set up the user workstation includes setting up sharing and security permissions, importing
encryption keys, and installing the Datacap client components.

On

Do This

Workstation

Ensure that Microsoft .NET Framework 3.5.1 is Installed
Start > Control Panel > Programs > Programs and Features
Select Turn Windows features on or off

Select Microsoft .NET Framework 3.5.1 and click OK

Reboot the machine, if prompted.

Workstation

Run installation program wizard.

Install theDatacap client component - exclude all components except
Datacap Client and the connectors to which you are entitled

Expand Datacap client. Exclude the Applications, Datacap Studio, and
Maintenance Manager components. Exclude FastDoc, if you are not
using it.

Workstation

Import encryption keys
Navigate to the Datacap server on which you generated keys

Copy the dc_KTF.xml file from Datacap server to the
C:\Datacap\Taskmaster folder on the developer workstation.
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On

Do This

Datacap server

Set up sharing and security permissions for users.

Set up sharing on the Datacap folder. Add or ensure that the
domain/Windows user IDs of Datacap users are set to allow Full
Control.

Set up security on Datacap folder: Add or ensure that the
domain/Windows user IDs of Datacap users are set to allow Read &
Execute.

Set up security on the application folder. Add or ensure that the
domain/Windows user IDs of Datacap users are set to allow Full
Control

Workstation

Optional: Install Scanner

Ensure that scanner works outside of Datacap, set up application to
use scanner

Workstation

Set the location of Datacap.xml file.

In the Start menu, clickIBM Datacap Services > Datacap Application
Manager

Click Service tab. Ensure that path location of the datacap.xml on
Datacap server is correct.

Parent topic: Client/server installation checklist

Datacap Report Viewer setup

To install Report Viewer in a client server environment, you must perform the required set up tasks on the

server and the workstation.

On Do This

Serve | Ensure that a domain/Windows Account Exists for Report Viewer

When Datacap Web or Report Viewer are installed on the same web server, they must use the same
domain/Windows account.

Ensure that a domain/Windows account exists for Report Viewer

serve

Web |Add Report Viewer account to Administrators group

Add domain/Windows account to Administrators group

Serve | Stop Datacap Server Service

In the Start menu, click IBM Datacap Services> Datacap Server ManagerStop
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On Do This
Web | Ensure that Microsoft .NET Framework 3.5.1 is Installed
serve
r Start > Administrative Tools > Server Manager
In the Server Manager hierarchy pane, select Features
Click Add Features
Select .NET Framework 3.5.1 Feature, click Next
Click Install
Web | Ensure that Required IIS Components are Installed
serve
r Start Administrative Tools > Server Manager
Expand Roles, select Web Server (IIS)
In Web Server (IIS) pane:
Under Common HTTP Features, ensure Static Content is installed
Scroll down to Role Services, under Application Development ensure that ASP.NET and ASP modules
are installed
Scroll down further to Management Tools, ensure that IIS Management Console is installed
Serve | Set Report Viewer Sharing Permissions on Datacap Folder
r
Right-click C:\Datacap folder, select Sharing, select Advanced Sharing
Click Permissions, add Report Viewer account, set to allow Read
Serve | Set Report Viewer Security on Datacap Folder
r
Right-click C:\Datacap folder, select Properties
Click Security tab
Add Report Viewer account, set to allow Read & Execute
Web |Install Report Viewer on web server
serve
r Install only Report Viewer component
Web | To use ADSI or LDAP authentication with Report Viewer, confirm that EnableLDAP value="true" in
serve | the Datacap\RV2\web.config file.
r
Web | Import encryption keys
serve

Navigate to the Datacap Server on which you generated keys

Copy the dc_KTF.xml file from Datacap Server to the C:\Datacap\Taskmaster folder on the web server
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On

Do This

Web
serve

Add Application Pool for Report Viewer

Start > Administrative Tools >Internet Information Services Manager

Connections pane > Expand the Server > right-click Application Pools, select Add Application Pool
Set: Name to Report Viewer

Set: .NET Framework version to v 4.0.30319

Set: Managed pipeline mode to Integrated

Select: Start application pool immediately, click OK

Web
serve

Create Report Viewer Web Site

Start > Administrative Tools >Internet Information Services Manager

Connections pane > Expand the Server > expand Sites

Right-click Default Web Site, select Add Application

Set: Alias to Report Viewer

Click Select, select the Report Viewer Application Pool you added (Report Viewer), click OK

Set: Physical path to C:\Datacap\RV2, click OK

Connections pane, select Application Pools

Select Report Viewer application pool, then in Actions pane, click Advanced Settings

Ensure that Microsoft .NET version is set to v4.0, ensure that Enable 32-Bit Applications is set to True

Click Browse next to Process Model Identity, select Custom account, click Set and enter Report Viewer
domain/Windows account information (accounthname@domainname), click OK

Set Load User Profile to True, click OK

Select the Report Viewer site, double-click Session State

Under Cookie Settings, change Name to Report Viewer, click Apply

Connections pane, select Default Web Site, in Actions pane, under Manage Web Site, click Restart

Ensure that Web Server, Application Pool and Default Web Site are all started

Web
serve

Set Location of Datacap.xml
In the Start menu, click IBM Datacap Services and select Datacap Application Manager.

Click Service tab, change path to reflect the location where the datacap.xml file is located on the
Server (\\Server\Datacap\datacap.xml)
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On Do This
Web | Set the database type
serve

Open the \Datacap\RV2 folder.
Back up the reports.xml file and then edit the original file by setting the dbtype parameter:

Microsoft Access

dbtype="0"
SQL Server

dbtype="1"
Oracle

dbtype="2"
DB2

dbtype="3"

Apply for all applicable reports, and then save reports.xml.

e Viewing Datacap Report Viewer reports
To view Report Viewer reports in a client server environment, you must perform the required set up
tasks on the server and the workstation.

Parent topic: Client/server installation checklist

Viewing Datacap Report Viewer reports

To view Report Viewer reports in a client server environment, you must perform the required set up tasks on
the server and the workstation.

Oon Do This

Server Start Datacap Server Service
Start > All Programs > Datacap > Administrator > Datacap > Datacap Server Manager > Start

Workstati | Add Report Viewer Address as Trusted Site

on or

developer Start IE > Tools > Internet Options > Security tab > Select Trusted sites > Click Sites button >

workstatj | Trusted sites dialog

on On Trusted sites dialog, if Report Viewer URL starts with http:, clear Require server verification,
and add either the default IP address of the Datacap web server (http://localhost) or the web
server's IP address or name as it is defined in your network's DNS (http://WebServerName or
https://WebServerName), click Add
Click Close

Workstati | Log onto Report Viewer, View Standard Report

on or

developer Start IE, enter http://WebServerName/RV2/Login.aspx

kstati .. - .
\;vr(])r statl Select Batch Productivity report, select application, click Run Report
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On Do This

Workstati | Create Report Viewer Report Filter

on or
developer On home page, select report
\(/)v':)rkstah Click Manage Filters

In Add Filter field, enter name for new filter, click Add
Select column name, select action, enter value

Click Add Field to add another field

Select Public or Private

Click Save

Click Run Report

Workstati | Add Reports to Report Viewer Dashboard

on or
developer On home page, click Dashboard
\;Vr?rkStatl Select report and application name, select filter

Click Add to add another report

Click Refresh and select a refresh interval

Parent topic: Datacap Report Viewer setup

Rulerunner installation and configuration

The checklist includes tasks to set security and sharing permissions on the Datacap\RRS folder, install

Rulerunner, and import encryption keys.

On Do This

All Shut down Datacap software on all machines.

e Datacap client software.
e Datacap Web Client.

e Datacap Web Services
e Datacap Server service.

Datacap server Set sharing permissions on the Datacap folder.

e Click the Sharing tab and click Advanced Sharing.
e Click Permissions.

to allow Full Control.

e Right-click the C:\Datacap folder and select Properties.

e Add or ensure that the domain/Windows account for Rulerunner is set
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On

Do This

Datacap server

Set up security on Datacap folder.

e Right-click the C:\Datacap folder and select Properties.

e Click the Security tab and click Edit.

e Add or ensure that the domain/Windows account for Rulerunner set to
allow Full Control.

Datacap server

Set up security on the Datacap\RRS folder.

e Right-click C:\Datacap\RRS folder and select Properties.

e Click Security tab and click Edit.

e Add or ensure that domain/Windows account for Rulerunner set to
allow Full Control.

Datacap server

Set up security on Datacap\Application folder.

e Right-click the C:\Datacap\Application folder and select Properties.

e Click Security tab and click Edit.

e Add or ensure that domain/Windows account for Rulerunner set to
allow Full Control.

Rulerunner server

Ensure that Microsoft .NET Framework 3.5.1 is installed.

e Start > Administrative Tools > Server Manager.

¢ Inthe Server Manager hierarchy pane, select Features.
e Click Add Features.

e Select .NET Framework 3.5.1 Feature and click Next.

e Click Install.

Rulerunner server

Install Rulerunner on the Rulerunner server.

¢ Install Datacap client, Rulerunner, and separately licensed connectors
to which you are entitled.

Rulerunner server

Install all required third-party software components, if Rulerunner is
exporting to IBM® or third-party repositories.

Rulerunner server

Import encryption keys.

¢ Navigate to the Datacap server on which you generated keys.
e Copy the dc_KTF.xml file from the Datacap Server to the
C:\Datacap\Taskmaster folder on the Rulerunner server.

Rulerunner server

Set the location of Datacap.xml file.

e 1Inthe Start menu, click IBM Datacap Services > Datacap Application
Manager.

e Click the Service tab and change the path to the location of the
datacap.xml file, such as \\Server\Datacap\datacap.xml.

e Configure Rulerunner account permissions
The checklist to configure the Rulerunner account includes tasks for setting up security and granting
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permissions.

e Configure Rulerunner authentication
The checklist includes tasks that setting up Rulerunner to authenticate with the Datacap authentication
method or an external authentication system.

e Configure Rulerunner to run application tasks
The checklist includes configuring task profiles in the Datacap Application Manager and adding threads
for the Rulerunner to run application tasks.

Parent topic: Client/server installation checklist

Configure Rulerunner account permissions

The checklist to configure the Rulerunner account includes tasks for setting up security and granting

permissions.

On

Do This

Rulerunner server

Grant Rulerunner account DCOM Config permissions.

Start > Administrative Tools > Component Services > Computers > My Computer >
DCOM Config > DCOProcessor application.

Right-click DCOProcessor application and select Properties.

e Click the Security tab. Set Launch and Activate permissions to Customize
and click Edit.

e Add Rulerunner account and set Local Launch and Local Activation to
Allow.

Right-click RRProcessor and select Properties.

e Click the Security tab. Set Launch and Activate permissions to Customize
and click Edit.

e Add Rulerunner account and set Local Launch and Local Activation to
Allow.

Rulerunner server

Set up security on systemprofile\AppData folder.

e Right-click C:\Windows\SysWOWé64\config\systemprofile\AppData folder
and select Properties.

e Click Security tab, click Edit.

e Add or ensure that domain/Windows account for Rulerunner set to allow
Modify.

Rulerunner server

Grant Rulerunner Log On as a Service privilege.

e Start > Administrative Tools > Services.

e Right-click Rulerunner Service and select Properties.

e Click the Log On tab and select This account. Click Browse and select the
Rulerunner account and enter the password. Click Apply.

Parent topic: Rulerunner installation and configuration

Configure Rulerunner authentication
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The checklist includes tasks that setting up Rulerunner to authenticate with the Datacap authentication
method or an external authentication system.

On

Do This

Datacap server

Create or ensure that a domain/Windows account exists for Rulerunner. All
instances of Rulerunner can use the same account.

Datacap server

Start the Datacap Server service.

In the Start menu, click IBM Datacap Services > Datacap Server Manager .

Developer workstation

Log in to Datacap Web Client.

e Open Internet Explorer and enter http://WebServerName.
e Select application, enter user ID, password, station, and click Login.

Developer workstation

When you are using Datacap authentication

e Create or ensure a Datacap user exists that Rulerunner can use.

e Create or ensure a Datacap station exists that Rulerunner can use.

e Set up Rulerunner to use Datacap Authentication and enter Datacap
user, password, and station.

Developer workstation

When you are using ADSI or LDAP

e Obtain the name of the domain and authentication security group.

e (Create or ensure a domain/Windows account exists that Rulerunner
can use.

e Add group to Datacap application where Name is a group ID that is a
concatenation of your security group name, a dot, and the short
domain name.

e Add station to Datacap application where Name is the name of
Rulerunner server, and set Maximum to 9999.

e Set up Rulerunner to use Windows Authentication.

Developer workstation

When you are using ADLDS or LLLDAP

e Create or ensure that an account for Rulerunner is set up in ADLDS
or LLLDAP authentication system.

e Add Datacap user to application with same name as authentication
system account.

e Add station to Datacap application.

e Set up Rulerunner to use Datacap Authentication and enter Datacap
user, password, and station.

Parent topic: Rulerunner installation and configuration

Configure Rulerunner to run application tasks

The checklist includes configuring task profiles in the Datacap Application Manager and adding threads for the
Rulerunner to run application tasks.

On

Do This
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On

Do This

Various

Ensure the following before starting.

e Ensure that you have working versions of your Datacap applications
and that you have successfully run all tasks manually.

e Configure Rulerunner authentication.

e Install Rulerunner on a server that is running Windows Server
2008.

e Determine which Datacap tasks to process, and gather required
task information.

Developer workstation

Configuring task profiles in the Datacap Application Manager.

e Inthe Start menu, click IBM Datacap Services>Datacap Application
Manager

e Select application, ensure that paths are correct.

e Click Rulerunner tab. Click the red X to remove task profiles that
Rulerunner is not to process.

e Click Add new Task to add a profile that Rulerunner is to process.
Profile names are case-sensitive.

Various

Stop and restart Datacap server service.

e Inthe Start menu, click IBM Datacap Services>Datacap Server
Manager.

e Click Stop.

e Click Start.

Rulerunner server

Start Rulerunner.

e Inthe Start menu, click IBM Datacap Services>Datacap Rulerunner
Manager > Start.

e Click Rulerunner Login . Select Datacap Authentication and enter
credentials. Click Connect.

e Click Workflow:Job:Task tab. Click the box next to MyApp1 to
expand the tree.

Rulerunner server

Configure Rulerunner to run a task.

e Right-click Threads. Select Add Thread to add a single thread or
Add Threads to add more than one thread.

e Inthe other pane, under My2app1, click the box next to the node.
Click and drag the node onto the thread in right pane.

e C(Click Save and Yes.

e Ifrequired, click node and change priority or increase value for
skipsamebatch.

e Ifrequired, click the Logging tab and change the settings.

e Click Save.

e Click Rulerunner Login tab, click Disconnect.
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On

Do This

Rulerunner server

Reset Rulerunner Login Credentials.

Reset login credentials for Rulerunner, if you are not using Datacap
Authentication.

Rulerunner server

Run Myapp1l tasks, start Rulerunner, and monitor batches that are
processed by Rulerunner.

Parent topic: Rulerunner installation and configuration

Fingerprint Service setup

The checklist includes tasks to configure the Fingerprint service application pool and set up security on the

Datacap and application folders.

On

Do This

Datacap server

Create or ensure that a domain/Windows account exists for the Datacap
Fingerprint service.

Datacap server

Set Sharing Permissions for Datacap folder.

e Right-click C:\Datacap folder and select Properties.

e Click Sharing tab, click Advanced Sharing.

e Click Permissions.

e Add or ensure that domain/Windows account for Fingerprint
Service set to allow Full Control.

Datacap server

Set Security on Datacap\Application\fingerprint folder.

¢ Right-click C:\Datacap\Application\fingerprint folder and select
Properties.

e Click Security tab, click Edit.

e Add or ensure that domain/Windows account for Fingerprint
Service is set to allow Read & Execute.

Datacap server

Set Security on Datacap\Application\Batches folder.

e Right-click C:\Datacap\Application\Batches folder and select
Properties.

e Click Security tab, click Edit.

e Add or ensure that domain/Windows account for Fingerprint
Service is set to allow Read & Execute.

Fingerprint server

Install Fingerprint service.

Install only Rulerunner component.
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On Do This

Fingerprint server Set Security on Datacap\FingerprintService folder.

e Right-click C:\Datacap\FingerprintService folder and select
Properties.

e Click Security tab, click Edit.

e Add NETWORK SERVICE and local IUSR and set both to allow Read
& Execute.

Fingerprint server Add Fingerprint Service account to IIS_IUSRS group.

e Start > Control Panel > Administrative Tools > Computer
Management > Local Users and Groups > Groups > IIS_IUSRS and
select Properties.

e Add Fingerprint Service domain/Windows account, click OK.

Fingerprint server Add Application Pool for Fingerprint service.

e Start > Control Panel > Administrative Tools > Internet Information
Services Manager > Connections pane. Expand the server name and
right-click Application Pools. Select Add Application Pool.

e Set Nameto fpservice.

e Set.NET Framework versiontov4.0.30319.

e Set Managed pipeline mode to Integrated.

e Select Start application pool immediately,

Fingerprint server Set up Fingerprint service.

e Start > Control Panel > Administrative Tools > Internet Information
Services Manager > Connections pane. Expand Server and Sites.
Right-click Default Web Site and select Add Application.

e Set Alias to fpservice.

e Click Select, select fpservice Application Pool, click OK.

e Set Physical path to C:\Datacap\FingerprintService.

e Click OK.

e Click Test Settings, click Close, click OK.

¢ In Connections pane, select Application Pools

e Select fpservice Application Pool and click Advanced Settings.

e Set Enable 32-Bit Applications to True.

e In Process Model > Identity, click the browse button. Select Custom
account and Set.

e Enter the Fingerprint Service domain/Windows account information
in the format, accountname@domainname. This information is the
same account that you added to the Fingerprint server IIS_IUSRS
group. Enter the account's password twice, click OK

e In Process Model > Idle Time-out, set to zero, click OK.

e Test Fingerprint Service setup

The checklist includes tasks to validate the Fingerprint service installation and confirm the service can

load fingerprints.

Parent topic: Client/server installation checklist
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Test Fingerprint Service setup

The checklist includes tasks to validate the Fingerprint service installation and confirm the service can load

fingerprints.

On

Do This

Fingerprint server

Validate Fingerprint Service Installation.

Start Internet Explorer enter http://127.0.0.1/
fpservice/Service.asmx?WSDL to display the Service CCO Fingerprints
DB Service page.

Fingerprint server

Confirm the Fingerprint service can load fingerprints.

In the Start menu, click IBM Datacap Developer Tools>Datacap
Fingerprint Service Test Tool .

Enter the application name.

Enter Fingerprints URL as http://127.0.0.1/fpservice/Service.asmx?
WSDL.

Enter the full UNC path to the fingerprint directory of your application
in the Fingerprint Directory field. Click Upload All Fingerprints From
Directory, confirm number of Fingerprints Loaded is correct and the
names are correct.

Confirm that the Fingerprint Service matches .cco file to a loaded
fingerprint. Enter the full path of one fingerprint, which is displayed in
the pane, in the Find Fingerprint field. Click Find Fingerprint. Match
results should be 1.00;1;0;0.

Parent topic: Fingerprint Service setup

Datacap Maintenance Manager setup

You must complete the required account and configuration settings before you can runDatacap Maintenance
Manager on Datacap in a client/server environment. You can run Maintenance Manager for demonstration,
proof of concept, development, and test purposes.

About this task

On Do This

Server Create or ensure that a domain/Windows account exists for Maintenance
Manager
Create or ensure that a domain/Windows account exists for the developer

Server Ensure that the domain/Windows account for the developer was granted
sharing and security permissions on the Server. These permissions allow the
development of a new Maintenance Manager application, see Configuring
Datacap on the server.
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On Do This

Developer workstation, the [Add Maintenance Manager domain/Windows account to the Administrators or
computer on which Backup Operators group

Maintenance Manager runs
in production

Server Set Maintenance Manager account sharing permissions for Datacap folder
Right-click C:\Datacap folder and select Properties

Click Sharing tab, click Advanced Sharing

Click Permissions

Add or ensure that Domain/Windows account for Maintenance Manager set to
allow Full Control

Server Set Maintenance Manager account security permissions for Datacap folder
Right-click C:\Datacap folder and select Properties
Click Security tab

Add or ensure that Domain/Windows account for Maintenance Manager set to
allow Read & Execute

Server Set Maintenance Manager account security permissions for Datacap\RRS folder
Right-click C:\Datacap\RRS folder and select Properties
Click Security tab

Add or ensure that Domain/Windows account for Maintenance Manager set to
allow Read & Execute

Developer workstation Run installation program wizard

Install Datacap Client component (including Datacap Studio, Maintenance
Manager ), and the applications and connectors to which you are entitled

Developer workstation Import encryption keys
Go to the Datacap Server on which you generated keys

Copy the dc_KTF.xml file from Datacap Server to the C:\Datacap\Taskmaster
folder on the developer workstation

Parent topic: Client/server installation checklist

Datacap installation command-line parameters

You can run the Datacap installation program Setup.exe file by using command-line parameters from the
command line.

About this task

The parameters that are available are the installation program parameters, the Microsoft Windows Installer
parameters, and the Datacap-specific parameters.
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e Viewing the installation program parameters
Open the Datacap installation program Setup.exe file to display a list of the parameters.
® Microsoft Windows Installer parameters
Open the msiexec.exe file in Datacap to display a list of the Microsoft Windows Installer parameters.
e Commonly used Datacap Setup.exe parameters
You can use the Datacap Setup.exe parameters to run a silent installation of Datacap and many of its
components.

Parent topic: Installing and configuring in a client/server environment

Viewing the installation program parameters

Open the Datacap installation program Setup.exe file to display a list of the parameters.

About this task

To view the installation program parameters that are available, follow this procedure.

Procedure

1. From the Windows Start menu, select Run. The Run dialog opens.

2. Click Browse and go to the folder that contains the Datacap installation program Setup.exe file.

3. Select Setup.exe and click Open. The Browse window closes and the full path to the Setup.exe file is
displayed in the Run dialog.

4. After Setup.exe, add a space and /2 then click OK. The installation program parameters are displayed.

5. Click OK to close the installation program message box.

Parent topic: Datacap installation command-line parameters

Microsoft Windows Installer parameters

Open the msiexec.exe file in Datacap to display a list of the Microsoft Windows Installer parameters.

About this task

To view the Microsoft Windows Installer parameters that are available:

Procedure

1. From the Windows Start menu, select Run. The Run dialog opens.

2. Click Browse and navigate to the folder containing the Microsoft Windows Installer program msiexec.exe
file.

3. Select msiexec.exe and click Open. The Browse window closes and the full path to the msiexec.exe file
is displayed in the Run dialog.

4. After msiexec.exe, add a space and /? (for example: C:\WINDOWS\system32\msiexec.exe /?), then click
OK. The Windows Installer parameters are displayed.

5. Click OK to close the Windows Installer message box.

Parent topic: Datacap installation command-line parameters

Commonly used Datacap Setup.exe parameters
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You can use the Datacap Setup.exe parameters to run a silent installation of Datacap and many of its
components.

The following table describes how to use the command lines that are most commonly used when you are
installing Datacap.

Attention:

When these commands are run, they must be run as Administrator.

When you are installing components individually, you must also install the LAP and Shared components,
otherwise the individual component does not function properly.

Name/value pairs, such as INSTALLDIR=\"<path>\" and ADDDEFAULT=LAP, Shared, Server, are
case-sensitive. Each Name is capitalized. The case values are as shown in the table.

Replace <path> with full path (for example C:\Datacap).

Replace <filename> with name to assign to log file (for example: InstallLog).

To prevent unintended changes to the main Datacap application settings file (datacap.xml), the version
of theApplication Manager that is installed with every component during a command-line installation is a
restricted version. The restricted version allows only the location of the datacap.xml file to be changed.
Add the DSACTION=3 parameter to the command to install the unrestricted version of the Application
Manager. For an example, see the reference in the following table, Datacap Desktop and Datacap Studio.

To Do This Use This Command Line

Silent Installation: Quiet mode, no user setup.exe /S /V"/quiet DSACTION=3"
interaction, all components installed

Silent Installation: Quiet mode, different setup.exe /S /V"/quiet INSTALLDIR=\"<path>\"
location, all components installed

DSACTION=3"

Silent Installation: Unattended mode, progress setup.exe /S /V"/passive DSACTION=3"
bar only, all components installed

Silent Installation: Unattended mode, different setup.exe /S /V"/passive INSTALLDIR=\"
location, all components installed

<path>\" DSACTION=3"

Create Install Log, all components installed setup.exe /V"/log <path>\<filename>.txt
DSACTION=3"
Install Datacap Server only setup.exe /S /V"/passive

ADDDEFAULT=LAP, Shared, Server"

Install Datacap Server and Datacap Web Client |setup.exe /S /V"/passive

ADDDEFAULT=LAP, Shared, Server, Web"

Install Datacap Desktop setup.exe /S /V"/passive

ADDDEFAULT=LAP, Shared,Client"

Install Datacap Desktop and Datacap Accounts | setup.exe /S /V"/passive
Payable application

ADDDEFAULT=LAP, Shared,Client, APT"

Manager (Notification)

Install Datacap Desktop and Medical Claims setup.exe /S /V"/passive

Application ADDDEFAULT=LAP, Shared,Client,MClaims"

Install Datacap Desktop and FastDoc setup.exe /S /V"/passive
ADDDEFAULT=LAP, Shared,Client, FastDoc"

Install Datacap Desktop and Datacap Studio setup.exe /S /V"/passive
ADDDEFAULT=LAP, Shared, Client, DStudio
DSACTION=3"

Install Datacap Desktop and Maintenance setup.exe /S /V"/passive

ADDDEFAULT=LAP, Shared,Client, NENU"
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To Do This Use This Command Line

Install Rulerunner (Rulerunner Service and setup.exe /S /V"/passive
Fingerprint Service) ADDDEFAULT=LAP, Shared, Rulerunner

Install Datacap Web Client setup.exe /S /V"/passive
ADDDEFAULT=LAP, Shared, Web"

Install Datacap Web Services setup.exe /S /V"/passive
ADDDEFAULT=LAP, Shared, wTM"

Install Report Viewer setup.exe /S /V"/passive
ADDDEFAULT=LAP, Shared, RV2"

Install eMail Input (eMail & eDoc) setup.exe /S /V"/passive
ADDDEFAULT=LAP, Shared, eMail"

Install Fax Input setup.exe /S /V"/passive
ADDDEFAULT=LAP, Shared, Fax"

Install Documentum Connector setup.exe /S /V"/passive
ADDDEFAULT=LAP, Shared, Documentum"

Install SharePoint Connector setup.exe /S /V"/passive
ADDDEFAULT=LAP, Shared, SharePoint"

Install Insight Edition (Document Analytics) setup.exe /S /V"/passive
ADDDEFAULT=LAP, Shared, DocumentAnalytics"

Parent topic: Datacap installation command-line parameters

Configuring Datacap databases

The Datacap applications can use DB2®, Microsoft SQL Server, or Oracle databases to store workflow
definitions, security parameters, processing information, and fingerprints.

Datacap is installed with sample applications and templates that use Microsoft Access for their application
databases. However, Microsoft Access is not supported in a Datacap production environment.

You can configure the following Datacap application databases to use DB2, Microsoft SQL Server, or Oracle:

Administration database
Contains definitions of the workflows, jobs, and tasks in the application. Also contains the security
parameters for the users, user groups, stations, and job-task shortcut icons in the application.
Engine database
Stores current and historical processing information for each batch of documents and its contents.
Fingerprint database
Manages the fingerprints of the application if you are using matching fingerprints to identify and align
forms for the application.

Note: For the Admin, Engine, and Fingerprint databases, when connecting to an Access database, use Microsoft
Access (Jet). If Microsoft Access (Jet) interface is not used, then the applications might go through connection
issues. Microsoft Access (ACE) interface is generally used with a specific type of databases such as LookupDB,
and not recommended to connect with Admin, Engine, or Fingerprint databases.

Lookup and other application-specific databases that do database tasks for the Datacap applications can also
be configured to use DB2, Microsoft SQL Server, or Oracle.

The following information describes how to define the database structure, populate the database, move the
database, and configure the application to use the database. This information does not describe how to do
lookups or export to the database.
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Prerequisites

Before you can configure a DB2, SQL Server, or Oracle database for a Datacap application, you must have
access to the database. A Database Administrator must initially create each DB2, SQL Server, or Oracle
database and grant appropriate access rights.

For SQL Server, if you want to create an isolated test environment, you can use Microsoft SQL Server Express®,
which you download from the Microsoft website.

For Oracle, the Oracle client must be installed on any computers that communicate directly with an Oracle
database. You must install the appropriate third-party drivers or software (for example, Oracle connectivity
software) on the computer where a Datacap component needs to communicate with the database. For
example, the third-party drivers or connectivity software must be installed on:

e The machine where Datacap Server is installed.

e The machine where Rulerunner is installed, if an application calls actions that performs lookups to these
databases.

e Other machines running the client software if the clients perform lookups or other queries to the
database.

The computers on which you run the clients that connect to the Fingerprint database or Oracle, or run rules
that make SQL calls to any Oracle database, such as for lookups, require the Oracle client installed. These
clients include Datacap Desktop, Datacap FastDoc, Rulerunner, and Datacap Web Client. When you are using
the Application Copy Tool, that computer must have the Oracle client that is installed and connectivity to any
source or destination Oracle database.

For DB2, the DB2 client must be installed on any computers that communicate directly with a DB2 database.
You must install the appropriate third-party drivers or software (for example, DB2 connectivity software) on the
computer where a Datacap component needs to communicate with the database. For example, the third-party
drivers or connectivity software must be installed on:

e The machine where Datacap Server is installed.

e The machine where Rulerunner is installed, if an application calls actions that performs lookups to these
databases.

e Other machines running the client software if the clients perform lookups or other queries to the
database.

The computers on which you run the clients that connect to the Fingerprint database or DB2, or run rules that
make SQL calls to any DB2 database, such as for lookups, require the DB2 client installed. These clients
include Datacap Desktop, Datacap FastDoc, Rulerunner, and Datacap Web Client. When you are using the
Application Copy Tool, that computer must have the DB2 client that is installed and connectivity to any source
or destination DB2 database.

e Configuring an application to use the database
You configure the Datacap application for a DB2, Microsoft SQL Server, or Oracle database by using
Datacap Application Manager to set the encrypted connection strings that are stored in the application
configuration (.app) file.

e Database security permissions
Datacap users must have database permissions for DB2, Microsoft SQL Server, or Oracle to create the
database and its schema, initialize the data in the database, and run daily operations on the database.

e Defining the database structure
SQL scripts define the structure of the Datacap application databases for DB2, Microsoft SQL Server, or
Oracle databases.

e Moving the application files
You can use the Datacap Application wizard to copy a Microsoft Access based application and move it to
a folder on another computer.
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e Verifying the database connection
After you configure the application for the database, verify the connection to the DB2, Microsoft SQL
Server or Oracle database works properly.

Configuring an application to use the database

You configure the Datacap application for a DB2®, Microsoft SQL Server, or Oracle database by using Datacap
Application Manager to set the encrypted connection strings that are stored in the application configuration
(.app) file.

About this task

You use the Datacap Application Manager to configure the application to use the database. Datacap Application
Manager works well with separate Test and Production environments because it stores the information that is
specific to the Datacap application environment such as database locations and physical paths.

In a Test and Production paradigm, the physical applications are identical. The rules, workflows, page types,
and other components, are identical, except for the *.app file. The difference between the environments is what
the Datacap Application Manager stores. In the Test environment, the Datacap Application Manager stores the
Test environment details while the Production system has its own unique environmental settings.

When you configure Datacap for a DB2, Microsoft SQL Server, or Oracle database, you can put the
Administration, Engine, and Fingerprint schemas for the same application in a single database. You cannot put
schemas for different applications in the same database.

For Oracle, each computer that accesses the database must have the Oracle 32-bit client software installed. A
net service name must be created on that computer as well.

For DB2, if the user ID that created the database tables is different from user ID that is used in the connection
string, you must also specify the user ID that created the database tables as the schema. To specify the correct
schema, use the user ID in the connection string. Use CurrentSchema=user ID that created the tables.

Procedure

To configure an application to use the database:

. In the Start menu click IBM Datacap Services > Datacap Application Manager.

. Select a Datacap application. For example, select TravelDocs.

. Click the Main tab.

In the Administration field, click Browse and select a database provider.

. Enter the database authentication information and click OK.

. In the Engine field, repeat the Administration database steps.

. Close the Datacap Application Manager.

. If you are using a Fingerprint or Lookup database, scroll down to the Workflows section and repeat these
steps for each database.

0N A WN R

Parent topic: Configuring Datacap databases

Database security permissions

Datacap users must have database permissions for DB2®, Microsoft SQL Server, or Oracle to create the
database and its schema, initialize the data in the database, and run daily operations on the database.
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You set up database permissions for Datacap users by using the database-specific tool and following the
instructions that are provided with your database:

e For DB2, contains multiple tools that you can use to configure DB2 databases. Select one of the
following tools and log on as administrator:
o Datacap Studio: the Datacap application development tool
o DB2 Command Line Processor CLP: a command line equivalent to Oracle SQLPlus
o DB2 Command Line Processor CLPlus: another command-line equivalents to Oracle SQLPlus
e For SQL Server, start SQL Server Management Studio or SQL Server Enterprise Manager and log on to the
server as the administrator
e For Oracle, start the SQLPlus tool and log on to the SYS account as SYSDBA

Assign the appropriate permissions from the following table to the Datacap users based on these tasks:

e Database administrators: create the database and its schema

e Datacap developers: initialize the data in the database

e Datacap Server: Run daily operations on the Administrator and Engine database tables

e Rulerunner and Fingerprint Services: Run daily operations on the Fingerprint database

e Datacap Web Client, Rulerunner, Datacap Desktop, and other thick clients: Run daily operations on
queries that are run by actions. The permissions are application-specific and apply only to those queries
that are run by actions. These users usually need read and in some cases write permissions to the
Fingerprint database and any Lookup and Export databases that exist.

The following table lists the database permission and indicates which permissions are required for each of the
database tasks.

Table 1. Required database permissions for SQL Server, Oracle, and DB2 database tasks

Create database and Initialize data in the Run daily
Database permission schema database operations
Create an index Required Not required Not required
Drop an index Required Not required Not required
Create a sequence Required Required Not required
Create and initialize Required Required Not required
columns
Drop a sequence Required Required Not required
Select a sequence Required Required Required
Create a table Required Not required Not required
Drop a table Required Not required Not required
Insert a table Required Required Required
Select a table Required Required Required
Update a table Required Required Required
Delete records from a Required Required Not required
table
Create a trigger Required Not required Not required
Create a view Required Not required Not required

Parent topic: Configuring Datacap databases
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Defining the database structure

SQL scripts define the structure of the Datacap application databases for DB2®, Microsoft SQL Server, or Oracle
databases.

About this task

Use the SQL scripts that are installed as part of the Datacap installation to create an empty database structure.
You create this database structure for the Datacap Administration, Engine, and Fingerprint databases.

Procedure

To define the database structure:

1. Go to C:\Datacap\support\DBScript and select the scripts for the database you want to create:

Option Description

DB2 DB2_Adm_Base.sql
DB2_Eng_Base.sql

DB2_FP_Base.sql

Microsoft SQL Server | SQL_Adm_Base.sql
SQL_Eng_Base.sql

SQL_FP_Base.sql

Oracle Oracle_Adm_Base.sql
Oracle_Eng_Base.sql

Oracle_FP_Base.sql

2. For DB2, start the DB2 CLPPlus tool and log on as the owner of the database schema.

3. For SQL Server, start SQL Server Management Studio or SQL Server Enterprise Manager and log on to the
server as the administrator.

4. For Oracle, start the SQLPlus tool and log on as the owner of the database schema.

5. Create the database by following the instructions that are provided in the Microsoft SQL Server or Oracle
documentation that was provided with your database.

6. Open the appropriate scripts in the tool and run them to define the structure of the Datacap application
databases.

Parent topic: Configuring Datacap databases

Creating a single DB2 database for a Datacap application

You can create a single DB2® database to store the Administration, Engine, and Fingerprint databases for a
Datacap application.

Before you begin

You must create the DB2 database and set up the appropriate permissions to the database. Review and
complete the prerequisites for configuring Datacap databases.
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About this task

You define the structure of the Datacap application databases by running SQL scripts for the Administration,
Engine, and Fingerprint database schema.

You can run the SQL scripts for these Datacap application databases separately to create a separate DB2, SQL
Server, or Oracle database for each of the application databases. Alternatively, you can run the SQL scripts
together to create just one database that contains the Administration, Engine, and Fingerprint database
schemas. This procedure creates a single DB2 database user for all of the Datacap application databases.

Procedure

To create a single DB2 user for the Datacap databases in your Datacap application:

1. Create a new user for the DB2 database, for example, new_db_user. Grant DBADM privileges to

new_db user.

Important: The user name new_db_user is used as an example. Choose a more descriptive name such
as CaptureInvoiceTM or AcmeCapture to identify the function of the particular Datacap application
that this DB2 database will be used for.

2. Start the DB2 CLPPlus tool and log in as new _db_user.
3. Go to C:\Datacap\support\DBScript and find the following DB2 scripts:

o1

o DB2_Adm_Base.sql

o DB2_Eng_Base.sql

o DB2_FP_Base.sql

a. If this is not the first database that you are creating in this Datacap environment, you must modify

the scripts to have unique db_index values to uniquely associate with the application:

IDs for the db_index fields are hard-coded in the database creation scripts. If this is not the first
database that you are creating in this Datacap environment, you must set a new numeric value in
the db_index column in the scripts (the adminfo table in the Admin schema and the enginfo
table in the Engine schema) to uniquely identify the database with this Datacap application.

If you have one admin database per engine database for an application, you can use the same
unique numeric ID in both databases. If you have multiple admin databases per engine database,
specify different unique numeric IDs for each database, but use a numbering convention that
simplifies the identification of those databases for an application.

Tip: When batches are created in the Engine schema, each queue table row contains column
qu_admDB. This value displays which admin database is associated with the batch.

b. Run the scripts.

. Disconnect from the user account.

. Copy the data from the source database by using the Datacap Application Copy Tool.

. Point the Administration, Engine, and Fingerprint database schemas to the same location.
Tip: Because each of the Datacap databases is created in the same DB2 database, the connection string
for each of the Datacap databases will be the same per Datacap application.

. Configure the Datacap application to use the database by using the database user name that you
created in this task for that database.

Related tasks:

Configuring an application to use the database
Related information:

B* Authorities overview

[* Database administration authority (DBADM)
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Creating a single Oracle database for a Datacap application

You can create a single Oracle database for the Administration, Engine, and Fingerprint databases in a Datacap

application.

About this task

You define the structure of the Datacap application databases by running SQL scripts for the Administration,
Engine, and Fingerprint database schema. You can run SQL scripts for these Datacap application databases
separately to create a SQL Server or Oracle database for each of the application databases.

For Oracle databases, you can run the SQL scripts together to create 1 Oracle database that contains the
Administration, Engine, and Fingerprint database schema. This procedure creates a single Oracle database
user for all the Datacap application databases.

Procedure

To create a single Oracle user for Datacap databases:

1. Start the SQLPlus tool and log on to the SYS@net service name as SYSDBA. The net service name is

2.

specific to each computer.
Run the following script to create the user:

CREATE USER APTOra3X

IDENTIFIED BY APTOra3X;

Grant resource to APTOra3X;
Grant DBA to APTOra3X;
Grant EXP FULL DATABASE to APTOra3X;

Attention: The user name APTOra3x is used as an example. You can choose a more descriptive name
such as CaptureInvoiceTM or AcmeCapture to identify the function of this particular Oracle database.

3. Disconnect from the SYS account and log on to the user account that you created with SQLPlus.
4. Go to C:\Datacap\support\DBScript and find the following Oracle scripts:

o Oracle_Adm_Base.sql

o Oracle_Eng_Base.sql

o OQOracle_FP_Base.sql

a. If this is not the first database that you are creating in this Datacap environment, you must modify

the scripts to have unique db_index values to uniquely associate with the application:

IDs for the db_index fields are hard-coded in the database creation scripts. If this is not the first
database that you are creating in this Datacap environment, you must set a new numeric value in
the db_index column in the scripts (the adminfo table in the Admin schema and the enginfo
table in the Engine schema) to uniquely identify the database with this Datacap application.

If you have one admin database per engine database for an application, you can use the same
unique numeric ID in both databases. If you have multiple admin databases per engine database,
specify different unique numeric IDs for each database, but use a numbering convention that
simplifies the identification of those databases for an application.

Tip: When batches are created in the Engine schema, each queue table row contains column
qu_admbDB. This value displays which admin database is associated with the batch.

b. Run the scripts.

5. Disconnect from the user account.
6. Copy the data from the source database by using the Application Copy Tool.
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7. Point the Administration, Engine, and Fingerprint database schemas to the same location.
8. Configure the application to use the database by using the database user name that you created here.

Related tasks:
Configuring an application to use the database

Creating a single Microsoft SQL Server database for a Datacap
application

You can create a single SQL Server database to store the Administration, Engine, and Fingerprint databases for
a Datacap application.

Before you begin

You must create the SQL Server database and set up the appropriate permissions to the database. Review and
complete the prerequisites for configuring Datacap databases.

About this task

You define the structure of the Datacap application databases by running SQL scripts for the Administration,
Engine, and Fingerprint database schema.

You can run the SQL scripts for these Datacap application databases separately to create a separate DB2®, SQL
Server, or Oracle database for each of the application databases. Alternatively, you can run the SQL scripts
together to create just one database that contains the Administration, Engine, and Fingerprint database
schemas. This procedure creates a single SQL Server database user for all of the Datacap application
databases.

Procedure

To create a single SQL Server user for the Datacap databases in your Datacap application:

1. Start SQL Server Management Studio or SQL Server Enterprise Manager and log on to the server as the
administrator.

2. Select the database that you created for your Datacap application.

3. Create a new login name (user) and password and assign the db_owner role to this new user. For more
information about creating a new login, see the Microsoft SQL Server documentation for your database
version.

4. Log on to the database with your new user name.

5. Go to C:\Datacap\support\DBScript and find the following SQL Server scripts:

o SQL_Adm_Base.sql

o SQL_Eng_Base.sql

o SQL_FP_Base.sql

a. If this is not the first database that you are creating in this Datacap environment, you must modify
the scripts to have unique db_index values to uniquely associate with the application:

IDs for the db_index fields are hard-coded in the database creation scripts. If this is not the first
database that you are creating in this Datacap environment, you must set a new numeric value in
the db_index column in the scripts (the adminfo table in the Admin schema and the enginfo
table in the Engine schema) to uniquely identify the database with this Datacap application.

If you have one admin database per engine database for an application, you can use the same
unique numeric ID in both databases. If you have multiple admin databases per engine database,
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specify different unique numeric IDs for each database, but use a numbering convention that
simplifies the identification of those databases for an application.

Tip: When batches are created in the Engine schema, each queue table row contains column
qu_admDB. This value displays which admin database is associated with the batch.
b. Run the scripts.
6. Disconnect from the user account.
. Copy the data from the source database by using the Datacap Application Copy Tool.
8. Point the Administration, Engine, and Fingerprint database schemas to the same location.
Tip: Because each of the Datacap databases is created in the same SQL Server database, the connection
string for each of the Datacap databases will be the same per Datacap application.
9. Configure the Datacap application to use the database by using the database user name that you
created in this task for that database.

~

Related tasks:
Configuring an application to use the database

Converting applications from Jet database to Oracle database

If you have multiple applications that require Oracle database, you can convert the applications from a
Microsoft Jet Database to a single Oracle database using Datacap Application copy tool.

About this task

Multiple Datacap applications within a single Oracle instance are differentiated by the user credentials used to
access them. You can use the same Oracle database for multiple Datacap applications, as long as each unique
Oracle "User" owns the schema for each application.

Note: You cannot combine schemas for multiple Datacap applications into a single Oracle schema.

Procedure

1. Create a unique database user for each application. This will create a schema for that user.

Note: You can optionally specify a new tablespace for each user/schema. If the tablespace is not specified, by
default the users are created in the system tablespace. The users can be in the same tablespace or different
tablespaces.

Repeat the following steps for each user.

2. Log on to Oracle as one of the users created in step 1.

3. Navigate to ...\Datacap\support\DBScript\ and run the following Oracle scripts:
o Oracle_Adm_base.sql
o Oracle_Eng_base.sql
o Oracle_FP_base.sql

Example

Converting TravelDocs and Flex to Oracle versions

This example illustrates how to convert TravelDocs and Flex applications to Oracle versions. For test purpose,
the following server names are used. You must replace the server names, ports, etc. as applicable to your test
environment.

e MS Active Directory Server = WIN2K8R2A
e Datacap Server (and the location of the applications) = WIN2K8R2B
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e Datacap Web Server = WIN2K8R2C
e Datacap Dev station + Oracle = WIN2K8R2D

On WIN2K8R2D (Oracle)

1. In Oracle server, create a unique database user for each application, so that a schema for that user is
created. Log on to Oracle as one of the users created in this step.
Note:
o The users created for test purpose are TravelDocsORA and FlexORA
o Optionally, you can specify a new tablespace for each user/schema. In this test, the users were
created in the system tablespace by default.
o The users can be in the same tablespace or different tablespaces.
2. Navigate to the location ...\Datacap\support\DBScript\ and execute the following Oracle scripts against
each database mentioned above:
o Oracle_Adm_base.sql
o Oracle_Eng_base.sql
o Oracle_FP_base.sql

Repeat the steps 1 and 2 for each application. Optionally, you can create a separate user for each of
Oracle_Adm, Oracle_Eng and Oracle_FP. For example, FlexORAadmin, FlexORAengine, and FlexORAfingerprint.

On WIN2K8R2D (DEV Station)

1. Using command line, run the DAppCopy tool as described below to copy the TravelDocs app to
TravelDocsORA app:

DAppCopy -from -an TravelDocs -af \\WIN2K8R2B\Datacap|\TravelDocs -adb
"Provider=Microsoft.Jet.OLEDB.4.0;Data
Source=\\WIN2K8R2B\Datacap\TravelDocs|TravelDocsAdm.mdb;" -edb
"Provider=Microsoft.Jet.OLEDB.4.0;Data
Source=\|\WIN2K8R2B\Datacap|TravelDocs|TravelDocsEng.mdb;" -fdb
"Provider=Microsoft.Jet.OLEDB.4.0;Data
Source=\\WIN2K8R2B\Datacap|\TravelDocs\TravelDocsFingerprint. mdb;" -how online -to -af
|\WWIN2K8R2B\Datacap|TravelDocsORA -adb "Provider=0raOLEDB.Oracle.1;Data
Source=WIN2K8R2D;User ID=TravelDocsORA;Password=FileNet123;" -edb
"Provider=0raOLEDB.Oracle.1;Data Source=WIN2K8R2D;User
ID=TravelDocsORA;Password=FileNet123;" -fdb "Provider=0raOLEDB.Oracle.1;Data
Source=WIN2K8R2D,User ID=TravelDocsORA;Password=FileNet123;" -how onlineDAppCopy -from -an
TravelDocs -af \\WIN2K8R2B\Datacap|TravelDocs

2. Using command line, run the DAppCopy tool as described below to copy Flex app to FlexORA app:

DAppCopy -from -an Flex -af \\WIN2K8R2B\Datacap|\Flex -adb "Provider=Microsoft.Jet.OLEDB.4.0;Data
Source=\\WIN2K8R2B\Datacap|\Flex\FlexAdm.mdb;" -edb "Provider=Microsoft.Jet.OLEDB.4.0;Data
Source=\|WIN2K8R2B\Datacap|Flex\FlexEng.mdb;" -fdb "Provider=Microsoft.Jet.OLEDB.4.0;Data
Source=\\WIN2K8R2B\Datacap\Flex\FlexFingerprint.mdb;" -how online -to -af
\WWIN2K8R2B\Datacap|FlexORA -adb "Provider=0raOLEDB.Oracle.1;Data Source=WIN2K8R2D,;User
ID=FlexORA;Password=FileNet123;" -edb "Provider=0raOLEDB.Oracle.1;Data Source=WIN2K8R2D,User
ID=FlexORA;Password=FileNet123;" -fdb "Provider=0raOLEDB.Oracle.1;Data Source=WIN2K8R2D;User
ID=FlexORA;Password=FileNet123;" -how onlineDAppCopy -from -an Flex -af
|\WWIN2K8R2B\Datacap|Flex

On WIN2K8R2B

1. Update the datacap.xml to add TravelDocsORA.
2. Navigate to ...\Datacap\TravelDocsORA folder and rename the Port.app to TravelDocsORA.app.
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3. Create export and batches folders in the ...\Datacap\TravelDocsORA folder.
4, Install the Oracle 32-bit client.
5. Restart the Datacap Server service.

Repeat these five steps for FlexORA.
On WIN2K8R2D (Oracle)

1. In the TravelDocsORA.adminfo table, update the db_apptitle column from TravelDocs to TravelDocsORA.
Update the db_index column to a different value. (For test purpose, the value is increased by 1).

2. In the FlexORA.adminfo table, update the db_apptitlecolumn from Flex to FlexORA . Update the db_index
column to a different value. (For test purpose, the value is increased by 1)

On WIN2K8R2D (DEV Station)

1. Open Datacap Application Manager and verify/test the connection strings.
2. Test the basic connections to both applications in DStudio and DCDesktop.

On WIN2K8R2C (TMWEB.NET)

1. Edit the ...\Datacap\tmweb.net\apps.ini file to copy the TravelDocs section and copy it as described
below.

...from...
[TravelDocs]
Debug=0
Oracle=0

.. to...
[TravelDocsORA]
Debug=0
Oracle=1

2. Repeat this step for FlexORA.

Oracle= can be 0 (MSAccess or MSSQL) or 1 (either Oracle or DB2). Change it to 1.

Note: If the TravelDocs or the Flex sections do not exist, you must manually create them.
3. Restart the IIS web server.
4, Test the tmweb.net for both TravelDocsORA and FlexORA.

Moving the application files

You can use the Datacap Application wizard to copy a Microsoft Access based application and move it to a
folder on another computer.

About this task

The following steps are not required to use a DB2®, Microsoft SQL Server, or Oracle database. These steps
describe how to copy an application, move it to another environment, and update the appropriate paths. For
example, when you want to move an application between Test and Production systems and update the paths to
the fingerprints. You can also rename the application when you move it.
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You use the Datacap Application Copy Tool copy and move the application and its databases at the same time.

Procedure

To move the application files:

. Open Start > All Programs > IBM Datacap Developer Tools > Datacap Studio.
. Click Datacap application wizard.
. At the Overview window, click Next.
. Select Copy an existing RRS application and click Next.
. Select the name of the application that you want to copy. For example, select TravelDocs.
. In the Root folder on target system field, click [...] and select the database server where you want to
copy the application. For example, select C:\Datacap.
7. In the Datacap Web folder field, click [...] and select the folder on the Datacap Client where the
application is installed. For example, select C:\Datacap\tmweb.net.
8. Select Rename Copy and type the name of the application in the New Name field.
9. Click Next to collect the information to use to copy the application.
10. Click Finish to copy the application to the target database server.
11. Set the Oracle setting in the apps.ini.
a. Go to the Datacap\tmweb.net\apps.ini and copy the App_name section.
b. Rename the App_name section to match your new application name.
c. Locate the line Oracle in the App name section.
d. Change this field to read 0racle=1 for DB2 or Oracle. For SQL Server, use Oracle=0.
e. Locate the DateTimeSeparator line and change it to read DateTimeSeparator=".
f. Save your changes.

Nk WN P

Parent topic: Configuring Datacap databases

Verifying the database connection

After you configure the application for the database, verify the connection to the DB2®, Microsoft SQL Server or
Oracle database works properly.

Procedure

To verify the database connection:

1. In the Start menu click IBM Datacap Developer Tools > Datacap Studio. If you can log in and run the
application by using the Test tab, the Administration and Engine databases are working properly.

2. Click the Zones tab to verify that the Fingerprint database is working.

3. In the Start menu click IBM Datacap Services > Datacap Application Manager. Press Test connection in
the Connection string dialog to see if the databases are working properly.

Parent topic: Configuring Datacap databases

Advanced database settings for Datacap Server

Datacap can use custom connection strings from which it can target any database type that has a supported
database provider.

Connection strings
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The supported database providers for which you can use these connection strings are Microsoft Access, DB2¢®,
Microsoft SQL Server, and Oracle. The old Datacap format connection strings are still supported to provide
compatibility with an earlier version to your existing database connections.

The following examples describe OLEDB connection strings for each of the supported database providers:

DB2 using Standard Authentication

"Provider=IBMDADB2;Data Source= database alias; UID=******, PRD=****%%*,
CurrentSchema=db2admin;"

DB2 using Windows Authentication
N/A
Microsoft Access using Standard or Windows Authentication

"Provider=microsoft.jet.oledb.4.0;data source=C:\Datacap\MyApp\MyAppadm.mdb;
persist security info=false;"

SQL Server using Standard Authentication

"Provider=sqgloledb;data source=myServerAddress;Initial Catalog= myDataBase;
User Id=myUsername;Password=myPassword;"

SQL Server using Windows Authentication

"Provider=sqgloledb;data source=myServerAddress;Initial Catalog= myDataBase;
Integrated Security=SSPI;"

Oracle using Standard Authentication

Provider=0raOLEDB.Oracle;Data Source=MyOracleDB;User Id=myUsername;
Password=myPassword;

Oracle using Windows Authentication

Provider=0raOLEDB.Oracle;Data Source=MyOracleDB;OSAuthent=1;

Registry settings

Special cases in which database might act differently than usual are controlled by a set of settings in the
registry. Datacap uses these settings when database providers must use alternative logic implementations.
Otherwise, Datacap uses the default behavior. There are special settings for different database behavior that is
not default.

The following settings are in the InterThread section of TMS registry profile at
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Datacap\TMS\InterThread.

TO_DATE
Formats the date and time field values in TO_DATE format in SQL statements for the providers. This
example contains the default TO_DATE setting for Oracle.

ORACLE; ODBCORACLE ; MSORACLE ; ODBCMSORACLE ; OraOLEDB.Oracle; MSDAORA; IBMDADB2; DB20OLE
DB

ROWNUM
Use this ROWNUM syntax instead of SELECT TOP in SQL statements for these providers. This example
contains the default ROWNUM setting for Oracle.
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ORACLE; ODBCORACLE; MSORACLE; ODBCMSORACLE ; OraOLEDB.Oracle; MSDAORA; IBMDADB2; DB20OLE
DB

#DATETIME#
Use date and time field values that are wrapped in a # sign-in SQL statements for these providers. Some
of the databases want the date and time field values in # signs. This example contains the default
#DATETIME# setting for MS Access.

MSACCESS; ODBCMSACCESS;Microsoft.Jet .OLEDB.4.0;Microsoft.ACE.OLEDB.12.0

"FIELD NAME"
Use field names wrapped in quotes in SQL statements for these providers. Some database types need
quoted fields in SQL statements. This example contains the default "FIELD NAME" setting for Oracle.

ORACLE; ODBCORACLE ; MSORACLE ; ODBCMSORACLE ; OraOLEDB.Oracle; MSDAORA; IBMDADB2; DB20OLE
DB

"AUDIT"
Use audit table references wrapped in quotes in SQL statements for these providers. In some databases
Audit is a system/internal/key word, so you must wrap Audit in quotes to differentiate these databases.
This example contains the default "AUDIT" setting for Oracle.

ORACLE; ODBCORACLE ; MSORACLE ; ODBCMSORACLE ; OraOLEDB.Oracle;MSDAORA

MOVE_BY_ONE
When you must move the cursor on a recordset more than one row, you do it by moving by one row at
the time in a loop. Some providers might have issues trying to move several rows at once, so you must
do this loop procedure for them. This example contains the default MOVE_BY_ONE setting for Oracle.

ORACLE; ODBCORACLE ; MSORACLE ; ODBCMSORACLE; OraOLEDB.Oracle; MSDAORA

SELECT_COUNT
Use the SQL syntax for SELECT COUNT instead of using ADO API GetRecordCount because
GetRecordCount does not work for some databases. This example contains the default SELECT_COUNT
setting for Oracle.

ORACLE; ODBCORACLE ; MSORACLE ; ODBCMSORACLE ; OraOLEDB.Oracle; MSDAORA

RECORD_FORWARD_ONLY
Open ADO recordsets by using the forward only setting. The default setting is static bidirectional, but
some databases have issues with static bidirectional recordsets. This example contains the default
RECORD_FORWARD_ONLY setting for Oracle.

ORACLE; ODBCORACLE ; MSORACLE ; ODBCMSORACLE ; OraOLEDB.Oracle; MSDAORA

Application settings - {default} option

The Datacap Application Manager is updated so that you can select an option as {default} for some application
on the Application settings page.

e The Authenticator list shows the ADLDS option in the list. Selecting ADLDS must take effect on any
setting on the Task master server side.
e Added {default} option for following fields in application manager:
o Queue by
o Role-based batch filtering
o Authenticator
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e If the {default} option is set for these fields, then application picks up the setting for those fields from
the Taskmaster server manager.

e For "Role-based batch filtering" if the {default} option is set in application manager, then it picks up the
setting from the registry.
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Datacap\TMS\InterThread -> Role Mode
Where, Role Mode represents the following values:

o 0=None

o 1 =Exclusive
o 2 = Additive
o 3 =Inclusive

b

Upgrading

Migrating a Datacap environment to a new release requires that you upgrade the component software and
migrate your deployed applications. Depending on the currently installed version of Datacap, upgrading the
software may first require removing the previous version before installing the new release. The migration steps
can include revising existing functionality, adding new features, or changing baseline user interfaces.

Before you begin

For hardware and software requirements, see System Requirements: Hardware and Software Requirements for
IBM® Datacap, Version 9.0.1.

About this task

Upgrades from the following IBM Datacap versions are supported:

e IBM Datacap vV8.0.1
e IBM Datacap vV8.1.0
e IBM Datacap V9.0 or later version

Procedure

To upgrade to the latest Datacap software version:

1. Create the test environment. See Creating a test environment.
2. Create the production environment. See Creating a production environment.

Parent topic: Installing

$

Creating a test environment

Install Datacap in a test environment to deploy, configure, and test any modifications.

Procedure

To create a test environment:

1. In a non-production development environment, do the following actions based on your previous
Datacap version:
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Optlo

n Description
V9.0 a. Back up your Datacap application folders.
b. If you modified any of the standard Datacap applications, make a backup of those
folders also.

c. On each computer that you are upgrading, uninstall Datacap V9.0. (Uninstalling Datacap
V9.0 preserves the files that you added or modified).
Tip: If you already installed Datacap V9.0.1 without first uninstalling Datacap V9.0, see
Repairing a Datacap 9.0.1 installation.

All Uninstalling your previous version of Datacap is not necessary.
other
s

2. In a non-production development environment, install the latest version of Datacap. You might use new
interfaces that are available with the latest Datacap version. For example, the Datacap thick client in
version 8.0.1 is replaced by Datacap Desktop for the end users, and by Datacap Web Client and IBM®
Content Navigator for the administrators. For installation details, see Datacap installation and
configuration in a client/server environment .

3. Import encryption keys as necessary. You must have FIPS encryption as of version 8.1.0 for password
protection. For more information, see Importing encryption keys to Datacap computers.

4. Based on your previous Datacap version as shown in the following table, migrate and copy your
customizations from your previous Datacap environment to this test environment:

Option | Description

V8.0.1 | See Upgrading Datacap applications from Taskmaster 8.0.1.

V8.1 |See Upgrading Datacap applications from Taskmaster 8.1.

V9.0 |See Upgrading Datacap applications from 9.0.

5. Consult the What’s New topics to determine whether any existing rules or actions were eliminated or
deprecated in the new release. For more information, see What's new. Alternatively, open Datacap
Studio and determine whether any existing rules or actions were eliminated or deprecated in the new
release. Deprecated actions are designated as Private and they cannot run in the Test tab in Datacap
Studio. But they can run in your updated applications. In a subsequent release, remove these
deprecated actions from the application.

6. Modify your customized settings as needed. Based on your previous Datacap version as shown in the
following table, see the indicated topic:

Option Description

V9.0 feature pack 1 and 2 See Setting Datacap Navigator default layouts in Datacap 9 and
Feature Packs 1 and 2.

Any version before V9.0 See Migrating Datacap Navigator custom panels to Datacap 9.0

feature pack 2 Feature Pack 2 or later.

7. Update the code and customized user interfaces that were not fully migrated to maintain your current
level of function. For more information, see Customized panel conversion to Datacap Desktop.

8. Apply any new features in the updated software version that you want to implement.

9. Test your updated applications and configuration in the development environment against your current
production system. You run this parallel testing to validate features, performance, connectivity, and
volume throughput. For example, ensure that program communication works as intended between
servers and clients, web or otherwise.
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Upgrading Datacap applications from Taskmaster 8.0.1

If you want to use applications that were created in Taskmaster 8.0.1, use the Application Wizard to convert
these applications to work with the latest Datacap software.

Procedure

To migrate an application to the target computer with the new Datacap software version:

1.

O 00 N O

Copy the entire folder of the application that you want to convert to the \Datacap folder on the target
computer.

. On the target computer, open datacap.xml and add the name of the application that you want to update.

For example, if the application name is MyApp, copy the MyApp folder to \Datacap.

. If you are using DB2®, Oracle, or Microsoft SQL Server, create a new database by using the creation

scripts for each database type (administration, engine, fingerprint).
Attention: The creation scripts are in the C:\Datacap\support folder.

. If you are using a Microsoft Access database, complete these steps:

a. On the target computer, copy FormTemplateAdm.mdb, FormTemplateEng.mdb, and
FormTemplateFingerprint.mdb from C:\Datacap\Templates\FormTemplate to a temporary folder.
The databases that you are copying are blank, but they contain the target database table formats.
If the existing batches of documents are not needed in the converted application, you can use a
blank Engine database. If you need the batches of documents, complete the batches before you
convert the application.

b. Rename the three databases Adm, Eng, Fingerprint in the temporary folder to the name of the
application that you are converting. For example, if the application name is MyApp, rename the
three databases to MyAppAdm.mdb, MyAppEng.mdb, and MyAppFingerprint.mdb.

c. If you customized any of the Taskmaster 8.0.1 databases, you must add any custom columns and
new columns from the Taskmaster 8.0.1 databases to the target databases.

Important: Ensure that the column names that you are adding to the target databases match the
column names in the 8.0.1 databases.

. Start Datacap Studio on your workstation by clicking Start > IBM Datacap Developer Tools > Datacap

Studio.

. In the Datacap Studio startup dialog that prompts you to select an application, click Close.
. In Datacap Studio, click the Datacap application wizard icon.

. In the Application Wizard Overview window, click Next.

. Select Convert an 8.0.1 application to 9.0 format.

10.
11.

In the Source Application window, select the application that you want to convert.
In the 9.0 Target Databases dialog, enter the database information that your updated application must
use:
o Ifyou are using a Microsoft Access database, browse to the temporary folder where you copied
the databases and select the three databases.
o Ifyou are using a DB2 database, enter the service name of the DB2 source database. If the user
ID that created the database tables is different from the user ID in the connection string, you
must also specify the user ID that created the database tables as the schema. To specify the
correct schema, use the user ID in the connection string. Use CurrentSchema=user ID that
created the tables.
Important: You must enter information for each of the databases: Administration, Engine, and
Fingerprint. Click the corresponding tab to enter database information.
When you upgrade a custom Datacap application from Taskmaster 8.0.1 to 9.0 or later, if the Datacap
application wizard fails to upgrade the application, complete the following steps to resolve this issue:
a. Open the application app file. The app file is at C:\Datacap\application\application.app
b. Copy the following Taskmaster 8.0.1 plain connection string in the application.app file:
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PROVIDER=MSACCESS; DSN=C:\Datacap\application\applicationAdm.mdb;
For example, copy the

PROVIDER=MSACCESS; DSN=C:\Datacap\application\applicationAdm.mdb;

string in the attribute that has attribute value as "tmadmin."
c. Similarly, update the following attribute values by adding corresponding plain strings:
= tmengine
= fingerprintconn
. Save and close the app file.
. Open the Datacap application wizard.
. Select Convert a Taskmaster 8.0.1 application to Datacap 9.0 or later, and click Next.
. Select the custom application, and select Next.
. Browse to the Administration, Engine, and Fingerprint databases connection strings, and then
click Next. The Application wizard completes the migration.
When the plain text connection strings are set manually while running the wizard, the string in the
app file gets modified as:

>0 - O O

Provider=Microsoft.Jet.OLEDB.4.0;Data Source=[path/]\applicationEng.mdb;

12. Click Next and then Finish. The Application wizard displays a message to indicate a successful update,
and whether you must review the Application wizard log for any errors or warnings. The log file is in
C:\Datacap\application name\appwiz_convert.log.

Important: During the conversion of your application, Datacap makes the following modifications.

o Tasks that were previously mapped to use prelayout.aspx are now mapped to use verifine.aspx.

o Tasks that previously used project files are configured through the task setup window. You access
task setup by selecting the task on the Workflow page of the Administrator tab in the Datacap
Web Client, and clicking Setup.

o The databases in the temporary folder are merged with the databases in the application folder.
The databases in the temporary folder now contain the Taskmaster 8.0.1 application data in the
target tables.

13. If you are using a Microsoft Access database, copy the three databases in the temporary folder to the
application folder and select Yes, overwrite existing files at the prompt. For example, the application
folder might be C:\Datacap\MyApp.

14. Select Start > IBM Datacap Services > Datacap Application Manager to start Datacap Application
Manager and confirm that the three databases are pointing to the correct data source.

15. If necessary, change the path to the correct data source and restart the Datacap Server Manager on the
Service tab of the Datacap Application Manager.

16. Restart Datacap Studio, log on to the application that you converted, and confirm that you can connect
to the Administration and Engine databases.

17. Load the application in Datacap Studio and correct any action or rule errors:

a. Click Start > IBM Datacap Developer Tools > Datacap Studio.

b. Select the application that you want to update, click Next, and log on.

c. Correct any errors that are displayed such as warning messages or action errors that are
highlighted in red in the Ruleset window.

18. Update settings for all tasks that were configured for DotScan, DotEdit, or the multiple program option in
Taskmaster 8.0.1. Using Datacap Web Client or Datacap Navigator administration view, go to Workflows,
select the task, and click Settings. Verify or modify settings as required, and then save.

19. Optional: Port Datacap Web Client tasks in the application to Datacap Navigator. You must configure task
settings for Datacap Web Client tasks to work in Datacap Navigator. Some Datacap Web Client tasks port
directly to Datacap Navigator. For example, rScan corresponds to Scan, and Verifine corresponds to
Verify. However, other Datacap Web Client tasks (such as ProtoID, ImageEnter, and averify) do not have
direct equivalents in Datacap Navigator. If you need to port a customized task from Taskmaster Web to
Datacap Navigator, contact IBM® Professional Services for assistance.
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To port simple Datacap Web Client tasks to Datacap Navigator:

a. Ensure that the Datacap Navigator plug-in is deployed and a repository is created for the
application. For instructions, see Installing and configuring Datacap Navigator.
b. Open the Datacap Navigator administration view by using the following URL:

http://server:port/navigator/?desktop=dcadmin

c. In the left pane, click Workflows. Create a workflow with jobs and tasks that correspond to your
tasks in Datacap Web Client. Select appropriate program options for Datacap Navigator tasks as

follows:
Datacap Navigator task | Program option
Scan scan.js
Upload upload.js
Verify verify.js
Fixup classify.js

d. In the left pane, click Shortcuts. Create shortcuts for Datacap Navigator tasks.
X
$

Upgrading Datacap applications from Taskmaster 8.1

You can upgrade Taskmaster 8.1 applications by copying them to a server with the latest Datacap software
version. Taskmaster 8.1 applications with Datacap Web Client (formerly known as Taskmaster Web Client) and
Rulerunner tasks only will work without further configuration. Taskmaster 8.1 applications with DotScan and
DotEdit tasks require adjustments to task settings.

Procedure

To migrate an application from Taskmaster 8.1 to the target computer with the new Datacap software version:

1. Copy the application that you want to migrate to the target computer by using the Datacap Application
Copy Tool:
a. Ensure that your new Datacap system has access to the computer on which the Taskmaster 8.1
application and its databases reside.
b. Ensure that the processing of all batches is complete before you migrate the application.
c. Create new, empty databases for administration, engine, and fingerprint.

If you are using DB2®, Oracle, or Microsoft SQL Server, create new target databases by using the
creation scripts for each database type (administration, engine, fingerprint). The creation scripts
are in the C:\Datacap\support\DBScript directory. If custom columns were added to the tmbatch
table in the Taskmaster 8.1 database, add them to the target creation scripts.

If you are using Microsoft Access, see Updating Microsoft Access database schemas from
Taskmaster 8.1.

d. Click Start > IBM Datacap Services > Datacap Application Manager. On the Service tab in the Path
to the application management file field, specify the path to the datacap.xml file in the
Taskmaster 8.1 environment.

e. Click Start > IBM Datacap Developer Tools > Datacap Application Copy Tool and specify the
following settings:
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m Inthe Copy from area on the left, select the Taskmaster 8.1 application to copy. The path
to the Application files and the connection strings for the Administration and Fingerprint
databases are populated.

= Inthe Copy to area on the right, select Copy to portable data files, leave the Document
Hierarchy and Rules options selected, set the Application files path to a folder that does
not exist (the tool will create the folder), and leave the database settings empty.

Then, click OK to run the Datacap Application Copy Tool, and click OK on the confirmation
message that says "Do you want to replace or update the
'application files path' application?" The application folder will be created. In the
Copy to area, if you specified a folder that already exists, the copy fails and you must run the tool
again.

f. Start Datacap Application Manager. On the Service tab in the Path to the application management
file field, specify the path to the datacap.xml file in the version 9.0 or later environment.

g. In the Datacap Application Copy Tool, specify the following settings:

m Inthe Copy from area on the left, select Copy from portable data files and specify the
temporary application folder in the Application files folder.

= Inthe Copy to area on the right, select Add new application and set the path to a folder
that does not exist (the tool will create this folder), leave the Document Hierarchy and
Rules options selected, and specify connection strings for the administration and
fingerprint databases. Leave the engine database setting empty unless you need to
transfer existing batches to the migrated application. In this case, you should select the
Clear Engine database option and specify the connection string for the engine database. If
you are using Microsoft Access, you should specify the renamed FormTemplate databases
in the temporary folder.

Then, click OK to run the Datacap Application Copy Tool to copy the application files and database
contents to the folder and databases of the migrated application.
2. Configure environment settings by using Datacap Application Manager:
a. Click Start > IBM Datacap Services > Datacap Application Manager.
b. In the left pane, select the application that you want to update.
c. In the right pane, update settings on the Main tab and ensure that any settings on the Custom
values tab are correct for the Datacap 9.0 target environment.

If you are using Microsoft Access, the application configuration now points to the renamed and

updated FormTemplate databases in the temporary folder. You should move these databases to
the folder of the migrated application and update the connection strings in Datacap Application
Manager.

If you are using repositories or additional databases such as the lookup and export databases,
configure the repositories or databases in the migrated environment. Use the same instances, or
create new instances to avoid interfering with the Taskmaster 8.1 environment. Then, update
settings in Datacap Application Manager.

3. Load the application in Datacap Studio and correct any action or rule errors:
a. Click Start > IBM Datacap Developer Tools > Datacap Studio.
b. Select the application that you want to update, click Next, and log on.
c. Correct any errors that are displayed such as warning messages or action errors that are
highlighted in red in the Ruleset window.

4. Update settings for all tasks that were configured for DotScan, DotEdit, or the multiple program option in
Datacap Taskmaster 8.1. Using Datacap Web Client or Datacap Navigator administration view, go to
Workflows, select the task, and click Settings. Verify or modify settings as required, then save.

5. Optional: Port Datacap Web Client tasks in the application to Datacap Navigator. You must configure task
settings for Datacap Web Client tasks to work in Datacap Navigator. Some Datacap Web Client tasks port
directly to Datacap Navigator. For example, rScan corresponds to Scan, and Verifine corresponds to
Verify. However, other Datacap Web Client tasks (such as ProtoID, ImageEnter, and averify) do not have
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direct equivalents in Datacap Navigator. If you need to port a customized task from Taskmaster Web to
Datacap Navigator, contact IBM® Professional Services for assistance.

To port simple Datacap Web Client tasks to Datacap Navigator:

a. Ensure that the Datacap Navigator plug-in is deployed and a repository is created for the
application. For instructions, see Installing and configuring Datacap Navigator
b. Open the Datacap Navigator administration view by using the following URL:

http://server:port/navigator/?desktop=dcadmin

c. In the left pane, click Workflows. In the right pane, select a workflow and click Edit. Then, create
a job and tasks that correspond to your tasks in Datacap Web Client. Select appropriate program
options for Datacap Navigator tasks as follows:

Datacap Navigator task | Program option
Scan Scan.js

Upload Upload.js

Verify Multiple

Fixup Multiple

d. On the Task > Advanced tab, scroll down to the Datacap Navigator area and specify Web Program
options for Verify and Fixup tasks as follows:

Web Program option on the Advanced
Datacap Navigator task |tab

Verify Verify.js

Fixup Classify.js

e. In the left pane, click Shortcuts. Create shortcuts for Datacap Navigator tasks.
&
$

Updating Microsoft Access database schemas from Taskmaster
8.1

The Microsoft Access database schemas must be updated.

Procedure

To update Microsoft Access database schemas:

1. On the target computer, ensure that the FormTemplate application was not used to create batches or
customized. Then, copy FormTemplateAdm.mdb, FormTemplateEng.mdb, and
FormTemplateFingerprint.mdb from C:\Datacap\Templates\FormTemplate to a temporary folder.

2. Rename the three databases Adm, Eng, Fingerprint in the temporary directory to the name of the
application that you are converting. For example, if the application name is MyApp, rename the three
databases to MyAppAdm.mdb, MyAppEng.mdb, and MyAppFingerprint.mdb.

3. If you customized any of the Taskmaster 8.1 databases, you must add any custom columns to the target
databases.
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Upgrading Datacap applications from 9.0

To upgrade a Datacap application from 9.0.0, you must update the application database schemas. If your
application contains compiled rulesets, you must update any rulesets that were updated in the latest Datacap
version. You can add accuracy statistics to an existing application. Datacap Navigator settings for certain tasks
must be updated. If your application contains customized Desktop panels, you must rebuild them by using the
updated project on DeveloperWorks.

Procedure

To upgrade Datacap applications from 9.0:

1. If you modified any of the standard applications in Datacap 9.0 such as the Accounts Payable
application, you might want to preserve those changes. To do so, restore those application folders from
the backups that you made in step 1.

2. If your application uses DB2, SQL Server, or Oracle databases, update the database schemas "in place"
(without removing an existing older version):

DB2 a. Create full backups of the Admin, Engine, and Fingerprint database
tables.

b. Start IBM Data Studio.

. Connect to the application's databases.

d. Execute the following scripts in the \Datacap\support\DBScript\ folder:
= DB2_Adm_Upd901.sql
= DB2_Eng_Upd901.sql
» DB2_FP_Upd901.sql

O

SQL Server a. Create full backups of the Admin, Engine, and Fingerprint database
tables.

b. Start SQL Server Management Studio.

. Connect to the application's databases.

d. Execute the following scripts in the \Datacap\support\DBScript\ folder:
® SOL_Adm_Upd901.sql
= SQL_Eng_Upd901.sql
= SQL_FP_Upd901.sql

O

Oracle a. Create full backups of the Admin, Engine, and Fingerprint database
tables.

b. Start SQL Plus or SQL Developer.

. Connect to the application's databases.

d. Execute the following scripts in the \Datacap\support\DBScript\ folder:
= Oracle_Adm_Upd901.sql
® Oracle_Eng_Upd901.sql
®m Oracle_FP_Upd901.sql

3. If your application uses Microsoft Access databases, see Updating Microsoft Access database schemas
from Datacap 9.0.

4. If your application contains any of the following rulesets, manually copy the updated versions from the
\Datacap\rrs folder to your application's Rules folder:
Important: A bug-fix or an enhancement that has been added to a ruleset DLL will not be available in an
application until the updated ruleset DLL is manually copied from the RRS folder to the application Rules
folder. For example, your application’s Rules folder might be
\Datacap\TravelDocs\dco_TravelDocs\Rules\.

O

Ruleset File to copy
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Ruleset File to copy

Populate Fields Using Keywords Populate_Fields_Using_Keywords.Rul.dll
ExportToBoxRul ExportToBoxRul.dll

ImportFromBoxRul ImportFromBoxRul.dll
RecognizePagesAndFieldsRul RecognizePagesAndFieldsRul.dll

5. You might want to add statistics collection to an existing application from Datacap 9.0. Adding statistics
collections is necessary to support the Dashboard feature for Datacap Navigator, count processed
checks, and for other purposes. To add statistics collection, do the following steps:

a. Copy the files Profile Statistics.rule and Export Statistics.rule to \Datacap\RRS.
b. Use FastDoc to drag the Profile Statistics and Export Statistics rulesets to your application. For

example, manually copy
\Datacap\Templates\FormTemplate\dco_FormTemplate\rules\ProfileStatistics.rule to
\Datacap\RRS, and then use FastDoc to copy that ruleset to your application.

6. Load the application in Datacap Studio and correct any action or rule errors:
a. Click Start > IBM Datacap Developer Tools > Datacap Studio.
b. Select the application that you want to update, click Next, and log on to the application.
c. Correct any errors that are displayed such as warning messages or action errors that are

highlighted in red in the Ruleset window.

7. To use new Datacap Navigator features, re-enter task settings for the following task programs:

(o]
o
(¢]
(e]

Scan.js
Classify.js
Verify.js
Multiple

The following steps are required for each task that uses these Datacap Navigator task settings. If a task
is used in more than one job, you need to re-enter task settings for one job only. To re-enter task
settings:

a.

g0 .~ ® O 0 T

Open the Datacap Administration View. In a browser, enter a URL with the following format:
http://host _name:port number/context root/?desktop=dcadmin.

By default, the context root is navigator.

. In the left pane, click Workflows.

. In the right pane, select a workflow and click Edit.

. Click the Jobs tab, select a job, and click Edit.

. Click the Tasks tab, select a task, and click Edit.

. On the Task page, click the Advanced tab. Make a note of all task settings.

. Click the General tab and change the Program to Rulerunner. For example, if Program is set to

scan.js, select Rulerunner from the drop-down list.

h. Click Save to reset all task settings.

i. Change Program back to the original setting. For example, change it back to scan.js.
-

k. Re-enter the task settings that you noted in step f.

L

Click the Advanced tab.

Click Save.

8. If your application contains customized screen panels for Datacap Desktop, you must rebuild them with
the updated SDK for 9.0.1. See Rebuilding customized screen panels for Datacap Desktop.

$

Rebuilding customized screen panels for Datacap Desktop
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If your application contains customized screen panels for Datacap Desktop, you must rebuild them with the
updated SDK. This procedure requires Microsoft Visual Studio 2013.

Procedure

To rebuild customized screen panels:

1. Download the Datacap V9.0.1 Custom Panel project from IBM DeveloperWorks. See IBM® Datacap 9.0
and Datacap 9.0.1 DDK Datacap Desktop Custom Panels.
2. Start Microsoft Visual Studio 2013.
. Open the DCDesktopPanels solution.
4. Add the custom source files to your project that were used by your Datacap V9.0 custom panels:
a. Copy the files to your project folder.
b. Select the panel project.
c. Choose menu item Project > Add Existing Item and select the files that you copied.
5. Build the solution. If necessary, adjust your code to be compatible with the new Datacap software
version.
6. Deploy your custom DLL to the application and test.

w

$

Repairing a Datacap 9.0.1 installation

This procedure is required only if you installed Datacap 9.0.1 without previously uninstalling an existing 9.0
system on that computer.

Procedure

To repair a Datacap 9.0.1 installation:

1. Remove the leftover 9.0 components:
a. From Control Panel > Programs > Programs and Features, uninstall any of the following items if
they exist:
IBM® Datacap 9.0
IBM Datacap 9.0.0.1
IBM Datacap 9.0.0.2
IBM Datacap 9.0.0.3
Important: Do not uninstall IBM Datacap 9.0.1.
2. Delete any of the following folders and files if they exist. (They are restored as part of the Datacap 9.0.1
installation.)

Folders \Datacap\dcshared\ICRC
\Datacap\dcshared\OCRA\Data\ExtendedDictionaries
\Datacap\Flex

\Datacap\Templates

\Datacap\TravelDocs

O O O O O

(o]

\Datacap\dcshared\Accusoft.BarcodeXpress9.ActiveX.dll
o \Datacap\dcshared\NET\Accusoft.ScanFixXpress7.Net.dl
l

3. Install Datacap 9.0.1 in the same location that you uninstalled Datacap 9.0:
a. With Administrator privileges, run the Datacap 9.0.1 installer from the command line as shown
here:

Files
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http://www.ibm.com/developerworks/data/library/techarticle/dm-1412datacap-developer-kit/DevWorks-Datacap-9.0-DCDesktopPanels.html

setup.exe /[V'REINSTALLMODE=amus REINSTALL=ALL"

b. With Administrator privileges, run the following command from the command line to reregister
the Datacap Taskmaster Server service:

\Datacap\Taskmaster\TMS.exe /Service

$

Updating Microsoft Access database schemas from Datacap
9.0

This procedure requires Microsoft Access 2013 or later version.

Procedure

To update the Microsoft Access database schema for the target Datacap system with the latest Datacap
version:

1. Replace the 9.0 Engine database file with an empty Engine database for the target system:
Important: This step does not preserve existing batches.
a. Back up the Datacap 9.0 Engine database file in your application folder by renaming it or copying
it to a backup location.
b. Copy the Engine database file from the target system's Form Template application (such as
\Datacap\Templates\FormTemplate) and paste it into your application folder.
c. Rename the target system's Engine database file that you copied to match the original file name.
(The original file name is the name before any renaming done in step 1a.)
d. Delete existing batch folders from the application.
2. If your application contains custom columns, use Microsoft Access to add your custom columns to the
tmbatch table in the new Engine database.
3. Update the Fingerprint database schema to support the ClassifyLayout actions:
a. Start Microsoft Access and open the following file:
\Datacap\Templates\FormTemplate\FormTemplateFingerprint.db (Datacap 9.0.1 schema).
b. Start another copy of Microsoft Access and open the application's existing Datacap 9.0
Fingerprint database file.
c. Copy the Class, Feature, and Knowledge tables from the target system's schema and paste them
into the existing Fingerprint database.
4. Update the Administrative database schema with tables and fields reserved for future use:
a. Start Microsoft Access and open the following file:
\Datacap\Templates\FormTemplate\FormTemplateAdm.mdb (the target system's schema).
b. Start another copy of Microsoft Access and open the application's existing Datacap 9.0
Administrative database file.
c. Copy the views table from the target system's schema and paste it into the existing Administrative
database.
d. Close the target system's FormTemplateAdm database.
e. Open the existing adminfo table in design view and add a Number type field that is named
db_keymode. Set the Field Size to Long Integer.
f. Open the existing tmgroup table in design view and add the long integer field gr_key.

$
Upgrading Datacap applications from Datacap 9.1.1
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The sequence to upgrade Datacap applications from Datacap 9.1.1 to Datacap 9.1.3 is - a. Take a backup of
required files, b. Install Datacap 9.1.3, c. Start Datacap Taskmaster Service, d. Launch Datacap applications.

Procedure

The detailed procedure to upgrade to Datacap 9.1.3 is as follows -

1. During a maintenance window, take a backup of existing Admin, Engine, and Fingerprint database
tables, custom applications including any modified out of the box Datacap applications, custom actions,
RuleRuner configuration file (RuleRunner.xml), datacap.xml to a temporary location before upgrading.

2. Run the installer to install IBM Datacap 9.1.3. It automatically upgrades Datacap 9.1.1 applications to
Datacap 9.1.3.

3. Confirm that the user credentials are valid for running Datacap Taskmaster Service.

4, After the upgrade is successful, launch the Datacap applications. You can start processing batches.
Note:

o You do not need to uninstall Datacap 9.1.1 before upgrading to Datacap 9.1.3.

o Reconfigure Datacap accounts and groups that are based on your authentication system.

o Reconfigure connection strings to applications in Datacap Application Manager (where
applicable).

o Set up sharing and security permissions for users, Datacap folders, and Datacap applications.

o Previously generated encryption keys in the keystore are preserved and need not be generated
again.

o Review Installer.log file that is located at C:\Users\localadm\AppData\Local\Temp to confirm that
there are no errors.

$

Migrating Datacap Navigator custom panels to Datacap 9.0
Feature Pack 2 or later

Starting with IBM® Datacap Version 9.0 Feature Pack 2, Datacap Navigator custom panels are stored in a new
location.

About this task

In Datacap Version 9.0 and Feature Pack 1, Datacap Navigator custom panels were stored in the following
folder:

\IBM\WebSphere\AppServer\profiles\AppSrv01\installedApps\node_name\
navigator.ear\navigator.war\dcpanels\application_name\

In Feature Pack 2, Datacap Navigator custom panels are stored in the following folder:
Datacap_installation_folder\application_name\navigatorpanel\panels

If you created custom panels in Datacap Version 9.0 or Feature Pack 1 and want to use them in 9.0 Feature
Pack 2 or later, you must move your panels to the new location and create an XML file that names the custom
panels.

Procedure

To migrate Datacap Navigator custom panels to Datacap Version 9 Feature Pack 2 or later:
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1. Copy the custom panel (JSON file) that you want to migrate from this location:

\IBM\WebSphere\AppServer\profiles\AppSrv01\installedApps\node_name\
navigator.ear\navigator.war\dcpanels\application_name\

2. Paste the custom panel file into this folder:
Datacap_installation_folder\application_name\navigatorpanel\panels

3. Remove the *.json file extension from your custom panel file name. For example, if the name of your
custom panel file is MyPanel.json, change the file name to MyPanel.

4, Using a text editor, create an XML file that names the custom panel. For example, if the name of your
custom panel is MyPanel, create an XML file with the following content:

<Panels>
<Panel name="MyPanel" />
</Panels>
5. Name the file panels.xml and save it in the following folder, on the same level as the panels folder:
Datacap_installation_folder\application_name\navigatorpanel\

Important:

Ensure that the name of your custom panel is specified in the same way in the panels folder, in the
panels.xml file, and in the Name field on the Datacap Navigator Administration View > Panel page.

$

Setting Datacap Navigator default layouts in Datacap 9 and
Feature Packs 1 and 2

The Classify, Verify, and Scan pages contain widgets such as the image viewer, start panel, field details, and
batch structure. Starting with Datacap 9 Feature Pack 3, you can set the default location of the widgets for
specific tasks. To enable this functionality for tasks from Datacap 9 and Feature Packs 1 and 2, edit the task
configuration XML file.

Procedure

1. In a text editor, open the task.set.xml file that is located in the
Datacap_install\application\dco_application\ folder, for example:

C:\datacap\TravelDocs\dco_TravelDocs\nverify.set.xml

2. Paste the following text at the end of the file, before the final </s>:
<P n="NCLayout" tip="Defines runtime layout" title="Navigator Layout">

<V label="Layout" n="Layout" tip="Defines the runtime layout" type="text"></V>
</P>

3. Save and close the task.set.xml file.

&

Upgrading Datacap applications t0 9.1.0
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You can upgrade the Datacap applications to 9.1.0.

Procedure

To upgrade your Datacap application to 9.1.0, complete the following steps:

1.
2.

Ensure to take full backup of the Admin, Engine, and Fingerprint database tables.
Ensure that the Admin, Engine, and Fingerprint databases are transferred to SQL Server, Oracle, and
DB2.

. Run the installer to install IBM Datacap 9.1.0.

Note: You do not need to uninstall IBM Datacap 9.0.1 before upgrade.

. Use any of the following three cases for migration of Datacap 9.0.1 applications to 9.1.0. You might need

to update database schemas. Two cases require DB changes and one does not require changes to the
DB.

o Case A - Upgrade from 9.0.1 to 9.1 does not require DB schema changes.

o Case B - If you upgrade from Taskmaster 8.1 or 9.0 to 9.1, you must complete the DB migration
steps for 9.0 upgrade to 9.0.1. For more information, see Updating Microsoft Access database
schemas from Datacap V9.0 to V9.0.1.

o Case C - If you upgrade Datacap applications from Taskmaster 8.0.1 to 9.1, you must complete all
the following process:

®  Migrating Datacap applications from 8.0.1 to 9.0 or later

m  Updating Microsoft Access database schemas from Datacap V9.0 to V9.0.1
Note: A bug-fix or an enhancement that is added to a ruleset DLL is not available in an application
until the updated ruleset DLL is manually copied from the RRS folder to the application Rules
folder. If your application contains any of the following rulesets, you must manually copy the
updated versions of the rulesets to your application's Rules folder: Populate Fields Using
Keywords, ExportToBoxRul, ImportFromBoxRul, and RecognizePagesAndFieldsRul.

. Open the \Datacap\rrs folder, and copy and paste the following files into the Rules folder of your

application. For example, your application’s Rules folder can be
\Datacap\TravelDocs\dco_TravelDocs\Rules\:

o Populate_Fields_Using_Keywords.Rul.dll

o ExportToBoxRul.dll

o ImportFromBoxRul.dll

o RecognizePagesAndFieldsRul.dll

. After the upgrade is complete, restart the computer.
. Rebuild and reinstall your customized Datacap Desktop panels, if any. The Datacap Desktop panels are

for use with IBM Datacap 9.1.

What to do next

After you upgrade Datacap applications to 9.1.0, complete the following steps:

1.
2.
3.

Validate that the upgrade to 9.1.0 is successful with no errors.

Validate that the Install.log contains no errors or warnings.

For each application upgraded to 9.1.0, validate that batch records are intact and have identical details
compared with 9.0.1 FP2 using the following clients:

Datacap Desktop

Datacap Studio

Fastdoc

TMWeb

RV2

O O O O O

The Datacap Desktop panels are for use with IBM Datacap 9.1
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This project contains a modifiable version of the universal verify panel. DCDesktop can be configured to use the
built-in universal panel or use the customized universal panel that is contained in this project. Any of the other
customized panels can be displayed as well, as in previous releases.

To use this project, IBM Datacap 9.1 must be installed on the development computer.

Follow the directions in the guide to build the panel project. The project must be built on a computer that has
IBM Datacap 9.1 installed. The build might initially fail due to references that are not located by the compiler.
To help the compiler find the .NET dependent DLLs, in each of the project files add a "Reference Path" to the
DCDesktop folder, such as C:\Datacap\DcDesktop\. If the compiler still cannot find the referenced .NET DLL,
then right-click the DLL, and select "Remove", click "References", and select "Add Reference". Then, browse to
the DLL and add it as a reference.

If the compiler cannot find a DLL referenced through COM, then delete the COM reference from the project and
readd the COM reference. Delete the reference by right-clicking on it and selecting "Remove", then right-click
"References", select "Add Reference", and select the COM library from the COM section.

The panel guide also includes steps to place your custom panel into its own DLL instead of placing it into the
DotEditPanel.dll.

If you have existing panels which change to files that are provided in the template, it is recommended that you
start fresh with the new template and reapply your changes to the template. If you replace files in the template
with older versions of the files from an earlier project, your project might not run successfully.

b

Customized panel conversion to Datacap Desktop

If you used customized Batch Pilot or DotEdit panels in Datacap, you must convert those panels so that they
can be used in Datacap Desktop on the latest version of Datacap.

About this task

If you do not have Datacap V8.0.1 installed on a separate computer, you must convert the Batch Pilot panel
before you can upgrade.

Procedure

To convert the customized panels:

1. Generate the layout XML file for the panel. See Generating the layout XML file.

2. Open the layout XML file in a text editor. For more information, see The layout XML file.

3. Convert the panel by using Microsoft Visual Studio. See Creating the Datacap Desktop in Microsoft Visual
Studio.

$
Generating the layout XML file

You can convert your customized panels to Datacap Desktop panels. You must generate a layout XML file that
contains the panel to convert and the name and location of the converted panel.

Procedure
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To generate the layout XML file:

w N

O 00 O 01 &

$

. Start the client for which you want to convert panels, Batch Pilot, or DotEdit.
. Click File > Open Project.
. Select the Verify project of the application and click Open. For example,

\Datacap\Survey\dco_Survey\verify.bpp.

. In the Batch View window, expand the application to the page level so that the pages are visible.
. Right-click the page that you want to convert and choose View Form.

. Click Form > Run Script.

. Press Shift+Alt+S to run the script that exports the form information as a layout XML file.

. Select the target location and specify the file name.

. Click Open to generate the XML file.

The layout XML file

After you generate the layout XML file, you can open the file in a text editor like Notepad. You can review the
control types that are listed in the file.

The layout XML file contains information about each of the standard Datacap controls that are used. The file
includes the control type, control name, position, and other attributes. The script exports only the following
control types.

dcimage
dcedit
combobox
label

If your form includes other control types, you must manually add them by using Microsoft Visual Studio.

$

Creating the Datacap Desktop in Microsoft Visual Studio

After you generate and review the layout XML file, open the layout XML file in Microsoft Visual Studio. Then, you
can convert the customized panel to the Datacap Desktop panel.

Procedure

To create the Datacap Desktop form in Microsoft Visual Studio:

1.
. From the Select User Control list, select the DotEditPanels.dotMaster.
. Inthe DCO Setup field, click Browse and select the application DCO XML file. For example,

w N

No oA~

[e0]

In Visual Studio, open the Datacap Desktop project and press Ctrl+F5.

C:\Datacap\MyApp\dco_MyApp\MyApp.xml.

. In the Layout XML field, click Browse and select the XML file that you generated.

. In the Page Type field, select the page for which to create the custom panel.

. In the New name field, enter the name for the new C# class.

. Click Create. Datacap Desktop displays a message that indicates you must reload the project. You are

prompted to do reload the project in the next step.

. Click OK to close the message box and then close the ‘dotmaster' UserControl TestContainer window.
. Click Reload.
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10. In the Solution Explorer, double-click the new .cs file to display the new custom panel that is generated
from the XML file.

$

Creating a production environment

Upgrade a production client/server environment by installing Datacap software on newly provisioned
computers and migrating the application to a new environment.

Procedure

To create a production environment:

1. Install and verify the new version of Datacap software on computers that are not running current
Datacap software. For installation details, see Datacap installation and configuration in a client/server
environment.

2. Copy the migrated or newly customized applications from your test environment to the newly installed
release. For details on migrating database information, see Copying the application to the Datacap
server,

. Test and verify the functions of the new configuration before you deploy it into production.

. Ensure that users can connect to the newly updated production-ready configuration.

5. Switch to the newly configured system for production use. For example, you might disable user activity

permanently on the previous production system and ensure that new server IP addresses are correctly
designated.

B W

&

Uninstalling Datacap

The Datacap installation removal process removes only those files that the previous Datacap installation
process created.

Before you begin

Before you begin the uninstall, ensure that all Datacap client and Datacap Web Client users and administrators
on all workstations are logged off.

Verify that all developers are logged off and all background client processes are shut down, including Datacap
Web Client Upload Service, the Rulerunner Service, Datacap Studio, FastDoc, Maintenance Manager, and
Report Viewer.

Finally, ensure that you stop the Datacap Web Client site and any other Datacap sites or web-based services.

After you ensure that no other Datacap software components are running, shut down the Datacap Server
Service.

Important: In Windows Explorer, navigate to a network location and create one or more folders for storing the
backup copy of your customized application folders and shortcuts.

About this task

Any files, settings, registry keys, administrative users, websites, process model identity changes that you
altered or created in Datacap or that were changed by Datacap processing are not removed automatically by
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the installation removal process. You must remove these things manually.

If you are installing a newer version of Datacap on the same machine in the same location, customized
applications that were untouched by the installation removal process are not changed by the later installation.
But you must follow all applicable upgrade instructions, if any, provided with the newer version of Datacap for
your custom application.

The complete installation removal process includes several steps.

1.

Backing up custom applications

You must make backups of folders that contain the customization that you want to keep. Make copies of
every customized application, including customized Datacap Web Client pages and Report Viewer
reports.

. Backing up custom application shortcuts

You can make backup copies of the Datacap client shortcuts for custom applications that are found on
user and developer workstations or on servers.

. Removing Datacap Web Client and Datacap Report Viewer sites

Windows servers on which Datacap Web Client and Report Viewer were installed and configured contain
sites that can be removed. The Report Viewer site can be removed manually. The Datacap Web Client
Server Configuration tool must be used to unconfigure the Datacap Web Client site before you remove
the site.

. Removing the Datacap Application Pools

Windows servers on which Datacap Web Client and Report Viewer are configured contain one or more
Datacap application pools that you can remove.

. Removing IBM Datacap Version 9.0.1

To remove Datacap 9.0.1, use the Microsoft Windows removal process.

. Removing accounts from Administrator and Backup Operator groups

A number of Datacap components required that domain/Windows accounts be added to the
Administrator or Backup Operator Groups on the server. Repeat this procedure on each server on which
Datacap was installed.

. Deleting the Datacap registry keys

Every machine on which Datacap components were installed contains Datacap registry keys that you
must delete. Repeat this procedure on each machine on which Datacap was installed.

. Deleting the program shortcuts

Program shortcuts were created on every computer on which a Datacap component was installed.
Repeat this procedure to delete shortcuts from the Windows 7 and Windows 2008 computers on which
a Datacap component was installed.

. Deleting the remaining folders

Some folders, including the C:\Datacap folder and some of its subdirectories, might not automatically be
deleted during the uninstall process. You must manually delete these folders after the uninstall process
is completed.

Parent topic: Installing

Backing up custom applications

You must make backups of folders that contain the customization that you want to keep. Make copies of every
customized application, including customized Datacap Web Client pages and Report Viewer reports.

Procedure

To back up your custom applications:

1.

Using Windows Explorer on the Datacap server, go to the C:\Datacap folder.
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. Copy the datacap.xml file to your backup folder.

. Using Windows Explorer, go to C:\Datacap\application name folder.

. Copy the application name folder to your backup folder.

. If other files associated with the custom application exist in other locations, copy them to your backup
folder as well. For example, your Administrator and Engine databases are on a database server. Your
custom Datacap Web Client pages are on the Datacap Web Client Server. Customized Report Viewer
reports are on the Report Viewer server.

o wWN

Backing up custom application shortcuts

You can make backup copies of the Datacap client shortcuts for custom applications that are found on user and
developer workstations or on servers.

Procedure

To back up the user shortcuts for custom applications that appear on the Start menu of a Windows workstation
or a Windows server.

1. Using Windows Explorer, navigate to the C:\ProgramData\Microsoft\Windows\Start
Menu\Programs\Datacap\User\application folder. Depending on your Windows settings, the
C:\ProgramData folder might be hidden. If it is, you can either change the Folder Options to display
hidden files, or you can enter the path manually in Windows Explorer.

2. Right-click the |application folder and select Copy.

3. Using Windows Explorer, navigate to your backup folder.

4. Right-click in the folder and select Paste.

Removing Datacap Web Client and Datacap Report Viewer
sites

Windows servers on which Datacap Web Client and Report Viewer were installed and configured contain sites
that can be removed. The Report Viewer site can be removed manually. The Datacap Web Client Server
Configuration tool must be used to unconfigure the Datacap Web Client site before you remove the site.

Procedure

To unconfigure a Datacap Web Client site.

1. From the Start menu, select IBM Datacap Web > Datacap Web Client Server Configuration Tools. If User
Account Control (UAC) is on, the User Account Control window is displayed. Click Yes.

2. Click OK to close the information box.

3. Click Unconfigure.

4. Click OK, then click Exit.

To remove sites and virtual folders:

5. From the Start menu, select Administrative Tools > Internet Information Services (IIS) Manager.
6. Expand the Computer and Sites nodes.

7. Right-click the Datacap Web Client or Report Viewer site and select Remove.

8. Close the Internet Information Services (IIS) Manager window.

Removing the Datacap Application Pools
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Windows servers on which Datacap Web Client and Report Viewer are configured contain one or more Datacap
application pools that you can remove.

Procedure

To remove Datacap application pools:

1. From the Start menu, select Administrative Tools > Internet Information Services (IIS) Manager.
2. In the Connections pane, select Application Pools. The Application Pools are listed in the center pane.
3. For each Datacap application pool, right-click the application pool and select Remove.

Removing IBM® Datacap Version 9.0.1

To remove Datacap 9.0.1, use the Microsoft Windows removal process.

Procedure

1. In Windows, select Start > Control Panel > Programs > Programs and Features.

2. On the Programs and Features window, scroll down to Datacap 9.0.1 and click Uninstall. A message box
prompts you to confirm that you want to remove the software.

3. Click Yes.

4, If the User Account Control (UAC) window is displayed, click Yes.

Removing accounts from Administrator and Backup Operator
groups

A number of Datacap components required that domain/Windows accounts be added to the Administrator or
Backup Operator Groups on the server. Repeat this procedure on each server on which Datacap was installed.

Procedure

To remove accounts from either or both of the Windows Administrator and Backup Operator groups:

1. From the Start menu, select Administrative Tools > Computer Management > Local Users and Groups >
Groups.

2. Double-click the Administrators group to open it and remove all Datacap accounts, then click OK.

3. Double-click the Backup Operators group to open it and remove all Datacap accounts, then click OK.

Deleting the Datacap registry keys

Every machine on which Datacap components were installed contains Datacap registry keys that you must
delete. Repeat this procedure on each machine on which Datacap was installed.

Procedure

To delete the Datacap registry keys:

1. From the Start menu, select Run.

2. Enter regedit, then click OK. When User Access Control (UAC) is on, click Yes.

3. On both Windows 32 and Windows 64-bit machines, navigate to and delete the following
key:\HKEY_CURRENT_USER\Software\Datacap.
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4. On Windows 32-bit machines, navigate to and delete the following
key:\HKEY_LOCAL_MACHINE\SOFTWARE\Datacap.

5. On Windows 64-bit machines, navigate to and delete the following
key:\HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Datacap.

6. Close the Registry Editor window.

Deleting the program shortcuts

Program shortcuts were created on every computer on which a Datacap component was installed. Repeat this
procedure to delete shortcuts from the Windows 7 and Windows 2008 computers on which a Datacap
component was installed.

Procedure

1. Using Windows Explorer, navigate to C:\ProgramData\Microsoft\Windows\Start Menu\Programs folder.
Depending on your Windows settings, the C:\ProgramData folder might be hidden. If it is, you can either
change the Folder Options to display hidden files, or you can enter the path manually in Windows
Explorer.

2. Right-click the Datacap folder and select Delete.

3. If there are shortcuts on the desktop, right-click the shortcut, and select Delete.

Deleting the remaining folders

Some folders, including the C:\Datacap folder and some of its subdirectories, might not automatically be
deleted during the uninstall process. You must manually delete these folders after the uninstall process is
completed.

Procedure

To delete the remaining folders that were not removed by the uninstall process:

1. Using Windows Explorer, navigate to the C:\Datacap folder.

2. Right-click on the Datacap folder and select Delete. If access is denied, delete the individual subfolders
before you delete the Datacap folder.

3. If you processed batches using the Datacap Web Client, the Scan Into field identified the folder that was
used to temporarily hold images during scanning. The default name and location of this folder is
C:\Datacap\scan. If this folder is not in C:\Datacap, navigate to and delete the folder.

Monitorowanie

System mozna monitorowac w trybie online za pomoca Datacap Navigator lub poprzez uruchamianie raportow.

e Monitorowanie systemu w programie Datacap Navigator
Mozesz monitorowac system Datacap za pomocg kokpitu w programie Datacap Navigator. Kokpit
przedstawia wizualne podsumowanie statystyk systemowych zawierajace takze alerty dotyczace
niektérych metryk systemu, uruchamiane, gdy metryki te nie spetniaja konfigurowanych parametréw
ustalonego poziomu wydajnosci.

e Monitorowanie systemu za pomocg przegladarki raportow w programie Datacap
Mozesz monitorowac system Datacap, uruchamiajac raporty standardowe lub niestandardowe.

Monitoring your system with Datacap Navigator
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You can monitor your Datacap system by using a dashboard in Datacap Navigator. The dashboard shows
summary information for the following categories: in-progress tasks, team performance, and OCR accuracy.
Included in the system summary are alerts for some system metrics when those metrics do not satisfy
configurable service-level-agreement parameters.

The summary information is shown in two main ways:

Donuts | The relative amounts of various items are shown visually in circles that are called donuts. For
example, for in-progress tasks, the proportion of batches that are in the Verify task is shown.

Graphs | Item metrics over time are shown.

You can drill down on the summary information to see the details.

e Accessing the dashboard
You can use the dashboard to monitor your Datacap system.

e Enabling application statistics collection
To use the dashboard for monitoring accuracy-related statistics, you must enable the collection of
statistics for one or more applications.

e Configuring dashboard features

To use the dashboard, you must add the dashboard as one of your Datacap Navigator desktop features.

When you add the desktop as a feature, you enter values for parameters that affect the dashboard
display and alerts. Also, you optionally enter an email address for receiving email notifications.

Accessing the dashboard

You can use the dashboard to monitor your Datacap system.

Before you begin

If you did not already do so, perform the following actions:

1. Install Datacap Navigator. For more information, see Installing and configuring Datacap Navigator.
2. Enable statistics collection. For more information, see Enabling application statistics collection.
3. Add the dashboard to Datacap Navigator. For more information, see Configuring dashboard features.

Procedure

To access the dashboard:

1. Open Datacap Navigator. For more information, see Datacap Navigator access.
2. Click the Open Datacap Dashboard icon.

Parent topic: Monitoring your system with Datacap Navigator

Enabling application statistics collection

To use the dashboard for monitoring accuracy-related statistics, you must enable the collection of statistics for

one or more applications.

About this task

Important: Enabling statistics collection for an application makes your application's Export task run slower.
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Procedure

To enable statistics collection for an application:

1. In the Start menu, select IBM Datacap Services>Datacap Application Manager. If the User Account
Control window opens, click Yes.

2. In the Applications pane, select the application.

3. Click the Main tab.

4. On the Main tab, select Save Statistics.

5. Close the Datacap Application Manager.

Parent topic: Monitoring your system with Datacap Navigator

Configuring dashboard features

To use the dashboard, you must add the dashboard as one of your Datacap Navigator desktop features. When
you add the desktop as a feature, you enter values for parameters that affect the dashboard display and alerts.
Also, you optionally enter an email address for receiving email notifications.

The feature name for the dashboard is Datacap Dashboard Page. For the procedure for adding this feature, see
Customizing Datacap Navigator desktops. When you select this feature, a Feature configuration pane displays
to the right.

e Enabling email notification
To enable email notification, you must perform some JAR file configuration in addition to specifying an
SMTP mail server and email address during dashboard feature configuration.

e Dashboard parameters
For the SLA JSON string field, you enter parameter values that affect the behavior of the dashboard.

Parent topic: Monitoring your system with Datacap Navigator

Enabling email notification

To enable email notification, you must perform some JAR file configuration in addition to specifying an SMTP
mail server and email address during dashboard feature configuration.

About this task

When you enable email notification, the Datacap system sends emails to alert you of certain conditions based
on your configured thresholds. Two types of emails are sent:

Threshold An email might be sent when a threshold is reached or exceeded.

exceeded
For example, suppose that you set the pending batch threshold to 60 minutes. If a

batch is in pending state for that amount of time or longer, an email might be sent. (An
email is sent only if the batch is one of the top 10 pending batches.) The email
indicates the exceeded-threshold condition for the batch.

Cleared Another email is sent when the threshold condition is satisfied.

For example, suppose that a threshold-exceeded email was sent for a pending batch.
When that batch is no longer pending, an email is sent that indicates the cleared status
of the original alert.
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Procedure

To configure the JAR files that are needed for email notification:

1. Find the directory that contains the DatacapWebPlugin.jar file on your system. This file is installed as

part of the Datacap Navigator installation. For information about this installation, see Installing and
configuring Datacap Navigator.

. Open a DOS command window.

. In the DOS command window, change directories to the directory that contains the
DatacapWebPlugin.jar file. For example, you might change directories to the C:\Datacap\tmweb.java
directory with the following command: cd C:\Datacap\tmweb.java.

. Run the following commands:

jar —-xvf DatacapWebPlugin.jar lib\activation.jar
jar —-xvf DatacapWebPlugin.jar lib\javax.mail-1.5.4.jar

These commands extract the following files:
o activation.jar
o javax.mail-1.5.4.jar
. Copy the extracted files to the following directory: ../navigator.ear/navigator.war/WEB-INF/lib. This
directory is relative to your application server profiles directory for installed applications.

Parent topic: Configuring dashboard features

Dashboard parameters

For the SLA JSON string field, you enter parameter values that affect the behavior of the dashboard.

For information about these parameters and the specific parameter names to use, see the Service-level-
agreement parameters section in this topic. Use the following format for the field value (but without any
carriage returns):

{"SLA": {

}

"parameterl-name": parameterl-value,
"parameter2-name": parameter2-value,
"parameterN-name": parameterN-value

}

Here is an example:

{"SLA" : {
"businessName": "IBM Corporation",
"appName": "TravelDocs",

}

"batchesAbortedInPresetTime": 20,
"batchesPendingInPresetTime": 100,
"pageAccuracy": 97.9,
"fieldAccuracy": 96.5

}

Service-level-agreement parameters

Parameter subject
matter

Parameter name

Statistics
type

Comments
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Parameter subject Parameter name Statistics | Comments

matter type

Accuracy rate - field - fieldAccuracy OCR A percentage such as 96.5 that

minimum accuracy specifies the minimum OCR accuracy
rate for fields. A warning is shown if the
recent OCR accuracy rate is below the
specified minimum but not more than
10% below the minimum. An alert is
shown if the recent OCR accuracy rate
is more than 10% below the minimum.

Accuracy rate - page - pageAccuracy OCR A percentage such as 97.9 that

minimum accuracy specifies the minimum accuracy rate for

page type identification. A warning is
shown if the recent page identification
accuracy rate is below the specified
minimum but not more than 10% below
the minimum. An alert is shown if the
recent page identification accuracy rate
is more than 10% below the minimum.

Batches - aborted

batchesAbortedInPresetT
ime

In-progress
tasks

The number of minutes that a batch
must have an aborted status to be
reported by the dashboard as aborted.
For example, a parameter value of 60
means that the dashboard shows all
aborted batches that were aborted 60
minutes ago or longer.

If you configure email notification, an
email is sent for a batch in the following
circumstances: the batch has an
aborted status beyond the specified
period, and the batch is one of the top
10 longest aborted batches. For details
about the emails that are sent, see
Enabling email notification.

Batches - pending

batchesPendingInPresetT
ime

In-progress
tasks

The number of minutes that a batch
must have a pending status to be
reported by the dashboard as pending.
For example, a parameter value of 120
means that the dashboard shows all
pending batches that were made
pending 120 minutes ago or longer.

If you configure email notification, an
email is sent for a batch in the following
circumstances: the batch has a pending
status beyond the specified period, and
the batch is one of the top 10 longest
pending batches. For details about the
emails that are sent, see Enabling email
notification.
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Parameter subject Parameter name Statistics | Comments

matter type

Name - application appName N/A The names of the applications for which
you enabled statistics collection. For
information about enabling statistics
collection, see Enabling application
statistics collection.

Name - business businessName N/A The name of your business

Parent topic: Configuring dashboard features

Monitoring your system with Datacap Report Viewer

You can monitor your Datacap system by running standard or custom reports.

Logging in to Datacap Report Viewer

When you log in to Report Viewer, the user ID that you use on the login page is automatically logged in to
all Datacap applications for which that user ID is a valid Datacap user.

Viewing a standard Datacap Report Viewer report

You can run and view standard Report Viewer reports to get batch productivity results.

Viewing a custom report in the Datacap Report Viewer web interface

You can review a custom report in the Report Viewer web interface. If you are logged on to the Report
Viewer home page, you must log off and log back in to see the new report.

Creating a Datacap Report Viewer report filter

You can filter the data that is displayed in a Report Viewer report, based on the values in one or more
fields. For example, if you want to view activity that is related to a specific operator, you filter the data by
operator name.

Adding reports to the Datacap Report Viewer dashboard

You can view up to six reports simultaneously on the Report Viewer dashboard. The dashboard is
typically used for viewing chart-based reports.

Modifying the Datacap Report Viewer dashboard

You can re-size, move, or remove any of the reports that are displayed on the dashboard.

Standard reports

Report Viewer provides a set of standard reports and the ability to customize existing reports and create
new reports.

Logging in to Datacap Report Viewer

When you log in to Report Viewer, the user ID that you use on the login page is automatically logged in to all
Datacap applications for which that user ID is a valid Datacap user.

Before you begin

If you did not already do so, install Datacap Report Viewer. For information about a single-machine installation,
see Datacap Report Viewer. For information about a client/server installation, see Installing and configuring
Datacap Report Viewer.

About this task

The following procedure describes how to access and log in to Report Viewer in either a single computer
environment or when you are running Internet Explorer on the Report Viewer Web Server.
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Procedure

To log in to Report Viewer:

1. Verify that the Datacap Server service is started. For more information, see Ensuring that the Datacap
Server Service is started.

2. Open Internet Explorer, and connect to:
Single machine environment (local host):

http://127.0.0.1/RV2/Login.aspx
Remote web server:

http://WebServer/RV2/Login.aspx

3. Enter the Datacap Admin User, Password, and Station (admin, admin, and 1), then click Login The
Report Viewer home page is displayed with the Datacap applications to which the Datacap login user ID
has access.

Parent topic: Monitoring your system with Datacap Report Viewer

Viewing a standard Datacap Report Viewer report

You can run and view standard Report Viewer reports to get batch productivity results.

Procedure

To view a standard Report Viewer report:

1. On the Report Viewer home page, select the Batch Productivity report.
2. Select the application and click Run Report.
3. Click Reports to return to the Report Viewer home page.

Parent topic: Monitoring your system with Datacap Report Viewer

Viewing a custom report in the Datacap Report Viewer web
interface

You can review a custom report in the Report Viewer web interface. If you are logged on to the Report Viewer
home page, you must log off and log back in to see the new report.

Before you begin

Custom reports must be created.

Procedure

To view a custom report in the Report Viewer web interface:

1. In your web browser, go to the Report Viewer home page, http://<machine_name>/Login.aspx.

2. Enter your user name, password, and station ID. Click Login.

3. Select your application from the application list. You can select multiple applications by holding down
the CTRL key.
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Important: The application list comes from the file C:\Datacap\datacap.xml. If an application that you
are looking for is not listed, verify that the application is included in the datacap.xml file.

4. Select your custom report.
Important: If your report is not listed, log out of Report Viewer and log back in again. You must log out
and log back in any time that you add a report or modify an existing report.

5. Click Run Report. Report Viewer displays the default custom report.

Parent topic: Monitoring your system with Datacap Report Viewer

Creating a Datacap Report Viewer report filter

You can filter the data that is displayed in a Report Viewer report, based on the values in one or more fields. For
example, if you want to view activity that is related to a specific operator, you filter the data by operator name.

About this task

Each filter is associated with a single report. The Select Filter list on the Report Viewer home page displays only
those filters that are available for the report that you selected.

Procedure

To create a Report Viewer report filter:

. On the Report Viewer home page, select the report from the list.
. Click Manage Filters to display the Filter-related fields.
. In the Add Filter field, enter a name for the new filter.
. Click Add to display more fields.
. Set up the filter as follows:
a. In the first field, select the column name such as Operator.
b. In the second field, select the action such as equal to.
c. In the third field, enter the value such as admin.
. Click Add Filter and repeat the previous step to add another field.
. Select Public to make the filters available to all users or Private to make the filters available only to you.
. Click Save.
. Click Run Report to run the report by using the new filter.
10. Click Reports to return to the Report Viewer home page.
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Parent topic: Monitoring your system with Datacap Report Viewer

Adding reports to the Datacap Report Viewer dashboard

You can view up to six reports simultaneously on the Report Viewer dashboard. The dashboard is typically used
for viewing chart-based reports.

Procedure

To add reports to the Report Viewer dashboard:

1. On the Report Viewer home page, click Dashboard.

2. Select the report and the application name to display the report. If applicable, select a filter.

3. To add another report, click Add and repeat the previous step.

4. If you want the data on the reports to refresh automatically, click Refresh and select a refresh interval.
5. Click Reports to return to the Report Viewer home page.
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Parent topic: Monitoring your system with Datacap Report Viewer

Modifying the Datacap Report Viewer dashboard

You can re-size, move, or remove any of the reports that are displayed on the dashboard.

Procedure

To modify the Report Viewer dashboard:

1. On the Report Viewer home page, click Dashboard.
2. To re-size a report, click the cross-hatched area on the window and drag.

3. To move a report, click the dotted area of the report and drag the report to a different location.

4. To remove a report, click the report that you want to remove, then click Remove.
5. Click Reports to return to the Report Viewer home page.

Parent topic: Monitoring your system with Datacap Report Viewer

Standard reports

Report Viewer provides a set of standard reports and the ability to customize existing reports and create new

reports.

The following standard reports for monitoring batch status, station activity, and problem batches are included
with the Report Viewer software component:

Table 1. Standard reports for monitoring batch status, station activity, and problem batches

Repo

rt

Nam Data
e Description source
Probl | Displays all queued batches that aborted or are offline, or ran for longer than 2 hours. queue
em table
Batc

hes

Curre | Displays all queued batches that are not complete or were not canceled. queue
nt table
Batc

hes

Batc |Same as Current Batches except that it includes elapsed time since batch was started. queue
h table
Agin

g

Curre | Displays the station IDs and IP addresses of all stations that are currently logged, plus the gstats
nt number of batches that are processed by each station. table
Stati

ons
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Repo
rt
Nam Data
e Description source
Stati | Displays a bar chart that shows the number of batches that are completed by each station gstats
on within the last 4 hours. table
Activ
ity
Pend | Displays a bar chart that shows the number of queued batches with a status of Pending. queue
ing table
Task
s
Task | Displays a bar chart for the selected date range that shows the percentage of each hour taskstat
s Use | spent processing by each station. s table
Hourl
y
Task [Displays a bar chart for the selected date range that shows the percentage of each day taskstat
s Use [ spent processing by each station. s table
Daily
Task [Background taskstat
s Displays summary of all batches that are processed, grouped by station ID. Includes |s table
aggregates for processing time, number of pages that are scanned, and so on, for
each station.
Scan
Displays a list of the Datacap Desktop scanned batches, which are grouped by
operator. Includes aggregates for processing time, number of pages that are scanned,
and so on, for each operator.
Fixup
Displays a list of all batches that were through Fixup, which is grouped by operator.
Includes aggregates for processing time, number of pages that are rescanned,
inserted, and so on, for each operator.
Verify
Displays all batches that are in or ready for verification, which is grouped by operator.
Includes aggregates for processing time, pages processed, average documents per
hour, and so on, for each operator.
Task e Background Summary taskstat
S e Scan Summary s table
Sum e Fixup Summary
mary e Verify Summary
Batc | Displays a list of all batches with status of "Job done." Includes number of pages that are queue
h scanned and total elapsed time for each batch from when batch was started until and
Prod |completed. Also includes average number of pages and average elapsed time per batch. tmbatch
uctivi tables
ty
Debu | Displays a list of all batches in the debug table (for example, batches that were deleted debug
g manually). Includes the batch status, status before the batch is moved to the debug table, table
and so on.
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Parent topic: Monitoring your system with Datacap Report Viewer

Dostosowywanie i uruchamianie aplikaciji

Razem z produktem IBM Datacap dostarczane sa przyktadowe aplikacje branzowe.

Uzywanie pulpitu aplikacji Datacap z aplikacjami Datacap

Po pomyslnej instalacji programu Datacap w wersji 9.0.1 mozesz wykorzysta¢ program Datacap Desktop
do tworzenia partii, rozpoznawania stron, tworzenia dokumentow i eksportowania partii.
Przygotowywanie i uruchamianie aplikacji Fastdoc

W programie FastDoc mozesz tworzy¢ aplikacje do skanowania, indeksowania i recznego uruchamiania
czynnosci dotyczacych dokumentéw w tle zaréwno w autonomicznym $rodowisku, jak i jako klient
programu Datacap.

Uruchamianie aplikacji Datacap Accounts Payable

Uzyj aplikacji klienckiej programu Datacap Accounts Payable do przetwarzania przyktadowych, wstepnie
zeskanowanych obrazéw faktur zawartych w opcji produktu Datacap Accounts Payable.

Zastosowania dla wnioskéw medycznych

Uzyj aplikacji klienckiej programu Datacap Medical Claims do automatyzacji wprowadzania danych z
profesjonalnych formularzy wnioskéw (CMS 1500) uzywanych przez indywidualnych
$wiadczeniodawcdw lub dostawcow ustug medycznych oraz formularzy wnioskow (UB04) uzywanych
przez instytucje, na przyktad szpitale.

Aplikacja Traveldocs

Przyktadowa aplikacja TravelDocs wchodzaca w sktad instalacji produktu Datacap pokazuje, w jaki
sposo6b aplikacja Datacap przetwarza rozne dokumenty zwigzane z podréza.

Konfigurowanie sktadnika Rulerunner do wykonywania czynnosci w aplikacji

Po pomyslnym skonfigurowaniu aplikacji do recznego przetwarzania czynnosci mozesz skonfigurowaé
sktadnik Rulerunner w celu automatycznego uruchamiania w czynnosci aplikacji w tle. Niektore z
czynnosci, dla ktérych mozesz zechcie¢ skonfigurowac uruchamianie sktadnika Rulerunner, obejmuja
rozpoznawanie, wstepne przetwarzanie obrazu, sprawdzanie poprawnosci i eksportowanie. Czynnosci
skanowania wirtualnego (VScan) mozna takze uruchomié, jesli sa przygotowane do automatycznego
gromadzenia obrazow bez koniecznosci recznego wyboru obrazow przez uzytkownika.

Running tasks with Datacap Desktop

You can use Datacap Desktop to run application tasks.

You can confirm that a task is complete and that the next task is pending by checking the Job Monitor in
Datacap Desktop, FastDoc, or your web client.

Task profiles for Datacap Desktop

You can use Datacap Desktop to run various tasks. Some of these tasks are automated, which means
that they do not require human intervention.

Starting a task with Datacap Desktop

You can use Datacap Desktop to run all of the default tasks that the Datacap Studio application wizard
generates.

Running the VScan task with Datacap Desktop

The VScan task creates a batch by importing electronic files from a specified location. It is mostly used
for demonstration purposes.

Running the Scan task with Datacap Desktop

You can use Datacap Desktop to scan hardcopy pages.

Running the Fixup task with Datacap Desktop

The Fixup task requires user input to correct any errors or integrity issues that were encountered in a
preceding task. The batch does not continue to the next task until the Fixup task is completed. Datacap
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Desktop identifies the problem document, page, field, or subfield in the batch so that you can make any
corrections.

Related information:
Job monitoring

Task profiles for Datacap Desktop

You can use Datacap Desktop to run various tasks. Some of these tasks are automated, which means that they
do not require human intervention.

Tasks are instances of task profiles. The following table shows the relevant task profiles for Datacap Desktop.

Task profile | Automated | Description

task?

VScan No Creates a batch by importing electronic files from a specified location. For more
information, see Running the VScan task with Datacap Desktop.

Scan No Scans hardcopy pages. For more information, see Running the Scan task with
Datacap Desktop.

PagelD Yes Identifies the page type of a scanned image. Specifically, Datacap Desktop
applies the page type identification rules on a batch and displays a completion
message when the task is finished.

Profiler Yes Creates documents out of the pages. To do so, Datacap Desktop applies rules
that are based on predefined criteria. Datacap Desktop displays a completion
message when the task is finished.

Fixup No Fixes errors or problems. For more information, see Running the Fixup task with
Datacap Desktop.

Verify No Verifies the accuracy of the captured data.

Export Yes Exports a pending batch to a specified location. Datacap Desktop displays a
completion message when the task is finished.

Important: You must complete the Verify task, if it is included in the job, before
you can complete the Export task. The Verify task can be completed only in the
web client or Datacap Desktop, depending on how you configured the Verify task.

Background | Yes Automates the completion of pending batches and completes all automated
tasks. The automated tasks are run consecutively, except for the VScan, Fixup,
and Verify tasks.

Parent topic: Running tasks with Datacap Desktop

Starting a task with Datacap Desktop

You can use Datacap Desktop to run all of the default tasks that the Datacap Studio application wizard
generates.

About this task

Datacap applications include tasks that you can run from the Datacap Web Client or Datacap Desktop. The
client that you use to run a task depends on your business requirements and environment.

Procedure
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To start a task:

1. Start Datacap Desktop. In the Start menu, select IBM Datacap Clients > Datacap Desktop. Select the
application for the task that you want to run, and log on with an account that has sufficient rights to
complete the task.

2. Select the task from the Shortcut menu and click Start.

Tip: If you do not see the task in the Shortcut menu, confirm that you specified Datacap Desktop as the
program to use in the task’s Setup dialog window in the Datacap Web Client. For more information, see
Creating and configuring a task to use with Datacap Desktop.

Parent topic: Running tasks with Datacap Desktop

Running the VScan task with Datacap Desktop

The VScan task creates a batch by importing electronic files from a specified location. It is mostly used for
demonstration purposes.

Before you begin

Optionally configure barcode recognition. For more information, see Setting up a barcode type as a document
separator.

Procedure

To run the VScan task:

1. In Datacap Desktop, start the VScan task. In the Scan from field, browse to the location from which to
import the files and then click Scan. For more information, see Starting a task with Datacap Desktop.

2. If necessary, arrange the batch by removing images or moving the images up or down to change their
order.

3. Click Done.

Parent topic: Running tasks with Datacap Desktop

Running the Scan task with Datacap Desktop

You can use Datacap Desktop to scan hardcopy pages.

Before you begin

e Set up your scanner. For more information, see Setting up your scanner.
e Optionally configure barcode recognition. For more information, see Setting up a barcode type as a
document separator.

Procedure

To scan hardcopy pages:

1. Load the pages that you want to scan into your scanner's feeder.
2. In Datacap Desktop, start the Scan task. Log on with an account that has sufficient rights to complete a
scanning task. For more information, see Starting a task with Datacap Desktop.
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3. Click Select, if you are scanning documents from Datacap Desktop for the first time or if you are
changing your scanner.

4. After you select your scanner, click Configure, if you want to change your scanner’s settings. The settings
that you can modify are determined by the scanner’s options and function.

5. After you modify the scanner settings, click OK.

Tip: Datacap Desktop provides the option for specifying the paper source and the scanned image’s color
mode, DPI resolution, brightness, and contrast.

6. Click Scan.

o Datacap Desktop arranges the thumbnails of the scanned images in the Image View pane, which
you can arrange by clicking Off, Vert, or Horz.

Tip: You can rotate an image by selecting the image in the Batch View pane and clicking one of the
rotation buttons in the center pane.

o The Batch View pane displays a list of scanned images in the current batch. You can organize the
scanned images by selecting an image and then clicking the corresponding button to insert,
replace, remove, move up or down, join, or split the image or document.

Tip: The buttons in Datacap Desktop are enabled with tooltips that provide information about the
function of the button.

7. If necessary, you can place more pages into your scanner’s feeder and click Scan to add images to the
batch.

8. After you finish scanning, select an image in the Batch View pane. Datacap Desktop displays the
selected imaged in the Image View pane and assigns the page type by selecting an option from the Type
menu.

9. In the Status field, select either OK or Problem from the menu.

Important: Selecting the Problem value places the batch in a Pending status and the batch does not
proceed to the next task in the workflow until a Fixup task is successfully completed.

10. After you finish organizing the batch and assigning page types and statuses, click OK. Datacap Desktop
displays a message that the batch is finished and that you can proceed to the next batch.

11. You can confirm that the scan task is complete and that the next task is pending by checking the Job
Monitor in Datacap Desktop, FastDoc, or your web client.

Parent topic: Running tasks with Datacap Desktop

Running the Fixup task with Datacap Desktop

The Fixup task requires user input to correct any errors or integrity issues that were encountered in a preceding
task. The batch does not continue to the next task until the Fixup task is completed. Datacap Desktop identifies
the problem document, page, field, or subfield in the batch so that you can make any corrections.

About this task

In Fixup task, you can manipulate, rearrange or delete pages. The pages are marked in the Verify task.
However, the actual operation is completed in the Fixup task. You might need to rescan an image as part of the
Fixup task. There are two possible selection modes for rescanned images: automatic and manual. For more
information, see Configuring the image selection mode for the Datacap Desktop Fixup task.

Procedure

To rescan images in manual selection mode:

1. Scan the page one or more times. For example, you might rescan a page three times so that you have a
total of four images for that page. All of the rescanned images are stored in the batch folder until you
submit the batch.

286 Datacap9.1.3



2. Navigate to the image that you want to retain. To do so, use Ctrl+U to move backwards through the
images and Ctrl+Y to move forwards.

3. Submit the batch. The current image is retained and all other images are deleted.
Important: If you put a batch on hold and later return to that batch, the current image is initially the last
scanned page image. That is, the system does not save the current page image when you put the batch
on hold. Therefore, you might need to navigate back to the image that you want to retain.

Parent topic: Running tasks with Datacap Desktop

Preparing and running FastDoc applications

You can create applications on FastDoc to scan, index, and manually run background tasks on documents in a
stand-alone environment or as a client to Datacap.

In Local mode, you can use FastDoc for rapid application development with the Datacap application as a
starting point to quickly create new Datacap applications without using Datacap Studio.

In Datacap Server mode, FastDoc runs as a client that scans, auto indexes, and uploads batches of documents
to Datacap Server. FastDoc is extended to take advantage of Datacap Studio, Application Manager, and other
Datacap features.

In Datacap Server mode, you can create an application and setup document hierarchy items such as batches,
documents, pages, and fields for that application. You can configure compiled rulesets for the document
hierarchy items to run functions like import, page identification, image enhancement, fingerprint matching, and
export on the application. The compiled rulese